
Line Origination Setup Guide

Oracle Financial Services Lending and Leasing
Release 14.5.0.0.0

Part No. E95814-01

May 2018



Line Origination Setup Guide
May 2018
Oracle Financial Services Software Limited

Oracle Park

Off Western Express Highway
Goregaon (East)
Mumbai, Maharashtra 400 063 
India
Worldwide Inquiries:
Phone: +91 22 6718 3000
Fax:+91 22 6718 3001
https://www.oracle.com/industries/financial-services/index.html

Copyright © 2007, 2018, Oracle and/or its affiliates. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective 
owners.

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed 
on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to 
the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, 
modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the 
hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other 
rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or 
intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use 
this software or hardware in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup, 
redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages 
caused by use of this software or hardware in dangerous applications.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and 
are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may 
not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part, in 
any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for 
interoperability, is prohibited.
The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, 
please report them to us in writing.

This software or hardware and documentation may provide access to or information on content, products and services from third 
parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect 
to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services.

https://www.oracle.com/industries/financial-services/index.html
https://www.oracle.com/industries/financial-services/index.html


Table of Contents

1. Navigation ................................................................................................ 1-1
1.1 Audience..................................................................................................................  1-1

1.2 Conventions Used ...................................................................................................  1-1

1.3 Logging In................................................................................................................  1-1

1.4 Template and Navigation.........................................................................................  1-2

1.4.1  Home Screen..............................................................................................  1-2

1.4.2  Screens ....................................................................................................  1-11

1.5 Common Operations .............................................................................................  1-11

1.5.1  Basic Operations ......................................................................................  1-11

1.5.2  Basic Actions ............................................................................................  1-12

1.5.3  Personalization Options............................................................................  1-13

1.6 Keyboard Compatibility..........................................................................................  1-17

1.6.1  Keyboard Compatibility.............................................................................  1-17

1.7 Tool Tips................................................................................................................  1-18

1.8 Accessibility ...........................................................................................................  1-18

1.8.1  Understanding Accessibility......................................................................  1-18

1.8.2  Application Accessibility Preferences .......................................................  1-18

1.8.3  Documentation Accessibility Preferences ................................................  1-18

2. Administration System ............................................................................ 2-1
2.1 System Parameters .................................................................................................  2-1

2.1.1  System Parameters Setup..........................................................................  2-2

2.1.2  Organization Parameters............................................................................  2-4

2.1.3  Company Parameters.................................................................................  2-6

2.2 Lookups Setup screen.............................................................................................  2-7

2.3 User Defined Tables................................................................................................  2-9

2.4 Audit Tables...........................................................................................................  2-13

2.5 User Defined Defaults ...........................................................................................  2-15

2.6 Transaction Codes ................................................................................................  2-19

2.6.1  Transaction Codes sub screens ...............................................................  2-23

2.7 Data Files ..............................................................................................................  2-25

2.7.1  Output tab.................................................................................................  2-26

2.7.2  Input tab....................................................................................................  2-28

2.8 Events....................................................................................................................  2-30

2.8.1  Events.......................................................................................................  2-30

2.9 Batch Jobs.............................................................................................................  2-39

2.9.1  Batch Jobs................................................................................................  2-39

2.9.2  Batch Jobs Available ................................................................................  2-43

2.10 Producer Cycles ....................................................................................................  2-91

2.11 Vendors .................................................................................................................  2-93

2.11.1  Cycles Tab................................................................................................  2-93

2.11.2  Vendor Services Tab ................................................................................  2-95

2.11.3  Vendor Fees Tab......................................................................................  2-96

2.11.4  Invoice Rules tab ......................................................................................  2-98

2.12 Reports ..................................................................................................................  2-98

2.13 Error Messages ...................................................................................................  2-100

2.14 Translation...........................................................................................................  2-101



2.14.1  Setup Translation ...................................................................................  2-102

2.14.2  Message Translation Setup....................................................................  2-103

2.15 Seed Data............................................................................................................  2-106

2.15.1  Factory Data ...........................................................................................  2-107

2.15.2  Current Data ...........................................................................................  2-109

2.15.3  Comparison Data....................................................................................  2-110

2.15.4  Download Data .......................................................................................  2-111

2.16 Data Masking.......................................................................................................  2-112

2.16.1  Setup Data Masking ...............................................................................  2-114

2.16.2  Create data redaction policy...................................................................  2-116

2.16.3  Masking User defined data.....................................................................  2-116

3. Administration User ................................................................................ 3-1
3.1 Organization ............................................................................................................  3-1

3.2 Companies ..............................................................................................................  3-6

3.3 Access ...................................................................................................................  3-10

3.3.1  Data ..........................................................................................................  3-11

3.3.2  Screen ......................................................................................................  3-12

3.3.3  Reports .....................................................................................................  3-14

3.3.4  Correspondence .......................................................................................  3-16

3.3.5  Webservice...............................................................................................  3-17

3.4 Users .....................................................................................................................  3-20

3.4.1  Replacement users...................................................................................  3-22

3.4.2  Application and Oracle Identity Manager Synchronization .......................  3-23

3.5 Credit Bureau ........................................................................................................  3-23

3.5.1  Credit Bureau ...........................................................................................  3-24

3.5.2  Special Metro II Code reporting................................................................  3-35

3.5.3  Oracle Wallet Manager setup ...................................................................  3-36

3.5.4  Oracle JVM Security setup .......................................................................  3-37

3.5.5  Importing a trusted certificate into an Oracle Wallet .................................  3-38

3.5.6  Importing the Certificates into an Oracle Wallet .......................................  3-39

3.5.7  De-duping Credit Bureau data..................................................................  3-41

3.6 Correspondence ....................................................................................................  3-42

3.6.1  Correspondence .......................................................................................  3-43

3.6.2  Creating Correspondence ........................................................................  3-52

3.6.3  Generating Correspondence ....................................................................  3-54

3.7 Queues ..................................................................................................................  3-56

3.7.1  Origination Tab .........................................................................................  3-56

3.7.2  User Groups Tab ......................................................................................  3-61

3.8 Printers ..................................................................................................................  3-62

3.9 Bank Details ..........................................................................................................  3-64

3.10 Standard Payees ...................................................................................................  3-67

3.11 Check Details ........................................................................................................  3-69

3.12 Currencies .............................................................................................................  3-70

3.12.1  Currency Definition ...................................................................................  3-71

3.12.2  Currency Pair link .....................................................................................  3-71

3.13 Zip Codes ..............................................................................................................  3-72

4. Product ..................................................................................................... 4-1
4.1 Asset Types.............................................................................................................  4-1

4.2 Index Rates .............................................................................................................  4-4

4.3 Currency Exchange .................................................................................................  4-6



4.4 Scoring Parameters.................................................................................................  4-7

4.5 Products ..................................................................................................................  4-9

4.5.1  Product Itemizations .................................................................................  4-11

4.6 Pricing....................................................................................................................  4-12

4.7 Contract .................................................................................................................  4-16

4.7.1  Balances...................................................................................................  4-25

4.7.2  Amortized Balances..................................................................................  4-26

4.7.3  Itemizations ..............................................................................................  4-26

4.7.4  Fees..........................................................................................................  4-28

4.8 Edits.......................................................................................................................  4-29

4.8.1  Interfacing OFSLL with Oracle Rule Author .............................................  4-34

4.9 Cycles....................................................................................................................  4-34

4.10 Scoring Models......................................................................................................  4-39

4.10.1  Credit Score Models .................................................................................  4-39

4.11 Fees.......................................................................................................................  4-44

4.12 Origination Fees ....................................................................................................  4-47

4.13 Insurance...............................................................................................................  4-49

4.14 Checklists ..............................................................................................................  4-52

4.15 Stipulations ............................................................................................................  4-54

4.16 Letters....................................................................................................................  4-56

4.17 Promotions ............................................................................................................  4-59

Appendix A:  Summary of the Application Credit Scoring Parameters ......A-1
A.1 Glossary .......................................................................................................................A-1

A.2 Credit Scoring Parameters by Category.......................................................................A-1

A.2.1  Applicant Details / Debt Ratios ......................................................................A-1

A.2.2  Line of Credit Details .....................................................................................A-4

A.2.3  Auto Trades / Inquiries ..................................................................................A-4

A.2.4  Bank Trades / Inquiries .................................................................................A-5

A.2.5  Card Trades / Inquiries ..................................................................................A-7

A.2.6  Installment Trades / Inquiries ........................................................................A-8

A.2.7  Line of Credit Finance Trades / Inquiries ......................................................A-9

A.2.8  Mortgage Trades / Inquiries ........................................................................A-10

A.2.9  Retail Trades / Inquiries ..............................................................................A-11

A.2.10  Revolving Trades ......................................................................................A-12

A.2.11  Sales Finance Trades / Inquiries ...............................................................A-14

A.2.12  Other Trades .............................................................................................A-15

A.2.13  Bankruptcy information .............................................................................A-19

A.2.14  Delinquency Information ...........................................................................A-21

A.2.15  Derogatory Trade Information ...................................................................A-22

Appendix B:  Rounding Amounts and Rate Attributes.................................B-1
Appendix C: System Parameters....................................................................C-1

C.1 Introduction...................................................................................................................C-1

C.2 System Parameters......................................................................................................C-1

C.3 Organization Parameters ...........................................................................................C-20

C.4 Company Parameters ................................................................................................C-24

C.5 Other Parameters.......................................................................................................C-29



1. Navigation

This document provides an overview of the basic template, navigation, common operations 
that can be performed, and keyboard short cuts available in Oracle Financial Services 
Lending and Leasing. Since this section details the general options available in the User 
Interface, some or all the parts of this section are applicable to you as per access provisions 
& licensing.

The document is organized into below topics:

 Logging In

 Template and Navigation

 Common Operations

 Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

1.1 Audience

This document is intended to all Prospective Users who would be working on the application.

1.2 Conventions Used

1.3 Logging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the 
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system 
administrator, in Administration > User screen. A User ID is disabled automatically by the 
system if it is inactive for a specified number of days.

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button
1-1



When you invoke the application, the Sign In screen is displayed. 

 User ID – Specify a valid User ID.

 Password – Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid 
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are 
grouped into two categories to enable easy understanding. These include:

 Home screen

 Screens

1.4.1 Home Screen

Once you login to the application with valid credentials, the system authenticates the details 
and displays the Home screen.

The Home screen consists of the following components:

 Header

 Left Pane
1-2



 Right Pane/Work Area

You can view the application version details and copyright information by clicking About link 
at the right corner of the screen.

Header 

In the Header, system displays the following:

 User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow, 
the system displays the following options:

– Change Password – Click to change the current password.
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Specify the current password in the Current Password field and a valid password, 
you wish to maintain as a new password, in the New Password field. Re-enter the 
password in Confirm Password field and click Submit to change the password.

– User Info – Click to view the current user info.

In this screen, apart from viewing the user info, you can also set Session Language, 
enable error log, and specify the time zone preference.

Session Language – Select a language that you need to set for the session, from 
the drop-down list.

Debug Enabled Ind – Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the 
following two types of system parameters:

The debug data can be viewed from Dashboard > System Monitor > Database 
Server Log Files.

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is 
recorded into a file in Database Server.

If parameter value is 4, then debug data is 
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the 
debug data is recorded.
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You can click on  List Files button to view the list of logged files.

Click on  Show File button to view the selected file contents in the ‘File Content’ 
section. You can also click  Download File button to extract a copy of debug 
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of 
this user manual.

Click Submit to save the changes or Close to close the screen without changes.

 Accessibility – Click the link to view accessibility features of the system.

Refer accessibility document for further details.

 Sign Out – Click the link to sign off from the application. You can also click on  
icon to sign off from the application.

Left Window

In the left pane, system lists and provides drop-down links for various modules available in 
the product. Click  to expand the Module Master Tabs and  to collapse them.
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the 
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the 
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle 
Financial Services Lending and Leasing. For example, on typing the first letter of the screen, 
the search box displays a list of all available screens starting with the letter entered in 
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is 
displayed in the main window/work area.

When there are multiple matches with same screen name, you can filter the results through 
the module from which the screen is accessed which is indicated in angular brackets. For 
example typing 'VEN' displays the following options for selection - Vendors(Collections), 
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search, 
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left 
pane, system displays the corresponding screen in the right pane.
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the 
system displays an error message.

Each active screen is displayed as a tab at the top of right pane, across its width. To view a 
screen, click the screen tab. You can identify the active screen with its white background. 
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right 
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind' = 'Y’ 
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel 
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the 
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master 
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications 
by clicking on the following links. Each successive click, opens a new Origination tab.

 Simple Application Entry

 Application Entry

 Underwriting

 Funding
1-7



Few screens in Origination are identical and are linked. Hence, when multi tab option is not 
enabled, you can open only one screen at a time from the group. A sample of the grouping 
structure is given below, based on stages of the screens:

Origination:

 Simple Application Entry

 Application Entry

 Underwriting

 Funding

As per the above listing, you will be able to open only one screen in the corresponding list and 
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid 
switching between tabs or navigating into sub tabs periodically. You can access the Right 
Splitter/Action Window while working on an Application or Customer Service screens. You 
can click  and  to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the 
following:

 Use Quick Search to search for an application based on application number, last 4 
digits of SSN (SSN of the primary applicant) or identification number. If multiple 
applications or accounts are found during ‘Identification #’ search, the system displays 
an error message as “Multiple Matches found for the Identification #, Please use normal 
Search”.

 Summary section displays critical information that has to be referred repeatedly during 
origination like – DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate 
and Term.

 Use Change Status section to change the application status to next level. If the 
application edit status is restricted, then the ‘Change Status’ will be read-only.

 Use Add Comment section to post an alert or comment during Underwriting and 
Funding stages.

For detailed information on the above options, refer to respective sections in the 
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action 
Window to do the following:

 Use Quick Search to search for an account based on account number, or customer Id, 
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple 
applications or accounts are found during ‘Identification #’ search, the system displays 
an error message as “Multiple Matches found for the Identification #, Please use normal 
Search”. You can also select the Queue Condition and Auto Run options during search. 
Clicking ‘Next Account’ button opens the subsequent account listed in search and 
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search 
and listed in Queue Assignment section.

 Use Add Comment section to post an alert or comment based on Type and Sub Type.

 Use Add Call Activity section to post all types of call activities including promise to pay, 
account conditions and so on, irrespective of the screen you are working on. This is 
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the 
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of 
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to 
increase the visible area of the screens. Click  to toggle upper pane and  to toggle left 
pane. To un-toggle click  and  respectively.
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1.4.1.1 Time Zone Preference

You can select any of the following three time zones from the User Info screen:

 Application Server Time Zone

 Company Branch Time Zone

 User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However, 
data is always stored in the application server time zone and based on the user preference of 
time zone, the display time would be User or Company or Application Server time zone. Any 
time zone related changes done at UI does not impact the other time bound activities which 
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting 
this time zone will have all date and time fields defined as per the time stored in application 
server. There is no offset in time if both storage (database server) and display (application 
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The 
various divisions defined under an organization can be set up with different time zones 
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

 Navigate to Setup > Administration > User > Organization and select the company or 
division listed under 'Division Definition'.

 In the Display Formats tab, select Time Zone and click ‘Edit’.

 In the Format field, select the required time zone from the adjoining options list and click 
‘Save’.

If 'Company Branch Time Zone' is selected as the time zone in User Info screen, then on save, 
all the time and date fields are automatically updated with the time zone of the company 
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User 
Definition screen. Various Users under same divisions defined under an organization can be 
set up with different time zones depending on geographical locations.
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To modify the User Time Zone:

 Navigate to Setup > Administration > User > Users.

 Select the required User record listed in “User Definition” section and click Edit.

 In the Time Zone field, select the required time zone from the adjoining options list and 
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time 
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed 
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped 
horizontally. The details are displayed when you click the tab under which they are grouped. 
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on 
‘Customer Service’ tab, the corresponding tabs are displayed.

You can click  to view the hidden tabs, if any.

1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three 
categories, based on their features. 

 Basic Operations

 Basic Actions

 Personalization Options

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic 
operations available are:

 Add

 Edit

 View

 Audit
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When you click any of the operation tabs, system displays the corresponding records inline, 
below the respective setup tables.

The table below gives a snapshot of them:

1.5.2 Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions. 

All or few of these actions are enabled when you select any of the Basic Operations. 

The table below gives a snapshot of them:

Basic Operation Description

Add Click to add a new record. When you click Add, the system displays 
a new record enabling you to specify the required data. It is 
mandatory to specify details for the fields marked with ‘*’ symbol.

Edit Click to edit an existing record. Select the record you want to edit 
and click ‘Edit’. The system displays an existing record in editable 
mode. Edit the required details.

View Click to view an existing record. Select the record you want to view 
and click ‘View’. The system displays the record details in display 
mode.

Audit Click to view audit info. If an audit is set for a field, then the system 
tracks the changes for that field. Select the record for which you 
want to view the audit info and click ‘Audit’. The system displays the 
details tracked for that field.

Close Click to close a screen or a record. When you try to close an 
unsaved, modified record, then the system alerts you with an error 
message. You can click ‘Yes’ to continue and ‘No’ to save the 
record.

Basic Actions Description

Save And Add Click to save and add a new record. This button is displayed when 
you click ‘Add’ button.

Save and Stay Click to save and remain in the same page. This button is displayed 
when you click 'Add/Edit' button.

Save And Return Click to save and return to main screen. This button is displayed 
when you click ‘Add’ or ‘Edit’ buttons.

Return Click to return to main screen without modifications. This button is 
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot 
of them:

Along with the basic actions, the following buttons are available for specific actions. The table 
below gives a snapshot of them:

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the 
settings for that User ID until next personalization. 

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

Click to navigate to the next record.

Click to navigate the last record.

Basic Actions Description

Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in 
the system.

Download File - Click to download the details of selected data.
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the 
following options of customization:

 Customize columns you wish to view

 Sort the order of displayed data

 Reorder columns

Additionally, the drop-down list provides selection of options 
adjoining ‘View’. 

Format Click to resize columns or wrap a data in the table cells.

Select the column you need to resize and select Resize Columns 
option from the Format drop-down list.

Specify the Width and unit for the selected column. Click OK to 
apply changes and Cancel to revert.

Query by Example Click to query for the data by an example. When this option is 
selected, the system displays an empty row above column heads. 
You can specify all or any of the details of the record you wish to 
query.

Freeze Select the column at which you need to freeze the table and click 
Freeze. Function is similar to the freeze option in MS excel. 

Detach Click to detach the setup table from the screen. An example of the 
detached table is provided below.
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Print option in Customer Service screen

The Print button  option in Customer Service/Collection screen facilitates you to print the 
contents on the screen as is without scroll bars. This button is available along with other 
options in the Action block. Clicking on this provides a browser print functionality and a new 
tab is opened where the print content is displayed.

Detach

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can 
either select the record from list or enter first alphabet of the value you want. When you 
provide the alphabet, system limits the selection to the values starting with the specified 
alphabet. These lists are grouped into two types:

Wrap Select the column in which the data needs to be wrapped and click 
Wrap.

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens 
have ‘View Last’ option to sort the volume of data being displayed 
on screen based on elapsed days.

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month / 
By Date. When ‘By Date’ is selected you can specify a date range 
(within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining 
calendar and clicking ‘Search’.

Options Description
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 Drop-down list – Provides the selection option. You can either select a record from the 
list or enter first alphabet of the required value.

 Combo drop-down list – The LOV contains huge data and provides both selection and 
search option. These drop-down arrows are smaller in size, when compared to normal 
drop-down arrows, thus enabling easy identification. 

Click the arrow button available before ‘Search’ to toggle the search options.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field 
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual 
ones.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select 
the search option from drop-down list adjoining the search criteria. 
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified 
characters. Select ‘Any’ to display results matching any of the 
specified characters.

Search Click to search for values based on the specified search criteria. 
The search results are displayed below with the details in respective 
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.
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Comments

In all the user input screens wherever comments are accepted, the system allows an input of 
4000 characters of information in the comment(s) field.

1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using 
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a 
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open 
‘Accessibility’ screen, press ‘Shift + Alt + y’. 

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the 
application. When the required link/tab/button/field is highlighted, press enter on the 
keyboard to edit.

3. Space bar to check or uncheck ‘Check Box’.

4. Arrow Keys to hover within the drop-down list.

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a 
change in key combination based on the browser on which the application is running. 

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom 
level.

Browser
Operating 
System

Key Combination Action

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne-
monic

Click

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet 
Explorer 7

Windows Alt + mnemonic Set focus

Microsoft Internet 
Explorer 8

Windows Alt + mnemonic Click or set focus

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne-
monic

Click

Shortcut Action

Ctrl++ To increase zoom level.
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1.7 Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in 
the screen, a popup is displayed with a tip on the action to be performed.

1.8 Accessibility

1.8.1 Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users 
with physical challenges. One of the most important reasons to make the application 
accessible is to provide them the opportunity to work. The four main categories of disabilities 
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or 
minimized by making the electronic information user-friendly and approachable.

1.8.2 Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility 
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define 
special accessibility preference in the application:

 The application user interface contents are readily accessible for all types of users 
without the need to select special accessibility modes.

 The components within the user interface are optimized for use with a screen reader by 
default.

 The contents are zoomable by default, eliminating the need for an application large fonts 
mode.

 The user interface components auto-detect if operating system (OS) is set to high 
contrast mode and automatically render content that is compatible with OS high 
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built 
on Oracle Application Development Framework (ADF) and the default accessibility feature 
supported by ADF are made available. For additional information, refer to ADF documentation 
on accessibility preferences.

1.8.3 Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are 
used to enhance the accessibility of documentation.

 Addition of text equivalent to all graphics

 Usage of standard fonts and avoiding shadow or reversed text

 Usage of strong foreground and background color contrast

 Color usages as per Oracle Accessibility guidelines have been ensured

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

Shortcut Action
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 Usage of styles and formatting elements

 Documentation in simple language to ensure easy understanding

 Including accurate and effective navigational features, such as cross-reference, tables 
of content and bookmarks as appropriate
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2. Administration System

In Administration > System, you can record setup data related to the application’s overall 
functionality and performance. This data affects;

 The mechanics of the system

 The processes of the system 

 The search for Location of files to complete the tasks. 

Navigating to Administration System

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > System

The System drop-down link records the following data:

 System Parameters

 Lookups

 User Defined Tables

 Audit Tables

 User Defined Defaults

 Transaction Codes

 Data Files

 Events

 Batch Jobs

 Producer Cycles

 Vendors

 Collection Cycles

 Reports

 Error Messages

 Translations

 Seed Data

Using these parameters, you can control the behavior of the system from a technical 
perspective. For example, determine parameter values, define what information is audited, 
and record default values. The product provides default values for all these screens.

2.1 System Parameters

System parameters define information or values used throughout the system. They act as 
switches that control the manner in which a function is implemented, or whether or not the 
system performs a particular task. Parameters are used throughout the system to control 
everything from user access to what information is stored on any given form. Parameters also 
define configuration data, such as the location of the system files, the URLs for the report and 
image servers, and other administration controlled data. Some of the system parameters are 
setup when the system is installed, but the values associated with the parameters need to be 
reviewed and maintained. 
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There are three types of parameters in the system, grouped by what part of the system they 
affect:

Hence, the System Parameters screen contains the following three tabs:

 System Parameters

 Organization Parameters

 Company Parameters

2.1.1 System Parameters Setup

The System Parameters Setup screen displays and records each system wide parameter, 
along with its current value and whether or not it is enabled. These parameters relate to the 
overall processing of the system, such as application server file locations and data purging 
configuration.

Note

You can only define these parameters. Changing the values of any of these parameters 
affects the related processing. 

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The 
system displays the System Parameter screen

Parameter Type: Parameter Range:

System parameters These parameters apply to the entire system.

Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization, division, 
and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and branch.

Examples: decision fax control, scoring model.
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2. In the System Parameters section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

2.1.1.1 FCUBS Integration

Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle 
FLEXCUBE Universal Banking System (FCUBS) with the capability to integrate the 
centralized CIF (Customer Information Files), ELCM (Enterprise Limits and Collateral 
Management) and CASA (Current Account and Savings Account) modules.

To work with the integrated environment functionalities, you need to enable the following core 
banking indicator.

Field Do this

Parameter System parameter of the specified parameter description is 
displayed here.

Parameter 
Description

Select the description of system parameter from the drop-down list.

Parameter 
Value

Specify the value for the system parameter (required).

Enabled Check this box to enable the parameter.

Parameter Parameter Description

CMN_CORE_BANK CORE BANKING INTERFACE INDICATOR
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Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration 
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

2.1.2 Organization Parameters

The Organization parameters control the system functions related to user log in, such as 
passwords and expiration dates, responsibility levels and the ability to access the system 
features. Individual parameters can be created with different values for uniquely defined 
organizations, divisions, and responsibility combinations. 

When determining which parameter to use, the system selects the best match based on a 
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL 
being a lower order match than an exact match. 

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL 
APPLICATIONS) is as follows:

 If a user belongs to an organization as ‘DMC’ with a responsibility of SUPERUSER and 
is using the Underwriting screen of Lending menu, the system will return with a value N, 
and the system will not allow the user to view all applications.

 If the user belongs to any organization with a responsibility of SUPERUSER, and is 
using the Underwriting screen of Lending menu, the system will return with a value Y, 
and the system will allow the user to view all applications.

Note

Be aware that while the system allows for Organization parameters to be defined at all 
three hierarchical (organization, division, and responsibility) levels, not all will be applica-
ble to each parameter. For example, while you can define the UIX_SMTP_SERVER 
(EMAIL SERVER FOR USER) for a responsibility, you would normally want only to define 
this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters >  
Organization tab. 
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2. In the Organization Parameters section, perform any of the Basic Operations mentioned 
in Navigation chapter. 

A brief description of the fields is given below:

Field Do this:

Parameter Parameter of the specified parameter description is displayed here.

Parameter 
Description

Select the description of system parameter from the drop-down list.

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter will be valid from 
the drop-down list.

Division Select the department for which the parameter will be valid from 
the drop-down list.

Responsibility Select the responsibility for which the parameter will be valid from 
the drop-down list.

IMPORTANT: In selecting which organization parameter to use, 
the system searches for a best match using the following attributes:

1. Organization

2. Division

3. Responsibility

Hence, Oracle Financial Services Software recommends creating 
a version of each organization parameter, where ALL is these 
fields.

Enabled Check this box to enable the parameter.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

2.1.3 Company Parameters

The Company parameters control the system processes associated with functions that may 
vary for different companies or branches. These parameters address credit scoring, credit 
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with 
different values for uniquely defined company and branch combinations. 

When these parameters values are requested by the system, the system responds with the 
“best” match based on a hierarchical sort ordered on company and branch fields, with values 
of ALL being a lower order match than an exact match. For example, assume the company 
parameter UIX_RUN_AAI_ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has 
been defined as:

The system uses these two parameters to determine whether to create and activate an 
account online.

 When processing items for the company US01, the system will return a value N and not 
create and activate an account online.

 When processing items for the company other than US01 and within the value ALL, the 
system will return with a value Y and create and activate an account online.

To set up the Company Parameters

1. Click Setup > Setup > Administration > System > System Parameters >  Company 
tab.

2. On the Company Parameters screen, perform any of the Basic Operations mentioned in 
Navigation chapter.
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

2.2 Lookups Setup screen

The Lookup Setups screen defines the contents in many drop-down fields used throughout 
the system. Fields that make use of drop-down field will accept only entries that are stored on 
this screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup 
types and codes can be system-defined or user-defined. The lookup types describe the 
function of the related lookup codes. 

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that 
is critical to the system and cannot be changed. However, you can still modify the lookup type 
description and Record indicator (Enabled/Disabled). 

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one 
that can be modified, depending on a user's business needs. You can modify the description, 
system indicator and record indicator. If a lookup type is user-defined, the lookup code 
belonging to that lookup type can either be system-defined or user-defined. 

A system-defined lookup code (Lookups screen, System Defined is selected) is one on 
which the system processing is dependent. Without this lookup code, the process produces 
incorrect results or fails. 

Field Do this:

Parameter The system displays the parameter, when you select parameter 
description.

Parameter 
Description

Select the description of system parameter from the drop-down list.

Parameter Value Specify the value for the system parameter.

Company Select the portfolio company for which the parameter will be valid 
from drop-down list.

Branch Select the portfolio branch for which the parameter will be valid from 
the drop-down list (required). 

IMPORTANT: In selecting which company parameter to use, the 
system searches for a best match using the following attributes:

1. Company

2. Branch

For this reason, the Software recommends creating a version of 
each company parameter where ALL is the value in these fields.

Enabled Check this box to enable the parameter.
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A user-defined lookup code (Lookups screen, System Defined is not selected) is one that 
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their 
related lookup codes will also be system defined. If you update and save a user-defined 
lookup type as a system-defined-lookup type (that is, change the System Defined button from 
No to Yes in the Lookup Type sub screen), the system will not allow you to change the lookup 
type back to user-defined in the future.

Note

Lookup codes cannot be deleted, as they may have been used in the past, and the display 
and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add 
new lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the 
Lookups screen. The details are grouped into two:

 Lookup Types

 Lookup Codes

2. In the Lookup Types section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Lookup Type Specify the lookup type.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Lookup Codes section, you can setup individual codes that a field or process using 
the related lookup type can have. Perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.3 User Defined Tables

In User Defined Tables you can maintain user-defined tables, such as the data attributes the 
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the 
User Defined Tables screen.

To set up a user-defined table, you must:

1. Define the fields on the table.

2. Join the related tables.

3. Assign the table a lookup type. 

You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system 
usage more efficient. These details are used with different functions of the system, including:

Description Specify the description for the lookup type .

System Defined 
Yes/No

Select ‘Yes’, if you wish to maintain the lookup type as system defined 
and ‘No’, if you wish to maintain lookup type as User defined.

Enabled Check this box to enable the lookup type.

Field Do this:

Lookup Code Specify the lookup code. These are solely dependent on the 
function of the Lookup Type.

Description Specify the lookup code description. This may be changed as per 
your business requirement.

Sort Specify the sort order for the lookup code. This determines the 
order these lookup codes are displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined 
Yes/No

Select ‘Yes’, if you wish to maintain the lookup code as system 
defined and ‘No’, if you do not want to maintain it as system 
defined. System defined lookup codes cannot be modified, 
except for changing the Description or Sorting fields. If the lookup 
type is not system defined, then the code can be modified.

Enabled Check this box to enable the lookup code.

Field Do this:
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 Tracking follow-up items

 Creating details in bankruptcy, foreclosure/repossession, and deficiency

Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be configured 
during the initial setup of the application to provide for your specific business needs. Oth-
ers, such as APPLICATION SEARCH, may be changed whenever your business needs 
change. Still others should not be changed without consulting Oracle Financial Services 
Software, as changing them would require changes to existing code for the expected re-
sults to be implemented. As a thumb rule, it is better to add or disable information on the 
User Defined Tables screen than to edit existing entries.

To set up the User Defined Tables

1. Click Setup > Setup > Administration > System > User Defined Tables. The system 
displays the User Defined Tables screen. The details are grouped into two:

 User Defined Tables

 User Defined Table Attributes

2. In the User Defined Tables section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Table Specify the user-defined table name.

User Table Type Select the user-defined table type from the drop-down list. This 
determines where and how the related data is being used.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

Description Specify the description for user-defined table.

System Defined 
Yes/NO

Select ‘Yes’, if you wish to maintain the User table type as system 
defined and ‘No’, if you do not want to maintain it as system 
defined. System defined entries cannot be modified. If the entry is 
not system defined, then it can be modified.

Enabled Check this box to enable the user-defined table (optional).

Product Type Select the product typefrom the drop-down list.

Funding Type Select the funding type associated with the user-defined table from 
the drop-down list.

Collateral Type Select the collateral type associated with the user-defined table 
from the drop-down list.

View Name Specify the view name.

SQL Statement Specify the SQL version of the statement. 

For Example: For SEARCH_ACC_ACCOUNTS table, the SQL is as 
follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID FROM ACCOUNTS 
WHERE

Note: For the above SQL, the where criteria is part of the User 
Defined Table Attributes

Sort Specify the sort order for the user-defined table relative to other 
tables of the same type.

Field Do this:
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4. In the User Defined Table Attributes section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Attribute Specify the user-defined table attribute.

Description Specify the description for the user-defined table attribute.

Data Type Select the data type for the attribute (CHARACTER, NUMBER, or 
DATE) from drop-down list.

Length Specify the maximum length of the user-defined table attribute.

Sort Specify the sort order of the user-defined table attribute. If the sort 
order is changed it will only affect new instances of the User Defined 
Table, and will not affect existing data.

Operator Select the operator for the user-defined table attribute from the drop-
down list.

System 
Defined Yes/No

Select ‘Yes’, if you wish to maintain the User table attribute as system 
defined and ‘No’, if you do not want to maintain it as system defined. 
System defined entries cannot be modified. If the entry is not system 
defined, then it can be modified.

Enabled Check this box to enable the user-defined table attribute so that the 
attribute will be considered when creating new instances of the User 
Defined Table.

Sub Attribute Specify the sub-attribute for the attribute (sub attributes are used to 
associate related attributes).
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.4 Audit Tables

The system allows you to track changes in the database during origination. This includes the 
tracking of:

 Application status history

 Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system 
stores the following details for the fields you want to audit for changes:

 Current value in field

 New value field 

 User who changed the field’s content

 Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the 
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays 
the Audit Tables screen. The details are grouped into two:

 Audit Tables

 Audit Columns

LOV Type Select the list of value (LOV) type for the user-defined table attribute 
from the drop-down list.

LOV Validation 
Ind

Check this box to enable LOV validation of the user-defined table 
attribute. This indicates whether the data must come from the LOV.

Lookup Types Specify the lookup type of the LOV associated with the user-defined 
table attribute.

Default Value Specify the default value for the user-defined table attribute.

Field Do this:
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2. In the Audit Tables section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

Field Do this:

Table The table name on which audit trigger needs to be 
created is displayed here (the system table being 
audited).

Description Specify the table description.

Display Description Specify the column description to be displayed on audit 
screen.

Display Column Select the table column to be displayed on audit screen 
from the drop-down list.

Enabled Check this box to enable the audit table so that it will be 
considered while generating the database triggers.

Reset Row ID Check this box to allow resetting the row identifier.

Primary Key 1 (unlabeled) The table primary key column 1 is displayed here. 
(These columns define how to access the data in the 
table.) 

Primary Key 2 (unlabeled) The table primary key column 2 is displayed here.

Primary Key 3 (unlabeled) The table primary key column 3 is displayed here.

Primary Key 4 (unlabeled) The table primary key column 4 is displayed here.

Primary Key 5 (unlabeled) Table primary key column 5 is displayed here .
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Audit Tables Columns section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.5 User Defined Defaults

The User Defined Defaults Setup screen allows you to set up default values to automatically 
populate in frequently used fields on the Application Entry screen. This streamlines the data 
entry process when entering an application.

To set up the User Defined Defaults

1. Click Setup > Setup > Administration > System > User Defined Defaults.The system 
displays User Defined Defaults screen.

Primary Key 6 (unlabeled) Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled) The table primary key column 7 is displayed here.

Primary Key 8 (unlabeled) The table primary key column 8 is displayed here.

Primary Key 9 (unlabeled) The table primary key column 9 is displayed here.

Primary Key 10 (unlabeled) The table primary key column 10 is displayed here.

Primary Key 11 (unlabeled) The table primary key column 11 is displayed here.

Primary Key 12 (unlabeled) The table primary key column 12 is displayed here.

Primary Key 13 (unlabeled) The table primary key column 13 is displayed here.

Primary Key 14 (unlabeled) The table primary key column 14 is displayed here.

Primary Key 15 (unlabeled) The table primary key column 15 is displayed here.

Field Do this:

Column Specify the column name on which the audit needs to be created from 
drop-down list (column in the table that is being audited)

Description Specify the column description (description of the data contained in the 
column).

Data Type The data type for the attribute is displayed here.

Enabled Check this box to enable the audit column.

Field Do this:
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2. In the Application Defaults section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Org Select the organization for which these defaults are applicable from 
drop-down list.

Division Select the division for which these defaults are applicable from drop-
down list.

Application Defaults

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Priority Select the priority from the drop-down list.

Channel Select the channel from the drop-down list.

Producer Type Select the producer type from the drop-down list.

Purpose Select the purpose from the drop-down list.

Product Select the product from the drop-down list.

Applicant Defaults

Relation Type Select the applicant relation type from the drop-down list.

Gender Select the applicant gender from the drop-down list.
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Marital Status Select the applicant marital status from the drop-down list.

Language Select the applicant language from the drop-down list.

ECOA Select the applicant ecoa from the drop-down list.

Class Type Select the applicant class type from the drop-down list.

Race National 
Origin

Select the applicant race or national origin from the drop-down list.

Privacy Opt-Out Check this box to indicate that the applicant has elected to refrain 
from the non-public sharing of information.

Address Defaults

Address Type Select the address type from the drop-down list.

Postal Type Select the postal address type from the drop-down list

Street Pre Select the street pre type from the drop-down list.

Street Type Select the street type from the drop-down list.

Street Post Select the street post type from the drop-down list.

Country Select the country from the drop-down list.

Rent Amount Specify the rent amount. The system defaults this rent amount if the 
rent amount received from the interface is zero. 

This rent amount will be defaulted for a new application also.

State Frequency Select the stated frequency from the drop-down list.

Actual 
Frequency

Select the actual frequency from the drop-down list.

Ownership Select the ownership type from the drop-down list.

Employment Defaults

Type Select the employment type from the drop-down list.

Occupation Select the occupation from the drop-down list.

Country Select the country from the drop-down list.

Stated 
Frequency

Select the stated frequency from the drop-down list.

Actual 
Frequency

Select the actual frequency from the drop-down list.

Income Defaults

Income Type Select the income type from the drop-down list.

Frequency Select the frequency from the drop-down list.

Field Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

Liability Defaults

Liability Type Select the liability type from the drop-down list.

Frequency Select the frequency from the drop-down list.

Asset Defaults

Status Select the asset status from the drop-down list.

Condition Select the asset condition from the drop-down list.

Country Select the country from the drop-down list.

Vehicle Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Valuation Source Select the asset valuation source from the drop-down list.

Home Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Occupancy Select the occupancy type from the drop-down list.

Valuation Source Select the asset valuation source from the drop-down list.

Other Defaults

Asset Type Select asset type from the drop-down list

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Valuation Source Select the asset valuation source from the drop-down list

Comment Defaults

Comment Type Select the comment type from the drop-down list.

Comment Sub 
Type

Select the comment sub type from the drop-down list.

Field Do this:
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2.6 Transaction Codes

The system uses transaction codes to define the actions and tasks it can perform; for 
example, activating an account, changing a due date, applying a late fee, and charging off an 
account. 

The Transaction Codes Setup screen catalogs and defines these core system actions.

The system organizes transaction codes in ‘Super Groups’. All transaction codes within a 
particular super group are processed in a similar manner. The transaction super groups in the 
system are as follows:

Super Group Type: Description:

ACCOUNT CONDITION TXN These transaction codes control a user’s ability to 
open and close account conditions.

ACCOUNT MONETARY TXN These transaction codes affect the monetary value of 
accounts in the system; for example, activating accrual 
of interest, the assessment of fees, and closing the 
account.

ACCOUNT NON MONETARY 
TXN

These transaction codes do not have a direct effect on 
the monetary value of the account, but are used in 
maintaining account information. This includes chang-
ing a customer’s driving license, or adding information 
for automated clearing house (ACH).

AMORTIZATION TXN These transaction codes affect the amortized balances 
of the accounts in the system.

CORRESPONDENCES These transaction codes relate to the system corre-
spondences.

ESCROW ANALYSIS AND 
DISBURSEMENTS

These transaction codes allow for reviewing and 
approving escrow analysis, stopping an escrow over-
ride, and posting escrow disbursement.

ESCROW MONETARY 
TRANSACTIONS

These transaction codes affect the monetary value of 
escrow accounts in the system; for example, disburs-
ing escrow to a customer and insurance, and receiving 
payment.

ESCROW NON MONETARY 
TRANSACTIONS

These transaction codes do not have a direct effect on 
the monetary value of an escrow account, but are used 
in maintaining account information, such as changing 
insurance maturity date and adding new escrow tax 
details.

FEE ASSESSMENTS These transaction codes determine if fees such as 
nonsufficient funds fees or membership fees are to be 
applied.

FUNDING TXN These transaction codes affect the funding of applica-
tions and accounts within the system.

ITEMIZATION TXN These transaction codes affect the itemization of appli-
cations and accounts within the system.
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Three sub screens, Parameters, Access Grid, and Products, record any additional information 
required to perform a transaction, the user types that can perform the transaction, and the 
product type to which the transaction codes apply.

Note

The Software recommends that you restrict the access to the seed data once you are in 
production.

To set up the Transaction Codes

1. Click Setup > Setup > Administration > System > Transaction Codes. The system 
displays the Transaction Codes screen. 

MENU TXN These transaction codes affect the menus within the 
system.

PRODUCER MONETARY TXN These transaction codes relate to the monetary trans-
actions that apply to the the system producers (or 
“dealers”).

REPORTS These transaction codes are related to generating the 
system reports.

SECURITIZATION TXN These transaction codes affect the pools of securitized 
loans or accounts within a pool of securitized loans.

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to change 
the existing setup data, even if they are allowed 
access to the form, by restricting access to the Lock/
Unlock Record icon on the the system tool bar.

Super Group Type: Description:

ACCOUNT CONDITION TXN These transaction codes control a user’s ability to 
open and close account conditions.

CORRESPONDENCES These transaction codes relate to the system 
correspondences.

MENU TXN These transaction codes affect the menus within the 
system.

REPORTS These transaction codes are related to generating the 
system reports.

SECURITIZATION TXN These transaction codes affect the pools of securitized 
loans or accounts within a pool of securitized loans.

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to change 
the existing setup data, even if they are allowed 
access to the form, by restricting access to the Lock/
Unlock Record icon on the system tool bar.

Super Group Type: Description:
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2. In Transaction Super Group section, you can view the following information

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field Do this:

Super Group Select the Super Group you want to work with in the Transaction 
Codes screen.
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4. In the Transaction Codes section, perform any of the Basic Operations mentioned in 
Navigation chapter

A brief description of the fields is given below:

Field Do this:

Txn Code Specify the transaction code (required).

Description Specify the description for the transaction.

Group Select the transaction group (the group within the Transaction Super 
Group that the transaction code belongs to) from the drop-down list.

Action Select the action type code for the transaction (what action will take 
place when the transaction occurs) from the drop-down list.

Monetary Check this box to maintain the transaction as a monetary transaction. If 
unchecked, then the transaction is nonmonetary.

System 
Defined Yes/
No

Select ‘Yes’, if you wish to maintain the transaction code as system 
defined and ‘No’, if you do not want to maintain it as system defined. 
System defined entries cannot be modified. If entry is not system 
defined, then it can be modified.

Enabled Check this box to enable the transaction.

Txn/Bal Type Select the transaction / balance type affected by the Transaction from 
the drop-down list.

Statement 
Txn Type

Select the statement transaction type (how the transaction should 
appear on the customer statement) from the drop-down list.

Batch Check this box to perform the transaction in a batch process. 
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1 Transaction Codes sub screens

The Transaction Codes screen contains three sub screens: 

 Parameters

 Access Grid

 Products

Note

Please contact your System Administrator / Implementation Manager before making any 
changes in these sub screens.

2.6.1.1 Parameters

Here, you can define the parameter information for the associated transaction. The 
Parameters apply exclusively to these super groups:

 ITEMIZATION TXN

 AMORTIZATION TXN

 PRODUCER MONETARY TXN

 FUNDING TXN

 ACCOUNT CONDITION TXN

 CORRESPONDENCES

 FEE ASSESSMENTS

Note

Treat the Transaction Parameters sub screen as containing view-only information. This is 
very sensitive data and you should not change it without consulting Oracle Financial Ser-
vices Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.

2. In the Transaction Parameters section, perform any of the Basic Operations mentioned 
in Navigation chapter.

Manual Check this box, if the transaction is a manual transaction. If you define a 
transaction as manual, the system recommends that the transaction 
that reverses it also be defined as manual.

Stmt Print Check this box to print the transaction on customer statements.

GL Check this box, if the transaction is a general ledger transaction.

Field Do this:
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1.2 Access Grid

The Access Grid sub screen allows you to control access to each transaction according to 
user responsibility, account status, and account condition. It allows the administrator to 
control when these transactions may be conducted. Normally, you would create or modify the 
access based on either the user responsibility or account condition. Account status access is 
left unchanged.

To set up the Access Grid sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

2. In the Transaction User Access Definition section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field Do this:

Parameter 
Code

Select the parameter code associated with the transaction code, from 
the drop-down list.

Default Specify the default value for the transaction parameter (value to initially 
populate, or used if no value is supplied).

Sort Specify the sort order for the transaction parameter.

Displayed? 
Yes/No

Select ‘Yes’ to display the parameter and ‘No’ if you do not want to 
display in current use.

Required? 
Yes/No

Select ‘Yes’ if the parameter is required and ‘No’ if you do not require the 
parameter. (You must select Required as empty values are not allowed.)

Field Do this:

Access Type Select the access grid function type (ACCOUNT CONDITION AND 
ACCOUNT STATUS) that is being used to control the creation of the 
associated transaction, from the drop-down list.

Access 
Value

Select the access function grid value from the drop-down list (based on a 
lookup associated with the Access Type. Multiple entries for each access 
type may be created as long as each has a different access value).

Allowed? 
Yes/No

Select ‘Yes’ if the access is allowed and ‘No’ if the access is not allowed 
(indicates whether the current Access Type / Access Value may create 
the associated transaction).

System 
Defined Yes/
No

Select ‘Yes’, if you wish to maintain access type as system defined and 
‘No’, if you do not want to maintain it as system defined. System defined 
entries cannot be modified. If entry is not system defined, then it can be 
modified.
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2.6.1.3 Products

The Products sub screen allows you to define the products to which the transaction codes 
apply. It allows the administrator to control if the associated transaction code will be available 
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given 
Allowed value. Additional Access Values are then defined for the same Access Types with the 
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Products.

2. In the Transaction Product Definition section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7 Data Files

The Data Files Setup screen organizes information pertaining to the various input/output data 
files that the system can generate. The system uses the Data Files Setup screen to outline 
the file layouts of each data file produced/received within the system, including the length and 
data type of each column name.

These files are typically produced during the nightly process.

One major advantage for the system-defined data files is the format mask of each column 
name within each data file. A format mask is like a stencil that forces data input to be of the 
same format before accepting the data. 

You can change the order in which the fields are displayed in the file.

Note

Any addition or removal of a field or change in the data type length requires the Software 
involvement.

Data Files screen consists of the following two tabs:

 Output

 Input

Field Do this:

Product Type Select the product type associated with the transaction code from 
the drop-down list.

Funding Type Select the funding type associated with the transaction code from 
the drop-down list.

Allowed? Yes/No Select ‘Yes’ if the transaction is allowed and ‘No’ if the transaction is 
not allowed (indicates whether the current Access Type / Access 
Value may create the associated transaction).
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2.7.1 Output tab

The Output tab in the Data Files screen allows you to define the structure of output data file 
through the following sections:

 Data File Definitions

 Record Definitions

 Column Definitions

2.7.1.1 Data File Definitions

The Data File Definitions section defines specific data files. Each is associated with a specific 
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While 
new data file definitions may be created they will have no use unless a batch job is also 
created to populate the data.

To set up Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Outpout tab.

2. In the Data Files Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Name Specify data file type (name of data file definition).

Description Specify data file description.

File Name Specify data file name. Prefix used for files generated for this Data 
File. This is the only field on the Data File Definitions screen that can 
or should be modified by your Administrator. The generated file name 
will be in the form of <FILE NAME>_<COMPANY ID>_<BRANCH 
ID>_<MMDDYYYY>_<PROCESS ID>.DAT. The inclusion of 
_<COMPANY ID> and _<BRANCH ID> depends entirely on the 
associated batch process.

Directory Path Specify the directory path.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.2 Record Definitions

Each data file definition is made up of one or more record definitions. These define 
organization of the data. The associated batch file determines how these records are used. 
The order in which the data is populated determines the order in which those records will 
appear in the output file. This is generally related to the order the records appear in the Data 
File Definition section.

1. In the Record Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.3 Column Definitions

Each record definition is made up of one or more column definitions. These define the output 
of the data. Much of this data is informational; it indicates what data is being provided by the 
associated batch job. Unless otherwise noted, the data should not be changed without 
changing the associated batch job.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

System Defined 
Yes/No

Select ‘Yes’, if you wish to maintain the data file definition as system 
defined and ‘No’, if you do not want to maintain it as system defined. 
System defined entries cannot be modified. If the entry is not system 
defined, then it can be modified.

Enabled Check this box to enable the data file definition.

Field Do this:

Record Type Specify the type of record being defined.

Description Specify record description.

Record Format Select the format of output data (FIXED, VARIABLE) from the drop-
down list.

Delimiter Specify the delimiter (column separator used with VARIABLE 
format).

Terminator Select the record terminator code (how the end of each record is 
indicated within the file -- CARRIAGE RETURN, LINE FEED, or 
CARRIAGE RETURN AND LINE FEED) from the drop-down list.

Field Do this:

Seq Specify the order in which the output data dump will process the 
column information.

Field Do this:
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2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.2 Input tab

Oracle Financial Services Lending and Leasing facilitates processing of a input data file 
received from external interface into the system through an automated batch job 
(IDDPRC_BJ_000_01) triggered on regular intervals.

The Input tab in the Data Files screen allows you to define the input data file through the 
following sections:

 Input Data File Definitions

 Column Definitions

2.7.2.1 Input Data File Definitions

In the Input Data File Definitions section, you can define and maintain the structure of input 
data file to populate data from external system.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

Column Name Specify name/description of the column (informational only).

Data Type Specify the data type. This describes the type of data the column is 
expected to contain (CHARACTER, DATE, or NUMBER). This effects 
how the ODD process handles the data, and should not be changed 
.

Format Mask Select the format mask for the column from the drop-down list. For 
DATE or NUMBER columns, this field defines the output format of 
the data. For example; Date fields may be entered using the MM/DD/
YYYY format, Number fields may be entered as decimal numbers 
with varying degrees of precision. Other formats for each data type 
are available.

Length Specify the column length (the maximum number of characters of the 
output data to be included in the output file). Each output data details 
column may contain up to 240 characters of data. If the output data 
details column contains more data than the length value the data will 
be truncated. For VARIABLE records the length should be set to “-1” 
or a Delimited file will be created with FIXED LENGTH columns.

Data Column Specify the data column sequence. This is the column that will be 
used to select the data that is being output. This should not be 
changed.

Output Column Specify the output column sequence. This is the column that will 
appear in Output File. The Output Data Dump process allows for the 
output of 250 columns of data per record. No output column should 
be repeated in the setup for a record.

Field Do this:
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2. In the Input Data Files Definitions section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.2.2 Column Definitions

Each input data file definition is made up of one or more column definitions. These define the 
structure of data to be loaded from external system.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Name Specify a unique name for the input data file.

Description Specify data file description.

Directory Path Specify the directory path configured within OFSLL Database server 
to process the input data file.

Delimiter Specify the delimiter used to separate column data. (Ex: Comma).

Record Format System defaults the record format as ‘VARIABLE’.

Enabled Check this box to enable the input data file definition.

Field Do this:

Seq Specify the order in which the input data dump will process the 
column information.

Column Name Specify name of the column.

Column 
Description

Specify description of the column.
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2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8 Events

During Origination, when an application moves from one status/sub status to another, or 
changes condition, the system can trigger an event and perform the associated event actions. 
This can occur either online or in batch mode.

Note

Only predefined events and actions can be set up on the Events Setup screen. You cannot 
create new event types or action types.

As processing events and associated actions require additional processing at the server level, 
the performance of the transactions, for which the events are setup, may be adversely 
affected dependent upon your specific configuration.

2.8.1 Events

In the Events screen you can setup “trigger events” with associated actions which the system 
performs during application entry. The fields on this form are both system and user defined. 
There are four sub screens on the Events screen to set up and maintain these events:

 Events Types

 Event Action Types

 Online

Data Type Select the data type from the drop-down list. The selected data type 
describes the type of data the column is expected to contain such as 
INTEGER/DATE/NUMBER/CHARACTER. This effects how the input 
data file processing handles the data, and should not be changed.

Format Mask Select the format mask for the column from the drop-down list. The 
list displays the format depending on the Data Type selected.

For example; Date fields may be entered using the MM/DD/YYYY 
format, Number fields may be entered as decimal numbers with 
varying degrees of precision. Other formats for each data type are 
available.

Length Specify the column length (the maximum number of characters of the 
data to be included in the input file).

Each input data details column may contain up to 240 characters of 
data. If the output data details column contains more data than the 
length value the data will be truncated. For VARIABLE records the 
length should be set to “-1” or a Delimited file will be created with 
FIXED LENGTH columns.

Sort Specify the order in which the column definitions are to be sorted for 
display in the external interface screen (Customer Service > External 
Interfaces). There can be a maximum of 61 column definitions.

Enabled Default selected. If not, you can check this box to enable the column 
definition.

Field Do this:
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 Batch

Event Types and Action Types sections of this screen provide a master table for setting up 
the online and batch events. This setup triggers the event, which in turn triggers the actions 
associated with the events, during application entry.

Navigating to Events

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Events.

2.8.1.1 Event Types

1. Click Setup > Setup > Administration > System > Events > Line of credit > Events 
Types.

2. In the Events Type section, perform any of the Basic Operations mentioned in Navigation 
chapter. 

A brief description of the fields is given below:

Field: Do this:

Event Type Code Specify the event type code.

Description Specify the event description.

Process Type Specify the process type (BATCH or ONLINE) from the drop-
down list.

Entity Type Specify the entity type (ACCOUNTS or APPLICATIONS) from 
the drop-down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.2 Event Action Type

The Event Action Types section is system defined and lists the action codes supported in 
the system. 

1. Click Setup > Setup > Administration > System > Events > Line of credit > Event 
Action Types.

2. In the Events Action Types section, perform any of the Basic Operations mentioned in 
Navigation chapter.  

A brief description of the fields is given below:

Engine Type Specify the engine type (MONETARY TRANSACTIONS PRO-
CESSING, NON-MONETARY TRANSACTION PROCESSING, 
CONDITION/ASSIGNMENT PROCESSING, APPLICATION STA-
TUS CHANGE, CREDIT BUREAU PROCESSING, LETTERS 
PROCESSING or CORRESPONDENCE) from the drop-down list.

Enabled Check this box to activate the event type.

System Defined Select ‘Yes’ to indicate that the event type is system defined. 
Select ‘No’ to indicate that the event type is user defined.

Field: Do this:

Action Code Specify the action code.

Description Specify the action description.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.3 Online

The Online screen allows you to set up the online events by defining all online events and the 
event criteria actions. The system supports the following online events:

 CHG OFF Reversal

 Paid Off Reversal

 BKRP is closed

 BKRP Is Opened

 When Queue is Closed

 When status/ Sub status changed to 'Approved- Rehashed'

 Account condition SCHG is closed

 Account condition SCHG is Opened

 Change in application status / sub status to APPROVED – REHASHING

The events that can be performed online after each of the events listed above are as follows:

 Generate correspondence for an application

 Send a credit bureau request for an application.

To setup Online Event

1. Click Setup > Setup > Administration > System > Events > Line of credit > Online. 

Process Type Select the process type (BATCH or ONLINE) from the drop-
down list.

Entity Type Select the entity type from the drop-down list.

Engine Type Select the engine type from the drop-down list.

Enabled Check this box to activate the action.

System Defined Select ‘Yes’ to indicate that the event type is system defined. 
Select ‘No’ to indicate that the event type is user defined.

Field: Do this:
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2. In the Events section, perform any of the Basic Operations mentioned in Navigation 
chapter.  

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Event Criteria section allows you to name and describe the query for an event, as well 
as enable or disable the query.

4. In the Event Criteria section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Event Code Specify the event code.

Event Type Specify the event type from the drop-down list.

Frequency Specify the event frequency from the drop-down list.

Synchronous Check this box to set the event as synchronous (any failure in trigger-
ing the event will fail to trigger the entire transaction). If unchecked, 
then the event is asynchronous (any failure in the event will not affect 
the transaction, which will be successfully completed).

Enabled Check this box to activate the event type.

Field: Do this:

Query Name Specify the query name.

Description Specify the query description.
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details

The Criteria Details sub screen allows you to define the selection criteria for the event. The 
event engine uses these criteria to determine which application to include in the event action.

6. In the Setup > Setup > Administration > System > Events > Line of credit > Online > 
Criteria section, you can define the event selection criteria. Perform any of the Basic 
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Actions

The Actions section records the actions the system performs after the event is triggered.

8. In the Setup > Setup > Administration > System > Events > Line of credit > Online > 
Action section, define the action you want the system to perform for the event by entering 
the following information. (You can set up more than one event action for a particular 
event, then use the Seq field to define the order in which the events will occur)

A brief description of the fields is given below:

9. Perform any of the Basic Actions mentioned in Navigation chapter.

10. For each event action, use the Action Parameters section to set up the required action 
parameters and values. Perform any of the Basic Operations mentioned in Navigation 
chapter.

Enabled Check this box to activate the event criteria.

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down list.

Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.

Field: Do this:

Description Select the event action description from the drop-down list.

Seq specify sequence number.

Enabled Check this box to activate the event action.

Field: Do this:
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A brief description of the fields is given below: 

11. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.4 Batch

The Batch screen allows you to set up the events performed as a batch transaction by the 
system. The system supports the following predefined batch events for application 
processing. (These batch events are listed in the Events Types section on the Setup screen): 

 APPLICATION LEVEL BATCH EVENT #01

  APPLICATION LEVEL BATCH EVENT #02

  APPLICATION LEVEL BATCH EVENT #03

  APPLICATION LEVEL BATCH EVENT #04

  APPLICATION LEVEL BATCH EVENT #05

  APPLICATION LEVEL BATCH EVENT #06

  APPLICATION LEVEL BATCH EVENT #07

  APPLICATION LEVEL BATCH EVENT #08

  APPLICATION LEVEL BATCH EVENT #09

  APPLICATION LEVEL BATCH EVENT #10

To setup the Batch Event

1. Click Setup > Setup > Administration > System > Events > Line of credit > Batch.

2. In the Events section, perform any of the Basic Operations mentioned in Navigation 
chapter.  

Field: Do this:

Description Specify the parameter description from the drop-down list.

Value Specify parameter value.
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Events Criteria section allows you to name and describe the query for an event, as well 
as enable or disable the query.

4. In the Events Criteria section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details

The Criteria Details sub screen allows you to define the selection criteria for the event. The 
event engine uses these criteria to determine which application to include in the event action.

6. In the click Setup > Setup > Administration > System > Events > Line of credit > 
Batch > Criteria section, you can define the event selection criteria. Perform any of the 
Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Event Code Specify the event code.

Event Type Specify the event type from the drop-down list.

Frequency Specify the event frequency from the drop-down list.

Synchronous Check this box to set the event as synchronous (any failure in triggering 
the event will fail to trigger the entire transaction). If unchecked, then the 
event is asynchronous (any failure in the event will not affect the transac-
tion, which will be successfully completed).

Enabled Check this box to activate the event type.

Field: Do this:

Query Name Specify the query name.

Description Specify the query description.

Enabled Check this box to activate the event criteria.

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down list.

Criteria Value Specify criteria value.

) Specify right bracket.
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7. Perform any of the Basic Actions mentioned in Navigation chapter.

Action

The Action sub screen allows you to define the actions performed in the batch event. The 
system supports the following batch event actions:

 Send letter for an application

 Generate correspondence for an application

8. Click Setup > Setup > Administration > System > Events > Line of credit > Batch > 
Action.

9. In the Actions section, define the action you want the system to perform for the event by 
entering the following information. (You can set up more than one event action for a 
particular event, then use the Seq field to define the order in which the events will occur.) 
Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

10. Perform any of the Basic Actions mentioned in Navigation chapter.

11. For each event action, use the Action Parameters section to set up the required action 
parameters and values. Perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below: 

12. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.5 Monitoring Events

You can verify the status of events and event actions on the Monitor Jobs screen of the 
Utilities form. 

To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, clickDashboard >  
Dashboard > System Monitor > Jobs > Back Ground. 

The system displays the status for all asynchronous events that have been completed 
or failed for an application.

For further details, on monitoring events refer Dashboard Chapter of this Guide.

Logical Expression Specify logical operator from the drop-down list.

Field: Do this:

Description Select the event action from the drop-down list.

Seq Specify sequence numbers (required).

Enabled Check this box to activate the event action.

Field: Do this:

Description Select the event action from the drop-down list.

Value Specify sequence numbers (required).

Field: Do this:
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2.9 Batch Jobs

“Batch jobs” refer to the back-end processes that automatically run at a certain time. There 
are two types of batch jobs: 

 Business processes (such as billing and delinquency processing)

 Housekeeping tasks (such as application aging and application purging)

2.9.1 Batch Jobs

The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch 
jobs can also be configured to trigger an e-mail or phone message if a batch job fails. 

Critical batch jobs control job flow and system date rollover to allow recovery during errors. 
Errors are instances where a process did not successfully complete. Failures indicate that a 
particular job encountered errors that require remedial action. The number of errors allowed 
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped 
into two tabs:

 Batch Jobs tab

 Job Holidays tab

2.9.1.1 Batch Jobs

In the Batch Job Setup screen, you can track and maintain all batch processes within the 
system. Using this form, the system administrator can configure the frequency and start time 
of each batch process, as well as set the number of threads to improve performance.

“Threading” allows a specific job to be separated into smaller units that are processed at the 
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in 
less time.

You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each 
process is listed with the last run date (Last Run Dt field) and the next scheduled process date 
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency 
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to 
incorporate a dependency on another batch set. This way, if the initial batch fails, the 
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays 
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and 
Leasing system, Oracle Financial Services Software suggests that the system administrator 
has a clear understanding of the various functionalities within Oracle Financial Services 
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document, 
dbk_std_detail_design_job_sets.vsd

To setup a Batch job

1. Click Setup > Setup > Administration  >  System > Batch Jobs. 
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2. In the Batch Job Sets section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Set Code Specify the code for the batch job set.

Job Set Description Specify the description for the batch job set.

Frequency Select the frequency at which the job set is to be executed 
from the drop-down list.

Frequency Value Select the frequency value from the drop-down list. The fre-
quency value will be displayed based on the frequency code 
selected.

Start Time Specify the start time for the job set.

Critical Check this box to set job as critical. A “critical” job is one that 
prevents the General Ledger (GL) post date from rolling for-
ward, should the job fail.

Enabled Check this box to enable the job set.

Last Run Dt The system displays the last run date of the job set.

Next Run Dt Specify the next run date for job set. You can select the data 
from adjoining calendar icon.

Parent Select the parent job set from drop-down list.

Dependency Select the type of dependency on the parent from drop-down 
list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Batch Job section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Batch Job Thread section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: Do this:

Seq Specify the batch job sequence number.

Note: Within a job set, jobs are executed sequentially based on the 
sequence number assigned.

Job Type Select the batch job request type from the drop-down list.

Job Code Specify the batch job request code.

Job Description Specify the batch job description.

Threads The system displays the number of threads used by the job.

Commit Count Specify the number of rows after which auto-commit is triggered.

Errors Allowed Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on weekend.

Holiday Check this box to perform batch jobs on a holiday. (Holidays are 
defined on the Job Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down list.

Dependency Select the dependency clause of the batch job from the drop-down 
list.

Command Specify the command line for the job (required).

RollbackSegment If you choose, use this field to specify the rollback segment for job.

Field: Do this:

Thread Specify the name of thread.

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The higher the number, the 
more activities the system can trace.

Enabled Check this box to enable the thread.
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2.9.1.2 Job Holidays

The system allows you to define holidays within the company on Job Holidays screen. You 
can then use the Batch jobs screen to set up whether you want the system to perform batch 
jobs on these days or not, using the Holiday box of Batch Jobs section .

To define job holidays

1. Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays. 

2. In the Job Holidays section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: Do this:

Holiday Dt Specify the date of the job holiday. You can select the date from the 
adjoining calendar icon.

Description Specify the job holiday description (required).

Enabled Check this box to enable the holiday.
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2.9.2 Batch Jobs Available

The below table provides a list of Batch Jobs maintained in the system and a brief description 
to each:
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AAE Application 
Account 
Interface

aaiprc_b-
j_100_01

APPLICA-
TION TO 
ACCOUNT 
INTERFACE

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process peri-
odically picks up 
applications in 
'Approved-Veri-
fied' status and 
creates accounts.

ACH ACH 
Accounts

acaprc_b
j_100_01

ACCOUNT 
ACH PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process pro-
duces the ACH file 
for the eligible cus-
tomer payments.

ACH ACH Produc-
ers

acp-
prc_b-
j_100_01

PRO-
DUCER 
ACH PRO-
CESSING

Y
e
s

Y
e
s

N
o

C
o
m
m
o
n

This process pro-
duces the ACH file 
for the eligible pro-
ducer payments.

ACH ACH Ven-
dors

acvprc_b
j_100_01

VENDOR 
ACH PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process pro-
duces the ACH file 
for the eligible ven-
dor payments.

ACH ACH Pro-
ducer/Ven-
dors/
Customer/
Third Party

acx-
prc_b-
j_100_01

ACH Pro-
ducer/Ven-
dors/
Customer/
Third Party

Y
e
s

Y
e
s

N
o

C
o
m
m
o
n

This process pro-
ducers the ACH 
file for the eligible 
Producer/Vendors/
Customer/Third 
Party

AGE Aging Appli-
cations

agaap-
p_b-
j_100_01

APPLICA-
TION 
AGING 
PROCESS

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process puts 
applications into 
'Aged-Application' 
substatus.

AGE Aging Con-
tracts

agcco-
n_b-
j_100_01

CON-
TRACT 
AGING 
PROCESS

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process puts 
contracts into 
'Aged-Contract' 
substatus.
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ALT-
PFS

ALLOT-
MENT 
EXTRACT 
FILE DUMP

PFSEFT-
PRC_B-
J_111_0
1

BACKUP 
EFT

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates the Backup 
EFT file

ALT-
PFS

ALLOT-
MENT 
EXTRACT 
FILE DUMP

PFSL-
BAPRC_
BJ_100_
01

POSTING 
ALLOT-
MENT PAY-
MENTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
the payments from 
the allotment file 
received from the 
bank

ALT-
PFS

ALLOT-
MENT 
EXTRACT 
FILE DUMP

PFSOD-
DALT_B-
J_100_0
1

ALLOT-
MENT 
EXTRACT 
FILE DUMP

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
sends the allot-
ment draft notice to 
the bank

ALT-
PFS

ALLOT-
MENT 
EXTRACT 
FILE DUMP

PFSNS-
FPRC_B
J_100_0
1

NSF BATCH N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
the NSF file 
received from the 
bank

API API Accounts accaa-
i_b-
j_100_01

API AAI N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates accounts from 
validated conver-
sion applications/
contracts

API API Accounts accd-
mp_b-
j_100_01

MOVE 
API_XX TO 
ITABS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cop-
ies data from con-
version API tables 
to conversion 
applications table

API API Accounts accval_bj
_111_01

VALIDATE 
ITABS 
(LOAN)

N
o

Y
e
s

N
o

L
o
a
n

This process vali-
date all conver-
sion applications 
loan accounts by 
running the edits
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API API Accounts accval_bj
_112_01

VALIDATE 
ITABS 
(LINE)

N
o

Y
e
s

N
o

L
i
n
e

This process vali-
date all conver-
sion applications 
line of credit 
accounts by run-
ning the edits

API API Accounts acm-
prc_b-
j_100_01

LOAD 
API_COM-
MENTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates account com-
ments from 
conversion appli-
cations/contracts

COL Appointment 
Cancellation

cap-
prc_b-
j_100_01

APPPOINT-
MENT CAN-
CEL 
PROCESS-
ING

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process can-
cels all the expired 
appointments.

COL Payment 
Promise Pro-
cessing

cppprc_b
j_100_01

BROKEN 
PROMISE 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
updates any bro-
ken promises as of 
the run time.

CRB Credit 
Bureau 
Reporting

cbuutl_b-
j_100_01

CREATE 
METRO2 
FILE

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates the METRO2 
file for Credit 
Bureau reporting 
for the specified 
date.

DOT Document 
Tracking 
Load

dolprc_b-
j_000_01

ACCOUNT 
DOCU-
MENT 
LOAD

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process reads 
acct_doc_load 
directory. Attach 
the documents to 
specified accounts 
and move docu-
ments to appropri-
ate directory
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Job

Description

O
ri

g
in

at
io

n

S
er

vi
ci

n
g

C
o

ll
ec

ti
o

n

P
ro

d
u

c
t 

Comment
2-45



DLX Accounts 
Dialer Exclu-
sion

ODX-
PRC_B-
J_100_0
1

ACCOUNTS 
DIALER 
EXCLU-
SION

N Y Y C
o
m
m
o
n

This process gen-
erates a dialer 
exclusion file with 
account details 
and checks if the 
maintained call 
action result entry 
is made on any 
account during the 
specified time 
interval.

GLP GL Interface gliprc_b-
j_100_01

GL SUMMA-
RIZATION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process sum-
marizes GL trans-
actions for the day.

GOV Debt Report-
ing IRS 
1099A /
1099C

gdraap_
bj_100_0
1

IRS 1099-A 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the 1099-A 
flat file for govern-
ment reporting.

GOV Debt Report-
ing IRS 
1099A /
1099C

gdrcad_b
j_100_01

IRS 1099-C 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the 1099-C 
flat file for govern-
ment reporting.

GOV HMDA 
Reporting

ghr-
prc_b-
j_100_01

IRS HMDA 
PROCESS-
ING

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process gen-
erates the HMDA 
flat file for govern-
ment reporting.

GOV Interest 
Reporting 
IRS 1098

girprc_b-
j_100_01

IRS 1098 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the 1098 flat 
file for government 
reporting.
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JOB Scheduler jsctst_b-
j_000_01

Scheduler Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process test 
the job scheduler

LBP Lockbox lbxprc_b-
j_100_01

LOAD 
LOCKBOX 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process loads 
any lockbox files 
available. This pro-
cess can be set to 
run periodically 
throughout the day.

LNT Lien Tracking OFD-
PRC_B-
J_111_0
3

OUTPUT 
LIEN 
TRACKING 
FOR DATA 
CHANGE

N Y N C
o
m
m
o
n

This process gen-
erates output file 
with changes in 
customer informa-
tion such as 
Address/Phone 
no./Borrower/Co-
borrower name.

LNT Lien Tracking OFD-
PRC_B-
J_111_0
4

OUTPUT 
LIEN 
TRACKING 
FOR VOID 
ACCOUNT

N Y N C
o
m
m
o
n

This process gen-
erates output file 
for 'Void Accounts' 
to be sent to dealer 
track.

LTR Collections 
Letter

lcolt1_b-
j_100_01

GENERATE 
FIRST COL-
LECTION 
LETTER

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the first col-
lection letter for 
eligible accounts.

LTR Collections 
Letter 

lcolt2_b-
j_100_01

GENERATE 
SECOND 
COLLEC-
TION LET-
TER

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the second 
collection letter for 
eligible accounts.

LTR Collections 
Letter

lcolt3_b-
j_100_01

GENERATE 
THIRD COL-
LECTION 
LETTER

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the third col-
lection letter for 
eligible accounts.
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LTR Customer 
Service Let-
ter

lcspdf_b-
j_111_01

PAID IN 
FULL LET-
TER

N
o

Y
e
s

N
o

L
o
a
n

This process gen-
erates the paid-in-
full letter for the 
relevant accounts.

LTR Customer 
Service Let-
ter

lcspo-
q_b-
j_111_01

PAYOFF 
QUOTE 
LETTER

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the payoff 
quote letter for the 
requested 
accounts.

LTR Customer 
Service Let-
ter

lcsst-
m_b-
j_100_01

CUS-
TOMER 
STATE-
MENT LET-
TER

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the cus-
tomer statement 
letter for requested 
accounts.

LTR Customer 
Service Let-
ter

lcswel_b-
j_111_01

WELCOME 
LETTER

N
o

Y
e
s

N
o

L
o
a
n

This process gen-
erates the wel-
come letter for the 
newly funded 
accounts.

LTR Origination 
Letter

loraco_b-
j_111_01

Origination 
Adverse 
Action Let-
ter(Condi-
tional) 
(Loan)

Y
e
s

N
o

N
o

L
o
a
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.

LTR Origination 
Letter

loradv_b-
j_111_01

Origination 
Adverse 
Action Let-
ter (Loan)

Y
e
s

N
o

N
o

L
o
a
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.

ODD Coupon 
Book Dump 
File

ocn-
prc_b-
j_100_01

CUS-
TOMER 
COUPON 
BOOK GEN-
ERATION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates coupon 
books, if appropri-
ate.

ODD Output Data 
Dump File

odd-
prc_b-
j_000_01

CREATE 
OUTPUT 
DATA DUMP 
FILES

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process cre-
ates any defined 
output data dump 
files set in the sys-
tem.
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ODD Collections 
Letter

olclt1_b-
j_100_01

COLLEC-
TION LET-
TER 1 FILE 
CREATION

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the first col-
lection letter for 
eligible accounts.

ODD Collections 
Letter 

olclt2_b-
j_100_01

COLLEC-
TION LET-
TER 2 FILE 
CREATION

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the second 
collection letter for 
eligible accounts.

ODD Collections 
Letter

olclt3_b-
j_100_01

COLLEC-
TION LET-
TER 3 FILE 
CREATION

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process gen-
erates the third col-
lection letter for 
eligible accounts.

ODD Origination 
Letter

olo-
aco_b-
j_100_01

ADVERSE 
ACTION 
CONDI-
TIONAL 
LETTER 
FILE CRE-
ATION

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.

ODD Origination 
Letter

oload-
v_b-
j_100_01

ADVERSE 
ACTION 
LETTER 
FILE CRE-
ATION

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.

ODD Customer 
Service Let-
ter

olspdf_b-
j_100_01

PAID IN 
FULL FILE 
CREATION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the paid-in-
full letter for the 
relevant accounts.

ODD Customer 
Service Let-
ter

olspo-
q_b-
j_100_01

PAY OFF 
QUOTE 
FILE CRE-
ATION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the payoff 
quote letter for the 
requested 
accounts.
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ODD Customer 
Service Let-
ter

ols-
wel_b-
j_100_01

WELCOME 
LETTER 
FILE CRE-
ATION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the wel-
come letter for the 
newly funded 
accounts.

ODD Producer 
Statement 
Dump File

opsprc_b
j_100_01

DEALER 
STATE-
MENTS 
GENERA-
TION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the dealer/
producer state-
ments at the speci-
fied frequency.

ODD Customer 
Statement 
Dump File

ostprc_b-
j_100_01

CUS-
TOMER 
STATE-
MENTS 
GENERA-
TION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process gen-
erates the cus-
tomer statement 
for eligible 
accounts.

PRQ Payable 
Requistion 
Customer

pcu-
prc_b-
j_100_01

CUS-
TOMER 
REFUND 
PAYMENT 
REQUISI-
TIONS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates requisitions 
for customer over-
payment refunds.

PRQ Payable 
Requisition 
Producer

ppores_b
j_100_01

MONTH 
END 
DEALER 
RESERVE 
PAYMENT 
REQUISI-
TIONS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates requisitions 
for dealer compen-
sation payments 
on month-end.

PRQ Payable 
Requisition 
Vendor

pvn-
prc_b-
j_100_01

VENDOR 
INVOICE 
PAYMENT 
REQUISI-
TIONS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates requisitions 
for vendor invoice 
payments

PUR Archive 
Accounts

pacarc_b
j_100_01

ARCHIVE 
ACCOUNT 
DATA TO 
OTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives account 
data from 
ACCOUNTS table 
to OACCOUNTS 
table.
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PUR Archive 
Accounts

pacarc_b
j_100_02

ARCHIVE 
ACCOUNT 
DATA TO 
OOTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives account 
data from OAC-
COUNTS table to 
OOACCOUNTS 
table.

PUR Archive 
Applications

paparc_b
j_100_01

ARCHIVE 
APPLICA-
TION DATA 
TO 
OTABLES

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process 
archives applica-
tion-related data 
from APPLICA-
TIONS to OAPPLI-
CATIONS table.

PUR Archive 
Applications

paparc_b
j_100_02

ARCHIVE 
APPLICA-
TION DATA 
TO OOT-
ABLES

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process 
archives applica-
tion-related data 
from OAPPLICA-
TIONS to OOAP-
PLICATIONS 
table.

PUR Archive GL pglarc_b-
j_100_01

ARCHIVE 
GL DATA TO 
OTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives General 
Ledger data from 
GL tables to OGL 
tables.

PUR Archive GL pglarc_b-
j_100_02

ARCHIVE 
GL DATA TO 
OOTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives General 
Ledger data from 
OGL tables to 
OOGL tables.

PUR Purge Job 
Requests

pjrjrq_b-
j_100_01

Purge Job 
Requests

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
purges job 
requests from the 
system.

PUR Purge Output 
Data Dump

pododh_
bj_100_0
1

PURGE 
OUTPUT 
DATA 
HEADERS

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
purges Output 
Data Headers from 
the system.
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PUR Archive 
Securitiza-
tion

ppaarc_b
j_100_01

ARCHIVE 
POOL DATA 
TO 
OTABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives securiti-
zation data from 
TABLE to corre-
sponding OTABLE.

PUR Archive 
Securitiza-
tion

ppaarc_b
j_100_02

ARCHIVE 
POOL DATA 
TO OOT-
ABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives securiti-
zation data from 
OTABLE to corre-
sponding OOT-
ABLE.

PUR Archive Pro-
ducers

pprarc_bj
_100_01

ARCHIVE 
PRO-
DUCER 
DATA TO 
OTABLES

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives producer 
data from PRO-
DUCERS table to 
OPRODUCERS 
table.

PUR Archive Pro-
ducers

pprarc_bj
_100_02

ARCHIVE 
PRO-
DUCER 
DATA TO 
OOTABLES

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives producer 
data from OPRO-
DUCERS table to 
OOPRODUCERS 
table.

PUR Archive Pro-
ducers Txns

ppx-
arc_b-
j_100_01

ARCHIVE 
PRO-
DUCER 
TXNS DATA 
TO 
OTABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives producer 
transaction data 
from PRODUC-
ERS table to 
OPRODUCERS 
table.

PUR Archive Pro-
ducers Txns

ppx-
arc_b-
j_100_02

ARCHIVE 
PRO-
DUCER 
TXNS DATA 
TO OOT-
ABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives producer 
transaction data 
from OPRODUC-
ERS table to 
OOPRODUCERS 
table.

PUR Archive 
Statements

pstarc_b-
j_100_01

ARCHIVE 
ACCOUNT 
STATE-
MENT AND 
TXNS DATA 
TO 
OTABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives account 
statement and 
transaction data 
from TABLE to cor-
responding 
OTABLE.

E
n

g
in

e
 T

yp
e

Description
Batch 
Job

Description

O
ri

g
in

at
io

n

S
er

vi
ci

n
g

C
o

ll
ec

ti
o

n

P
ro

d
u

c
t 

Comment
2-52



PUR Archive 
Statements

pstarc_b-
j_100_02

ARCHIVE 
ACCOUNT 
STATE-
MENT AND 
TXNS DATA 
TO OOT-
ABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives account 
statement and 
transaction data 
from OTABLE to 
OOTABLE.

PUR Terminate 
User

ptuus-
r_b-
j_100_01

Terminate 
User

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process termi-
nates user satisfy-
ing the selection 
criteria.

PUR Archive Txns 
(To O tables)

ptxarc_b-
j_100_01

ARCHIVE 
TXNS DATA 
TO 
OTABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives data from 
TXNS table to 
OTXNS table.

PUR Archive Txns 
(To OO 
tables)

ptxarc_b-
j_100_02

ARCHIVE 
TXNS DATA 
TO OOT-
ABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
archives data from 
OTXNS table to 
OOTXNS table.

PUR Purge User 
Logins

pululg_b-
j_100_01

Purge User 
Logins

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
purges user login 
data from the sys-
tem.
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PUR Archive Ven-
dor Assign-
ments

pvaarc_b
j_100_01

ARCHIVE 
VENDOR 
ASSIGN-
MENTS 
DATA TO 
OTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
assignment data 
from TABLE to 
OTABLE.

The criteria for 
archival is based 
on following valida-
tion - Work Order 
Status = Closed / 
Completed / 
Repossessed + 
Days mentioned in 
system parameter 
‘PVA_ARCHIVE_-
DAYS’.

PUR Archive Ven-
dor Assign-
ments

pvaarc_b
j_100_02

ARCHIVE 
VENDOR 
ASSIGN-
MENTS 
DATA TO 
OOTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
assignment data 
from OTABLE to 
OOTABLE based 
on the days men-
tioned in system 
parameter 
‘PVA_OAR-
CHIVE_DAYS’.

PUR Archive Ven-
dor Invoices

pviarc_b-
j_100_01

ARCHIVE 
VENDOR 
INVOICES 
DATA TO 
OTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
invoice data from 
TABLEs to 
OTABLEs.

The criteria for 
archival is based 
on following valida-
tion - Invoice Sta-
tus = ‘Close’ + 
Days mentioned in 
system parameter 
‘PVI_ARCHIVE_-
DAYS’.
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PUR Archive Ven-
dor Invoices

pviarc_b-
j_100_02

ARCHIVE 
VENDOR 
INVOICES 
DATA TO 
OOTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
invoice data from 
OTABLEs to OOT-
ABLEs based on 
the days men-
tioned in system 
parameter 
‘PVI_OAR-
CHIVE_DAYS’.

PUR Archive Ven-
dors 

pvearc_b
j_100_01

ARCHIVE 
VENDORS 
DATA TO 
OTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
invoice data from 
TABLEs to 
OTABLEs.

The criteria for 
archival is based 
on following valida-
tion - Vendor end 
date is less than 
system date - Days 
mentioned in sys-
tem parameter 
‘PVE_ARCHIVE_-
DAYS’.

PUR Archive Ven-
dors

pvearc_b
j_100_02

ARCHIVE 
VENDORS 
DATA TO 
OOTABLES

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
archives vendor 
invoice data from 
OTABLEs to OOT-
ABLEs based on 
the days men-
tioned in system 
parameter 
‘PVE_OAR-
CHIVE_DAYS’.

QUE Queue Cus-
tomer Ser-
vice

qcsprc_b
j_100_01

CUS-
TOMER 
SERVICE 
QUEUE 
PROCESS-
ING

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process cre-
ates the customer 
service/collections 
queues

RDB
1

RDB1 
Accounts

racd-
mp_b-
j_100_01

Data Dump 
Accounts

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
data from (OLTP) 
Regular tables to 
Temporary T tables

E
n

g
in

e
 T

yp
e

Description
Batch 
Job

Description

O
ri

g
in

at
io

n

S
er

vi
ci

n
g

C
o

ll
ec

ti
o

n

P
ro

d
u

c
t 

Comment
2-55



RDB
1

RDB1 Appli-
cations

rapd-
mp_b-
j_100_01

LOAD 
APPLICA-
TION 
RELATED 
DATA INTO 
T TABLES

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process trans-
fers the applica-
tion data from 
(OLTP) Regular 
tables to Tempo-
rary T tables

RDB
1

RDB1 Asset 
Tracking

ratd-
mp_b-
j_100_01

LOAD 
ASSET 
RELATED 
DATA INTO 
T TABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the account 
asset data from 
(OLTP) Regular 
tables to Tempo-
rary T tables

RDB
1

RDB1 Bank-
ruptcy

rbkd-
mp_b-
j_100_01

LOAD 
BANK-
RUPTCY 
DATA TO T 
TABLES

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
bankruptcy data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
1

RDB1 Call 
Activities

rcad-
mp_b-
j_100_01

LOAD CALL 
ACTIVITIES 
DATA INTO 
T TABLES

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
call activity data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
1

RDB1 Defi-
ciency

rchd-
mp_b-
j_100_01

LOAD DEFI-
CIENCY 
DATA INTO 
T TABLES

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
deficiency data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
1

RDB1 Con-
tracts

rcod-
mp_b-
j_100_01

LOAD CON-
TRACT 
DATA INTO 
T TABLES

Y
e
s

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the account 
contracts data from 
(OLTP) Regular 
tables to Tempo-
rary T tables

RDB
1

RDB1 
Reposses-
sions

rfod-
mp_b-
j_100_01

LOAD 
REPO 
FORECLO-
SURE DATA 
INTO T 
TABLES

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
bankruptcy data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables
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RDB
1

RDB1 Pro-
ducers

rprd-
mp_b-
j_100_01

LOAD PRO-
DUCER 
AND ITS 
TXNS DATA 
INTO T 
TABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the producer 
and producer 
transactions data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
1

RDB1 Setup rstd-
mp_b-
j_100_01

LOAD 
SETUP 
RELATED 
DATA INTO 
T TABLES

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process trans-
fers the setup data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
1

RDB1 Txns rtxd-
mp_b-
j_100_01

LOAD TXN 
DATA INTO 
T TABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the account 
transactions data 
from (OLTP) Regu-
lar tables to Tem-
porary T tables

RDB
2

RDB2 
Accounts

racac-
c_b-
j_100_01

Load 
Reporting 
Tables 
Accounts

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
data from T tables 
to RDB tables

RDB
2

RDB2 
Accounts 
(Derived 
Fields)

rac-
drv_b-
j_100_01

Update 
Reporting 
Tables 
Accounts

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
updates the codes 
with description for 
account RDB 
tables

RDB
2

RDB2 Appli-
cations

rapap-
p_b-
j_100_01

Load 
Reporting 
Tables Appli-
cations

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process trans-
fers the applica-
tion data from T 
tables to RDB 
tables

RDB
2

RDB2 Appli-
cations 
(Derived 
Fields)

rap-
drv_b-
j_100_01

Update 
Reporting 
Tables Appli-
cations 
(Derived 
Fields)

Y
e
s

N
o

N
o

C
o
m
m
o
n

This process 
updates the codes 
with description for 
application RDB 
tables
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RDB
2

RDB2 Asset 
Tracking

ratase_bj
_100_01

Load 
Reporting 
Tables Asset 
Tracking

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the account 
asset tracking data 
from T tables to 
RDB tables

RDB
2

RDB2 Asset 
Tracking 
(Derived 
Fields)

ratdrv_b-
j_100_01

Update 
Reporting 
Tables Asset 
Tracking 
(Derived 
Fields)

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
updates the codes 
with description for 
account asset 
tracking RDB 
tables

RDB
2

RDB2 Bank-
ruptcy

rbkab-
d_b-
j_100_01

Load 
Reporting 
Tables 
Bankruptcy

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
bankruptcy data 
from T tables to 
RDB tables

RDB
2

RDB2 Call 
Activities

rca-
cac_b-
j_100_01

Load 
Reporting 
Tables Call 
Activities

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
call activities data 
from T tables to 
RDB tables

RDB
2

RDB2 Defi-
ciency

rchaof_bj
_100_01

Load 
Reporting 
Tables Defi-
ciency

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
deficiency data 
from T tables to 
RDB tables

RDB
2

RDB2 Con-
tracts

rco-
con_b-
j_100_01

Load 
Reporting 
Tables Con-
tracts

Y
e
s

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the account 
contract data from 
T tables to RDB 
tables

RDB
2

RDB2 Con-
tracts 
(Derived 
Fields)

rcodrv_bj
_100_01

Update 
Reporting 
Tables Con-
tracts 
(Derived 
Fields)

Y
e
s

Y
e
s

N
o

C
o
m
m
o
n

This process 
updates the codes 
with description for 
account contract 
RDB tables
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RDB
2

RDB2 
Reposses-
sions

rfoafr_b-
j_100_01

Load 
Reporting 
Tables 
Reposses-
sions

N
o

N
o

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
repossession data 
from T tables to 
RDB tables

RDB
2

RDB2 Pro-
ducers 
(Derived 
Fields)

rprdrv_b-
j_100_01

Update 
Reporting 
Tables Pro-
ducers 
(Derived 
Fields)

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
updates the codes 
with description for 
producer and pro-
ducer transactions 
RDB tables

RDB
2

RDB2 Pro-
ducers

rprpro_b-
j_100_01

Load 
Reporting 
Tables Pro-
ducers

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process trans-
fers the producer 
and producer 
transactions data 
from T tables to 
RDB tables

RDB
2

RDB2 Setup rststp_b-
j_100_01

Load 
Reporting 
Tables 
Setup

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process trans-
fers the setup data 
from T tables to 
RDB tables

RDB
2

RDB2 Txns rtxdrv_b-
j_100_01

Load 
Reporting 
Tables Txns

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process trans-
fers the account 
transaction data 
from T tables to 
RDB tables

RDB
2

RDB2 Txns 
(Derived 
Fields)

rtxtxn_b-
j_100_01

Update 
Reporting 
Tables Txns 
(Derived 
Fields)

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
updates the codes 
with description for 
account transac-
tions RDB tables

SEC Pool Sum-
mary

ssm-
prc_b-
j_100_01

POOL SUM-
MARY 
TABLE 
POPULA-
TION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process popu-
lates summary 
tables for all pools
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SET-
OVR

OVERPAY-
MENT 
REALLOCA-
TIONS

PFSTX-
NOVR_B
J_100_0
1

OVERPAY-
MENT 
REALLOCA-
TIONS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process han-
dles the overpay-
ments/overages 
existing on an 
account

TPE Earning/
Amortization

tam-
prc_b-
j_100_01

AMORTIZA-
TION 
TRANSAC-
TIONS 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates the month-
end interest 
accrual transac-
tions on month-
end.

TPE Earning/
Amortization

tam-
prc_b-
j_111_01

MONTH 
END AMOR-
TIZATION 
TRANSAC-
TIONS

N
o

Y
e
s

N
o

L
o
a
n

This process cre-
ates the month-
end interest 
accrual transac-
tions on month-
end.

TPE Escrow Non 
Monetary 
Transactions

tenbmt_b
j_100_01

Escrow Non 
Monetary 
Batch Trans-
actions

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process posts 
escrow non mone-
tary transactions in 
the background at 
the specified time 
interval.

TPE Escrow Anal-
ysis & Dis-
bursements

tesanl_b-
j_100_01

Escrow 
Analysis 
Posting

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
all approved 
escrow analysis to 
the account 

TPE Escrow Anal-
ysis & Dis-
bursements

tesanl_b-
j_100_02

Create 
batches for 
Customer 
Refund 
Requests

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates company 
branch wise 
batches for cus-
tomer refund 
requests.

TPE Escrow Anal-
ysis & Dis-
bursements

tesanl_b-
j_100_03

Create 
Transaction 
of Customer 
Refund 
Requests

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process popu-
late customer 
refund request in 
respective batch 
created above
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TPE Escrow Anal-
ysis & Dis-
bursements

tesanl_b-
j_100_04

Compute 
control totals 
for cus-
tomer refund 
request 
batches

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process popu-
lates control totals 
for the bathes cre-
ated for customer 
refund requests.

TPE Escrow Anal-
ysis & Dis-
bursements

tesanl_b-
j_100_05

Escrow 
compliance 
checking

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
checks escrow-
able account for 
compliance

TPE Escrow Anal-
ysis & Dis-
bursements

tesds-
b_b-
j_100_05

Escrow dis-
bursement 
posting & 
requisition 
creation

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
processed escrow 
disbursement and 
creates requisi-
tions.

TPE Non Mone-
tary Transac-
tions

tnmb-
mt_b-
j_100_01

NON MON-
ETARY 
TRANSAC-
TIONS 
POSTING

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This process posts 
non monetary 
transactions in the 
background at the 
specified time 
interval.

TPE Compensa-
tion

tpr-
com_b-
j_111_01

Compensa-
tion

N
o

Y
e
s

N
o

L
o
a
n

This process cre-
ates transaction for 
month-end pro-
ducer compensa-
tion

TPE Statement tprps-
g_b-
j_111_01

Producer 
Statement

N
o

Y
e
s

N
o

L
o
a
n

This process cre-
ates the month-
end interest 
accrual transac-
tions on month-
end.

TPE Monetary 
Transactions

txnacr_b-
j_100_01

INTEREST 
ACCRUAL 
AND DELIN-
QUENCY 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
any payment 
batches open in 
the system. This 
process can be set 
to run periodically.
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TPE Monetary 
Transactions

txnact_b-
j_100_01

ACCOUNT 
ACTIVA-
TION

N
o

Y
e
s

N
o

C
o
m
m
o
n

This job activates 
new accounts i.e. 
changes status 
from PENDING to 
ACTIVE.

TPE Monetary 
Transactions

txnad-
v_b-
j_112_01

Advance 
Posting

N
o

Y
e
s

N
o

L
i
n
e

This process posts 
any advance 
batches open in 
the system. This 
process can be set 
to run periodically.

TPE Monetary 
Transactions

txnan-
n_b-
j_100_01

ANNIVER-
SARY PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process car-
ries out the anni-
versary processing 
for eligible 
accounts

TPE Monetary 
Transactions

txnbmt_b
j_100_01

MONE-
TARY 
TRANSAC-
TIONS 
POSTING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
monetary transac-
tions in the back-
ground at the 
specified time 
interval.

TPE Monetary 
Transactions

txnch-
g_b-
j_100_01

Chargeoff 
Processing

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
charges off eligi-
ble or scheduled 
for chargeoff 
accounts.

TPE Monetary 
Transactions

txnch-
g_b-
j_100_03

Chargeoff 
reversal

N
o

Y
e
s

N
o

C
o
m
m
o
n

On posting charge 
off reversal trans-
action, this pro-
cess moves the 
remaining expense 
and fee from 
charge off balance 
to active balance.

TPE Monetary 
Transactions

txncls_b-
j_100_01

VOID/PAID 
ACCOUNT 
CLOSE 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
closes void and 
paid off accounts.
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TPE Monetary 
Transactions

txnddt_b-
j_100_01

BILLING/
DUE DATES 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process cre-
ates/updates the 
due dates for the 
accounts in the 
system.

TPE Monetary 
Transactions

txnfpd_b-
j_100_01

FIRST PMT 
DEDUC-
TION PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process posts 
the first payment 
deduction pay-
ment to the eligi-
ble accounts.

TPE Monetary 
Transactions

txnfpr_b-
j_111_01

FIRST PMT 
REFUND 
PROCESS-
ING

N
o

Y
e
s

N
o

L
o
a
n

This process posts 
the first payment 
deduction pay-
ment to the eligi-
ble accounts.

TPE Monetary 
Transactions

txnltc_b-
j_100_01

LATE 
CHARGE 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
assesses late 
charge depending 
on the rules, for all 
accounts in the 
system.

TPE Monetary 
Transactions

txnmt-
d_b-
j_100_01

MONTH 
END PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process popu-
lates the month 
end balances and 
carries over the 
balances to next 
month.

TPE Monetary 
Transactions

txnp-
mt_b-
j_100_01

Payment 
Posting

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process does 
the daily accrual 
and delinquency 
processing.

TPE Monetary 
Transactions

txn-
prm_b-
j_100_01

PROMO-
TION END 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 'ends' 
the promotion on 
the account.
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TPE Monetary 
Transactions

txn-
prm_b-
j_100_03

TLP PRO-
MOTION 
CANCEL 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 'can-
cels' the promo-
tion on the 
account.

TPE Monetary 
Transactions

txnrat_b-
j_100_01

RATE 
CHANGE 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process 
changes the prev-
alent rate on an 
account.

TPE Monetary 
Transactions

txn-
sch_b-
j_100_01

SCHEDULE 
FOR 
CHARGED
OFF PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process puts 
the 'Schedule for 
Charge Off' condi-
tion on eligible 
accounts.

TPE Monetary 
Transactions

txntip_b-
j_100_01

TERMINA-
TION PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process puts 
the "Paid" status 
on eligible 
accounts

TPE Monetary 
Transactions

txnytd_b-
j_100_01

YEAR END 
PROCESS-
ING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This process popu-
lates the year end 
balances and car-
ries over the bal-
ances to next year.
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XPR DEALER 
TRACK 
PRO-
DUCER 
LOAD

XPRP-
ST_EW_
100_01

DEALER 
TRACK 
PRO-
DUCER 
LOAD

N Y Y C
o
m
m
o
n

This process 
dumps producer 
details maintained 
in the system into 
Dealer Track.

System can either 
use MDB flow by 
generating out-
bound JMS mes-
sage if system 
parameter ‘OUT-
BOUND_DL-
R_TRACK_Q’ is 
set to ‘Y’ or use 
existing flow by 
making database 
synchronous out-
bound calls to pro-
ducer data dump 
web service.

XPR
2

ROUTE ONE 
PRO-
DUCER 
LOAD

XPRP-
ST_EW_
100_01

ROUTE 
ONE PRO-
DUCER 
LOAD

N Y Y C
o
m
m
o
n

This process 
dumps producer 
details maintained 
in the system into 
ROUTEONE.

System can either 
use MDB flow by 
generating out-
bound JMS mes-
sage if system 
parameter ‘OUT-
BOUND_ROU-
TEONE_Q’ is set 
to ‘Y’ or use exist-
ing flow by making 
database synchro-
nous outbound 
calls to producer 
data dump web 
service.

LTR CONDI-
TIONAL 
ADVERSE 
ACTION 
LETTER

LORAC
O_B-
J_100_0
1

CONDI-
TIONAL 
ADVERSE 
ACTION 
LETTER 
GENERA-
TION

Y
e
s

N
o

N
o

L
o
a
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.
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LTR ADVERSE 
ACTION 
LETTER

LORAD-
V_B-
J_100_0
1

ADVERSE 
ACTION 
LETTER 
GENERA-
TION

Y
e
s

N
o

N
o

L
o
a
n

This process gen-
erates the adverse 
action letter for rel-
evant applications.

RPT ACCOUNT 
LIST

ROPAC-
C_EM_1
00_01

ACCOUNT 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT ADVANCE 
POSTING 
LIST

ROPAD-
V_EM_1
00_01

ADVANCE 
POSTING 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT ASSET 
TRACKING 
DETAILS

ROPAT-
K_EM_1
00_01

ASSET 
TRACKING 
DETAILS

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT BANK-
RUPTCY 
ACCOUNT 
LIST

ROPBN
K_EM_1
00_01

BANK-
RUPTCY 
ACCOUNT 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT COLLEC-
TOR ACTIV-
ITY DETAILS

ROP-
COL_EM
_100_01

COLLEC-
TOR ACTIV-
ITY 
DETAILS

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT DEFI-
CIENCY 
ACCOUNT 
LIST

ROP-
DEF_EM
_100_01

DEFI-
CIENCY 
ACCOUNT 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n
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RPT DELIN-
QUENT 
ACCOUNT 
LIST

ROP-
DLQ_EM
_100_01

DELIN-
QUENT 
ACCOUNT 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT FUNDING 
CONTRACT 
LIST

ROP-
FUN_EM
_100_01

FUNDING 
CON-
TRACT LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT GL TXN 
DETAILS 
LIST

ROP-
GLI_EM
_100_01

GL TXN 
DETAILS 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT APPLICA-
TIONS LIST

ROPOR
G_EM_1
00_01

APPLICA-
TIONS LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT PAYMENT 
ALLOCA-
TION POST-
ING 
DETAILS|

ROP-
PAL_EM
_100_01

PAYMENT 
ALLOCA-
TION POST-
ING 
DETAILS|

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT PAYMENT 
POSTING 
LIST

ROP-
PMT_EM
_100_01

PAYMENT 
POSTING 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT PAYABLE 
REQUISI-
TION LIST

ROP-
PRQ_E
M_100_0
1

PAYABLE 
REQUISI-
TION LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

E
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RPT REPOSSSE-
SION/FORE-
CLOSURE 
ACCOUNT 
LIST

ROPRE
P_EM_1
00_01

REPOS-
SSESION/
FORECLO-
SURE 
ACCOUNT 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT SCHEDULE 
TO CHAR-
GEOFF LIST

ROP-
SCH_EM
_100_01

SCHEDULE 
TO CHAR-
GEOFF 
LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT TERMINA-
TION IN 
PROGRESS 
LIST

ROP-
TIP_EM_
100_01

TERMINA-
TION IN 
PROG-
RESS LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT NON MON-
TETARY 
TXN POST-
ING LIST

ROPTN-
M_EM_1
00_01|

NON MON-
TETARY 
TXN POST-
ING LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT MON-
TETARY 
TXN POST-
ING LIST

ROPTX-
N_EM_1
00_01

MON-
TETARY 
TXN POST-
ING LIST

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT BATCH JOB 
SETUP

CMN-
BJB_EM
_100_01

BATCH JOB 
SETUP

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT BATCH JOB 
LOG

CMN-
BJB_EM
_100_02

BATCH JOB 
LOG

N
o

Y
e
s

N
o

C
o
m
m
o
n

E
n

g
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RPT NUMBER 
OF CREDIT 
APPLICA-
TIONS 
ENTERED 
BY USER

OUN-
ADE_EM
_100_01

NUMBER 
OF CREDIT 
APPLICA-
TIONS 
ENTERED 
BY USER

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT CREDIT 
APPLICA-
TIONS 
IMAGES BY 
STATUS

OUN-
ADE_EM
_100_02

CREDIT 
APPLICA-
TIONS 
IMAGES BY 
STATUS

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LOAN)

OUNUN
D_EM_1
11_11

UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LOAN)

OUNUN
D_EM_1
11_12

UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
(LOAN)

OUNUN
D_EM_1
11_13

UNDER-
WRITING 
STATUS BY 
MONTH 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LOAN)

OUNUN
D_EM_1
11_14

UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LINE)

OUNUN
D_EM_1
12_11

UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LINE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

E
n

g
in

e
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e
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RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LINE)

OUNUN
D_EM_1
12_12

UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LINE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
(LINE)

OUNUN
D_EM_1
12_13

UNDER-
WRITING 
STATUS BY 
MONTH 
(LINE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LINE)

OUNUN
D_EM_1
12_14

UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LINE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LEASE)

OUNUN
D_EM_1
21_11

UNDER-
WRITING 
STATUS BY 
MONTH 
AND PRO-
DUCER 
(LEASE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LEASE)

OUNUN
D_EM_1
21_12

UNDER-
WRITING 
STATUS BY 
MONTH 
AND 
UNDER-
WRITER 
(LEASE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT UNDER-
WRITING 
STATUS BY 
MONTH 
(LEASE)

OUNUN
D_EM_1
21_13

UNDER-
WRITING 
STATUS BY 
MONTH 
(LEASE)

N
o

Y
e
s

N
o

C
o
m
m
o
n

E
n

g
in

e
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e
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RPT UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LOAN)

OUNUN
D_EM_1
21_14

UNDER-
WRITING 
STATUS BY 
UNDER-
WRITER 
(LOAN)

Y
e
s

N
o

N
o

L
e
a
s
e

RPT ACCOUNT 
PAYABLE 
(ORIGINA-
TION)

OFNA-
PY_EM_
100_01

ACCOUNT 
PAYABLE 
(ORIGINA-
TION)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT ACCOUNT 
PAYABLE 
(SERVIC-
ING)

OFNA-
PY_EM_
100_02

ACCOUNT 
PAYABLE 
(SERVIC-
ING)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT PRE-FUND-
ING CON-
TRACTS 
(LOAN)

OFNF-
ND_EM_
111_01

PRE-FUND-
ING CON-
TRACTS 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT FUNDED 
CON-
TRACTS 
(LOAN)

OFNF-
ND_EM_
111_02

FUNDED 
CON-
TRACTS 
(LOAN)

Y
e
s

N
o

N
o

l
o
a
n

RPT PRE-FUND-
ING CON-
TRACTS 
(LINE)

OFNF-
ND_EM_
112_01

PRE-FUND-
ING CON-
TRACTS 
(LINE)

Y
e
s

N
o

N
o

L
o
a
n

RPT FUNDED 
CON-
TRACTS 
(LINE)

OFNF-
ND_EM_
112_02

FUNDED 
CON-
TRACTS 
(LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PRE-FUND-
ING CON-
TRACTS 
(LEASE)

OFNF-
ND_EM_
121_01

PRE-FUND-
ING CON-
TRACTS 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n
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g
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RPT FUNDED 
CON-
TRACTS 
(LEASE)

OFNF-
ND_EM_
121_02

FUNDED 
CON-
TRACTS 
(LEASE)

Y
e
s

N
o

N
o

L
o
a
n

RPT ACCOUNT 
PAYABLE 
LOG BY 
PRODUCER

OCSAP-
P_EM_1
00_01

ACCOUNT 
PAYABLE 
LOG BY 
PRODUCER

Y
e
s

N
o

N
o

L
o
a
n

RPT ACCOUNT 
PAYABLE 
LOG BY 
VENDOR

OCSAPV
_EM_10
0_01

ACCOUNT 
PAYABLE 
LOG BY 
VENDOR

Y
e
s

N
o

N
o

L
o
a
n

RPT COLLAT-
ERAL 
TRACKING 
LOG

OCSAS-
T_EM_1
00_01

COLLAT-
ERAL 
TRACKING 
LOG

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT GL POST-
ING LOG

OCS-
GLI_EM
_100_01

GL POST-
ING LOG

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PAYMENT 
POSTING 
(DAILY 
CASH) LOG

OCSP-
MT_EM_
100_01

PAYMENT 
POSTING 
(DAILY 
CASH) LOG

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PAYMENT 
POSTING 
ERROR 
LOG

OCSP-
MT_EM_
100_02

PAYMENT 
POSTING 
ERROR 
LOG

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT ACCOUNT 
LISTING 
(LOAN)

OCSAC-
C_EM_1
11_01

ACCOUNT 
LISTING 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n
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RPT EXCESS 
PAYMENT 
(REFUND) 
LOG (LOAN)

OCSP-
MT_EM_
111_03

EXCESS 
PAYMENT 
(REFUND) 
LOG 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT PAYMENT 
HISTORY 
(LOAN)

OCSP-
MT_EM_
111_04

PAYMENT 
HISTORY 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT PAYMENT 
ALLOCA-
TIONS LOG 
(LOAN)

OCSP-
MT_EM_
111_05

PAYMENT 
ALLOCA-
TIONS LOG 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT PAYMENT 
ALLOCA-
TIONS LOG 
BY GL POST 
DT (LOAN)

OCSP-
MT_EM_
111_06

PAYMENT 
ALLOCA-
TIONS LOG 
BY GL 
POST DT 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT PRO-
DUCER 
STATE-
MENT 
(LOAN)

OCSPS-
M_EM_1
11_01

PRO-
DUCER 
STATE-
MENT 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT PRO-
DUCER 
MONETARY 
TXNS LOG 
BY GL POST 
DT (LOAN)

OCSPTX
_EM_111
_01

PRO-
DUCER 
MONE-
TARY TXNS 
LOG BY GL 
POST DT 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG (LOAN)

OCSS-
CH_EM_
111_01

SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT AMOR-
TIZED TXNS 
LOG BY GL 
POST DT 
(LOAN)

OCSTA
M_EM_1
11_01

AMOR-
TIZED 
TXNS LOG 
BY GL 
POST DT 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n
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n

g
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RPT SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG (LOAN)

OCSTER
_EM_111
_01

SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT MONETARY 
TXNS LOG 
BY GL POST 
DT (LOAN)

OCSTX-
N_EM_1
11_01

MONE-
TARY TXNS 
LOG BY GL 
POST DT 
(LOAN)

Y
e
s

N
o

N
o

L
o
a
n

RPT ACCOUNT 
LISTING 
(LINE)

OCSAC-
C_EM_1
12_01

ACCOUNT 
LISTING 
(LINE)

Y
e
s

N
o

N
o

L
o
a
n

RPT ADVANCE 
POSTING 
LOG (LINE)

OCSAD-
V_EM_1
12_01

ADVANCE 
POSTING 
LOG (LINE)

Y
e
s

N
o

N
o

L
o
a
n

RPT ADVANCE 
POSTING 
ERROR 
LOG (LINE)

OCSAD-
V_EM_1
12_02

ADVANCE 
POSTING 
ERROR 
LOG (LINE)

Y
e
s

N
o

N
o

L
o
a
n

RPT PAYMENT 
HISTORY 
(LINE)

OCSP-
MT_EM_
112_04

PAYMENT 
HISTORY 
(LINE)

Y
e
s

N
o

N
o

L
o
a
n

RPT PAYMENT 
ALLOCA-
TIONS LOG 
(LINE)

OCSP-
MT_EM_
112_05

PAYMENT 
ALLOCA-
TIONS LOG 
(LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PAYMENT 
ALLOCA-
TIONS LOG 
BY GL POST 
DT (LINE)

OCSP-
MT_EM_
112_06

PAYMENT 
ALLOCA-
TIONS LOG 
BY GL 
POST DT 
(LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

E
n

g
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RPT SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG (LINE)

OCSS-
CH_EM_
112_01

SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG (LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT AMOR-
TIZED TXNS 
LOG BY GL 
POST DT 
(LINE)

OCSTA
M_EM_1
12_01

AMOR-
TIZED 
TXNS LOG 
BY GL 
POST DT 
(LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG (LINE)

OCSTER
_EM_11
2_01

SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG (LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT MONETARY 
TXNS LOG 
BY GL POST 
DT (LINE)

OCSTX-
N_EM_1
12_01

MONE-
TARY TXNS 
LOG BY GL 
POST DT 
(LINE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT ACCOUNT 
LISTING 
(LEASE)

OCSAC-
C_EM_1
21_01

ACCOUNT 
LISTING 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PAYMENT 
HISTORY 
(LEASE)

OCSP-
MT_EM_
121_04

PAYMENT 
HISTORY 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT PAYMENT 
ALLOCA-
TIONS LOG 
(LEASE)

OCSP-
MT_EM_
121_05

PAYMENT 
ALLOCA-
TIONS LOG 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n
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RPT PAYMENT 
ALLOCA-
TIONS LOG 
BY GL POST 
DT (LEASE)

OCSP-
MT_EM_
121_06

PAYMENT 
ALLOCA-
TIONS LOG 
BY GL 
POST DT 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG 
(LEASE)

OCSS-
CH_EM_
121_01

SCHED-
ULED FOR 
CHAR-
GEOFF 
ACCOUNTS 
LOG 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT AMOR-
TIZED TXNS 
LOG BY GL 
POST DT 
(LEASE)

OCSTA
M_EM_1
21_01

AMOR-
TIZED 
TXNS LOG 
BY GL 
POST DT 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG 
(LEASE)

OCSTER
_EM_12
1_01

SCHED-
ULED FOR 
TERMINA-
TION 
ACCOUNTS 
LOG 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT MONETARY 
TXNS LOG 
BY GL POST 
DT (LEASE)

OCSTX-
N_EM_1
21_01

MONE-
TARY TXNS 
LOG BY GL 
POST DT 
(LEASE)

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT BANK-
RUPTCY 
LOG

OCOBN
K_EM_1
00_01

BANK-
RUPTCY 
LOG

Y
e
s

N
o

N
o

C
o
m
m
o
n

RPT COLLEC-
TOR ACTIV-
ITY 
(DETAILED) 
LOG

OCO-
COL_EM
_100_01

COLLEC-
TOR ACTIV-
ITY 
(DETAILED) 
LOG

N
o

N
o
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g
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RPT COLLEC-
TOR PRO-
DUCTIVITY 
BY QUEUE

OCO-
COL_EM
_100_02

COLLEC-
TOR PRO-
DUCTIVITY 
BY QUEUE

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT DELIN-
QUENCY 
ANALYSIS 
BY PRO-
DUCER

OCO-
COL_EM
_100_03

DELIN-
QUENCY 
ANALYSIS 
BY PRO-
DUCER

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT DELIN-
QUENCY 
ANALYSIS 
BY CREDIT 
GRADE

OCO-
COL_EM
_100_04

DELIN-
QUENCY 
ANALYSIS 
BY CREDIT 
GRADE

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT DELIN-
QUENCY 
ANALYSIS 
BY STATE

OCO-
COL_EM
_100_05

DELIN-
QUENCY 
ANALYSIS 
BY STATE

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT PAYMENT 
PROMISE 
LOG

OCO-
COL_EM
_100_06

PAYMENT 
PROMISE 
LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT COLLEC-
TOR ACTIV-
ITY LOG

OCO-
COL_EM
_100_07

COLLEC-
TOR ACTIV-
ITY LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT DEFI-
CIENCY 
LOG

OCODE-
F_EM_1
00_01

DEFI-
CIENCY 
LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n
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RPT DELIN-
QUENCY 
LOG

OCODL
Q_EM_1
00_01

DELIN-
QUENCY 
LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT REPOSSES-
SION/FORE-
CLOSURE 
LOG

OCORE
P_EM_1
00_01

REPOS-
SESSION/
FORECLO-
SURE LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT NON MONE-
TARY TXNS 
LOG

OCOTN-
M_EM_1
00_01

NON MON-
ETARY 
TXNS LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT VENDOR 
INVOICE 
LOG

OCOVIN
_EM_10
0_01

VENDOR 
INVOICE 
LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT VENDOR 
WORK 
ORDER 
LOG

OCOVN
A_EM_1
00_01

VENDOR 
WORK 
ORDER 
LOG

N
o

N
o

Y
e
s

C
o
m
m
o
n

RPT POOL 
DELIN-
QUENCY 
SUMMARY 
(LOAN)

OCS-
SEC_EM
_111_01

POOL 
DELIN-
QUENCY 
SUMMARY 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL 
DEFAULTS 
(NON LIQUI-
DATED) 
(LOAN)

OCS-
SEC_EM
_111_02

POOL 
DEFAULTS 
(NON LIQ-
UIDATED) 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n
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g
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RPT POOL PAY-
OFFS 
(LOAN)

OCS-
SEC_EM
_111_03

POOL PAY-
OFFS 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL 
RECOVERY 
(LOAN)

OCS-
SEC_EM
_111_04

POOL 
RECOV-
ERY (LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL 
DELIN-
QUENCY 
(LOAN)

OCS-
SEC_EM
_111_05

POOL 
DELIN-
QUENCY 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL 
REPUR-
CHASED 
ACCOUNTS 
(LOAN)

OCS-
SEC_EM
_111_06

POOL 
REPUR-
CHASED 
ACCOUNTS 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL 
MONTHLY 
ACTIVITY 
(LOAN)

OCS-
SEC_EM
_111_07

POOL 
MONTHLY 
ACTIVITY 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL LIQ-
UIDATED 
CON-
TRACTS 
(LOAN)

OCS-
SEC_EM
_111_08

POOL LIQ-
UIDATED 
CON-
TRACTS 
(LOAN)

N
o

Y
e
s

N
o

C
o
m
m
o
n

RPT POOL TXNS 
LOG BY GL 
POST DT 
(LOAN)

OCS-
SEC_EM
_111_09

POOL TXNS 
LOG BY GL 
POST DT 
(LOAN)

N
o

Y
e
s

N
o

C
o
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o
n
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SET-
QRT

Real time 
Queues pro-
cessing

QCSPR
C_B-
J_100_0
2

Real time 
Queues pro-
cessing

N
o

Y
e
s

Y
e
s

C
o
m
m
o
n

This batch job pro-
cesses queues 
marked as real 
time based on 
refresh frequency 
setup in the job 
set.

TAM MONTH 
END COM-
PENSATION 
DISBURSE-
MENT PRO-
CESSING

TPR-
COM_B-
J_100_0
1

MONTH 
END COM-
PENSA-
TION 
DISBURSE-
MENT PRO-
CESSING

N
o

Y
e
s

N
o

C
o
m
m
o
n

TAM PRO-
DUCER 
STATE-
MENTS

TPRPS-
G_B-
J_100_0
1

PRO-
DUCER 
STATE-
MENTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

TAM PRO-
DUCER 
STATUS 
CHANGE

TPRSTA
_BJ_100
_01

PRO-
DUCER 
STATUS 
CHANGE

N
o

Y
e
s

N
o

C
o
m
m
o
n

TPE Escrow Anal-
ysis & Dis-
bursements

TXNCH-
G_B-
J_100_0
2

CHAR-
GEOFF 
PROCESS-
ING FOR 
ACTIVE 
ACCOUNTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This package con-
tains procedures 
related to Batch 
Job for chargeoff 
processing

ESC ESCROW 
ANALYSIS 
POSTING

TESAN-
L_B-
J_100_0
1

ESCROW 
ANALYSIS 
POSTING

N
o

Y
e
s

N
o

C
o
m
m
o
n

This package con-
tains procedures 
related to Batch 
Job for escrow 
analysis process-
ing

ESC CREATE 
BATCHES 
FOR CUS-
TOMER 
REFUND 
REQUESTS

TESAN-
L_B-
J_100_0
2

CREATE 
BATCHES 
FOR CUS-
TOMER 
REFUND 
REQUESTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

This package con-
tains procedures 
related to Batch 
Job for escrow 
analysis process-
ing
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ESC COMPUTE 
CONTROLS 
FOR CUS-
TOMER 
REFUND 
REQUEST 
BATCHES

TESAN-
L_B-
J_100_0
4

COMPUTE 
CON-
TROLS FOR 
CUS-
TOMER 
REFUND 
REQUEST 
BATCHES

N
o

Y
e
s

N
o

C
o
m
m
o
n

ESC ESCROW 
COMPLI-
ANCE 
CHECKING

TESAN-
L_B-
J_100_0
5

ESCROW 
COMPLI-
ANCE 
CHECKING

N
o

Y
e
s

N
o

C
o
m
m
o
n

ESC CREATE 
PAYABLE 
REQUISI-
TIONS 
FROM 
APPROVED 
DISBURSE-
MENT 
REQUESTS

TESDS-
B_B-
J_100_0
1

CREATE 
PAYABLE 
REQUISI-
TIONS 
FROM 
APPROVED 
DISBURSE-
MENT 
REQUESTS

N
o

Y
e
s

N
o

C
o
m
m
o
n

PUR ARCHIVE 
ACCOUNT 
DATA TO 
OTABLES

PACARC
_BJ_100
_01

ARCHIVE 
ACCOUNT 
DATA TO 
OTABLES

N
o

Y
e
s

N
o

C
o
m
m
o
n

EVE BATCH 
EVENTS 
FOR 
ACCOUNTS

EVBAC-
C_B-
J_100_0
1

BATCH 
EVENTS 
FOR 
ACCOUNTS

Y
e
s

EVE BATCH 
EVENTS 
FOR APPLI-
CATIONS

EVBAP-
P_B-
J_100_0
1

BATCH 
EVENTS 
FOR APPLI-
CATIONS

Y
e
s

EVE MAIN 
BATCH JOB 
FOR BATCH 
EVENTS 
PROCESS-
ING

EVB-
PRC_B-
J_100_0
1

MAIN 
BATCH JOB 
FOR BATCH 
EVENTS 
PROCESS-
ING

Y
e
s
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g
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ODD
2

BATCH JOB 
TO GENER-
ATE METRO 
2 DATA

CBUUT-
L_B-
J_100_0
2

BATCH JOB 
TO GENER-
ATE METRO 
2 DATA

Y
e
s

ODD
2

BATCH JOB 
FOR CRE-
ATING 
METRO 2 
DATA FILE

CBUUT-
L_B-
J_100_0
3

BATCH JOB 
FOR CRE-
ATING 
METRO 2 
DATA FILE

Y
e
s

ODD
2

THIRD 
PARTY ACH 
PROCESS-
ING

ACT-
PRC_B-
J_100_0
1

THIRD 
PARTY ACH 
PROCESS-
ING

Y
e
s

ODD
2

THIRD 
PARTY OUT-
PUT DATA 
DUMP SER-
VICING

OBI-
PRC_B-
J_100_0
1

CREATE 
THIRD 
PARTY 
CUS-
TOMER 
FILE

Y
e
s

This process pulls 
the customer 
account details 
shared in input 
data files for pro-
cessing.

ESC JOB TO 
GENERATE 
ESCROW 
DISCLO-
SURE 
STATEMENT

OED-
PRC_B-
J_100_0
1

JOB TO 
GENERATE 
ESCROW 
DISCLO-
SURE 
STATE-
MENT

Y
e
s

EDF ADR FILE EDFADR
_BJ_100
_01

ADR FILE Y
e
s

EDF IVR FILE EDFIVR
_BJ_100
_01

IVR FILE Y
e
s

TPE CONTRAC-
TUAL PRO-
MOTION 
CANCEL 
PROCESS-
ING

TXN-
PRM_B-
J_100_0
4

CONTRAC-
TUAL PRO-
MOTION 
CANCEL 
PROCESS-
ING

Y
e
s
_
_

E
n

g
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e
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e

Description
Batch 
Job

Description
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TPE RATE 
CHANGE 
PROCESS-
ING FOR 
BACK-
DATED 
INDEXES

TXN-
RAT_B-
J_100_0
2

RATE 
CHANGE 
PROCESS-
ING FOR 
BACK-
DATED 
INDEXES

Y
e
s

RDB
1

LOAD 
ACCOUNT 
RELATED 
DATA INTO 
T TABLES

RACD-
MP_B-
J_100_0
1

LOAD 
ACCOUNT 
RELATED 
DATA INTO 
T TABLES

Y
e
s

TPE EXPIRED 
INSUR-
ANCE PRO-
CESSING

TXNINS
_BJ_100
_01

EXPIRED 
INSUR-
ANCE PRO-
CESSING

Y
e
s

ADT UPDATE 
ROWID IN 
AUDIT 
TABLE (RUN 
THIS JOB 
AFTER 
EXPORT-
IMPORT OF 
TABLES)

ADT-
PRC_B-
J_100_0
1

UPDATE 
ROWID IN 
AUDIT 
TABLE 
(RUN THIS 
JOB AFTER 
EXPORT-
IMPORT OF 
TABLES)

Y
e
s

RDB
1

LOAD 
INSUR-
ANCE DATA 
TO T-
TABLES

RIND-
MP_B-
J_100_0
1

LOAD 
INSUR-
ANCE DATA 
TO T-
TABLES

Y
e
s

AGS SALE LEAD 
AGING

AGS-
SAL_B-
J_100_0
1

SALE LEAD 
AGING

Y
e
s

BOD PROCESS 
PARKED 
TRANSAC-
TIONS

JOB-
BOD_B-
J_000_0
2

PROCESS 
PARKED 
TRANSAC-
TIONS

Y
e
s

BOD MARK SYS-
TEM FOR 
BEGINING 
OF DAY

JOB-
BOD_B-
J_000_0
1

MARK SYS-
TEM FOR 
BEGINING 
OF DAY

Y
e
s

E
n

g
in

e
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e

Description
Batch 
Job

Description
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EOD SET SYS-
TEM MODE 
TO END-OF-
DAY

JOBEOD
_BJ_000
_01

SET SYS-
TEM MODE 
TO END-
OF-DAY

Y
e
s

ACR DAILY TRIAL 
BALANCE 
DATA 

TABAC-
C_B-
J_100_0
1

DAILY 
TRIAL BAL-
ANCE DATA 
GENERA-
TION

Y
e
s

LTR2 RATE 
CHANGE 
PRE-INTI-
MATION 
LETTER

LCS-
RAT_B-
J_100_0
1

RATE 
CHANGE 
PRE-INTI-
MATION 
LETTER

Y
e
s

BLK BULK 
UPLOAD 
FOR PRIC-
ING SETUP

BLK-
PRP_B-
J_100_0
1

BULK 
UPLOAD 
FOR PRIC-
ING SETUP

Y
e
s

BLK BULK 
UPLOAD 
FOR GL 
ATTRI-
BUTES

BLK-
GLS_B-
J_100_0
1

BULK 
UPLOAD 
FOR GL 
ATTRI-
BUTES

c
o
m
m
o
n

BLK BULK 
UPLOAD 
FOR GL 
TRANSLA-
TION 

BLK-
GLS_B-
J_100_0
2

BULK 
UPLOAD 
FOR GL 
TRANSLA-
TION DEFI-
NITION

c
o
m
m
o
n

BLK BULK 
UPLOAD 
FOR GL 
TRANSAC-
TION TYPES 

BLK-
GLS_B-
J_100_0
3

BULK 
UPLOAD 
FOR GL 
TRANSAC-
TION 
TYPES 
DETAILS

c
o
m
m
o
n

BLK BULK 
UPLOAD 
FOR GL 
TRANSAC-
TION LINKS

BLK-
GLS_B-
J_100_0
4

BULK 
UPLOAD 
FOR GL 
TRANSAC-
TION LINKS
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o
m
m
o
n
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g
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e
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Job

Description
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ODD
2

RATE 
CHANGE 
LETTER 
FILE 

OLSRAT
_BJ_100
_01

RATE 
CHANGE 
LETTER 
FILE CRE-
ATION

Y
e
s

TPE EXPIRED 
DRAW 
PERIOD 
PROCESS-
ING (STAGE 
FUNDED 
LOANS)

TXN-
DRW_B-
J_111_0
1

EXPIRED 
DRAW 
PERIOD 
PROCESS-
ING (STAGE 
FUNDED 
LOANS)

Y
e
s

ODD
2

DEALER 
SUBVEN-
TION 
STATE-
MENTS 

OPSSB-
V_B-
J_100_0
1

DEALER 
SUBVEN-
TION 
STATE-
MENTS 
GENERA-
TION

c
o
m
m
o
n

TAM SUBVEN-
TION 
RECEIV-
ABLE PRO-
CESSING 
(PAY AS GO)

TPRSB-
V_B-
J_100_0
1

SUBVEN-
TION 
RECEIV-
ABLE PRO-
CESSING 
(PAY AS 
GO)

c
o
m
m
o
n

ODD
2

PRO-
DUCER 
CHECK 
PRINT 

OPCPR
C_B-
J_100_0
1

PRO-
DUCER 
CHECK 
PRINT 
GENERA-
TION

c
o
m
m
o
n

BSR BEHAV-
IORAL 
SCORING

BSR-
PRC_B-
J_100_0
1

BEHAV-
IORAL 
SCORING

y
e
s

AGE TRANSAC-
TION IN 
WAITING 
FOR 
APPROVAL 
AGING 

TXNAGE
_BJ_100
_01

TRANSAC-
TION IN 
WAITING 
FOR 
APPROVAL 
AGING 
PROCESS

y
e
s

E
n

g
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e
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ACR PREPARE 
BATCH 
DATA FOR 
INTEREST 
ACCRUAL 
AND DELIN-
QUENCY 

TXNA-
CR_B-
J_100_0
2

PREPARE 
BATCH 
DATA FOR 
INTEREST 
ACCRUAL 
AND DELIN-
QUENCY 
PROCESS-
ING

y
e
s

PDC POST 
DATED 
CHECKS

PDCPR
C_B-
J_100_0
1

POST 
DATED 
CHECKS

y
e
s

PDC PENDING 
PDC 

PDCPN
D_B-
J_100_0
1

PENDING 
PDC PRO-
CESSING

y
e
s

LTR2 PDC 
RENEWAL 
LETTER 

LCSPD-
C_B-
J_100_0
1

PDC 
RENEWAL 
LETTER 
GENERA-
TION

y
e
s

DOT APPLICA-
TION DOCU-
MENT LOAD

DOL-
PRC_B-
J_000_0
2

APPLICA-
TION DOC-
UMENT 
LOAD

Y
e
s

ODD
2

ONE TIME 
ACH POST 
DATED PAY-
MENT LET-
TER 

OLSPD-
P_B-
J_100_0
1

ONE TIME 
ACH POST 
DATED 
PAYMENT 
LETTER 
PROCESS-
ING

Y
e
s

WFP BILLING WTX-
BIL_B-
J_132_0
1

BILLING 
PROCESS-
ING

Y
e
s

WFP DELIN-
QUENCY 

WTX-
DLQ_B-
J_132_0
1

DELIN-
QUENCY 
PROCESS-
ING

Y
e
s

E
n

g
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e
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WFP LATE 
CHARGE 

WTX-
LTC_B-
J_132_0
1

LATE 
CHARGE 
ASSESS-
MENT

Y
e
s

WFP STATEMENT WTXPS-
G_B-
J_132_0
1

STATE-
MENT GEN-
ERATION

Y
e
s

WFP RATE 
CHANGE 

WTX-
RAT_B-
J_132_0
1

RATE 
CHANGE 
PROCESS-
ING

Y
e
s

WFP TERMINA-
TION 

WTX-
TIP_B-
J_132_0
1

TERMINA-
TION PRO-
CESSING

Y
e
s

TPE PERIODIC 
MAIN-
TAINENCE 
FEE 

TXNPM-
F_B-
J_100_0
1

PERIODIC 
MAIN-
TAINENCE 
FEE PRO-
CESSING

WFP UNIT 
UPLOAD

WUP-
PRC_B-
J_132_0
1

UNIT 
UPLOAD

c
o
m
m
o
n

ODD
2

BATCH JOB 
FOR 
MONTHLY 
HANDSOFF 
FILE FOR 
SIMAH

CBUUT-
L_B-
J_100_0
4

BATCH JOB 
FOR 
MONTHLY 
HAND-
SOFF FILE 
FOR SIMAH

PUR PURGE ALL 
PTT TABLES

PTTPRC
_BJ_100
_01

PURGE ALL 
PTT 
TABLES

c
o
m
o
n

TPE BATCH JOB 
FOR SET-
TING 
MATURED 
ACCOUNT 
CONDITION

TXN-
MAC_B-
J_100_0
1

BATCH JOB 
FOR SET-
TING 
MATURED 
ACCOUNT 
CONDITION

y
e
s

E
n

g
in

e
 T
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e

Description
Batch 
Job

Description
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TPE NON 
REFUND GL 

TXNRF-
D_B-
J_100_0
1

NON 
REFUND 
GL PRO-
CESSING

c
o
m
m
o
n

TPE PAYMENT 
ARRANGE-
MENT 

TXNPA-
P_B-
J_100_0
1

PAYMENT 
ARRANGE-
MENT PRO-
CESSING

y
e
s

TPE DELAY FEE TXND-
LY_B-
J_100_0
1

DELAY FEE 
PROCESS-
ING

y
e
s

TPE STATE-
MENT PAST 
MATURITY 

TXNST-
M_B-
J_100_0
1

STATE-
MENT PAST 
MATURITY 
PROCESS-
ING 

y
e
s

TPE BLACK 
BOOK 
INTERFACE

VEVBB-
K_B-
J_100_0
1

BLACK 
BOOK 
INTERFACE

c
o
m
m
o
n

LBT BULK NSF 
PAYMENT 
REVER-
SALS

TXNNS-
F_B-
J_100_0
1

BULK NSF 
PAYMENT 
REVER-
SALS

ACR STOP 
INTEREST 
ACCRUAL 

TXNA-
CR_B-
J_100_0
3

STOP 
INTEREST 
ACCRUAL 
PROCESS-
ING

y
e
s

QRT CUSTOMER 
SERVICE 
REAL TIME 
QUEUE 

QCSPR
C_B-
J_100_0
2

CUS-
TOMER 
SERVICE 
REAL TIME 
QUEUE 
PROCESS-
ING

y
e
s

E
n

g
in

e
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Description
Batch 
Job

Description
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ODD
2

OUT-
BOUND 
CUSTOMER 
EXTRACTS 
TO PAY-
MENT 
AGENCIES

OCP-
PRC_B-
J_100_0
1

OUT-
BOUND 
CUS-
TOMER 
EXTRACTS 
TO PAY-
MENT 
AGENCIES

y
e
s

IFP OFFLINE 
CALL 
ACTIVITY 
POSTING

ICAPRC
_BJ_100
_01

OFFLINE 
CALL 
ACTIVITY 
POSTING

y
e
s

ACR RE-START 
INTEREST 
ACCRUAL

TXNA-
CR_B-
J_100_0
4

RE-START 
INTEREST 
ACCRUAL

y
e
s

IFP UPLOAD 
TRANSAC-
TIONS

ITUPRC
_BJ_100
_01

UPLOAD 
TRANSAC-
TIONS

y
e
s

IFP POST 
UPLOADED 
TRANSAC-
TIONS

ITUPRC
_BJ_100
_02

POST 
UPLOADED 
TRANSAC-
TIONS

y
e
s

IFP INPUT FILE 
PROCESS-
ING - CUR-
RENCY 
EXCHANGE 
RATE FILE 
UPLOAD

ICE-
PRC_B-
J_100_0
1

CUR-
RENCY 
EXCHANGE 
RATE FILE 
UPLOAD

Y
e
s

Y
e
s

Y
e
s

C
o
m
m
o
n

This process 
extracts currency 
exchange rates 
from desired 
source at sched-
uled intervals.

IFP INPUT FILE 
PROCESS-
ING - INPUT 
DATA 
INSERTION

IDDPRC
_BJ_000
_01

INPUT 
DATA 
INSERTION

Y
e
s

This process 
updates customer 
account informa-
tion corresponding 
to the details 
received from 
external system. 
Ex: Bankruptcy 
details in External 
Interface screen or 
Cure Letter details 
in Account Infor-
mation screen.

E
n

g
in

e
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yp
e

Description
Batch 
Job

Description
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IFP INPUT FILE 
PROCESS-
ING

IPIPRC_
BJ_100_
01

PI INFRO-
MATION 
FILE 
UPLOAD 
PROCESS-
ING

Y Y Y C
o
m
m
o
n

This process 
uploads input file 
with PII data into 
the data masking 
screen.

PUR ARCHIVE 
PURGE JOB 
SET

PJR-
PAC_B-
J_100_0
1

PURGE 
ACCOUNTS 
DATA

Y Y Y C
o
m
m
o
n

This process 
purges accounts 
data in archival 
tables based on 
the days defined in 
system parameter 
PAC_PURGE_-
DAYS.

PUR ARCHIVE 
PURGE JOB 
SET

PJRPA-
P_B-
J_100_0
1

PURGE 
APPLICA-
TION DATA

Y Y Y C
o
m
m
o
n

This process 
purges application 
data in archival 
tables based on 
the days defined in 
system parameter 
PAC_PURGE_-
DAYS.

PUR ARCHIVE 
PURGE JOB 
SET

PJRP-
GL_B-
J_100_0
1

PURGE GL 
TXNS DATA

Y Y Y C
o
m
m
o
n

This process 
purges general 
ledger transaction 
data in archival 
tables based on 
the days defined in 
system parameter 
PAC_PURGE_-
DAYS.

PUR ARCHIVE 
PURGE JOB 
SET

PJRP-
PA_B-
J_100_0
1

PURGE 
POOLS 
DATA

Y Y Y C
o
m
m
o
n

This process 
purges pools and 
its transactions 
data in archival 
tables based on 
the days defined in 
system parameter 
PAC_PURGE_-
DAYS.
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n

g
in

e
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Batch 
Job

Description
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2.10 Producer Cycles

The Producer setup screen enables you to define the dealer or producer status cycle. This 
tells the system which status a producer can cycle through. (This information is recorded in 
the Status field on the Producers section of the Producer setup screen.

For example,

The Producer Setup screen also defines the user responsibilities capable of changing the 
producer status.

Note

The system enables only producers/dealers with a status of ACTIVE to fund contracts.

PUR ARCHIVE 
PURGE JOB 
SET

PJRP-
PX_B-
J_100_0
1

PURGE 
PRO-
DUCER 
TXNS DATA

Y Y Y C
o
m
m
o
n

This process 
purges producer 
transaction data in 
archival tables 
based on the days 
defined in system 
parameter 
PAC_PURGE_-
DAYS.

PUR ARCHIVE 
PURGE JOB 
SET

PJRPTX-
_BJ_100
_01

PURGE 
TXNS DATA

Y Y Y C
o
m
m
o
n

This process 
purges account 
transaction data in 
archival tables 
based on the days 
defined in system 
parameter 
PAC_PURGE_-
DAYS.

PUR ARCHIVE 
PURGE JOB 
SET

PJRPVA
_BJ_100
_01

PURGE 
VENDOR 
ASSIGN-
MENTS 
DATA

Y Y Y C
o
m
m
o
n

This process 
purges vendor 
assignment data in 
archival tables 
based on the days 
defined in system 
parameter 
PAC_PURGE_-
DAYS.
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To set up Producer Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, clickSetup > 
Setup > Administration > System > Producer Cycles.

2. The system displays the Producer Cycles screen. The producer cycle screen contains 
three section:

 Cycle Definition

 Current/Next Status

 Status Change Responsibilities

3. In the Cycle Definitions section, you can view the following information.

4. In the Cycle/Next Status section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Status Change Responsibilities section, perform any of the Basic Operations 
mentioned in Navigation chapter.

Field: View This:

Cycle Displays the cycle name.

Type Displays the cycle type.

Field: Do this:

Current Code Select the current code from which you need to perform transition, 
from the drop-down list.

Next Code Select the code to which you need to perform transition, from the 
drop-down list.
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A brief description of the fields is given below:

2.11 Vendors

During the life of an account, a financial institution might require the use of specialized 
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an 
attorney for bankruptcy court proceedings, or making field calls. With the system’s Vendors 
screen, you can define the following:

 Cycles

 Vendor Services

 Vendor Fees

2.11.1 Cycles Tab

The Cycle link allows you to define the various vendor cycles and the responsibilities that can 
gain access to the various transactions in each cycle. The different categories are:

 You can define vendor status cycle and restrict the status change based on 
responsibility.

 You can define vendor invoice status cycle and restrict the status change based on 
responsibility.

 You can define vendor assignment status cycle and restrict the status change based on 
responsibility. 

 You can define vendor invoice payment status cycle and restrict the status change 
based on responsibility. 

To set up the vendor cycles

1. Click Setup > Setup > Administration > System > Vendors > Cycles. The screen 
contains three sections:

 Status Cycle

 Current/Next Status

Field: Do this:

Responsibility Code Select the responsibility that will be capable of executing this 
transition, from the drop-down list.

Allowed Indicator Check this box to enable the responsibility to execute the 
transition.
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 Status Change Responsibilities

2. In the Status Cycle section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields are given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Current/Next Status section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Note

When there is a change in status from ‘Current’ to ‘Next’, system posts respective call ac-
tivity on the account based on selected Action and Result code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: View this:

Cycle Specify the status cycle for the vendor.

Type Displays the type of vendor assignment status cycle.

Order Type Select the work order type for the vendor from the drop-down 
list.

Field: Do this:

Current Code Select the current code from which you need to transition, 
from the drop-down list

Next Code Select the Next status code to which you need to transition, 
from the drop-down list

Action Code Select the call activity action code from the drop down list.

Result Code Depending on the call activity action code, you can select the 
result code from the drop down list.
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6. In the Status Change Responsibilities section, perform any of the Basic Operations 
mentioned in Navigation chapter:

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11.2 Vendor Services Tab

The Vendor Service screen enables you to establish the links between the service type, 
vendor group, and the work order type. It records which vendor groups can provide which type 
of services and which service type belongs to which work order types.

For each service type (Service Type field), there can be multiple vendor groups and/or 
multiple work order type(s).Each vendor (Group field) can belong to one or multiple vendor 
group(s).

1. Click Setup > Setup > Administration > System > Vendors > Vendor Services. The 
screen contains three sections:

 Services

 Vendor Groups

 Work Order Types

Field: Do this:

Allowed Select ‘Yes’ to enable the responsibility to execute the transition and 
‘No’ to disable

Responsibility Select the responsibility that will be capable of executing this transition 
(from current code to the next code), from the drop-down list.
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2. In the Services section, you can view the following information:

3. In the Vendor Groups section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Work Order Types section, perform any of the Basic Operations mentioned in 
Navigation chapter:

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11.3 Vendor Fees Tab

The Vendor Fees tab allows you to define fee structure (with specific amount) for each service 
offered by specific vendor. The defined fees is auto populated as the estimated cost of the 
assignment when a specific vendor and service is selected during work order creation.

Field: View this:

Service Type Displays the service type.

Enabled Displays if the service is enabled or not.

Field: Do this:

Group Select the vendor group from the drop-down list.

Field: Do this:

Work Order Type Select the work order type from the drop-down list.

Transaction Select the associated transaction for the service type from the 
drop-down list.
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To define vendor fees

1. Click Setup > Setup > Administration > System > Vendors > Vendor Fees. The 
screen consists of Vendor Service Fee Definition section with option to define vendor 
fees.

2. In the Vendor Service Fee Definition section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Start Dt System defaults the current date as the start date. You can modify the 
same to a future date using the adjoining calendar.

End Dt Specify the end date from the adjoining Calendar.

Enabled Select the check box to enable the fee structure.

Amt Specify the amount charged by the vendor for a specific service.

Selection Criteria

Vendor 
Group

Select the vendor group from the drop-down list. You can also select 
‘ALL’ (default option) if the fee structure is applicable across vendor 
groups.

Vendor Select the vendor from the drop-down list. You can also select ‘ALL’ if 
you have selected the ‘Vendor Group’ as ‘ALL’. The list is sorted 
depending on the vendor group selected.

Services Select the service from the drop-down list. The list is sorted depending 
on the services offered by the selected Vendor.

Company System defaults this value based on the vendor selected. You can 
also select the required company from the drop-down list.

Branch System defaults this value based on the vendor selected. You can 
also select the required branch from the drop-down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11.4 Invoice Rules tab

The Invoice Rules tab allows you to define state specific rules with a combination of service 
and work order status. This helps to decide if a particular service fees in a work order is 
‘Collectable or Not’ from the customer.

When the same combination of service, work order status and state is detected during auto 
invoice validation, the ‘Collectible’ check box in Vendors > Invoice tab > Invoice Details 
section is selected. Further, the collectible amount is posted as an expense on the customer 
account.

To define invoice rules

1. Click Setup > Setup > Administration > System > Vendors > Invoice Rules.

2. In the Invoice Rules section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.12 Reports

The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays 
the Report screen. The details are grouped into two:

 Reports

Vendor 
Channel

System defaults this value based on the vendor selected. You can 
also select the required vendor channel from the drop-down list.

State System defaults the state in which the vendor operates. You can also 
select the state from the drop-down list.

Field: Do this:

Service Select the service from the drop-down list. The list consists of services 
offered by Vendors which can be associated with a work order.

Work Order 
Status

Select the work order status from the drop-down list.

Close Rea-
son

Select the close reason from the drop-down list. This field is enabled 
only if the work order status is selected as ‘CLOSE’.

State Select the state from the drop-down list. The selection here indicates 
that the state rules allow to collect the service fee for selected service 
from the customer.

Enabled Select the check box to enable the invoice rule.

Field: Do this:
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 Report Parameters

2. In the Reports section, perform any of the Basic Operations mentioned in Navigation 
chapter. 

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Report Parameters section,perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Code Specify the code of the report.

Description Specify the description of the report.

Package Specify the package .

Module Select the code of the report from the drop-down list.

System 
Defined Yes/
No

Select ‘Yes’, if you wish to maintain the Report as system defined 
and ‘No’, if you do not want to maintain it as system defined. 
System defined entries cannot be modified. If the entry is not 
system defined, then it can be modified.

Enabled Check this box to enable the report definition.

Field Do this:

Parameter Specify the parameter code of the report.

Description Specify the description of the parameter.
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13 Error Messages

In the Error Messages Setup screen, you can translate or modify the text of error messages. 
the system displays all messages as they appear to the system users in the Error Message 
section’s Message field. 

New messages created with the Error Messages screen can then be translated with the 
Setup > Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen

1. Click Setup > Setup > Administration > System > Error Messages. The system 
displays the Error Message screen.

2. On the Error Messages Setup screen’s Error Type section, use the Error Type field to 
select the error type. These are the categories of error messages available for creating or 
editing.

3. The error messages associated with the error type you selected appear in the Error 
Message section.

Parameter Type Select the parameter type of the report from the drop-down list.

Parameter Sub Type Select the parameter sub type of the report from the drop-down 
list.

Default Specify the default value for the report parameter (value to 
initially populate, or used if no value is supplied) (optional).

Sort Specify the sort order for the lookup code. This determines the 
order these report parameters are displayed or processed.

Enabled Check this box to enable the report definition.

Field Do this:
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4. In the Error Messages section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14 Translation

You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays 
the Translation screen. On this screen you can,

 Setup Translation

 Translate Error Messages

Field Do this:

Region Specify the region code.

Country Specify the country code.

Customer Specify the customer code.

Engine Specify the engine code.

Error Code Specify the error code.

System Defined Displays whether the record is system defined or not. 

Enabled Check this box to enable the data error message.

Error Message Specify the error message.
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2.14.1 Setup Translation

In the Setup Translation tab, you can translate the contents of a predefined list of setup 
description fields into a different language. 

After you translate an entry in the Translation Data section, the system adds the new data to 
the setup form. 

To set up the Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. In the Language section, you can select the language for which you need to setup the 
translation. 

Note

For more information, refer Language setup at the end of this chapter.

3. In the Source Type section, you can select the source (or location in the system) of the 
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data 
descriptions in the Translation section screen for the selected source type.
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If you have new entries and are unsure as to which setup items have been updated 
since the last translation, click Populate All, the system loads the additional data for all 
items with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

 All – to view all the records (both translated and un-translated) in the Translation Data 
section.

 Translated – to view all the translated records in the Translation Data section.

 Un Translated – to view all the un-translated records in the Translation Data section.

6. In the Translation Data section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14.2 Message Translation Setup

In the Message Translation tab, you can translate the contents of a predefined list of error 
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to 
the error message. 

Field Do this:

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.

System Defined Select ‘Yes’, if you wish to maintain the data as system defined 
and ‘No’, if you do not want to maintain it as system defined. 

Enabled Check this box to indicate that the record is active.

Desc 1 Translation 1 Specify the first translated description.

Desc 2 Translation 2 Specify the second translated description.

Desc 3 Translation 3 Specify the third translated description.

Desc 4 Translation 4 Specify the fourth translated description.
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To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message 
Translation.

2. In the Language section, you can select the language for which the translation needs to 
be done.

Note

For more information, refer Language setup at the end of this chapter.

3. In the Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages 
in the Error Message section for the selected error type.

If you have new entries and are unsure as to which error messages have been updated 
since the last translation, click Populate All, the system loads the additional data for all 
items with no impact to the previously translated data for any of the entries.

5. In the Error Message section, select:

 All – to view all the records (both translated and un-translated) in the Error Message 
section.

 Translated – to view all the translated records in the Error Message section.

 Untranslated – to view all the un-translated records in the Error Message section.

6. In the Error Message section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Note

You cannot add a new record.
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A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the 
TRD_LANGUAGE_CD lookup type and perform translations for those languages. 

However, translated data only appears in one language, which is defined by the User 
Language parameter. This parameter can be defined in the system configuration file, typically 
named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=ORA_USER=<schema_name> USR_LANG=<native language>

Note

<native language> should match lookup codes in the TRD_LANGUAGE_CD lookup type 
on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

1. Asset Sub Types

2. Asset Types

3. Assignments

4. Audit Table Columns

5. Audit Tables

6. Call Action Result Types

7. Call Action Types

8. Checklist Action Types

9. Checklist Types

10. Commission Plans

11. Companies

Field Do this:

Region Displays the region code.

Country Displays the country code.

Customer Displays the customer code.

Engine Displays the engine name.

Error Code Displays the error code.

System Defined Check this box to indicate that the record is system defined. 

Enabled Check this box to indicate that the record is active.

Message Specify the error message.

English Translation Specify the English translated description.
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12. Company Branch Departments

13. Company Branches

14. Compensation Plans

15. Credit Bureau Score Reasons

16. Credit Models

17. Credit Scoring Parameters

18. Edits

19. Escrow Disburse Rules

20. Escrow Sub Types

21. Flex Table Attributes

22. Flex Tables

23. GL Transaction Types

24. GL Translators

25. Job Sets

26. Jobs

27. Lookup Codes

28. Lookup Types

29. Portfolio Companies

30. Portfolio Company Branches

31. Producers

32. Product Instruments

33. Product Insurances

34. Product Pricings

35. Products

36. Promotions

37. Spreads

38. Standard Correspondences

39. Standard Document Definitions

40. Standard Element Definitions

41. Standard Function Definitions

42. Transaction Codes

43. Error Messages

44. Org. Fees

2.15 Seed Data

Seed data in general is referred to as any data delivered with the standard product installation 
and is required to be present in the production environment for application to work properly. 
Seed data basically consists of Table with its associated data that are uploaded into the 
system through DAT files.
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Seed Data screen in Oracle Financial Services Lending and Leasing displays the seed data 
details maintained in the system along with the updated seed data provided with the latest 
release or patch installation.

Note that, when you upgrade OFSLL from an existing version to higher version,

 New seed data provided as part of that release is automatically updated into the system.

 Seed data which are modified from previous release to current release needs to be 
manually accepted and updated into the system.

The modified seed data can have updates on base tables and/or its associated data and the 
changes can either be updated or skipped depending on the need.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the 
Seed Data screen.

2. On this screen you can do the following:

 View the factory shipped seed data and update/skip the seed data differences between 
existing and updated seed data in ‘Factory Data’ tab.

 View the customized (i.e. changed or configured) seed data as part of implementation 
in ‘Current Data’ tab.

 View the differences between Factory data and Current data in ‘Comparison Data’ tab.

 Download all or only the required table specific seed data in “Download Data’ tab.

2.15.1 Factory Data

The Factory Data tab displays the list of both existing and updated seed data which are 
provided though release/patch installation. In the Factory Data tab you can select and update 
only the required seed data changes into the respective seed data tables. During update, you 
can also skip the seed data changes for later updates (if required).

Accordingly, you can sort the view in Factory Data tab by selecting ‘Skipped’, ‘Update’ or ‘All’ 
options to display the list of corresponding seed data.

In the ‘Patch #’ drop-down list, you can further sort the list to display ‘ALL’ the seed data or 
only the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.
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The ‘Factory Data’ section displays the list of seed data with the following details:

The ‘Factory Data Details’ section displays the associated data of the selected seed data 
table along with the following details:

In the ‘Factory Data’ tab, you can click  (refresh) to fetch the latest details and click ‘View’ 
to display the detailed information of the selected record.

2.15.1.1 Update/Skip Seed Data

The ‘Update’ option in the Factory Data tab allows you to replace the existing seed data with 
the current update. However, ensure to double check the details before performing ‘Update’ 
operation since the same can have significant impact on system behaviour.

To Update/Skip Data

Field View this:

Table Displays the seed data table name.

Type Displays the category of seed data as either System or 
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.

Count Displays the total count of updated records in the seed data 
table.

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed data changes 
are identified.

Status Displays the current status of seed data as one of the 
following:

INSERT: This status indicates new seed data.

UPDATE: This status indicates if there are changes in the 
record when compared to the seed data released in previous 
patch.

POSTED: This status indicates that the seed data changes 
are updated into the main tables and is subsequently updated 
from previous status - SKIPPED OR UPDATE OR INSERT.

SKIPPED: This status indicates that the seed data is not 
updated into the main tables.

DEPRECATED - This status indicates that the seed data is no 
longer used.
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1. In the Factory Data’ tab, select ‘Update’. System displays those records which can be 
updated to the existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in 
subsequent section.

3. Select the required record to be updated by clicking on the adjacent check box. You can 
also click ‘Select All’ to select all the records.

4. Do one of the following:

– Click ‘Update Data’. This action updates the existing seed data with the updated 
seed data provided as part of the current patch release.

– Click ‘Skip Data’. This action skips the seed data changes received as a part of the 
patch release. The skipped records can be viewed by selecting ‘Skipped’ option in 
Factory Data tab. However, the same can further be updated into the system, by 
selecting ‘Update Data’.

5. Click ‘Yes’ in confirmation dialog to confirm the setup data changes.

On successful update, system does the following:

 When individual records are selected and updated, the same is removed from Factory 
Data Details section and the ‘Count’ column in Factory Data section is updated with the 
remaining number of records.

 In case of Bulk update, the record is removed from Factory Data tab.

2.15.2 Current Data

The Current data tab displays the customized seed data which are changed or configured as 
part of implementation. In the ‘Current Data’ tab, you can click  (refresh) to fetch the latest 
details and click ‘View’ to display the detailed information of the selected record.

Additionally you can click “Refresh Data’ to pull the seed data details from the production 
system and update the current seed data tables.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.
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The ‘Current Data’ section displays the following details:

The subsequent ‘Current Data Details’ section displays the associated data of the selected 
seed data table along with the following details:

2.15.3 Comparison Data

The ‘Comparison Data’ tab displays the differences between factory shipped seed data and 
current customized seed data.

To View Comparison Data

Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.

Field View this:

Table Displays the current seed data table name.

Type Displays the category of seed data as either System or 
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.

Count Displays the total count of records in the seed data table.

Last Refreshed Dt Displays the date and time when seed data for the selected 
table was last updated in the system.

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.
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The ‘Comparison Data’ section displays the list of seed data records with the following details:

The subsequent ‘Comparison Data Details’ section displays the associated data of the 
selected seed data table along with the following details:

In the ‘Comparison Data’ tab, you can click  (refresh) to fetch the latest details and click 
‘View’ to display the detailed information of the selected record.

2.15.4 Download Data

The Download Data tab allows you to download table specific seed data available in the 
system in ‘.dat’ format. While migrating from one environment to other, you can use the 
Download Data tab to download the existing seed data and perform a bulk upload of all/
required files.

Similar to other file download process, based on the value defined for the system parameter 
‘CMN_FILE_PROCESS_TO_LOB’, the seed data download file can be accessed from the 
Process Files interface (if value is ‘Y’) or Database Files system (if value is ‘N’). For more 
information on handling Incoming/Outgoing process files, refer to ‘Dashboard’ section in User 
Guides.

Field View this:

Table Displays the seed data table name to be inserted or updated.

Type Displays the category of seed data as either System or 
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.

Count Displays the total count of records in the seed data table.

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch release version with which the seed data 
was inserted/updated.
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To Download Data

1. Click Setup > Setup > Administration > System > Seed Data > Download Data tab.

The Download Data section displays the list of tables maintained in the system with ‘Table 
Name’ and ‘Table Type’. Click  (refresh) to fetch the latest details.

2. Select the check box adjacent to the required table in the list. You can choose ‘Select All’ 
check box to select all the tables with seed data maintained in the system.

3. Click ‘Submit For Download’ button. System displays an information message in the 
header indicating that the request has been submitted along with a reference number. 
The reference number is generated in format - useridDDMMHHMISS# followed by table 
name with ‘.dat’ extension. For example, (USER1230603121517#lookups.dat)

4. (Optional) If ‘CMN_FILE_PROCESS_TO_LOB’ is set to ‘Y’, navigate to DashBoard > 
Process Files screen > Outgoing Process File tab to download the selected seed data file 
which will be listed with the same reference number. The file can be downloaded to 
Application server.

2.16 Data Masking

Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask 
Personally Identifiable Information (PII) displayed in the application to safeguard the sensitive 
and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely 
to contain either organization / customer PI information are provided for data masking in 
disabled status. Based on need, the required fields can be enabled and masked for specific 
user responsibility in the Data Masking screen. Also if there are additional PII fields identified 
for masking, the same can be pooled into the system using input file processing method and 
masked using Data Masking screen.

The data masking process involves the following steps:

 Identify and enable field(s) (seed data) to be masked

 Select user responsibility for whom the data has to be masked

 Execute batch job to create data redaction policy

 Compile the data redaction policy

 (Optional) Process user identified PII data for masking
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The following table indicates the standard pre-defined fields (seed data) identified in 
respective screens/tabs which can be readily masked using the Data Masking screen.

Tab Name Field Names

Origination

Applicant First Name, MI, Last Name, Family Name, Birth Dt, Nationality, 
National ID, Visa #, Passport #, License #, Marital status, Mother's 
maiden name, Passport number, Gender, Language, Dependents, 
Ethnicity, Disability, Email, Race, and Education.

Applicant > FATCA Birth Place, Birth Country, and Permanent US Resident Status.

Applicant > Power 
of Attorney

Holder Name, Address, Country, Nationality, and Telephone 
Number.

Applicant Active Military Duty, Military Effective Date, Duty Order Number, 
and Active Military duty Release date. 

Addresses Country, Postal Address Type, Address #, Street Pre, Street 
Name, Street Type, Street Post, Apt #, Address 1, Address 2, 
Address 3, Zip, Zip Extn, City, State, and Phone.

Telecoms Phone and Extn

Employments Employer, Country, Address #, Address 1, Address 2, Zip, Zip 
Extn, City, State, Phone, Extn, Income Amt - Stated, Income Amt - 
Actual, Salary - Stated, Salary - Actual, and Title.

Applicant > 
Financials

Type, Source, Account #, and Currency.

Existing Accounts Account # and Title.

Servicing

Customer Name, Birth Dt, Nationality, National ID, Visa #, Passport #, 
License #, Marital status, Mother's maiden name, Passport #, 
Language, Disability, Email, and Education.

Customer > FATCA Birth Place, Birth Country, and Permanent US Resident Status.

Customer > Power 
of Attorney

Holder Name, Address, Country, Nationality, and Telephone 
Number.

Customer Active Military Duty, Military Effective Date, Duty Order Number, 
and Active Military duty Release date.

Addresses Country, Postal Address Type, Address #, Street Pre, Street 
Name, Street Type, Street Post, Apt #, Address 1, Address 2, 
Address 3, Zip, Zip Extn, City, State, Phone, and Address.

Employments Employer, Country, Address #, Address 1, Address 2, Zip, Zip 
Extn, City, State, Phone, Extn, and Title.

Assets tab

Assets Identification #, Lien Status, Lien Event Date, Second Lien Holder, 
Comments, Lien Release Entity, and Entity Name.
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Masking Format

Oracle Financial Services Lending and Leasing supports only complete masking (not partial) 
of both factory shipped and user identified PII data. On masking, the masked data is 
presented in same structural format to facilitate internal validations. The below table indicates 
the default values used for masking fields based on data type:

Note

It is recommended to avoid modifying masked data for user(s) with masked responsibility. 
However, while editing masked data (if permitted) requires to input full data replacing the 
masked characters. For example, editing a masked SSN (xxx.xx.xxxx) requires to specify 
all nine digits of SSN and not just the last four digits.

2.16.1 Setup Data Masking

1. Click Setup > Administration > System > Data Masking.

2. Define the parameters available in ‘Data Masking Details’ and ‘User Access Details’ tabs.

2.16.1.1 Data Masking Details

On clicking Data Masking link, the Data Masking Details tab is displayed by default and allows 
you to enable the required fields for masking.

Data Type Masking Value

NUMBER 9

VARCHAR X

DATE 31/12/9999

Phone number For UI represented format - 000-000-0009 
(Masked with 0’s and last digit as 9) and for 
generic, masked as 9999999999

Email xxxxx.xxx@<domain>.com
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1. In the Data Masking Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields are given below:

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.16.1.2 User Access Details

The User Access Details tab facilitates to define the user responsibility to whom the PII data 
should be masked. By default, all the selected PII data in Data Masking Details tab appears 
as masked for one or more user(s) selected in this tab.

1. Click Setup > Administration > System > Data Masking > User Access Details.

2. In the User Access Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields are given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field Do this:

Table Name View the table name which contains the selected field details.

Field Name View the selected field name.

Enabled Check this box to enable masking of the selected field.

System Defined View the type of seed data maintained in the system. ‘Y’ 
indicates factory shipped seed data and ‘N’ indicates user 
defined seed data.

Field Do this:

Responsibility Select the user responsibility from the drop-down list.

Masked Check this box to enable masking for the selected user.

Note: Defining a user and not selecting the masked check box 
will only create the record and masking rules are not applied.
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2.16.2 Create data redaction policy

Once the data masking details are defined and stored in the database, you need to create a 
data redaction policy which facilitates for field level masking while displaying the details to the 
respective user. A data redaction policy file contains the policies on the columns enabled in 
the Data Masking Details screen.

To create data redaction policy

Click Setup > Administration > System > Batch Jobs and execute the following batch job 
(in single thread mode only):

This batch job can either be scheduled for regular run or executed on-demand and facilitates 
to generate data redaction policy picking only the enabled data masking field information from 
database. On every run, the batch job drops and re-creates new set of policies in the file 
based on the details updated in Data Masking Details screen.

The generated policy is either written into CLOB or sql file depending on the following option:

 if the value of system parameter ‘CMN_FILE_PROCESS_TO_LOB’ is set to ‘Y’, the 
policy file is generated in CLOB and can be accessed by navigating to DashBoard > 
Process Files screen. For more information on handling Incoming/Outgoing process 
files, refer to ‘Dashboard’ section in User Guides.

 If the value of system parameter ‘CMN_FILE_PROCESS_TO_LOB’ is ‘N’, the policy is 
generated as an sql file and stored in the repository path as defined in the system 
parameter - CMN_SERVER_HOME. For example, /scratch/OFSLL/<release>/sql.

Further, the policy file needs to be manually compiled into database schema to apply the 
masking rules for respective fields for that particular user. Either a system administrator or any 
other user having administration privileges needs to compile the policies in the database.

Note

For every change in the data masking details such as masking additional fields or unmask-
ing / disabling masked fields, a new policy is to be created by executing the batch job.

2.16.3 Masking User defined data

Apart from factory shipped seed data, additional user identified PII data can be masked by 
uploading an input file with field details and processing it in Data Masking screen using input 
file processing method.

1. On identifying the fields, create an input file (in text file format) with table name, column 
name, and enabled indicator (Y/N) for each field level record. If enabled indicator is ‘N’, 
the record is not processed for data masking.

For example, BUSINESS_APPL_DETAILS,BSD_LEGAL_NAME,N

2. Place the input file to the path as defined in system parameter IPI_DIRECTORY. For 
example, $OFSLL_HOME/input/ipi

Set Code Description Job Code

SET-RED POLICY CREATION FOR PERSONAL 
IDENTIFIABLE INFORMATION DATA

REDPRC_BJ_100_01
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3. Navigate to Setup > Administration > System > Batch Jobs screen and execute the 
following batch job:

On execution, the batch job picks the file from the location, processes it and loads the seed 
data into Data Masking screen. By default, all the user identified PII data from input file is 
categorized separately in Data Masking screen by assigning the value of ‘System Defined’ 
property as ‘N’.

Once the data is available in Data Masking screen, enable the required fields, assign user 
responsibility and run the processing batch job - redprc_bj_100_01 to generate a redaction 
policy. For more details, refer Create data redaction policy section.

Note

In addition, an xml sample file with PII fields data is provided in the installation bundle 
(docs folder). The same is generated through Application Data Model (ADM) and can be 
imported to view the details of PII masked fields. However to do so, you need to have Or-
acle Cloud 13c installed.

Set Code Description Job Code

SET-IFP PI INFROMATION FILE UPLOAD PROCESSING IPIPRC_BJ_100_01
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3. Administration User

In the Administration > User, you can record setup data that define your organization 
structure and its users. Information in this link is more “data” related, whereas the information 
stored on the System drop-down link functions more like switches that control system 
behavior.

Navigating to Administration System

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User.

The User drop-down link records the following data:

 Organization

 Companies

 Access

 Users

 Credit Bureau

 Correspondence

 Queues

 Printers

 Bank Details

 Check Details

 Standard Payees

 Currencies

 ZipCodes

3.1 Organization

The Organization screen records the operational hierarchy of your business in terms of 
people. It groups the human resources of your business in three categories: organization, 
division, and department. The system uses this data to control access of users to applications 
(The Companies screen allows you to setup the location of these applications.)

Note

You can have only one active organization, so use the Organization field to define your 
organization at its highest level.

Divisions are groups within your organization that will have access to the same applications. 
Larger organizations often define their divisions by region. Smaller organizations may define 
division as branch offices or even departments, and might only have one division defined.
3-1



Departments are smaller units within a division. They expand on who is in the corresponding 
Division field. The system uses this sub screen, for example, when setting up the Services 
screen on the Utility form. At least one department must be defined for each division.

As an example of an organization setup, Oracle Corp. might be defined as:

Organization: O-0001Oracle Corp.ORA

Division: OD-001Central RegionC01

Department: ODD-01OriginationORG

Department: ODD-02FundingFUN

Department: ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department: ODD-11ServicingSER

Department: ODD-12CollectionCOL

Note

The Short Name field on the Organization screen allows you to create the ID that Oracle 
Financial Services Lending and Leasing will use when referring to the organization, divi-
sion, and department throughout the system. 

To setup the Organization screen

1. Click Setup > Setup > Administration > User > Organization.
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2. In the Organization Definition section, there can be only one active entry, so use this 
screen to define your organization at its highest level. Perform any of the Basic 
Operations mentioned in Navigation chapter. 

A brief description of the fields is given below:

Field: Do this:

Organization Specify the organization ID (the ID is the unique identifier used 
internally by Oracle Financial Services Lending and Leasing to 
represent your organization). 

Note: Do not edit this field.

Organization Name Specify the organization name.

Short Name Specify the short name for the organization.

Note: This ID represents this organization throughout the sys-
tem.

Enabled Check this box to enable the organization. 

Note: Only one enabled organization is currently allowed by 
Oracle Financial Services Lending and Leasing. 

Country Select the country where the organization is located from the 
drop-down list.

City Specify the city where the organization is located. 

State Select the state where the organization is located from the 
drop-down list.

Address Line 1 Specify the address line 1 for the organization.

Address Line 2 Specify the address line 2 for the organization.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Division Definition section, you can setup the information for the groups within 
your organization that will have access to the same applicationsPerform any of the Basic 
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Zip Select the zip code of the location where the organization is 
located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the organization.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the organization .

Extn 2 Specify the phone extension for the alternate phone number, if 
specified.

Fax 1 Specify the primary fax number for the organization.

Fax 2 Specify the alternate fax number for the organization.

Field: Do this:

Division Specify the division ID. The ID is the unique identifier used inter-
nally by the system to represent the division within the organiza-
tion. 

Note: Once specified, do not edit this field.

Division Name Specify the division name.

Short Name Specify the short name for the division.

Note: This ID represents this division throughout the system 
(required).

Enabled Check this box to enable the division.

Country Select the country where the division is located from the drop-
down list.

City Specify the city where the division is located.

State Select the state where the division is located from the drop-down 
list.

Address Line 1 Specify the address line 1 for the division.

Address Line 2 
(unlabeled)

Specify the address line 2 for the division.

Zip Select the zip code of the location where the division is located 
from the drop-down list.

Field: Do this:
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Administration > User > Organization > Department 
Definition.

7. On the Department Definition section, perform any of the Basic Operations mentioned 
in Navigation chapter.

A brief description of the fields is given below:

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the division.

Extn 1 Specify the extension for the primary phone number.

Phone 2 Specify the alternate phone number for the division.

Extn 2 Specify the extension for the alternate phone number .

Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

Field: Do this:

Department Specify the department ID. 

Note: The ID is the unique identifier used internally by the sys-
tem to represent the department within the division. 

Department Name Specify the department name.

Short Name Specify the short name for the department.

Note: This is the ID that appears throughout the system to repre-
sent this department.

Enabled Check this box to enable the department. 

Country Select the country where the department is located from the 
drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located from the drop-
down list.

Address Line 1 Specify the address line 1 for the department.

Address Line 2 Specify the address line 2 for the department.

Zip Select the zip code where the department is located from the 
drop-down list.

Extn Specify the zip extension where the department is located.

Phone 1 Specify the primary phone number for the department.

Extn 1 Specify the phone extension for the primary phone number.

Field: Do this:
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8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click Setup > Setup > Administration > User > Organization > Display Format.

10. On the Display Format section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

11. Perform any of the Basic Actions mentioned in Navigation chapter.

3.2 Companies

The Companies screen records the hierarchical structure of your portfolio companies and 
their branches. Just as Oracle Financial Services Lending and Leasing uses the Organization 
screen to determine the location of people, it uses the information on the Companies screen 
to determine the location of applications. In completing the Companies screen, there can be 
more than one company, and each company can have more than one branch.

Accounting is performed at the company level. Applications can be sorted down to the branch 
level. For this reason, branches are set up to reflect different business practices. You would 
set up different branches if, for example:

 The General Ledger (GL) differs between branches

 The branches work with different accounts

 There is a difference between branches in terms of the tasks they perform (line of credit 
origination, servicing, collections, and so on)  

As an example of the companies setup, Oracle Corp. might have the following companies and 
branches defined as:

Phone 2 Specify the alternate phone number for the department.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the department.

Fax 2 Specify the alternate fax number for the department.

Field: Do this:

Format Type Select the type of format from the drop-down list.

Format Sub Type Select the sub type of the format from the drop-down list. The format 
sub type will be displayed based on the format type selected. 

Format Specify or select the format based on the format type and format sub 
type selected. For Date and Time Zone format, select the required 
option from the drop-down list.

Format Mask Specify the format mask.

Format Filler Specify the format filler. 

Special Data Specify the special data, if any.

Enabled Check this box to enable the display format.

Field: Do this:
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Company: C-0001TrustOne Financial CorpTOFC

Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC

Branch: CB-11CCC - HeadquartersHQ

Branch: CB-12CCC - MissoulaMT

Note

– The system does not limit the number of companies or associated branches with 
the company you can enter.

– The Short Name field on the Companies screen allows you to create the ID that the 
system will use while referring to the company and branch. 

KEY CONCEPT: Note the difference between the Company screen and the Organization 
screen:

 On the Organization screen, Oracle Financial Services Lending and Leasing users 
belong to an organization and division.

 On the Companies screen, credit applications belong to a company and branch.

As you can see in the following Access screen section, the information on the Organization 
and Companies screens define the operational hierarchy of your companies in terms of which 
Oracle Financial Services Lending and Leasing users will have access to which applications 

To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen 
defines entities within your organization that originate and/or service Line of Credit.
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2. In the Company Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Company Specify the portfolio company ID. (This ID is the unique identifier 
used internally by the system to represent the company).

Name Specify the name of the portfolio company (required).

Short Name Specify the short name for the portfolio company (ID displayed to 
represent the company).

Currency Select the currency of the portfolio company from the drop-down 
list. The system displays the default value as ‘US DOLLAR’.

Enabled Check this box to enable the portfolio company.

Country Select the country where the portfolio company is located from the 
drop-down list. The system displays the default value as ‘UNITED 
STATES’.

City Specify the city where the portfolio company is located .

State Select the state where the portfolio company is located from the 
drop-down list.

Address Line 1 Specify the address line 1 for the portfolio company.

Address Line 2 Specify the address line 2 for the portfolio company.

Zip Select the zip code of the location where the portfolio company is 
located from the drop-down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Branch Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Extn Specify the extension of the zip code where the portfolio company is 
located.

Phone 1 Specify the primary phone number for the portfolio company.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio company.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio company.

Fax 2 Specify the alternate fax number for the portfolio company.

Tax ID # Specify the tax identification number for the portfolio company.

TCC Specify the transmitter control code for the portfolio company (1098 
Electronic Filing).

Contact Specify the contact information about the portfolio company.

Coupon Order 
Code

If you are using coupons, Specify the coupon order code to be used 
by a third party printing the coupons for billing statements.

HMDA Select the HMDA agency (Home Mortgage Disclosure Act reporting 
agency for the company).

Remittance Address section

Country Select the remittance address country from the drop-down list. The 
system displays the default value as ‘UNITED STATES’.

City Specify the remittance address city.

State Select the remittance address state from the drop-down list.

Remittance 
Address 1

Specify the remittance address line 1, if it is different from the com-
pany address. This address is included as the remittance address 
on statements.

Remittance 
Address 2 

Specify the remittance address line 2.

Zip Select the zip code of the remittance address line 1 from the drop-
down list.

Extn Specify the extension of the remittance address zip code.

Field: Do this:
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A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3 Access

Using the organizations, divisions, companies, and branches created on the Organization and 
Companies screens, you can control the access privileges of applications. On the Access 
screen, you define which organization/division (users) can gain access to which company/
branch (applications andaccounts) locations. 

Field: Do this:

Branch Specify the portfolio branch ID. (This ID is the unique identifier used 
internally by the system to represent the branch within your company).

Name Specify the name of the portfolio branch (required).

Short Name Specify the short name for the portfolio branch (ID displayed to repre-
sent the branch) (required).

Enabled Check this box to enable the portfolio branch.

Sub Unit Select the Sub Unit from the drop-down list.

Sub Unit refers the entity which is the source of funds for the credit 
application/Account.

System associates the selected sub unit with the particular company/
branch combination and displays by default when the same is selected 
during an application/Account creation.

Country Select the country from the drop-down list. The system displays the 
default value as ‘UNITED STATES’.

City Specify the city where the portfolio branch is located.

State Select the state from the drop-down list.

Address Line 1 Specify the address line 1 for the portfolio branch.

Address Line 2 Specify the address line 2 for the portfolio branch.

Zip Select the zip code of the location where the portfolio branch is located.

Zip Extn Specify the extension of the zip code, where the portfolio branch is 
located.

Phone 1 Specify the primary phone number for the portfolio branch.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio branch.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio branch.

Fax 2 Specify the alternate fax number for the portfolio branch.
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Normally, for each division within an organization, you would define a record with Company 
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other 
records for the same Organization and Division for other Company and Branch combinations 
with the Allowed box cleared to restrict access.

To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the 
Access screen. In this screen, you can control the access privileges of the user for the 
following categories:

 Data

 Screen

 Reports

 Correspondence

3.3.1 Data

The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.
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2. In the Access Grid section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2 Screen 

In the screen, you can control the access to the following:

1. Menu – Control access at the application menu level. For example, for Setup menu you 
can provide access only to an Administrator.

2. Screens – Control access to the screens available in the application

3. Buttons – Control access based on the stage. 

Field: Do this:

Organization Select the organization for which you are defining access privileges 
from the drop-down list.

Division Select the division within the organization for which you are defining 
Access privileges from the drop-down list.

Company Select the portfolio company to which you are defining access privi-
leges for the organization and division specified from the drop-down 
list.

Branch Select the portfolio branch of the company to which you are defining 
access privileges for the organization and division specified from the 
drop-down list.

Allowed Check this box to provide access to the data pertaining to the com-
pany and branch, for the organization and division specified.
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For example, Add and Edit buttons can be disabled once an application is funded.

If you want to restrict updating the Applicant details, then edit button has to be disabled 
for the stage.

The screen allows you to restrict access to different screens.

To set the Screen Security

1. Click Setup > Setup > Administration > User > Access > Screen.

2. In the Security Super Group section, you can view the details of the super group you 
want to work with.

3. In the Security Access Definition section, perform any of the Basic Operations 
mentioned in Navigation chapter.

Note

You can not add a new record

A brief description of the fields is given below:

Field: Do this:

Access Code The system displays the selected access code.

Description Modify the description of the access code.

Type The system displays the type of security access definition.

System Defined If ‘Yes’ is selected, the security access definition entry is system 
defined.

If ‘No’ is selected, the security access definition entry is manually 
defined. 
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4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Security User Access Details section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.3 Reports

In the Reports screen you can control access to generate certain reports. 

To set up Reports

1. Click Setup > Setup > Administration > User > Access > Reports.

Enabled Check this box to enable the security access definition entry is 
enabled.

Field: Do this:

Access Type Select the access type of the user who will have access to this 
screen from the drop-down list.

Active Value Select the active value of the user who will have access to this 
screen from the drop-down list.

Allowed Select ‘Yes’ to allow access to this screen or ‘No’ to deny access to 
this screen.

System 
Defined 

Select ‘Yes’, if the screen user access definition entry is system 
defined.

Select ‘No’, if the screen user access definition entry is manually 
defined. 

Field: Do this:
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2. In the Reports section, you can view the following information: 

A brief description of the fields is given below:

3. In the Reports User Access Definition section, you can set the access rights for the 
report selected in the Reports section. Perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field View this:

Code Displays the code of the report.

Module Displays the code of the report from the drop-down list.

Description Displays the description of the report.

Enabled Displays whether the report definition is enabled or not.

Field: Do this:

Access Type Select the access grid function type from the drop-down list.

Access Value Select the access function grid value from the drop-down list.

Allowed Select ‘Yes’ to allow access or ‘No’ to restrict access to the entry 
based on the access type and value.

System Defined 
Yes/No

Select ‘Yes’, if the report user access definition entry is system 
defined.

Select ‘No’, If the report user access definition entry is manually 
defined. 
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4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.4 Correspondence

The Correspondence screen allows you to restrict access to different correspondence 
commands on the Letters menu, thus restricting your ability to generate certain 
correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding 
command on the Letters menu is unavailable (dimmed). 

To setup the Correspondence

1. Click Setup > Setup > Administration > User > Access > Correspondence.

2. In the Correspondence Codes section, perform any of the Basic Operations mentioned 
in Navigation chapter. 

A brief description of the fields is given below:

3. In the Correspondence User Access Definition section, perform any of the Basic 
Operations mentioned in Navigation chapter.

Field: Do this:

Code The system displays the correspondence code name you want to work 
with.

Description The system displays the description for the correspondence code (dis-
play only).

Enabled Check this box to enable the selected correspondence code entry.
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A brief description of the fields is given below: 

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.5 Webservice

The Webservice screen in Access setup allows you to configure access to the available 
RESTful webservices in the system. The associated seed data for all the RESTful 
webservices are loaded during product installation and process of installing the same is 
detailed in the Installation guide.

As an administrator/superuser, you can Enable/Disable Web Service access to users based 
on their responsibility and ensure that only authorized user have access to those specific 
webservices in the system. Following list indicates some of the available RESTful 
webservices in the system:

 Generic Post Transaction Service

 Call Activity Service

 Scheduler Service

 Account Search Service

 Account Boarding Service

 Payment Posting Service

 Account Detail Service

 Calculator Service

 Application Search Service

 Get Scenario Analysis Service

 Post Scenario Analysis Service

 Lookup Service

 Dialer Integration Service

 Application GET Service

 Application Entry service

 Application Update Service

 Application Status Change

 Application Checklist

 Application ACH GET Service

 Application ACH POST Service

 Application Comment GET Service

Field: Do this:

Access Type Select the access grid function type from the drop-down list.

Access Value Select the access function grid value from the drop-down list.

Allowed Select ‘Yes’ to allow access or ‘No’ to restrict access to the entry 
based on the access type and value.

System Defined 
Yes/No

Select ‘Yes’, if the correspondence user access definition entry is 
system defined.

Select ‘No’, If the correspondence user access definition entry is 
manually defined. 
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 Application Comment POST Service

 Application Document GET Service

 Application Document POST Service

 Account Comment GET Service

 Account Comment POST Service

 Account Document GET Service

 Account Document POST Service

 Process File Upload Service

 Process File Download Service

 Process File List Service

 Product Service

 Asset Service

 Asset Sub-Type Service

 Scheduler Force ReSubmit

 Remarketing GET Service

 Remarketing POST Service

 Invoice GET Service

 Invoice POST Service

To setup the Webservice access

1. Click Setup > Setup > Administration > User > Access > Webservice. The screen 
consists of the following tabs:

 Security Super Group

 Security Access Definition

 Security User Access Details

2. The ‘Security Super Group’ section, contains the following super group categories for 
selection:

 COMMOM

 INTERFACES

 ORIGINATION

 SERVICING and COLLECTIONS

 SETUP
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 WHOLESALE FLOOR PLANNING

3. Select the required Super Group and the associated data in sub tabs are categorized 
accordingly.

4. In the ‘Security Access Definition’ section, you can view the following field details and edit 
only the ‘Description’ and ‘Enabled’ status of selected Security Access Definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Security User Access Details section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: Do this:

Access Code The system displays the webservice access code.

Description The system displays the description of the associated webser-
vice access code and can be edited for required changes.

Type The system displays the type of security access definition.

System Defined If selected as ‘Yes’, the security access definition entry is system 
defined. If selected as ‘No’, the security access definition entry is 
manually defined.

Enabled Check this box to enable the selected webservice access code.

Field: Do this:

Access Type Select ‘Responsibility’ (default) as the access type from the drop-
down list. For this access type to be available in the drop-down list, 
ensure that the Lookup Type ‘ACCESS_GRID_TYPE_CD’ is main-
tained in the system.

Access Value This field is ‘Read-only’ for ‘System Defined’ Security Access Defini-
tions which are loaded as part of seed data during installation.

For non-system defined Security Access Definitions, select the 
access value which is the user responsibility who needs to have 
access to this webservice from the drop-down list.

For user responsibilities to be populated in the drop-down list, ensure 
that the Lookup Type ‘RESPONSIBILITY_CD’ is maintained in the 
system.

Allowed Select ‘Yes’ to allow user access to this webservice or ‘No’ to deny 
access. By default, No’ is selected.

System 
Defined 

Select ‘Yes’, if the webservice user access definition entry is system 
defined.

Select ‘No’, if the webservice user access definition entry is manually 
defined.
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3.4 Users

The Users screen allows you to create and set up an user. In the User Definition section, you 
can assign a user an identification name and password to log on to the system. You can also 
assign the organization, division, and department where each user is located. Additional fields 
allow you to record information for contacting the user. You can also define the time frame 
within which a user has access to the system to ensure compliance to the company’s 
schedule. This is a very useful feature to prevent logins during scheduled maintenance. 

The Responsibility field records the job function of the user and defines the level of access 
that user has within the system; in particular:

 What menu items does the user have access to?

 What edits can the user perform on the Verification link during origination?

Note

The system’s SUPERUSER responsibility grants access to the entire system. Give careful 
consideration to the number and type of users who receive this responsibility.

To set up the Users screen

1. Click Setup > Setup > Administration > User > Users. The system displays the Users 
screen.

2. In the User Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below: 

Field: Do this:

User Specify the user ID. 

Note: This field is a unique indicator and cannot be updated, 
edited, or deleted once saved.
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Organization Select the organization to which the user belongs, from the drop-
down list.

Division Select the division to which the user belongs, from the drop-down 
list.

Department Select the department to which the user belongs, from the drop-
down list.

Start Dt Specify the start date for the user. You can also select from the 
adjoining calender icon.

End Dt Specify the end date for the user. You can also select from the 
adjoining calender icon.

System Defined Select ‘Yes’, if the entry is system defined. System defined entries 
cannot be modified. 

Select ‘No’, if the entry is not system defined and it can be modified.

Enabled Check this box to enable the user.

First Name Specify the first name of the user.

MI Specify the middle initial of the user.

Last Name Specify the last name of the user.

Responsibility Select the responsibility for the user from the drop-down list. 

Note: The users mapped to the role ‘Responsibility’ can only view 
the screens.

Review Request 
Supervisor

Select the supervisor responsibility who can also review and 
respond to review requests from the drop-down list.

The list displays the corresponding Review Request Supervisors 
who are either one or more levels higher from the above selected 
user ‘Responsibility’ as maintained in ‘RESPONSIBILITY_CD’ 
lookup code.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement 
User

Select the user ID of the replacement user from the drop-down list.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.4.1 Replacement users

By completing the Replacement User and Dt fields on the Users screen, you can replace an 
existing user with a new user. The system assigns all responsibilities of the original user to 
the new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current 
user in the User ID field. When you complete the Replacement User and Dt fields, save your 
entry, and then enable the record, the system replaces the original user. The system changes 
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have 
the same user responsibilities (or Super User responsibility) as set in the system. 

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to 
the replacement user’s queue.  

2. Assigns all applications in the replaced user’s funding queue with a status other than 
FUNDED to the replacement user’s queue. The system currently stores the collector 
name in the back end tables, which are updated with the replacement users ID in the case 
of the replacement of any user. 

3. Also updates the Producer Management screen with the replacement user in the 
Underwriter and Collector fields. The system assigns all applications routed to the 
original user to the replacement user. This also includes any future applications for the 
replaced user.

Dt Specify the date from when the replacement is effective. You can 
also select from the adjoining calender icon.

Note: These two fields allow you to create a replacement user for 
the current user. This is particularly useful when a new employee 
assumes the duties of a former. By completing the Replacement 
User and Replacement Dt field, the system recognizes the replace-
ment user as the current user on the effective date. For more infor-
mation, refer the section, ‘Replacement Users’.

Type Select the user type from the drop-down list.

Reference # Specify the reference number for the user from the drop-down list.

Email Specify user’s email address.

Default language Select the default language from the drop-down list.

Time Zone Select the required Time Zone from the drop-down list, The speci-
fied time zone would be applicable at company level.

Time Zone Level Select the time zone level (Organization, Company or User) that 
would apply by default, when specific time zone is not specified at 
Company and User level.

Field: Do this:
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4. The system automatically updates the Collector ID field in all accounts to the 
replacement user and routes all accounts assigned to the original user to the replacement 
user. 

Note

The system will not update the replacement user ID for accounts that are closed. 

5. On the queue setup of Customer Service screen’s Responsibilities sub screen, the record 
for the original user will be disabled and a new record will be created for the replacement 
user. If the replacement user already exists in the setup, The system will not create a new 
record. It updates the user ID and routes all accounts that were assigned to the original 
user, based on the account condition, to the replacement user.

3.4.2 Application and Oracle Identity Manager Synchronization

Oracle Identity Manager is for user administration. Oracle Financial Services Lending and 
Leasing has been developed in such a way that it can be implemented with or without Oracle 
Identity Manager. In case OID has been employed, the user definition is done in OID and then 
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility 
JAR called OID Synchronization JAR. In OID, users are defined across various groups 
belonging to a realm which is nothing but the directory structure in OID. A user can be 
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle 
Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the 
password with OID and provides access to those applications.

3.5 Credit Bureau

In the system, an important part of the origination process is pulling a credit report from a 
credit bureau and scoring that information against a user-defined risk model. These credit 
reports can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria. 
If the application passes a pre-screen edits check, the system advances the status of the 
application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on the 
application, such as co-signers and spouses by selecting the bureau from which you want to 
pull the report. If more than one report type is defined for the selected bureau, then you can 
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

 The credit bureau from which the report is pulled is determined by the applicant’s zip 
code. The credit bureau interface searches the information in the Credit Bureau Zip 
Matrix tab and matches the applicant’s zip code to determine the bureau(s) from which 
to request a report.

 The number of credit reports automatically pulled per applicant is controlled through the 
credit request parameter CRB_MAX_BUREAU_PULL. If this parameter is set to 1, a 
credit bureau request will be made for the Bureau1 credit bureau from the zip code 
matrix. Likewise, if this parameter is set to 2, a credit bureau request will be made for 
the Bureau1 and the Bureau2 credit bureaus from the zip code matrix.

 The system automatically pulls credit reports for only the primary applicant and the 
primary applicant's spouse (for joint applications) unless the 
CRB_ALL_APL_BUREAU_PULL credit request parameter is set to Y. However, if the 
parameter is set to Y, the system pulls credit reports for all of the applicants on the Line 
of credit, regardless of their relationship to the primary borrower.
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 Passwords, default report formats, and other required information from the credit 
bureaus are set up in the Report Formats screen.

 For identity scan data to flow into Equifax ACRO/ACRO Plus credit reports, the add-on 
has to be enabled at contract level. Please speak to your representative for enabling the 
add-on.

Member codes and passwords when switching credit bureau access methods (moving from 
dial-up to Net Connect). The member codes and passwords are not dependent on the 
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket 
connection. The connection is outbound only and it is to a specific port (699 or 700) on the 
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to 
the ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a 
response to the ECALS URL inquiry (the credit request URL). This access is from the 
database server access.

3.5.1 Credit Bureau

The setup for Credit Bureau spans across the following links:

 Report Formats

 Connections

 Zip Matrix

 Parameters

 Score Reasons

 Reporting

Navigating to Credit Bureau

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Credit Bureau.

3.5.1.1 Report Formats

The Reports Formats screen captures and tracks the attributes related to the multiple types 
of reports offered by the credit bureau agencies. When a company enlists the service of a 
credit bureau, the credit bureau provides a membership code and password. This information 
needs to be entered on the Reports Formats screen before you can request a credit report. 
You must define at least one report for each credit bureau from which you want to pull reports.

The information on the Report Formats screen is location-specific. If the business requires 
different membership codes for each location, be it a company or branch, then individual 
records must be set up.

The Score Type, Additional Product, and Inquiry Limit fields on the Credit Report Setup 
section are optional. They may not apply to all credit bureau types and even if they do apply, 
you may want to leave them blank and rely on a default value set up at the credit bureau. 

Note

For more information, refer to the the application Installation Guides.
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To setup Report Formats

1. Click Setup > Setup > Administration > User > Credit Bureau > Report Formats

2. In the Credit Bureau section, perform any of the Basic Operations mentioned in 
Navigation chapter.:

A brief description of the fields is given below:

Field: Do this:

Bureau Name Specify the name of the credit bureau company.

Short Name Specify the abbreviated or short name for the bureau.

Source Select the credit bureau source from the drop-down list.

Country Select the country of the credit bureau address from the drop-down 
list.

City Specify the city for the credit bureau address.

State Select the state of the credit bureau address from the drop-down list.

Address Line 1 Specify the address line 1 for the credit bureau.

Address Line 2 Specify the address line 2 for the credit bureau.

Zip Select the zip code for the credit bureau address from the drop-
down list.

Extn Specify the extension of the zip code for the credit bureau address.

Phone 1 Specify the primary phone number for the credit bureau.

Extn 1 Specify the extension for the primary phone number.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Credit Bureau Report Formats section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

Phone 2 Specify the secondary phone number for the credit bureau.

Extn 2 Specify the extension for the secondary phone number.

Fax 1 Specify the primary fax number for the credit bureau.

Fax 2 Specify the alternative fax number for the credit bureau.

Field  Do this:

Company Select the portfolio company that will be using the above credit 
bureau from the drop-down list.

Branch Select the portfolio branch from the company that will be using the 
above credit bureau from the drop-down list.

Description Specify the credit report format description.

Member Code Specify the credit bureau member code (assigned by bureau).

Password Specify the credit bureau password.

Customer Code Specify the customer code.

Auth Password 
Change Dt

Display the last authorization password change date. The Experian 
Net Connect product requires that the Auth Password (or SSP 
Password in Experian jargon) be changed every 90 days (or 
sooner). Equifax may have similar requirements, but they were not 
known at the time of this writing. Use the date displayed in this field 
to identify when the password needs to be changed.

Note: The password needs to be changed both in the system and at 
the credit bureau. Changing the password does not initiate or per-
form a change at the bureau. Changing the password at the bureau 
must be done outside the system. Contact the credit bureau for the 
procedure for changing the password (display only).

Auth User ID Displays the authorization user ID (display only).

Auth Password Displays the authorization password (display only).

Note: This field is not displayed to the user and is also encrypted 
before being stored in the database (display only). 

Change Authorization User Id/Password section

New Auth User Id Specify the authorization user ID.

New Auth User 
Password

Specify the authorization user password.

Field: Do this:
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5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Report Format Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.2 Connections

The Connections screen records and supports various connections to the credit bureau to 
receive reports from the agencies. The system supports connections to the bureaus through 
one or more modems attached to the database server, network accessed modem server, or 
direct network connection (usually frame relay). 

TransUnion Details section 

(Note: This is only applicable for TransUnion.)

Market Specify the TransUnion market id.

Sub Market Specify the TransUnion Sub Market id.

Industry Specify the TransUnion Industry code.

Experian Details section

(Note: This is only applicable for Experian.)

Preamble Specify the Experian preamble code.

Host Code Specify the Experian host ID.

UIC Specify the Experian UIC.

Equifax Details section

(Note: This is only applicable for Equifax.)

Service Name Specify the equifax service name. The service name will be pro-
vided to you by Equifax when your company's Internet System to 
System account is created. Possible values for pulling credit reports 
are acrotest (for access to the test system) and acro (for access to 
the production system).

Field Do this:

Report Specify the report name to be accessed from the credit bureau.

Report Type Select the report type of the credit bureau report from the drop-down list.

Score Type Select the credit score type from the drop-down list.

Addl Product Select the product code from the drop-down list.

Inquiry Limit Select the inquiry limit for the credit report from the drop-down list.

Enabled Check this box to enable the report as default.

Field  Do this:
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For modem-based connections, multiple credit bureaus can be accessed over the same 
modem. If there are multiple requests in the queue, the order in which the bureaus are listed 
determines the order in which the requests are processed. 

For example,

If the credit bureau service checks the submitted credit requests and finds three Experian, one 
Equifax, and two TransUnion credit requests and the connections setup is Bureau1=TUC, 
Bureau2=EFX, and Bureau3=EXP, the two TransUnion requests will be processed first, the 
Equifax request next, and then the three Experian requests. 

Note

For this above example, adding two more modems and assigning a specific bureau to 
each one would help to avoid the delay caused by queuing all requests through a single 
modem.

IMPORTANT: Direct network connections must be set up for only one bureau.

Like the Credit Bureau section on the Report Formats screen, the data fields used on the 
Connections screen are generic and not all fields are used for all access methods. The 
following table summarizes the data needed for each access method:

For frame relay access, specify the IP address provided by the bureau followed by a space 
and then the port number (for example, 192.168.36.2.700).

Experian Net Connect

At the time of this writing, the Experian product ECALS URL is:

http://www.experian.com/lookupServlet1?lookupService

Name=AccessPoint&lookupServiceVersion=1.0&serviceName=Net
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Connect&serviceVersion=2.0&responseType=text/plain

Note

The URL given above is one continuous string. This can be verified by entering the URL 
with a browser. The displayed value will be an HTTPS URL.

Enter the entire ECALS URL provided by Experian into the Device field. Notice that this URL 
does not start with https. The ECALS URL is a URL used by the credit bureau service to 
request the HTTPS URL. The HTTPS URL is not displayed on any setup screen and is only 
known to the credit bureau interface at runtime.

Equifax Internet System to System

At the time of this writing, the Equifax Internet System to System URL is:

https://transport5.ec.equifax.com/servlet/stspost

CSC Tri-Merge

At the time of this writing, the CSC URL is:

https://www.emortgage.Equifax.com/cgi-bin/emspop.exe

To setup the Connections

1. Click Setup > Setup > Administration > User > Credit Bureau > Connections.

2. In the Credit Bureau Connections section, perform any of the Basic Operations 
mentioned in Navigation chapter.
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.3 Zip Matrix

The system uses the zip code of the applicant’s current home address to determine which 
credit bureau to use when automatically pulling a report. The Zip Matrix screen allows you to 
record the credit bureau from which a report is pulled based on a range of zip codes, as well 
as the company, branch and country of the account.

When searching for a zip code match, the system:

1. Reads the first credit bureau defined in the matrix

2. Reads the credit report format to get the appropriate membership code and password for 
the user’s location

3. Requests a credit report.

If the system cannot pull a report from the first bureau, it pulls one from the second. If the zip 
code you entered does not fall in the matrix setup, then the system uses a default zip matrix 
(0000000000 to 0000000000) to select the required bureau.

To set up the Zip Matrix

1. Click Setup > Setup > Administration > User > Credit Bureau > Zip Matrix

Field: Do this:

Name Specify connection name.

Bureau 1 Select first credit bureau from the drop-down list.

Bureau 2 Select 2nd credit bureau from the drop-down list.

Bureau 3 Select 3rd credit bureau from the drop-down list.

Note: The Bureau1, Bureau2, and Bureau3 fields in the Credit Bureau 
Connections section specify which bureau types can be accessed over 
the connection. 

Device Specify the connection device name. The Device field lists the physical 
device name for a modem, or the IP address for a network accessed 
connection.

Device Speed Select the connection device speed. The Device Speed field is only 
applicable to server-attached modems. It is used to specify the com-
munications speed between the server and the modem.

Enabled Check this box to enable the connection.
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2. In the Credit Bureau Zip Code Matrix section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: Do this:

Company Select the portfolio company from the drop-down list.

Branch Select the portfolio branch from the drop-down list. The branch will be 
displayed based on the company selected.

Country Select the country from the drop-down list.

From Zip Specify the starting zip code (From).

To Zip Specify the ending zip code (To).

Bureau 1 Select the preferred bureau #1 (first bureau pulled), from the drop-down 
list. You must enter at least one credit bureau in the Bureau 1 field for 
each zip code range. The bureau entered in the Bureau 1 field for each 
range is the primary bureau. For any given range, do not list the same 
credit bureau in more than one field.

Bureau 2 Select the preferred bureau #2 (second bureau pulled) from the drop-
down list.

Bureau 3 Select the preferred bureau 3 (third bureau pulled) from the drop-down 
list.
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3.5.1.4 Parameters

The Parameters screen records parameters specifically dealing with credit bureau 
information. These parameters are divided into three groups:

 Parsing parameters

 Request parameters

 Configuration parameters

Parameters can be defined at the company or branch level. The following credit bureau 
parameters are configured during the installation:

PARSING PARAMETERS FOR CREDIT BUREAU SERVICE

CONFIGURATION PARAMETERS FOR CREDIT BUREAU SERVICE

The following credit bureau parameters are configured during implementation:

REQUEST PARAMETERS FOR CREDIT BUREAU SERVICE

To setup the Parameters

1. Click Setup > Setup > Administration > User > Credit Bureau > Parameters.

2. In the Credit Bureau Parameters section, perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Company Select the portfolio company from the drop-down list.

Branch Select the portfolio branch from the drop-down list. The branch will 
be displayed based on the company selected.
3-32



3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.5 Score Reasons

The Score Reasons screen allows you to define or modify the scoring reason codes and 
descriptions for the predefined scoring models used by the credit bureau agencies. 

Note

This information is not associated with the user-defined scores determined by the internal 
Oracle Financial Services Lending and Leasing model during product setup.

To setup the Score Reasons

1. Click Setup > Setup > Administration > User > Credit Bureau > Score Reasons.

2. In the Score Models section, you can view the following information.

A brief description of the fields is given below:

Parameter Group Select the credit bureau parameter group from the drop-down list.

Parameter Select the credit bureau parameter from the drop-down list

Parameter Value Specify the credit bureau parameter value.

Enabled Check this box to enable the credit bureau parameter.

Field: Do this:

Score Model Displays the credit bureau score model (display only).

Field: Do this:
3-33



3. On the Score Reasons sub screen, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.6 Reporting

The system reports to the credit bureau agencies in the Metro 2 format with the payment and 
account status information of each account holder. The Credit Bureau Reporting screen 
contains the program identifier to be reported to the bureaus. 

To setup the Reporting

1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.

2. In the Credit Bureau Reporting section, perform any of the Basic Operations mentioned 
in Navigation chapter.

A brief description of the fields is given below:

Enabled Displays if the credit bureau score model is enabled or not.

Field Do this:

Reason Code Specify the reason code. 

Description Specify the description.

Field Do this:

Company Select the portfolio company from the drop-down list.

Field: Do this:
3-34



3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.2 Special Metro II Code reporting

The system allows you to report the following special Metro II segments to the credit bureau 
output file: 

 Consumer Information Indicator Code (CIIC)

 Compliance Condition Code (CCCD)

 Special Comment Code (SPCC). 

The system users will need to use call Action/Results and Reason fields on the Call Activities 
sub screen of the Customer Service form (Lending > Customer Service > Customer Service 
(2) master tab > Account Details tab > Call Activities sub tab) to place specific account 
conditions where these Metro II segments are to be reported. The specific segment reported 
for a given condition will be based on the account condition and call activity reason codes. 

Note

It is the responsibility of the Administrator or individual user to setup Special Metro II Code 
reporting functionality.

When users open one of the following conditions:

The system recognizes the condition, processes the selected Metro II reporting call activity 
reason code, and generates the Metro II reporting segment in the Metro II reporting output file. 

Note

– You are responsible for selecting the correct Metro II reporting segment reason 
code to be reported. If you do not select a Metro II reporting segment reason code, 
the system will not generate information to Metro II output file. If you select an 
incorrect Metro II reporting segment reason code, the system will report the 
selected Metro II reporting segment. the system does not validate the contents of 
the Reason field with the contents of the Condition field.

– To end the reported Special Metro II Special Code, close the open Special Metro II 
Condition (no reason code needed). The system recognizes the closing of the open 

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer receives this from 
the bureau and uses it to identify itself to that bureau. You will 
need to update this information.

Enabled Check this box to enable the program.

Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)

Field Do this:
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Special Metro II Condition and will not create a Metro II reporting segment in the 
output file.

– The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system pa-
rameter determines if output file is generated and created daily or output file is writ-
ten with daily data and output monthly.

To setup Metro II Code reporting

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Queues > Call Action Results to open and close the 
following system defined condition codes:

When setup is completed, you can open and close Special Metro II code conditions. 

Note 

Opening and closing Special Metro II Code reporting is a manual process.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter 
determines, if output file is generated and created daily or output file is written with daily data 
and output monthly. 

3.5.3 Oracle Wallet Manager setup

The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the 
the system credit bureau service use functionality provided by the Oracle Wallet feature. Use 
the Oracle Wallet Manager on the database server to create and export a wallet for use by 
the credit bureau service.

Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already exists 
and is in use by one of the credit bureau interfaces, there is no need to create another wal-
let. Due to differing certificate requirements, there may be a need to import additional trust-
ed certificates into the wallet, but there will not be a need to create a new one. The credit 
bureau parameter ORA_WALLET_PATH contains the location of the Oracle Wallet used 
by the credit bureau service. 

To create and export a wallet suitable for use by the credit bureau 

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle 
Wallet Manager to create and manage a wallet:

1. If a wallet does not already exist, create one somewhere on the database server. The 
location must be readable and writable by the Oracle user. Make a note of the full path 
where the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or 
C:\oracle\WALLETS).

Action Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)
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 For Transunion credit bureau, a separate wallet file is needed under transunion folder 
inside the main wallet path (for example: /etc/ORACLE/WALLETS/oracle/transunion or 
C:\oracle\WALLETS\transunion).

2. The wallet needs to contain the public key for the certificate authority that issued the 
server certificate for each HTTPS web site that will be connected to by the credit bureau 
interface. At the time of this document, those sites are:

This list may change. Use the URL provided to you by the credit bureau when they set up your 
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by 
Experian into a web browser. The response returned to the browser is the HTTPS URL that 
will be used to communicate with Experian.

1. Import the necessary certificate authority’s certificate files into the Oracle wallet that was 
created in Step 1. See the appendix of this chapter for detailed instructions of how to 
download and install a trusted certificate.

2. Test the wallet by connecting to each web site with a simple command issued from 
SQLPlus.

SQL> select utl_http.request('https://ss1.experian.com', NULL, 
'file:/etc/ORACLE/WALLETS/oracle', 'password') from dual;

Replace the URL in the above command with each HTTPS URL given to you for use by 
the credit bureaus. Also replace the wallet path with the path to your wallet and your 
wallet password. The output from the command is not important, what is important is 
that it runs without displaying an Oracle error. If there is an Oracle error, then something 
is wrong with the contents of the wallet, the path to the wallet, and/or the wallet 
password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text 
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted 
Certificates. The text file MUST be located in the same directory as the wallet and the 
filename MUST be default.txt. Anytime a change is made to the trusted certificates in the 
wallet, the wallet must be re-exported to the same text file.

4. In the Setup > Setup > Credit Bureau > Parameters set the ORA_WALLET_PATH and 
ORA_WALLET_PASSWORD parameters. 

3.5.4 Oracle JVM Security setup

The Experian Net Connect interface within the credit bureau service requires the use of the 
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore, 
specific permissions must be granted to the Java classes used by the credit bureau service. 
These permissions have been added to the set_java_perms.sql script that is part of the 
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle 
Financial Services Software technical support Oracle Financial Services Lending and Leasing 
patches web site.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privileges). 
The script will prompt for SYS user id and password. Be prepared to provide it when 
prompted. Also, the script will select the value of the ORA_WALLET_PATH parameter from 
the credit bureau parameters table. Make sure that it has been updated with the proper wallet 
path before running the set_java_perms.sql script (although the script can be safely run again 
if necessary).

https://ss1.experian.com Experian

https://transport5.ec.equifax.com Equifax

https://www.emortgage.Equifax.com CSC
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Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no 
operational difference between accessing the credit bureaus via dial-up, frame relay, or the 
Internet.

3.5.5 Importing a trusted certificate into an Oracle Wallet

The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report 
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate 
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the 
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then 
the client inherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet 
Explorer has a large store of trusted CA certificates which makes secure communication 
between a client and a trusted HTTPS server relatively seamless and uneventful. 
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is 
likely that it will not contain the certificate of the CA that is certifying one or more of the credit 
bureau web sites. This means that the CA certificate must be imported into the wallet. To do 
this, the certificates must first be exported from a browser and then imported into the Oracle 
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLs referenced in the 
Oracle Wallet Manager Setup section of this document. 

If the web site asks for a user id and password, cancel the dialog box and remain on the 
top-level HTTPS screen.

2. Once connected, from the browser’s File menu, choose Properties.

3. Click the Certificates button.

4. Click the Certification Path tab. The bottom-most certificate is the one generated by the 
host itself. The one or more certificates above the bottom-most one are of greater 
importance to this task. The screen shot below displays a web site with two CAs (an 
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps 
are the same for saving the certificate as a text file.
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5. Click the first certificate above the bottom-most certificate (it may be the only certificate 
above the bottom-most certificate).

6. Click the View Certificate button.

7. Click the Details tab.

8. Click the Copy to File button.

9. Click the Next button.

10. Choose the Base 64 encoded format.

11. Click the Next button.

12. Enter a filename and location for the file.

13. Click the Next button.

14. Click the Finish button.

15. Repeat steps 5 through 14 for the next certificate in the certification path, if any.

3.5.6 Importing the Certificates into an Oracle Wallet

1. Copy the certificates exported and saved during the process described above onto the 
database server (not the iAS server).

2. As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

3. Open the wallet that will be used by the credit bureau service. Create a new wallet if one 
does not already exist.

4. View the list of Trusted Certificates in the wallet.

5. Check the list of certificates against the list of certificates that are in use on the HTTPS 
servers used by the credit bureaus (and that were exported and saved during the export 
process described above). 
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6. Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager. 

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites 
(File > Properties > Certificates > Certification Path > View Certificate > General) 
that will be contacted by the credit bureau service. Look through the list of certificates 
shown in the right panel of the Oracle Wallet Manager and look for a match between the 
Issued To and Valid To dates shown in the Internet Explorer View Certificate screen. 

The screen shot below shows a certificate that is already in the wallet’s list of trusted 
certificates (see the last entry for the www.verisign.com/CPS certificate).
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8. On the Operations menu, choose Import Trusted Certificate and follow the prompts for 
locating and loading the files that were copied onto the database server in step 1 for any 
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

3.5.7 De-duping Credit Bureau data

Oracle Financial Services Lending and Leasing allows you to remove duplicate (“de-dupe”) 
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among 
tradelines (only) to determine if they are duplicates. The following fields are used to 
determine if two tradelines are duplicates:

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION_DAYS days old will 
be used.

The following system parameters will be set up to provide switches to allow the functionality 
to be turned on and off:

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending 
and Leasing uses the following hierarchy to pick one of the items as the “correct” one:

1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the 
descending order of priority depending on who the tradeline belongs to: Primary, Spouse, 
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter 
DBR_JOINT_INC_DEBT_WITH_SPOUSE to decide whether to combine debt ratios of the 
spouse with the primary applicant. The DBR_JOINT_INC_DEBT_WITH_COAPP parameter 
decides whether to do the same on a non-spousal joint application. 

Field: Description:

Account # The account number of the consumer with the lender for the particular 
account.

Open Date The date the account was opened.

Member Code The subscriber code of the lender with the respective credit bureau. 

Note: Since member codes for the same lender differ across bureaus, 
this field is used only for tradelines reported by the same bureau. Since 
reports obtained from CSC can have tradelines from different bureaus, 
this field is only for reports pulled from the credit bureaus.
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When this indicator is checked, all liabilities in the Liability section on the Summary sub screen 
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio 
calculation.

The following system parameter will be set up to provide switches to allow the functionality to 
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the 
following manner:

Initial credit pulls on new applications

 If the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES 
system parameters are set to Y, uses the de-duping logic described above to uncheck 
the duplicate liabilities in the spouse's/co-applicant’s liabilities.

 If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ 
DBR_JOINT_INC_DEBT_WITH_ALLAPL parameters are set to Y, the system includes 
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary 
applicant.

 The system will use all available credit reports at the time.

Subsequent credit pulls (manual) 

 To remove duplicate liabilities from the calculation, choose the Dedup Liabilities button 
on the Underwriting form (Applicants master tab > Summary sub screen > Liability 
section). (Potential record locking situations force the action to remain manual versus 
the system automatically doing it).

 If the Populate Debt and Include Debt boxes are selected in the Applicant/Customer 
Detail section on the Bureau master tab on the Underwriting form for the credit 
request and the JOINT_DEDUP_SPOUSE_LIABILITIES/ 
JOINT_DEDUP_ALLAPL_LIABILITIES system parameters are set to Y, the system will 
use the de-duping logic described above to uncheck the duplicate liabilities in the 
spouse's/co-applicant's liabilities.

 If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ 
DBR_JOINT_INC_DEBT_WITH_COAPL parameters are set to Y, the system will include 
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary 
applicant.

 The system will use all available credit reports at the time of the request that have been 
requested within the number of days specified in the DEDUP_CRB_EXPIRATION_DAYS 
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot 
identify two tradelines as duplicates based upon the logic mentioned above, the individual 
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio 
calculation and it will be the user’s responsibility to disregard one of them by clearing the 
Include check box.

3.6 Correspondence

The Correspondence screen enables you to setup the system’s correspondence.
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The system provides two types of correspondence: predefined and ad hoc. The following 
chart provides a quick summary of both:

This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build 
custom documents that draw information from the system’s database without additional 
programming. You can choose what to include in a letter, create a template, and then use this 
template to produce a letter. 

The core of the Correspondence module is the document element -- the information stored in 
the database merged into the correspondence. The system has document elements defined 
for commonly used data elements in correspondence, such as account numbers, account 
balances, customer addresses, telephone numbers, and due dates. 

Correspondence consists of a document file with text of your choice and the document 
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a 
correspondence set consists of more than one document, such as the account details letter 
and a payment overdue letter, it prints both documents every time the system generates 
correspondence for a customer. 

The Correspondence module creates the following standard ad hoc correspondence:

 Microsoft Word (RTF)

 Adobe Acrobat (PDF/XFDF)

Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with 
Adobe Acrobat.

3.6.1 Correspondence

The Correspondence screen contains the following sub screens: 

 System Functions

 Elements

 E-Form Elements

 Documents

 Correspondence

Navigating to Correspondence

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Correspondence.
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3.6.1.1 System Functions

The System Functions screen enables you to view the predefined functions for the 
appropriate Line of credit product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is 
retrieved as elements which are either specific database columns or calculated values. 
Elements are recorded on the Elements screen.

To view the predefined system functions

1. Click Setup > Setup > Correspondence > Line of credit > System Functions.

2. In the Function Definition section, you can view the following information.   

A brief description of the fields is given below:

3. In the Functions Parameters section, you can view the following information.

A brief description of the fields is given below::

Field: View this:

Function Name Displays the function name.

Description Displays the function description.

Function Type Displays the function type.

Source Program Displays the source program.

Field: View this:

Position Displays the parameter position.
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3.6.1.2 Elements

The Elements screen displays the predefined document elements retrieved from the 
database when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.

To view the Elements

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit > 
Elements

2. On the Element Definitions screen, perform any of the Basic Operations mentioned in 
Navigation chapter. You cannot add a new record.   

A brief description of the fields is given below:

Parameter Displays the function parameter.

Description Displays the function parameter description.

Field: Do this:

Level0 Type Displays the element Level0 type.

Element Name Displays the element name.

Element Type Displays the element type.

Description Specify the element description.

Data Type Displays the element data type.

Field: View this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.3 E-Form Elements

The E-forms Elements screen defines elements included when the system generates online 
correspondence with a browser. The E-forms screen is set up only for PDF elements using 
the XFDF format. These definitions translate the external element required by the vendor to 
a systems correspondence element. 

For example,

To setup the E-forms Elements

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit > E-
Form Elements

Source Function Displays the element function.

Enabled Displays if the element is enabled or not.

Default Value Displays the default value.

Type Details

Vendor Element AllBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of 
primary customer)

The system’s Elements PRIM_APL_NAME

SPOUSE_APL_NAME 

PRIM_APA_ADDRESS1

PRIM_APA_ADDRESS2

PRIM_APA_ADDRESS3

Translation: PRIM_APL_NAME || ', ' || SPOUSE_APL_NAME || ', ' || 
PRIM_APA_ADDRESS1 || '; ' ||PRIM_APA_AD-
DRESS2 || '; ' || PRIM_APA_ADDRESS3

Field: Do this:
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2. In the E-form Elements Definitions section, perform any of the Basic Operations 
mentioned in Navigation chapter.    

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.4 Documents

The Documents screen enables you to set up the various documents and the data fields that 
the system compiles together when creating a correspondence. The system provides two 
different document formats: Word or XFDF: XML-based form. 

Field: Do this:

Level0 Type Select the element Level0 type from the drop-down list.

Source Code Select the element e-form source code from the drop-down list.

Element Name Specify the element name (the name used in the external form).

Description Specify the element description.

Data Type Code Select the element data type code from the drop-down list.

Translation Select the translation for the e-form element (SQL statement frag-
ment defining the element data), from the drop-down list.

Enabled Check this box to enable the e-form element.
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Note

Oracle Financial Services Software assumes that the user is familiar with Word and the 
Merge Document command. If the user is creating e-form documents with XFDF, then 
Oracle Financial Services Software assumes that person is familiar with Adobe forms.

To setup documents to be compiled in correspondence

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit > 
Documents.

2. In the Document Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.    

A brief description of the fields is given below:

Field: Do this:

Code Specify the document code to define the name for the new docu-
ment.

Description Specify the document description for the new document. This entry 
appears in the Correspondence section on the Request screen, 
when you generate an ad hoc correspondence.

File Name Specify the document file name for the resulting file (Word or XFDF 
document).

Level0 Type Select the level0 type from the drop-down list.

E-form Source Select the element e-form source from the drop-down list.

Product Select the document product from the drop-down list.

Source Select the document source type from the drop-down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Document Elements section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Document Template section, you can set the information about the template which 
is attached to the correspondence documents. The template thus saved is similar to the 
template functionality available in MS word. Perform any of the Basic Operations 
mentioned in Navigation chapter.

Enabled Check this box to enable the document definition.

Field: Do this:

Seq Specify the sequence number to order the document elements.

Type Select element type from the following from the drop-down list. This 
list provides the following options:

System-defined – If you select, the value is supplied by the system 
and cannot be changed in the Correspondence Request screen.

Constant.

User Defined Element – If you select, you can choose the value 
and change it in the Correspondence Request screen.

User Defined Constant – If you choose, you can choose the value, 
but you cannot change it in the Correspondence Request screen.

Translated Element – If a document contains an e-form element 
and you do not select this option, then the value will not be trans-
lated.

Element Name Select the element name from the drop-down list.

Description Specify element description. 

Notes: 

1. Check that the element name does not have blank spaces or 
special characters, such as the forward slash “/” or backward slash 
“\”. 

2. If the element is system-defined, then the system will automati-
cally complete this field.

Data Type Select the element data type from the drop-down list.

Format Mask Select the element format mask from the drop-down list.

Default Value Specify the element default value.

Enabled Check this box to include the element in the document.

Field: Do this:
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A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

The Document Elements sub screen records the system’s application or account information 
that appears in the ad hoc correspondence

To generate a data file for a document

1. In the Document Definition section of Setup > Setup > Administration > User > 
Correspondence > Line of credit > Documents, select the record for which you want 
to generate a data file.

2. Click Gen. Data File button.

The system displays a new screen with the following options:

Field: Do this:

File Name Specify the file name to define the name for the new template.

Product Select the product for which the template is valid, from the drop-
down list.

Customer State Select the customer state for which the product is valid, from the 
drop-down list.

Producer State Select the Producer state for which the product is valid, from the 
drop-down list.

App/Acc St Select the Applicant/Account state for which the product is valid, 
from the drop-down list.

New Template Check this box to load the template as a new template.

Loaded Check this box to indicate that the template is loaded.

Enabled Check this box to enable the template.
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 Open with – Select to view the data file in the format you want. The adjacent drop-down 
list provides a list of formats compatible with the system. The system downloads the file 
and displays it.

 Save File – Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected 
properties for the files which are similar to the current one.

3.6.1.5 Correspondence

The Correspondence screen enables you to define who will receive the documents you 
created on the Document Definition screen by creating correspondence sets. Each document 
must belong to a set, and a set can have more than one document. 

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit > 
Correspondence. The correspondence setup is classified into two:

 Documents

 Functions

2. In the Correspondence section, perform any of the Basic Operations mentioned in 
Navigation chapter.    

A brief description of the fields is given below:

Field: Do this:

Code Specify the correspondence code.

Description Specify the correspondence description (required).

Print Schedule Select the correspondence output schedule type from the drop-
down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Correspondence > Line of credit > 
Correspondence > Documents.

5. In the Documents section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click Setup > Setup > Correspondence > Line of credit > Correspondence > 
Functions.

8. In the Functions sub screen, you can define the functions that should be executed before 
or after correspondence is generated. Perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence

1. To create a correspondence add a record in the document definition block. For example: 
SAMPLE_LOAN_APP

2. In the Document Elements section, add the elements required in the correspondence.

Level Select the correspondence level type from the drop-down list.

Group Select correspondence group from the drop-down list.

Company Select the correspondence company from the drop-down list.

Branch Select the correspondence branch from the drop-down list.

Product Select the correspondence product from the drop-down list.

Enabled Check this box to enable the correspondence.

Field: Do this:

Document Select the correspondence document from the drop-down list.

Recipients Select the recipients for the document from the drop-down list.

Enabled Check this box to enable the recipient selected.

Field: Do this:

Function Select the correspondence functions from the drop-down list.

Execute 
When?

Select when to execute the correspondence function from the 
drop-down list.

Field: Do this:
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3. Click on Gen.Data File to generate PDF file of the report.

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have 
the same name as entered in the Code column of Document Definition section. For 
Example: SAMPLE_LOAN_APP.xml.

5. Open MS Word.

Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed and the 
user is familiar with the BIP Report Tool.

6. In BI Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For 
Example: SAMPLE_LOAN_APP.xml.
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7. Create the template by inserting required elements tag.

8. The template created in MS Word should be saved with .rtf extension. For Example: 
SAMPLE_LOAN_APP.rtf

Note

 The .xml and .rtf file should be saved with the same name as entered in the ‘Code’ col-
umn of Document Definition section.

9. Upload the rtf template in the BIP and create the data model with SQL query as “select 
CDO_XML_DOCUMENT from correspondence_docs where cdo_id = :docId”.

10. After the data model creation, launch the correspondence screen and click 
Correspondence tab. 

11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence

1. To generate a correspondence open the application for which the correspondence should 
be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.
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3. Select the created Correspondence. Click Save and Add to save and add a new record. 
Click to Save and Return save and return to main screen. Click Return to return to main 
screen without modifications.

4. Click Generate to generate the selected correspondence and View Correspondence to 
view the Correspondence in PDF format.
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3.7 Queues

When processing an application, various users might work on the application to complete 
different tasks. A data entry person might complete the Application Entry screen before an 
underwriter works on the application using the Applications screen. Later, another user might 
use the Applications screen to fund the application.

The application processing workflow facilitates the movement of the application from one 
person to another with queues. Queues create a work section of accounts waiting for a 
particular and common task to be performed, such as application entry or verification. The 
system’s powerful queuing module automates this otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on 
a daily basis to ensure that all applications are in the queues of the appropriate users at all 
times.

Any time an application’s status is changed, the system checks whether the application is in 
the right queue. 

The system will sort queues based on an application’s status and sub status.

3.7.1 Origination Tab

The Origination screen on the Queue Setup form allows you to set up queues that direct 
applications to users during the loan origination cycle. Origination queues are based on an 
application’s status and sub status. Whenever an application changes its status/sub status, 
the system moves the application to a queue based on the information on this screen.

You can define the loan origination queues and the corresponding selection criteria based on:

 Application status

 Application sub status

 Product type

 Funding type

 Product

 Underwriter

 State

 Channel

 Producer type

 Producer

With loan origination queues set up, the applications in your work queue automatically appear 
on the Results screen when you open the Underwriting or Funding screen. The queue to 
which you are assigned appears in the Queue Name field. You would then begin processing 
the applications in the order of which they are listed, double-clicking the application at the top 
of the list to load it.

On the Setup > Setup > Queues screen, you can determine the direction of the applications 
to users who process then. Whenever there is a change in the status or sub status of the 
application, the system places the application in a appropriate queue based on the 
information available in this screen.

Applications are further filtered based on the following criteria:

 Selection Criteria
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 Sort Order

 Responsibilities and Users

 Data Node Assignments

 Group Assignment

To setup Origination Queues

You can either define new Queue Definition details or specify a new name in the New Queue 
field and click Create Copy to create a copy of selected queue definition with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Queues > Origination.

2. In the Origination Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Queue Name Specify queue name.

Queue Description Specify queue description. 

Note: The system uses this entry when referring to the queue 
on other forms.

Override Responsibility Select an override responsibility code from the drop-down list. 

The system uses this data to determine the User who holds the 
override responsibility for the specified queue, if an application 
triggers an “override” edit.

Priority Specify the priority number. 

The system sorts applications by the higher number. For 
example, an application with a priority # 5 is considered to have 
a higher priority than the one with a priority # 3.

Company Select the company from the drop-down list.

Branch Select the branch drop-down list.

Enabled Check this box to enable the queue.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.1 Selection Criteria

Here, you can further filter the applications in a particular queue. This criteria is generally used 
by organizations to categories and allocate large number of applications to different queues.

Note

If you want to execute search on like operators, then use '%'.

To setup Selection Criteria

1. Click Setup > Setup > Queues > Origination > Selection Criteria > Application Status

2. In the Application Status section, use the Status and Sub Status fields to define the 
credit application status/sub status combinations that should be considered for the queue. 

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

All is the default value for each field.

5. Click Setup > Setup > Queues > Origination > Selection Criteria > Selection Criteria. 
In the Selection Criteria section, use the fields to define the credit application that should 
be considered for the queue. 

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Status Select application status from drop-down list.

Sub Status Select application sub status drop-down list.

Enabled Select the check box to enable the application status.

Field: Do this:

Product Type Select the product type as loan from the drop-down list.

Funding Type Select funding type from the drop-down list.

Product Select product from the drop-down list.

State Select state from the drop-down list.

Channel Select channel from the drop-down list

Underwriter Select underwriter from the drop-down list.

Producer Type Select producer type from the drop-down list.
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7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.2 Sort

In the Sort sub tab of Queue Definition, the new applications which are in origination queue 
are displayed here based on sort criteria defined. In case of any overrides, applications would 
be sorted automatically without the need of a setup definition. However, there is no impact if 
sort is not defined for a queue.

To setup Sort Criteria

1. Click Setup > Setup > Queues > Origination > Selection Criteria > Sort

2. In the Sort section, use the Seq, Sort field, and Order to rearrange the queue.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.3 Responsibilities and Users

1. Click Setup > Setup > Queues > Origination > Responsibilities and Users.

2. In the Responsibilities section, use the Responsibilities field to define the 
responsibilities roles which are authorized to work on the queues.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Producer Group Select producer Group from the drop-down list

Producer Select producer from the drop-down list.

Region Select region of the producer from the drop-down list.

Territory Select territory of the producer from the drop-down list.

Sales Agent Select sales agent for the producer from the drop-down list.

Funder Select funder for the producer from the drop-down list.

Field: Do this:

Seq Specify the sequence number representing the sorting priority.

Sort Field Select the sort criteria from the list of parameters available in the drop-
down list.

Order Select either 'ascending' or 'descending' as the sort order.

Field: Do this:

Responsibility Select the responsibility from the drop-down list.

Enabled Check this box to enable the responsibility.

Field: Do this:
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5. In the Users section, use the User field to define the users who are authorized to work 
on the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.4 Data Node Assignments

Data node Assignments provides user with the flexibility to view the tabs in origination. User 
will have option to enable disable Tabs. All the enabled tabs will be displayed when 
application is in that particular queue. Disabled tabs for the tabs will not be shown when 
applications is in respective queue.

For example: Application entry Queue

If summary tab to be disabled, the search for the ULN Summary tab and Disable. IN 
application Entry summary will not be shown

1. Click Setup > Setup > Queues > Origination > Node Assignments. You can enable 
the administrator to configure the User interface nodes that should be made available for 
the applications that are being processed in that particular origination queue. 

2. In the Node Assignments section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Load Queue Nodes to display the respective UI nodes in the origination module.

3.7.1.5 Group Assignment

The Group Assignment sub tab allows you to add user groups to Origination Queue.

Note

Modification of user details (adding or disabling users) within a user group which is added 
to Group Assignment will implicitly be updated in Responsibilities and Users tab also.

To add User Group to Group Assignment

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > 
Administration > User > Queues > Origination > Group Assignment.

Field: Do this:

User Select user from the drop-down list.

Enabled Check this box to enable.

Field: Do this:

Node Select the node from the drop-down list.

Enabled Check this box to enable the record.
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2. In the User Group section, Click Add. You can also perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.2 User Groups Tab

The User Groups tab in Queues is a centralized repository which allows you to define user 
groups, add and remove users from user groups.

The User Groups tab consists of User Group Definition section listing the defined User 
Groups and User section below listing the associated users of the selected User Group. 

To define a User Group

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > 
Administration > User > Queues > User Groups.

2. In the User Groups section, Click Add. You can also perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Group Name Select the user group name from the drop-down list. The list 
displays the pre-defined user groups available in the system.

Enabled Check this box to enable the user group.

Field: Do this:

Name Specify user group name.

Description Specify an appropriate user group description. The same is 
used while referring this User Group on other screens.

Responsibility Select the responsibility of the user group from the drop-down 
list. You can later add only those ‘Users’ who have the selected 
responsibility into the user group.

Enabled Check this box to enable the user group.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > 
Administration > User > Queues > User Groups.

2. In the User Groups section, select the required User Group.

3. In the Users section, Click Add. You can also perform any of the Basic Operations 
mentioned in Navigation chapter.

A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8 Printers

The Printers screen allows you to set up an unlimited number of network printers and fax 
devices to be used with the system server. The system uses the information on this screen 
while selecting a printer, when the printing process involves a batch job or uses a job 
scheduler. Examples include printing reports and correspondence. 

The printers and fax devices can be set up at each organization, division, or department to 
promote efficient printing of documents, and reports. The system uses this information during 
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Additionally, you may set up composite entries in the Printer Name field to perform two or 
more functions at the same time. This can be done by defining a printer name with the 
following format:

PRINTER NAME = <PRINTER_NAME1> + <PRINTER_NAME2>

Field: Do this:

Name Select the user from the drop-down list, The list displays the 
available users based on the responsibility defined for the user 
group.

Enabled Check this box to enable the user.

Name Description

UNDEFINED Indicates that the document to be printed is to be previewed in your 
browser instead of actually printing the document.

ARCHIVE Instead of sending an item to the printer, the system generates a 
PDF document and saves it in the archive directory on your server.

EMAIL For Loan origination correspondences that can be faxed, the system 
e-mails the document as a PDF attachment to the consumer for 
direct Loans or to the producer in the case of in-direct Loans.

FAX For Loans origination correspondences that can be faxed, the sys-
tem generates a PDF document and will send to the fax server 
defined in System Parameters.
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For example, if a printer named JET4050 was previously defined, as were the special printer 
names listed above, then the following additional printers could be defined:

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the 
Printers screen

2. In the Printers section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

Name Description

JET4050+ARCHIVE Prints the document with the jet4050 printer and archives the 
document.

FAX+ARCHIVE Faxes and archives the document.

EMAIL+ARCHIVE+J
ET4050

E-mails, archives, and prints the document with the jet4050 
printer. 

Field: Do this:

Printer Name Specify the printer name. The name of the printer as defined by the 
server. For a UNIX server, the name might be JET4050, while to 
access the same printer from a Windows server the name would 
be: \\servername\jet4050.

Description Specify the description for the printer.

Organization Select the organization to which the printer belongs, from the drop-
down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.9 Bank Details

The Banks screen defines the banks, a company/branch uses for processing Automatic 
Clearing House (ACH) and lock box payments. 

Note

This is “behind the scenes” information that the system uses for payments and does not 
appear on any other forms.

To set up the Banks

1. Click Setup > Setup > Administration > User > Bank Details link. The system displays 
the Bank Details screen. 

Division Select the division to which the printer belongs, from the drop-
down list. The division will be displayed based on the organization 
selected.

Department Select the department to which the printer belongs, from the drop-
down list. The department will be displayed based on the division 
selected.

IMPORTANT: When you select a printer to use, the system 
searches for a best match using the following attributes:

1 Organization

2 Division

3 Department

Hence, Oracle recommends creating a version of each edit, where 
ALL is the value in these fields.

It is also recommended that, you define a default printer for an 
Organization, Division and Department.

Default Check this box to set the printer as a default printer.

Enabled Check this box to enable the printer and that the printer is active. 

Note: Never disable the UNDEFINED printer. 

Field: Do this:
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2. In the Banks Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code Specify the bank code (ID used internally by Oracle Financial Ser-
vices Lending and Leasing to represent the bank).

Name Specify the name for the bank.

Short Name Specify the short name for the bank (ID displayed to represent the 
bank. This may be included in any output files).

Enabled Check this box to enable and indicate this as an active bank

Account # Specify the account number used for banking transactions with the 
bank. 

Note: If the organizational parameter UIX_HIDE_RESTRICTED_-
DATA is set to Y, this appears as a masked number; for example, 
XXXXX1234.

Routing # Specify the routing number of the bank.

BIC Select the Business Identifier Code from the drop-down list. The list 
displays the BIC codes defined in the system.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Bank Details > ACH.

5. On the ACH Definition sub screen, you can create ACH files for the bank listed in the 
Banks section. Perform any of the Basic Operations mentioned in Navigation chapter.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used 
for identifying bank accounts across national borders with a minimal 
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based 
on modulo 97. On save, system automatically validates the IBAN 
number length based on country code, characters, white spaces, and 
checksum. Validation is also done during posting non-monetary 
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per 
the country code in the user defined table (Setup > Administration > 
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by 
default with length of IBAN as 18.

Country Select the country where the bank is located, from the drop-down list.

City Specify the city where the bank is located.

State Select the state where the bank is located, from the drop-down list.

Address Line 1 Specify the address line 1 for the bank.

Address Line 2 Specify the address line 2 for the bank.

Zip Specify the zip code where the bank is located, from the drop-down 
list.

Extn Specify the extension of the zip code where the bank is located.

Creditor Id Specify the creditor identification details.

Phone 1 Specify the primary phone number of the bank.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the bank.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the bank.

Fax 2 Specify the alternate fax number for the bank.

ACH Format Select the ACH format accepted by this bank from the drop-down list. 
The list displays the following options:

- NACHA Format

- SEPA Format

Field: Do this:
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A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click Setup > Setup > Administration > User > Bank Details > Lock Box.

8. On the Lock Box sub screen, you can create lock box files for the bank listed in the Banks 
screen. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.10 Standard Payees

The Standard Payees screen defines the third parties that are frequent payees for checks 
issued within your organization. These payees are then available on the Consumer Lending 
screen’s Advance Entry screen. When you select the Payee # in the Advance Allocation 
section, the system completes the remaining fields in this screen with information from the 
Standard Payees screen. 

Note

The Payee # field on the Advance Payment forms is a non-validated field. This allows you 
to select an entry or enter one of your own.

To set up the Standard Payees

1. Click Setup > Setup > Administration > User > Standard Payee. The system displays 
the Standard Payees screen.

Field: Do this:

Company Select the portfolio company from the drop-down list.

Branch Select the portfolio branch from the drop-down list.

ACH Identifier Specify the lock box ID provided by the bank. This field is used in the 
ACH files to identify the bank.

Enabled Check this box to enable the ACH and indicate this as an active ACH 
identifier.

Field: Do this:

Lock Box 
Identifier

Specify the lock box ID provided by bank. This field is used in the lock 
box files to identify the bank.

Company Select the portfolio company from the drop-down list.

Branch Select the portfolio branch from the drop-down list.

Enabled Check this box to enable the lock box.
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2. In the Payee Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Payee # Specify the payee number (Identifier for the payee).

Name Specify the payee name.

Pmt Mode Select the payment method for the payee from the drop-down list.

Enabled Check this box to enabled the payee.

Country Select the country where the payee is located from the drop-down 
list.

City Specify the city where the payee is located.

State Select the state where the payee is located from the drop-down list.

Address Line 1 Specify the address line 1 for the payee (optional).

Address Line 2 Specify the address line 2 for the payee (optional).

Zip Select the zip code where the payee is located from the drop-down 
list.

Extn Specify the extension of the zip code where the payee is located.

Phone 1 Specify the primary phone number for the payee.

Phone 2 Specify the alternate phone number for the payee.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.11 Check Details

The Check Details screen allows you to set up check details.

To setup the Check Details

1. Click Setup > Setup > Administration > User > Check Details. The system displays the 
Check Details screen.

Bank Name Specify the payee ACH bank name used by the standard payee.

Routing # Specify the payee ACH bank routing number of bank used by the 
standard payee.

Account Type Select the payee type of ACH bank account maintained by the Stan-
dard Payee from the drop-down list.

ACH Account # Specify the payee ACH bank account number. 

BIC Select the Business Identifier Code from the drop-down list. The list 
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used 
for identifying bank accounts across national borders with a minimal 
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based 
on modulo 97. On save, system automatically validates the IBAN 
number length based on country code, characters, white spaces, and 
checksum. Validation is also done during posting non-monetary 
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per 
the country code in the user defined table (Setup > Administration > 
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by 
default with length of IBAN as 18.

Start Dt Specify the payment mode start date, the date the current payment 
method was implemented (defaults on Pmt Mode change). you can 
also select from the adjoining calendar icon.

Comment Specify a comment for this advance allocations. This is the default 
comment to include with payments to this Payee.

Field: Do this:
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2. In the Check Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.12 Currencies

The Currencies link allows you to set up currency details.

Navigating to currencies

1. Click Setup > Setup > Administration > User > Currencies. The system displays the 
Currencies screen. In this screen, you can set up:

 Currency Definition

 Currency Pair Definition 

Field: Do this:

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Payee Type Select the payee type from the drop-down list.

Check # Specify the check number (required).

Printer Name Specify the printer name (required).

Enabled Check this box to enable the check details entry.
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3.12.1 Currency Definition

The Currency Definition screen allows you to set up currency details.

To set up the currency definition information

1. Click Setup > Setup > Administration > User > Currencies > Currency. The system 
opens the Currency Definition tab by default.

2. In the Currency section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.12.2 Currency Pair link

The Currency Pair Definition link allows you to set up currency pair details.

To set up the currency pair definition information:

1. Click Setup > Setup > Administration > User > Currencies > Currency Pair. The 
system displays the Currency Pair Definition screen

Field: Do this:

Currency Select the currency you want to define, from the drop-down list.

Currency Name The system displays the currency name based on the currency 
selected.

Country Select the country for which the currency is defined, from the drop-
down list.

Enabled Check this box to enable the currency entry.
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2. In the Currency Pair Definition section, perform any of the Basic Operations mentioned 
in Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13 Zip Codes

The Zip Codes screen allows you to set up zip code details.

To set up the zip codes information

1. Click Setup > Setup > Administration > User > ZipCodes. The system displays the Zip 
Codes screen

Field: View this:

Currency Code Select the currency code from the drop-down list.

Currency Pair Code Select the currency pair code from the drop-down list.

Through Currency Check this box to set the selected currency as a through cur-
rency.

Through Currency 
Code

Select the through currency code from the drop-down list.

Enabled Check this box to enable the currency pair entry.
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2. In the Zip Codes section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below::

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Field: View this:

Country Select the country from the drop-down list.

State Select the state from the drop-down list.

Zip Code Specify the zip code (required).

City Specify the city.

County Specify the county.
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4. Product

Under the Setup master tab’s drop-down link bar, the product Setup link opens screens that 
enable you to configure the basic business guidelines necessary to support one or more 
products in the system. This includes defining the types of collateral your company supports, 
creating lending instruments, and determining what is included in credit bureau reporting. 
Setting up the Products screens requires a thorough understanding of the current rules of 
your business and must be completed before you can use Oracle Financial Services Lending 
and Leasing. The Products drop-down link opens screens to record data of all the products 
supported by the system and contains the following links:

Navigating to Products

In the Setup > Setup > Products link enables you to setup the options related to following 
closed ended products your company offers:

 Asset Types

 Index Rates

 Currency Exchange

 Scoring Parameters

 Products 

 Pricing

 Contract

 Edits

 Cycles

 Scoring Models

 Fees

 Origination Fees

 Insurances

 Checklists

 Stipulations

 Letters

 Promotions

This chapter explains how to setup the screens associated with each one.

4.1 Asset Types

In Assets types you can setup the asset types that can serve as an application or account’s 
collateral.

The information on the Assets screen is used by the system to automatically display the 
appropriate collateral screen (Vehicle, Home, or Other) on the Application Entry screen. 

The system recognizes the following four types of collateral:

Collateral Type Description

Home collateral Homes, manufactured housing, or any real estate collateral.

Vehicle collateral All vehicle types, such as cars, trucks, and motorcycles.
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The Asset Sub Type section allows you to further categorize an asset; for example, the asset 
type VEHICLE might be categorized as CAR, TRUCK, or VAN. 

The Attributes/Addons and Makes and Models sub screens continue to further detail the asset 
both in description and value. For example, a VEHICLE asset might include addons such as 
LEATHER SEATS and CRUISE CONTROL. 

Note

Neither asset types nor asset sub types can be deleted. As they may have been used in 
the past, the display and processing of that data is still dependent on the existing setup.

To set up the Asset Types

You can either define new Asset Type or specify a new name in the New Asset Type field 
and click Create Copy to create a copy of selected asset with details.

1. Click Setup > Setup > Products > Asset Types. 

2. In the Asset Type section, perform any of the Basic Operations mentioned in Navigation 
chapter.

Household goods 
and other collateral 

All other collateral types not defined as home, vehicle, or 
unsecured; for example, household items such as water heaters, 
televisions, and vacuums.

Unsecured 
collateral

All unsecured lending instruments. (This collateral type makes 
the collateral tabs on the system forms unavailable.)

Collateral Type Description
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Asset Sub Type section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Products > Assets > Attributes/Addons.

7. In the Attributes/Addons section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Field: Do this:

Asset Type Specify the asset type.

Description Specify the description for the asset. (This is the asset type which will 
appear throughout the system).

Collateral Type Select the collateral type (the general category that the asset type 
falls within) from the drop-down list. 

Note: There is no need to define an asset for UNSECURED 
COLLATERAL, as by definition there is no asset on such account.

Company Select the portfolio company to which the asset type belongs, from 
the drop-down list. These are the companies within your organization 
that can make Lines using this asset type. This may be ALL or a 
specific company.

Branch Select the portfolio branch to which the asset type belongs, from the 
drop-down list. This is the branch within the selected company that 
can make Lines using this asset type. This may be ALL or a specific 
branch. This must be ALL if in the Company field you selected ALL.

IMPORTANT: By selecting which asset type to use, the system 
searches for a best match using the following attributes:

1 Company

2 Branch

Hence, the system recommends creating one version of each asset 
type where ALL is the value in these fields.

Enabled Check this box to enable the asset type and indicate that the asset 
type is currently in use.

Field: Do this:

Asset Sub Type Specify the asset sub type.

Description Specify the description for the asset subtype

Asset Property Type Select the type of property from the drop-down list.

Enabled Check this box to enable the asset sub type.
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A brief description of the fields is given below:

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click the Setup > Setup > Products > Assets > Makes and Models.

10. In the Makes and Models section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

11. Perform any of the Basic Actions mentioned in Navigation chapter.

4.2 Index Rates

The Index Rates screen maintains your organization’s history of periodic changes in index 
rates. It allows you to define index rates to support variable rate lines of credit. The index rate 
provides the base rate for a credit line where:

interest rate = index rate + margin rate. 

The Index section displays the currently defined indexes on the Lookups screen. You may 
create additional user-defined lookup codes for this lookup type as needed.

Note

You cannot tie an index rate to a product rate.

Field: Do this:

Attribute/Addon Displays the asset attribute or addon name for the selected asset).

Description Select the description for the asset attribute/addon from the drop-
down list.

Default Specify the default text to be copied or displayed when the asset 
attributes and addons fields are completed on an application for 
this asset.

Value Specify the default monetary value to be copied or displayed when 
the asset attributes and addons fields are completed on an 
application for this asset.

Enabled Check this box to enable the asset attribute/Addon and indicate 
that it is available for this type of asset.

Field: Do this:

Make Specify asset make.

Model Specify asset model.

Style Specify asset style type.

Model Year Specify asset model year.

Enabled Check this box to enable the asset make and model and indicate that it 
is included on fields for this asset type.
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You can also record any index rate change on the Index Rates screen. During nightly batch 
processing, all the accounts with that index type are included when posting the RATE 
CHANGE transaction. After the system processes the batch, the interest rate of the account 
is changed. The system will use this new interest rate when computing all future interest 
calculations.

To set up Index Rates

1. Click Setup > Setup > Products > Index Rates.

2. In the Index section, perform any of the Basic Operations mentioned in Navigation 
chapter.:

3. A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Index Details section allows you to define multiple index values using the Start Dt and 
Rate fields. 

Note

The history appears in descending order, with the most current record at the top.

5. In the Index Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Field: Do this:

Index Type Select the type of index from the drop-down list.

Short Description Specify a short description of the index.

Description Specify the index description.

Enabled Check this box to activate the index type.
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A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Variable rate functionality is not extended to pre-compute accounts.

4.3 Currency Exchange

The Currency Exchange screen maintains currency exchange rates. You can define the 
currency exchange details and schedule a batch job (SET-IFP- ICEPRC_BJ_100_01 - 
CURRENCY EXCHANGE RATE FILE UPLOAD) which in-turn pulls the currency exchange 
rates from desired source at scheduled intervals through input file processing.

To set up the Currency Exchange

1. Click Setup > Setup > Products > Currency Exchange.

2. In the Currency Exchange Rates section, perform any of the Basic Operations 
mentioned in Navigation chapter. 

Field: Do this:

Start Dt Specify the effective start date for the index rate. You can even select 
the date from the adjoining Calendar icon.

Rate Specify the new index rate effective from above mentioned date as a 
percentage.

Note: For the FLAT RATE index there should be only one entry with a 
Start Dt. = 01/01/1900 and a RATE = 0.0000.

Enabled Check this box to activate the index rate effective from start date 
mentioned above.
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.4 Scoring Parameters

With the Scoring Parameters, you can define the scoring parameters of a company’s credit 
scorecard and behavioral scoring.

While the system’s pricing scores apply to applications and are based on information 
recorded during origination, behavioral scoring applies to accounts and is based on account 
history attributes and performed on a monthly basis.

Behavioral scoring 

Behavioral scoring examines the repayment trends during the life of the account and provides 
a current analysis of the customer. This logical and systematic method identifies which 
accounts are more likely to perform favorably versus accounts where poorer performance is 
probable. This is useful when determining which other Lines of credit/loan products a 
customer may qualify for. Behavioral scoring applies to all the three products: loans, lines of 
credit and leases.

This information appears on the Customer Service form in the Account Details screen’s 
Activities section.

Credit Scoring 

Parameters define the factors that can be used when scoring an application during 
underwriting and generating an initial decision on whether you wish to fund an amount. The 
combination of the flexible definition of these parameters, along with the scoring set up on the 
Scoring Models screen, allows you to automate much of the initial decision process in 
underwriting accounts. 

The Formula Definition section on the Scoring Parameters screen allows you to build a 
mathematical expression to express the scoring parameter, test its validity, and locate specific 
information with the resulting scoring parameters. The system calculates scoring parameters 
using application data, credit bureau information, and applicant details. 

To set up the Scoring Parameters

You can either define new Scoring Parameters or specify a new name in the New 
Parameter field and click Create Copy to create a copy of selected parameter with details.

1. Click Setup > Setup > Products > Scoring Parameters.

Field: Do this:

Currency Select the currency being exchanged from the drop-down 
list.

Currency Pair Select the currency to be paired with from the drop-down list.

Effective Date and Time Specify date and time of the exchange rate. You can even 
select the date from the adjoining Calendar icon.

Rate Specify the exchange rate (required).

Enabled Check this box to activate the currency exchange rate.
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2. In the Parameters section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Formula Definition section allows you to define a mathematical expression of the 
scoring parameter you want to define. The expression may consist of one or more sequenced 
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula 
definition, the system displays an error message in this section when you choose Show 
Expression.

Field: Do this:

Parameter Specify the name of the scoring parameter. The system 
recommends entering a name that in some way reflects how the 
parameter is used; for example, use FICO_SCORE instead of 
PARAMETER_1.

Description Specify a description of the parameter. Again, Specify a name that 
reflects how the parameter is used; for example, use FICO SCORE 
and WEIGHTED FICO SCORE instead of FICO SCORE NUMBER 1 
and FICO SCORE NUMBER 2.

Data Type Select the data type of the scoring parameter being defined from the 
drop-down list. This determines how the system handles the values. 
(While DATE and CHARACTER are available data types, generally 
only NUMBER should be used when defining a scoring parameter.

Scoring Type Select the scoring type from the drop-down list: CREDIT SCORING 
or BEHAVIORAL SCORING.

Enabled Check this box to enable and indicate that the scoring parameter is 
available.
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4. In the Formula Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Parameters section, click Show Expression.

The mathematical expression appears in the Formula Expression section (in sequential order) 
in the Expression field.

4.5 Products

The Product screen defines the closed ended products your organization offers. This screen 
is enhanced to support Islamic along with the conventional.

A product is based on the following attributes:

 The collateral type and sub type

 The billing cycle

 Whether the amount is paid directly or indirectly to the customer

The Product Definition section records details about the product such as the description, start 
and end dates, collateral type and sub type, credit bureau reporting attributes, billing cycle, 
index and rate calculation attributes.

The Product Itemization section is used to define itemized entries for a product. This 
information is used on the Itemization sub screens of the Application Entry and Application 
screens. 

The Rate Adjustments section is used to define the frequency of rate change allowed during 
interest rate calculations.

Field: Do this:

Seq Specify the sequence number (the order in which the formula definition 
variable will be assembled and evaluated).

( Specify a left bracket, if you need to group part of your formula definition.

Variable Select the variable from a validated field based on the user-defined table 
SCR_CRED_SUMMARY: SCORING PARAMETERS, from the drop-down 
list.

Constant 
Value

Specify the constant value (optional).

Mathematical 
Operator

Select the math operator to be used on the adjacent formula definition 
rows, from the drop-down list.

) Specify a right bracket, if you are grouping part of your formula definition.

Enabled Check this box to enable the formula and indicate that it is included when 
building a definition for the scoring parameter.
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To set up the Product

You can either define new Product details or specify a new product code in the New Product 
field and click Create Copy to create a copy of selected product with details.

1. On the Oracle Financial Services Lending and Leasing home screen, Setup > Setup > 
Administration > User > Products > Products > Line.

2. In the Product Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.     

A brief description of the fields is given below:

Field: Do this:

Product Specify the product code as defined by your organization (in other 
words, how you want to differentiate the products). For example, 
products can be differentiated according to asset. The product code, or 
name, is unique.

Description Specify the description of the product. (This is the product description as 
it appears throughout the system).

Start Dt Specify the start date for the product. You can even select the date from 
the adjoining Calendar icon.

End Dt Specify the end date for the product. You can even select the date from 
the adjoining Calendar icon.

Direct Check this box, if you need the product to be originated directly to 
customer. (In this case, the compliance state is the state listed in the 
customer’s current mailing address.) If unchecked, the product is an 
indirect lending product; that is, payment is made to the producer. (In this 
case, the compliance state is the state listed in the producer’s address.)
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.5.1 Product Itemizations

1. Click Setup > Setup > Administration > User > Products > Products > Line >  
Product Itemizations.

2. In the Product Itemization sub screen, perform any of the Basic Operations mentioned in 
Navigation chapter.

Customer 
Credit Limit

Check this box to enable ‘Customer Credit Limit’ tab in Origination 
module. Using the ‘Customer Credit Limit’ tab, an underwriter can define 
a specific credit limit for the customer while funding the first application 
and based on that credit limit, subsequent applications can be funded.

For more information, refer to ‘Customer Credit Limit’ details in User 
Guide.

Same Billing 
Cycle

Check this box to set the same billing cycle (supported only billing cycles 
Monthly and Weekly) for all the future applications funded for an existing 
customer.

Enabled Check this box to activate the product.

Note: You can check this box only when Rate adjustment schedule is 
maintained, i.e., All the products should be variable rate products

Collateral 
Type 

Select the collateral type for the product, from the drop-down list. This 
field identifies what type of collateral is associated with the and assists 
the system in identifying the correct screen(s) to display.

Collateral 
Sub Type 

Select the collateral sub type for the product, from the drop-down list.

Credit 
Bureau 
Portfolio 
Type* 

Select the credit bureau portfolio type for the product, from the drop-
down list.

Credit 
Bureau 
Account 
Type*

Select the account type for the product, from the drop-down list.

*Note: The Credit Bureau Portfolio Type and Credit Bureau Account 
Type fields determine how the portfolio is reported back to the credit 
bureaus.

Billing Cycle Select the billing cycle for the product, from the drop-down list.if

Category Select the category as Standard for the conventional product and Islamic 
for the Islamic product, from the drop-down list. This serves to group 
products for reporting purposes.

Index 
Rounding

Select the index rate rounding factor for the product, from the drop-down 
list. 

Note: For more information, refer Appendix C: Rounding Amounts and 
Rate Attributes.

Field: Do this:
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A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.6 Pricing

The Pricing screen records pricing information related to your products. the system uses the 
information in the Pricing Definition section to identify the correct pricing for an application, 
depending upon the product and the specific application parameters. the system will always 
search for a unique match.

When you choose the Select Pricing while making a decision on the Underwriting window, 
the system displays the best match and completes the Pricing and Approved sections under 
Summary sub tab. The information in the Approved section cite the minimum amounts for the 
loan, though the user can edit these figures. 

The system determines the best match by looking at all enabled pricing strings on the Pricing 
screen that meet the following criteria: 

 Exactly match the application values for the Promotion and Billing Cycle fields.

 Are less than or equal to the application values for the Term, Amount, Age, and Start 
Date fields.

 Match either the application value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches of ALL. The returned 
rows are then ranked based on the weighted values and the hierarchical position of the field 
(see above). They are then ranked by start date. The system recognizes the first row returned 
as the best match.

Note

– You should set up a default pricing for each billing cycle and pricing that the system 
can select to ensure error-free performance. Oracle Financial Services Software 
recommends creating a single version of each edit type, where ALL is the value in 
the selection criteria fields listed above. If the system cannot find a pricing match, it 
will display an error message.

– The system supports the bulk uploading of product pricing setup data. This allows 
you to upload multiple setup data, avoid re-entering setup data, and more impor-

Field: Do this:

Itemization Select the itemization type for the product selected in product 
definition section, from the drop-down list.

Discount Rate Specify the discount rate.

Sort Specify the sort order.

Sign Select +ve for a positive number and -ve for a negative number.

Note: The +ve and -ve buttons determine whether the values will 
increase or decrease the itemization total for the product based on 
the selected product. Together the contents of the Product 
Itemization sub screen, positive and negative, add up to the 
amount.

Enabled Check this box to indicate that this product itemization is currently 
available.
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tantly, reduce data entry mistakes. The system currently supports uploading using 
a fixed-length format only, where each data is at a pre-fixed position. You can run 
batch jobs with the Set Code SET-BLK to upload pricing and GL data.

To set up the Pricing

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Pricings > Line.

2. In the Pricing Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter. 

A brief description of the fields is given below:  

Field: Do this:

Pricing* Specify the code for the pricing.

Description* Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt Specify the start date for this pricing. You can even select the 
date from the adjoining Calendar icon.

End Dt Specify the end date for this pricing. You can even select the 
date from the adjoining Calendar icon.

Enabled Check this box to enable the pricing.

Result section

Draw Period Specify the draw term for which this pricing is valid.

Repmt Period Specify the repayment term for which this pricing is valid

Max Credit Specify the maximum credit Limit for this pricing.

Index Select the index type associated as FLAT/PRIME RATE from 
the drop-down list.
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Margin From Specify the minimum margin rate for the selected index type.

Margin To Specify the maximum margin rate for the selected index type.

Maturity Index Select the maturity index type associated as FLAT/PRIME 
RATE from the drop-down list.

Maturity Margin Rt 
From

Specify the minimum margin rate for the selected maturity 
index type.

 Maturity Margin To Specify the maximum margin rate for the selected maturity 
index type.

Selection Criteria

Company
Select the portfolio company for this pricing, from the drop-
down list. This may be ALL or a specific company.

Branch Select the portfolio branch for this pricing. This may be ALL or 
a specific branch. (This must be ALL if in the Company field 
you selected ALL), from the drop-down list.

Billing Cycle Select the billing cycle for this pricing, from the drop-down list.

Product Select the product for this pricing, from the drop-down list. 
This may be ALL or a specific product. The available values 
come from a validated field based on the selected billing cycle 
and the product setup.

State Select the state for this pricing, from the drop-down list. This 
may be ALL or a specific state.

Pro Group Select the producer group for this pricing, from the drop-down 
list. This may be ALL or a specific producer group.

Pro Type Select the producer type for this pricing, , from the drop-down 
list. This may be ALL or a specific producer type.

Producer Region Select the region of the producer.

Producer Territory Select the territory of the producer.

Producer Select the producer from the drop-down list. This may be ALL 
or a specific producer. The available values come from a 
validated field based on the product group and product type.

Grade Select the credit grade for this pricing, from the drop-down list. 
This may be ALL or a specific grade.

Credit Limit Specify the minimum credit limit for which this pricing is valid.

Asset Class Select the asset class from the drop-down list. This may be 
ALL or a specific asset class. The available values come from 
a validated field based on the collateral type. You may create 
additional user-defined lookup codes for these lookup types 
as needed.

Field: Do this:
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Asset Type Select the asset type from the drop-down list. This may be 
ALL or a specific asset type. The available values come from 
a validated field based your assets setup.

SubType Select the asset sub type from the drop-down list. This may be 
ALL or a specific asset sub type. The available values come 
from a validated field based your assets setup, and is linked to 
the selected asset type.

Asset Make Select the asset make from the drop-down list. The available 
values come from a validated field based your assets setup 
and is restricted based on the selected Asset Type and Asset 
Sub Type. For example, If ALL was selected for either Asset 
Type or Asset Sub Type, then ALL will be the only available 
selection for the asset make.

Asset Model Select the asset model from the drop-down list. The available 
values come from a validated field based your assets setup, 
and is restricted based on the selected Asset Type and Asset 
Sub Type. If ALL was selected for either Asset Type or Asset 
Sub Type, then ALL will be the only available selection for the 
asset model.

Age Specify the asset age (the minimum age for the selected 
pricing).

Note: If your entry in this field is based on the number of years 
of age of the asset and not the actual year of make, you must 
update this entry annually to ensure that the proper pricing is 
available.

Trade-In Specify if there is a trade in of an asset by selecting Yes/No.

Mileage If there is a Trade-In of an existing asset, then specify its 
mileage in km.

Currency Select the currency for this pricing, from the drop-down list.

Promotion Select the promotion applicable to this pricing from the drop-
down list. The available values come from a validated field 
based on the promotions setup.

Asset Value Specify the asset value.

LTV Specify the loan to value ratio.

Existing Customer Select one of the following options from the drop-down list to 
define the applicability of the current pricing definition:

ALL - Applicable to both existing and new customers

YES - Applicable to existing customer only

NO - Applicable to new customer only.

Based on the selection criteria, system defaults the first 
pricing for applications with ‘Existing customer flag = Y’ at 
primary applicant details.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7 Contract

The Contract screen allows you to define the instruments used within your system. A 
instrument is a contract used by a financial organization with specific rules tied to it. When 
processing an application, an instrument associated with the application informs the system 
of the type of contract being used for the approved loan. This ensures that all parameters tied 
to the instrument are setup for the account as it is booked - without requiring you to do it.

Instruments can be setup at different levels:

 Company

 Branch

 Product

 Application state

 Currency

The following groups of parameters are setup at the instrument level (Each has its own 
section on the Contract screen):

 Selection Criteria

 Accrual

 Scheduled Dues

 Billing

 Delinquency

 Extension

 Advance Details

 Rate Cap And Adjustments

 Other

Items defined in the contract are “locked in” when you choose Select Instrument on the 
Funding form’s Contract link.

The Contract screen’s Instrument and Description fields allow you to enter the financial 
instrument’s name and description.

To set up the Contract

You can either define new Contract Definition details or specify a new name in the New 
Instrument field and click Create Copy to create a copy of selected contract with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > Products > Contract > Line

Existing Customer 
Since (In Years)

Specify the duration from when customer account was created 
in the system up to the current date in years.

Selection Criteria : Business - allows you to indicate the age of business by 
evaluating the total number of years elapsed.

Years In Business Specify the total number of years in business.

Field: Do this:
4-16



2. On the Contract Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.      

A brief description of the fields is given below:  

Field: Do this:

Contract Definition section

Instrument Specify the code identifying the instrument.

Description Specify the description of the instrument being defined.

Start Dt Specify the start date for the instrument. You can even select the 
date from the adjoining Calendar icon.

End Dt Specify the end date for the instrument. You can even select the 
date from the adjoining Calendar icon

Enabled If you check this box, the system will consider this contract definition 
when selecting a instrument for an application.

Note: Once the field is enabled load balances button in balances 
sub tab will be disabled

Selection Criteria section

Company Select the company for the instrument from the drop-down list. This 
may be ALL or a specific company.

Branch Select the branch within the company for the instrument from the 
drop-down list. This may be ALL or a specific branch. This must be 
ALL, if you have selected ‘ALL’ in the Company field.

Billing Cycle Select the billing cycle selected from the drop-down list.

Product Select the product for the instrument from the drop-down list. This 
may be ALL or a specific product. 
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State Select the state in which the instrument is used from the drop-down 
list. This may be ALL or a specific state.

Currency Select the currency for the instrument from the drop-down list.

IMPORTANT: By selecting which type to use, the system searches 
for a best match using the following attributes:

1. Billing Cycle

2. Start Date

3. Company

4. Branch

5. Product

6. State

Hence, Oracle Financial Services Software recommends creating 
one version of each type, where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used from the drop-
down list. This may be ALL or a specific pricing.

Accrual section

Accrual Post 
Maturity

Check this box to indicate that this is the post maturity default rate.

Extensions allow you to extend the maturity of the contract by one or 
more terms by allowing the customer to skip one or more payments. 
The skipped terms are added to the end of the contract. 

Accrual Method Select the accrual method used to calculate interest accrual for this 
instrument from the drop-down list.

Start Dt Basis Select to define the start date from when the interest accrual is to be 
calculated for this instrument from the drop-down list.

Note: 

If you select the Effective Date, then the interest is calculated from 
the Contract date.

If you select the Payment Date, then the interest is calculated based 
on (first payment date minus one billing cycle).

Base Method Select the base method used to calculate interest accrual for this 
instrument from the drop-down list.

Accrual Start 
Days

Specify the number of days for which the interest accrual is to be 
calculated.

Int Amortization 
Freq

Select the interest amortization frequency from the drop-down list.

Scheduled Dues section

Max Due Day 
Change Days

Specify the maximum number of days a due date can be moved.

Field: Do this:
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Due Day Min Specify the minimum value allowed for the due day for this 
instrument.

Due Day Max Specify the maximum value allowed for the due day for this 
instrument.

Note: If billing cycle is selected as weekly, then Due Day Max field 
value cannot be greater than 7.

Max Due Day 
Change / Year

Specify the maximum number of due day changes allowed within a 
given year for this instrument.

Max Due Day 
Change / Life

Specify the maximum number of due day changes allowed over the 
life of a product funded with this instrument.

Billing section

Pre Bill Days Specify the prebill days. This is the number of days, before the first 
payment due, that accounts funded with this instrument will be billed 
for the first payment. Thereafter, the accounts will be billed on the 
same day every month. If an account has a first payment date of 10/
25/2003 and Pre Bill Days is 21, then the account will bill on 10/04/
2003, and then bill on the 4th of every month.

Billing Type Select the billing type for accounts funded using this instrument from 
the drop-down list.

Draw Period 
Billing Method 
Billing Method

Select the draw period billing method for accounts funded using this 
instrument from the drop-down list.

Repmt Billing 
Method

Select the billing method for the repayment period from the drop-
down list.

Draw Billing % Enter the payment percentage for the draw period.

Repmt Term 
Payment %

Enter the payment percentage for the repayment draw period.

Delinquency section

Late Charge 
Grace Days

Specify the number of grace days allowed for the payment of a due 
date before a late charge is assessed on the account.

Stop Accrual 
Days

Specify the number of days a contract can be in delinquent state, 
after which the interest accrual must stop for an account.

A Batch Job is run daily to select accounts in delinquent status for a 
pre-defined number of days and post ‘No Accrual transaction’ for 
such accounts on current date. When the account recovers from 
Delinquency, the system will then post a ‘Start Accrual Transaction’ 
on the date the account is recovered from delinquency.

Delq Grace Days Specify the number of grace days allowed for the payment of a due 
date before an account is considered delinquent. This affects DELQ 
Queues, the system reporting, and the generation of collection 
letters.

Field: Do this:
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Time Bar Years Specify the total number of years allowed to contact the customer 
starting from the first payment date and beyond which the account is 
considered delinquent. You can specify any value between 0-999.

Cure Letter Gen 
Days

Specify the number of delinquency days to initiate cure letter gener-
ation.

Cure Letter Valid 
Days

Specify the number of days during which the issued cure letter is 
valid. Usually financial institutions will start the collection activities 
after the lapse of cure letter validity date.

Delq Category 
Method

Select the delinquency category method to determine how the 
system populates delinquency counters on the Customer Service 
form. 

Note: This value does not affect credit bureau reporting.

Extension section

Max Extn Period 
/ Year

Specify the maximum number of terms that the contract may be 
extended, within a given rolling calendar year.

Max Extn Period 
/ Life

Specify the maximum number of terms that the contract may be 
extended, within the life of the loan.

Max # Extn / 
Year

Specify the maximum number of extensions that may be granted 
within a given rolling calendar year. 

Max # of Extn / 
Life

Specify the maximum number of extensions that may be granted 
within the life of the loan.

Minimum # 
Payments

Specify the minimum number of payments that must be made before 
extension.

Extension Gap in 
Months

Specify the gap between previous extension provided in the account 
and current one as specific number of months.

Advance Details section

Min Initial 
Advance

Specify the minimum initial advance amount allowed. This is the 
smallest possible initial advance that can be disbursed to the 
borrower after funding.

Max Initial 
Advance

Specify the maximum initial advance amount allowed. This is the 
largest possible initial advance that can be disbursed to the borrower 
after funding.

Min Advance Specify the minimum advance amount. This is the smallest advance 
amount that a borrower may subsequently request after the initial 
advance.

Max Advance Specify the maximum advance amount. This is the largest advance 
amount that a borrower may subsequently request after the initial 
advance.

Rate Cap & Adjustments section

Field: Do this:
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Max Rate 
Increase / Year

Specify the maximum rate increase allowed in a year.

Max Rate 
Increase / Life

Specify the maximum rate increase allowed in the life of the loan.

Max Rate 
Decrease / Year

Specify the maximum rate decrease allowed in a year.

Max Rate 
Decrease / Life

Specify the maximum rate decrease allowed during the life of the 
loan.

Max # 
Adjustments / 
Year

Specify the maximum number of rate changes allowed in a year.

Max # 
Adjustments / 
Life

Specify the maximum number of rate changes allowed during the life 
of the loan.

Min Interest Rate 
(Floor)

Specify the minimum rate.

Max Interest 
Rate (Ceiling)

Specify the maximum rate.

Other section

Refund Allowed Check this box to indicate that refunding of customer over payments 
are allowed.

Refund 
Tolerance

Specify the refund tolerance amount. If the amount owed to the 
customer is greater than the refund tolerance, the over payment 
amount will be refunded if Refund Allowed box is selected.

WriteOff 
Tolerance Amt

Specify the write off tolerance amount. If the remaining outstanding 
receivables for accounts funded using this instrument is less or 
equal to the write off tolerance amount, the remaining balance on 
the account will be waived.

Pmt Tolerance 
Amt*

Specify the payment tolerance amount. This is the threshold amount 
that must be achieved before a due amount is considered PAID or 
DELINQUENT. If (Payment Received + Pmt Tolerance: $Value) >= 
Standard Monthly Payment, the Due Date will be considered as 
satisfied in terms of delinquency. The amount unpaid is still owed.

Pmt Tolerance%* Specify the payment tolerance percentage. This is the threshold 
percentage that must be achieved before a due amount is 
considered PAID or DELINQUENT. If Payment Received >= 
(Standard Monthly Payment * Pmt Tolerance% / 100), the due date 
will be considered satisfied in terms of delinquency. The amount 
unpaid is still owed.

The system uses the greater of these two values.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

Extension of Terms

The system facilitates extension of terms, provided the following conditions are satisfied:

 Specified number or more payments made in the account

 Gap between the previous and current extension provided in the account must be a 
specific number of months that could be specified

If the above conditions are not satisfied, then the system displays an appropriate error 
message.

Promise 
Tolerance Amt*

Specify the promise tolerance amount. This is the threshold amount 
that must be achieved before a due amount is considered KEPT or 
BROKEN. If (Payment Received + Promise Tolerance: $Value) >= 
Promise Amount, the Due Date will be considered KEPT (satisfied).

Promise 
Tolerance %*

Specify the promise tolerance percentage. This is the threshold 
percentage that must be achieved before a due amount is 
considered KEPT or BROKEN. If Payment Received >= (Promised 
Amt * Promise Tolerance%), the due date will be considered KEPT 
(satisfied).

The system uses the greater of these two values.

Adv Tolerance Enter the advance tolerance amount.

Adv Tolerance % Enter the advance tolerance percentage

Default Pmt 
Spread

Select the default payment spread to be used when receiving 
payments for this account if one is not explicitly chosen, from the 
drop-down list.

Min Finance 
Charge

Enter the minimum finance charge amount.

Minimum Pmt Enter the minimum billed amount.

Anniversary 
Period

Enter the anniversary term.

Repmt Currency Select the currency from the drop-down list.

PDC Security 
Check

Check this box to indicate that post dated checks are the method of 
repayment for this contract.

ACH Fee Ind Check this box to indicate that direct debit fee is included.

Note: The ACH Fee/Direct Debit Fee balance will be displayed in 
Balances sub tab only when this checkbox is selected.

Stmt Preference 
Mode

Select the account statement preference mode as either Email or 
PHYSICAL from the drop-down list.

The selected preference will be propagated to Application > Contract 
screen when the instrument is loaded.

Field: Do this:
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A new transaction Force Extension will be available. This transaction will be posted when you 
want the system to bypass the extension validations defined at the contract level.

When a backdated transaction with TXN Date exists before the transaction date of extension, 
all the transactions are reversed and posted again. If extension transaction is posted again, 
then the validation rules are not validated again.

Staged Funding

Staged funding for closed-end loans allows you to disburse funds to customers through 
multiple advances or draws up to the approved amount within a specified “draw period.”

To create a multiple disbursement contract for a transaction

1. In the Contract Definition section, click Add and complete the fields following the 
instructions above, making sure to complete the following steps:

 In the Advance Details section, select the Multiple Disbursement Permitted check box. 
When you select a contract instrument that permits staged funding (multiple 
disbursements) on the Funding screen, the system copies the information for that 
instrument from the Setup Module screen’s Contract screen to the Funding screen’s 
Contract screen. 

Note

You cannot clear the Multi Disbursement Allowed box in the Advance section on the Con-
tract screen.

 Complete the fields in the Advance Details section to define the limits for initial and 
subsequent advances for staged funding.

Note

This information appears in the Advance section of the Funding screen’s Contract link.

2. If you choose, set the following APPLICATION CONTRACT EDITS as an ERROR or 
WARNING on the Setup Module screen’s Edits screen. 

Note

For more information, see the Edits link (Edits screen) section in this chapter.

1. REQUIRED: ADV DRAW END DATE

2. XVL: ADV DRAW END DT MUST BE AFTER CONTRACT DT

3. XVL: ADV DRAW END DT MUST BE LESS THAN FIRST PMT DT - PREBILL DAYS

These edits appear on the Funding screen’s Verification screen.

Repayment scheduling for staged funding

When funding a loan, the system computes repayment schedules from the contract date, 
irrespective of whether funds have been disbursed or not. The system uses the approved 
amount (amount financed) for computing repayment schedules on the contract date. 

As the might have been disbursed through multiple draws, or the draws have been less than 
the approved amount, or the amount may have been repaid in some amount before the draw 
end date, you may need to change the payment amount. In such cases, you can manually 
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change the payment in the system by posting the monetary transaction CHANGE PAYMENT 
AMOUNT on the Customer Service screen’s Maintenance link.

Disbursements for staged funding

The approved amount for staged funding can be disbursed with the Funding screen or at a 
later time using the Advances screen. If the first disbursement is requested during funding, 
you may enter it on the Itemization sub screen of the Funding screen’s Contract screen.

If the entire approved amount is not disbursed during initial funding, it can be disbursed using 
the Advances screen’s Advance Entry screen.

If the initial amount on the Advance Entry screen is not within the minimum or maximum limits 
(as entered in the Advance Details section on the Setup Module screen’s Contract screen), 
the system displays any of the following error or warning messages in the Advances section’s 
Error Reason field:

 ADVANCE AMOUNT IS LESS THAN THE INITIAL ADVANCE AMOUNT MINIMUM

-or-

 ADVANCE AMOUNT IS MORE THAN THE INITIAL ADVANCE AMOUNT MAXIMUM

The Advance Entry screen also allows you to enter subsequent funding / disbursements. If 
subsequent advances are not within the predetermined minimum or maximum amounts, the 
system displays any of the following warning or error messages in the Advances section’s 
Error Reason field:

 ADVANCE AMOUNT IS LESS THAN THE ALLOWED SUBSEQUENT ADVANCE 
AMOUNT

-or-

 ADVANCE AMOUNT IS MORE THAN THE ALLOWED SUBSEQUENT ADVANCE 
AMOUNT 

Additional messages in the Error Field regarding Staged Funding

If you attempt to post an advance after the draw end date, then the system displays the 
message in the Advances section’s Error Reason field as, "ADVANCE DT IS AFTER DRAW 
PERIOD END DATE".

If you attempt to post an advance above the approved amounts, including tolerance, the 
system displays the message in the Advances section’s Error Reason field as "ADVANCE 
AMOUNT IS MORE THAN THE TOTAL APPROVED AMOUNT INCLUDING TOLERANCE".

Since this is not a revolving loan, if any repayment is made against the approved amount 
principal balance, the system will not adjust the disbursed amount allowing for subsequent 
additional staged funding or advances.

Note

There is no change to the payoff quote functionality in the system. The system uses the 
actual amount of the advance(s) and any interest accrued since the date of the last pay-
ment or credit in the PAYOFF QUOTE VALID UPTO DATE value when the payoff quote is 
requested before the draw end date.
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4.7.1 Balances

The Balances sub screen lists the balances that will be established when an account is 
booked and funded. 

CAUTION: Please contact your Implementation Manager for changes to this section. 

To set up the Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Line > 
Balances.

2. On the Balances sub screen, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Balance Type Displays the balance type.

Chargeoff Method Select the charge off method to determine how the outstanding 
amount of this balance type will be handled from the drop-down 
list, if the account becomes uncollectable and the product is 
charged off.

Writeoff Method Select the write off method to determine how the outstanding 
amount of this balance type will be handled from the drop-down 
list, if the account is within the write off tolerance of being PAID.

Reschedule Method Select the reschedule method to determine how the outstanding 
amount of this balance type will be handled from the drop-down 
list, if the account is rescheduled.

Sort Specify the sort order of how account balances will appear on the 
Customer Service form’s Balance screen.

Billed Check this box to indicate that outstanding amounts for this 
balance type are considered a part of the billed amount. This also 
determines whether payments applied to this balance type are 
considered when satisfying outstanding amounts due.

Accrued Check this box to indicate that outstanding amounts for this 
balance type will be included when interest is accrued against the 
account.

Non Performing 
Rollover 

Check this box to indicate that “non-performing” is used as an 
intermediary status on your general ledger prior to charge off and 
want to create balances for non-performing accounts for this 
balance type. 

Note: (The Non-Performing Rollover box applies only to Balance 
Types of ADVANCE/PRINCIPAL and INTEREST. For all other 
Balance Types, this box would be cleared).

Non Performing 
Balance Type 

Select the balance type you want to rollover from drop-down list, 
if you select the Non-Performing Rollover box (Advance/
Principal).

Enabled Check this box to indicate that this balance type will be created 
when the account is booked and funded
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

The system loads the currently defined balances for accounts. 

If your organization maintains additional balances, contact your Implementation 
Manager for information regarding those balances. 

4.7.2 Amortized Balances

With the Amortize Balances sub screen, you can select one or more balances to be amortized 
over the life of the loan. You can also define the amortization method. 

To set up the Amortization Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Line > 
Amortized Balances.

2. In the Amortization Balances section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7.3 Itemizations

On the Itemizations sub screen, you can define the itemized components for each type of 
contract, indicate if it is required, and determine whether it has a positive or negative bearing 
on the contract itemization math. You can establish the following groups of itemization 
transactions:

Field: Do this:

Amortize Balance Type Select the amortize transaction type from the drop-down 
list.

Amortization Method Select the amortization method used to calculate the net 
amortization amount from the drop-down list.

Cost/Fee method Select the amortization cost/fee method.

Sort Specify the sort sequence to define the order of the 
amortize balances.

Enabled Check this box to enable the amortize balance to be created 
when the account is booked and funded.

Advance Total amount of the product that is not a part of financed fees; in other 
words, the total amount the customer requested to be advanced.

Financed 
Fees

Fees rolled into the principal balance of the product. Financed fees are 
also considered to be a part of the finance charge.

Pre-Paid 
Fees

Fees that are paid by the consumer prior to the funding of the loan. 
These fees are not rolled into the balance of the product but are 
considered as part of the finance charge and are included in the 
calculation of the APR.

Producer Fees that are paid to or by the producer of the loan; for example, a fee 
that is being charged to the producer. These transactions will affect 
proceeds.
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To set up the Itemizations

1. Click Setup > Setup > Administration > User > Products > Contract > Line > 
Itemizations.

2. On the Itemization sub screen select the option button to indicate the type of itemization 
you are working with: Advance, Financed Fees, Pre-Paid Fees, Producer, or Escrow.

3. On the Itemization sub screen, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Escrow Allows you to connect the actual escrow itemization with the escrow type 
and the funding transaction.

Field: Do this:

Itemization Select the itemization from the drop-down list.

Disbursement 
Type

Select the disbursement type from the drop-down list.

Transaction Select the funding transaction type from the drop-down list.

Itemization Type Select the itemization type from the drop-down list.

Notes: 

1. On selecting the "Prefunding Txns" as itemization type, it 
indicates that this particular itemization expects a payment from the 
customer prior to funding.

2. The itemization type "Prefunding Txns" is available only for loans.

Sort Specify the sort order to define the order of the itemization 
transactions.

Sign If the itemized transaction increases the group balance, click +ve.

-or- 

If the itemized transaction decreases the group balance, click -ve.

Enabled Check this box to enable the itemization and indicate that this 
itemization transaction will be created when the account is booked 
and funded.

Amortize 
Balance

Select the amortize balance affected by this itemization transaction 
from the drop-down list. Note: Advance itemizations do not affect 
amortize balances.

Refund 
Calculation 
Method

Select the refund calculation method from the drop-down list

Taxable Check this box, if the itemization type is taxable. However, note that 
the taxable option defined in Setup > Administration > System > 
Sale Tax screen will supersede with this preference.

Seller Pmt Check this box to enable seller payment

Escrow Select the escrow from the drop-down list.
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4. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7.4 Fees

Any fees that are defined in the contract are set up on the Fees sub screen. The system 
currently supports the following contract fees:

 Late charges

 Non sufficient funds

 Extensions

 Prepayment penalties

 Delay Fee

 ACH Fee

The Fees sub screen allows you to define those fees whose value and method of calculation 
are set at the time of the loan. As these amounts cannot be changed after the product is 
booked and funded, you should only set up fees here that will not change over the life of the 
loan. Individual contract fee types may be defined multiple times in order to create graduated 
fees.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases, 
the contract fee, if present, is used first.

To set up the Fees

1. Click Setup > Setup > Administration > User > Products > Contract > Line > Fees.

2. In the Fees section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

Itemization 
Formula 

Select the itemization formula description from the drop-down list.

Refund 
Calculation 
Method

Check this box to enable Refund calculation Method.

Escrow 
Required 

If this is an escrow account, check this box to indicate that an 
escrow is required during the application process (though at that 
time the user can choose Opt Out to decline.)

Discount. Rate Specify the discount rate for the itemization.

Field: Do this:

Type Select the fee type from the drop-down list. 

Txn Amt From Specify the lowest transaction amount or balance amount against 
which this contract fee definition may be applied.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8 Edits

Edits ensure your organization’s guidelines are properly followed and that all exceptions are 
sent to the appropriate personnel to review.

You can configure your system so that during the origination process, at each change to an 
application’s status, the system will perform a set of edits on the Verification link’s Edits screen 
(found on the Application Entry, Underwriting, and Funding windows).

Edits ensure your organization’s guidelines are properly followed and that all exceptions are 
sent to the appropriate personnel to review. If the edits check fails, then the system will not 
allow the change of status, and the application will remain in its current status. This screen 
allows you to define the validations the system must perform on the Verification master tab, 
as the status of application changes.

Origination edits are used to validate applications entered through the standard Application 
Entry and Applications windows. The Edits screen contains two sections, the Edit Type 
Definition section and the Edit Sub Type Definition section. 

To set up the Edits

You can either define new Edit Type Definition details or specify a new name in the New Edit 
Type field and click Create Copy to create a copy of selected edit type definition with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Edits > Line.

2. On the Edits screen, choose Origination or Open Interface. 

Credit Limit 
From

Specify the minimum value of credit limit for the pricing.

Method Select the method of calculating the fee to be assessed from the drop-
down list.

Frequency Select the frequency of calculating the fee to be assessed from the 
drop-down list.

Min Amt Specify the minimum fee amount to be assessed.

Max Amt Specify the maximum fee amount to be assessed. If you selected 
FLAT in the Method field, then this field is not used and is normally 
populated as $0.00.

Percent Specify the fee percentage of the outstanding transaction amount to 
be assessed as a fee. This amount will be adjusted to fall within the 
Min Amount and the Max Amount.

Enabled Check this box to create the selected contract fee when the account is 
booked and funded.

Field: Do this:
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3. In the Edit Type Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Edit Specify the edit name.

Description Specify the description for the edit.

Edit Type Select the edit type code from the drop-down list.

System Defined Select ‘Yes’, if the entry is system defined. System defined entries 
cannot be modified. Select ‘No’, if the entry is not system defined 
and it can be modified.

Enabled Check this box to enable the edit.

Company
Select the portfolio company associated with this edit, from the 
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch within the company associated with this 
edit, from the drop-down list. This may be ALL or a specific 
branch. This must be ALL if you selected ALL in the Company 
field.

Channel Select the channel from the drop-down list, This can be ALL or a 
specific channel.

Product Select the product associated with this edit, from the drop-down 
list. This may be ALL or a specific product.

State Select the state with this edit from the drop-down list. This may be 
ALL or a specific product.
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4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Edit Sub Type Definition section, perform any of the Basic Operations mentioned 
in Navigation chapter.

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Using the Edit Type field of the Edit Type Definition section, you can define when you want 
the edits check to occur by selecting from the following list of edit types:

Currency Select the currency associated with this edit, from the drop-down 
list. This may be ALL or a specific branch.

Field: Do this:

Edit Sub Type Select the edit sub type for the edit, from the drop-down list.

Edit Select the description for the edit, from the drop-down list.

Result Select the result type for the edit, from the drop-down list.

Enabled Check this box to enable the edit.

Value Specify the expected value for the first edit. The Value field records 
the threshold value for the edit. The actual function of the entered 
value is dependent on the edit category.

Override 
Responsibility

Select the responsibility that can override the edit, from the 
drop-down list, if the edit result is an override. Designates the 
user responsibility level required to continue processing 
applications that fail the edit based on the Value field. You 
may define the same edit multiple times with a Result = 
OVERRIDE and different Value and Override Responsibility 
combinations to encompass various results.

System Defined Select ‘Yes’, if the entry is system defined. System defined entries 
cannot be modified. Select ‘No’, if the entry is not system defined 
and it can be modified.

Edit type: Description:

APP ENTRY 
EDITS 

Edits that normally run on Application Entry form.

APP 
PRESCREENIN
G EDITS 

Edits that run between application entry and the pulling of a 
credit bureau. These edits determine whether the application 
should be reviewed further, and whether a credit bureau should 
be pulled.

PRE Qualify 
Edits

Edits that run to check whether the minimum details which are 
required to prequalify the application are satisfied or not.

Field: Do this:
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Each entry in the Edit Sub Type field is grouped into the following categories:

Each entry in the Edit Sub Type field can be set up with more than one entry in the Description 
field. The purpose of specific edits fall into the following types:

APP 
AUTOMATIC 
APPROVAL 
EDITS

Edits that run after a credit bureau has been pulled and scored. 
These edits determine whether an application should be 
automatically approved or declined.

APP 
APPROVAL 
EDITS 

Edits that run whenever an application is manually 
changed to a status/sub status that indicates the application (in 
its current state) should be approved.

APP DECLINE 
EDITS 

Edits that run whenever an application is manually changed to 
a status/sub status that indicates the application (in its current 
state) should be declined.

APP 
CONTRACT 
EDITS 

Edits that run whenever an APPROVED or CONDITIONED-
APPROVED application is about to be funded. These edits 
ensure the validity of the contract data. 

Origination edit 
sub types:

Description

ORIGINATION 
APPLICANT EDITS 

Edits that pertain to data entered for an applicant on an 
application.

ORIGINATION 
APPLICATION 
EDITS 

Edits that pertain to data entered for the requested loan.

ORIGINATION 
ASSET EDITS 

Edits that pertain to data entered for asset entered on the 
application.

ORIGINATION 
CONTRACT EDITS 

Edits that pertain to data entered for the contract on the 
application.

ORIGINATION 
CREDIT BUREAU 
EDITS 

Edits that pertain to data gathered from the credit bureau 
reports for the applicants on the application.

ORIGINATION 
DECISION EDITS 

Edits that pertain to data required to make a decision on 
the application.

Description 
starts with:

(Edit Category) Description of Edit Category:

CHD: (RECORD POPULATION EDITS) Check for the existence 
of an entire data record.

DUPLICATE: (DUPLICATION EDITS) Check for duplication of existing 
data.

Edit type: Description:
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An Edits check can produce one of three results: an ERROR, a WARNING, or an OVERRIDE.

Note

Do not set the Result field to Override for credit application edits. 

RANGE: (VALUE RANGE/TOLERANCE EDITS) Check to determine 
whether data entered for a specific data field is within the 
specific tolerance.

REQUIRED: (REQUIRED FIELD EDITS) Check to determine whether a 
specific data field has been populated within a data 
record.

FLK: (LOOKUP VALUE EDIT) Check API entered data against 
the existence of that value in the related lookup types 
lookup codes.

XVL: (CROSS VALIDATION EDIT) Check to determine whether 
specific field, or set of fields, value corresponds to a value 
obtained by calculating them from another field or set of 
fields (for example, Total Payments = Terms * Standard 
payment amount).

Edit type: Results:

ERROR   The system will prevent you from proceeding when an edits 
check fails. The only option is to change the source data. The 
application will revert to its previous status/sub status. The user 
will be directed to correct the specific error. Until the edits that 
return an ERROR value are addressed, the user cannot 
continue processing the application.

Warning When an edits check fails in these cases, the system allows the 
process to continue. Warnings serve as informational messages 
and can be ignored. The user will be notified that an edit failed, 
but the failure need not stop the current processing of the 
application. The user can either ignore the error, or have the 
application revert to its previous status/sub status and address 
the error before processing the application further.

Override The edit check has failed; however, the system allows users 
with the responsibility specified in the Override Responsibility 
field to continue. Multiple override levels can be setup 
depending upon the resulting value of the edit. If the user has 
override responsibility, the application will process as if the edit 
had not failed. If the user does not have override responsibility, 
the application will revert to its previous status/sub status and 
the sub status changes to OVERRIDE REQUIRED. The system 
will then direct the application to a user with the authority to 
process the application. (See the Queues chapter for more 
information).

Description 
starts with:

(Edit Category) Description of Edit Category:
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4.8.1 Interfacing OFSLL with Oracle Rule Author

Oracle Business Rules is a component of Oracle Application Server that enables applications 
to rapidly adapt to regulatory and competitive pressures. This increased agility is possible due 
to the adoption of Oracle Rule author wherein a lending Institution can create or change a 
business rule without having to indulge in coding and also without stopping the business 
process. Also, externalizing business rules allows to manage business rules directly, without 
involving programmers. It provides best of breed solutions that would help in configuring the 
rules very quickly by a business analyst or user with some insight on the database.

4.9 Cycles

The Cycles screen allows you to define the origination workflow process of your organization. 
As you delineate the steps in the origination process, you will also define:

 The user responsibilities that have access to perform the steps

 Any edits you want the system to perform between changes in status/sub status. 

The following diagram displays the general concept of workflow:

Cycle code definitions drive the application cycle. The following pairs of status/sub status 
define status/sub statuses that have system defined meanings and should be included in your 
origination workflow, if they are not already included.

After entering the basic details of the applicant, you can check whether the application pre-
qualifies or not. If the pre-qualified edits are satisfied, the status is changed to NEW-
PREQUALIFY APPROVED and you can modify or update any further details in the 
Application Entry screen. If the edits are not satisfied, the application will be pushed to the 
REJECTED APPLICATIONS queue with a status update to REJECTED-PREQUALIFY 
REJECTED, then you can also view the rejected pre-qualification in the Underwriting window.
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Note

The system status and sub status lists are predefined and cannot be changed by the  ad-
ministrator. If you require additional sub status codes, please contact Oracle Financial Ser-
vices Software to determine whether they can be added.

Status/Sub 
status:

Description:

NEW-BLANK This is the status/sub status of applications during data entry. 
Applications remain NEW-BLANK until you choose the Next 
Application on the Application Entry form and the system 
successfully performs the application edits check.

NEW-
PRESCREEN

The system processes the prescreen edits to determine whether a 
credit report should be pulled for this application or not.

NEW-
PRESCREEN 
APPROVED

Applications in this status/sub status have passed the prescreen 
edits. The system will now request a credit bureau pull.

NEW-
PREQUALIFIC
ATION 

The system checks the applicant details whether it is qualified or not.

NEW-
PREQUALIFY 
APPROVED

If the pre-qualified edits are satisfied, the status is changed to NEW-
PREQUALIFY APPROVED and you can modify or update any further 
details in the Application Entry screen.

REJECTED-
PREQUALFY

REJECTED

 If the edits are not satisfied, the application will be pushed to the 
REJECTED APPLICATIONS queue with a status update to 
REJECTED-PREQUALIFY REJECTED.

REJECTED-
PRESCREEN 
REJECTED

Applications in this status/sub status failed the prescreen edits. These 
applications will receive no further processing. The producer will be 
sent a decision fax and the consumer will receive an adverse action 
letter.

NEW- REVIEW 
REQUIRED

Either based on the scoring of the application’s credit bureau(s) pull, 
or the fact that a credit bureau report was not successfully obtained, 
the application needs to be reviewed by an underwriter.

NEW- 
RECOMMEND 
APPROVAL

Based on the scoring of the application’s credit bureau(s) pull, the 
application should be reviewed by an underwriter. However, based on 
the current setup, the system recommends approving this application.

NEW- 
RECOMMEND 
REJECTION

Based on the scoring of the application’s credit bureau(s) pull, the 
application should be reviewed by an underwriter. However, based on 
the current setup, the system recommends rejecting this application.

APPROVED-
AUTO 
APPROVED

Based on the scoring of the application’s credit bureau(s) pull, the 
system automatically approves the application. The producer will be 
sent a decision fax, and the application will be passed to funding.

REJECTED-
AUTO 
REJECTED

Based on the scoring of the application’s credit bureau(s) pull, the 
system automatically rejects the application. The producer will be 
sent a decision fax and the consumer will receive an adverse action 
letter.
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APPROVED-
BLANK

Application has been manually approved. Normally this occurs when 
an application is in the NEW- RECOMMEND APPROVAL, NEW- 
RECOMMEND APPROVAL status/sub status, or less often in the 
NEW- RECOMMEND REJECTION status/sub status. Any cycle code 
definition with next values of APPROVED-BLANK should have a 
lookup value of APP APPROVAL EDITS to ensure that all of the 
required data has been gathered in making the decision to approve 
the application (unless the application is currently in a status/sub 
status that assures the APP APPROVAL EDITS have been run).

NEW-
OVERRIDE 
REQUIRED

A user without sufficient override authority attempted to approve an 
application, which, based on setup, required a higher over-ride 
authority to approve.

APPROVED- 
VERIFYING

Contract has been received from the producer.

APPROVED-
FINAL 
DOCUMENT 
CHECK

The contract has been reviewed and the data is correct. Normally this 
occurs when an application is in APPROVED-FINAL DOCUMENT 
CHECK OR CONDITIONED-FINAL DOCUMENT CHECK status/sub 
status. Any cycle code definition with next values of APPROVED-
FINAL DOCUMENT CHECK or CONDITIONED-FINAL DOCUMENT 
CHECK should have a value of APP CONTRACT EDITS to ensure that 
all of the required data has been gathered in making the decision to 
approve the application, unless the application is currently in a status/
sub status that assures the APP CONTRACT EDITS have run.

APPROVED-
VERIFIED

The application has been processed and is awaiting funding.

APPROVED-
FUNDED

The application has been funded, and a check requisition has been 
created. If  Customer Service form is being used, then an account is 
also created at this time.

REJECTED-
BLANK

The application for whatever reason is being manually rejected 
regardless of its current status/sub status. Any cycle code definition 
with Next values of REJECTED-BLANK should have a lookup value of 
APP DECLINE EDITS to ensure that all of the required data has been 
gathered in making the decision to approve the application (unless 
the application is currently in a status/sub status that assures the APP 
DECLINE EDITS have run).

WITHDRAWN-
BLANK

The applicants have indicated that they are no longer pursuing this 
loan.

CONDITIONED
-<ANY>

These status/sub status pairs are analogous to the corresponding 
APPROVED-<ANY> pair and indicate that the application has had 
additional conditions placed on its approval. 

<ANY>-<ANY 
OVERRIDE>

Requires OVERRIDE approval. The meaning of the sub status is 
analogous to the corresponding OVERRIDE sub status, and may 
require that specific EDITS run before proceeding.

<ANY>-AGED 
APPLICATION

These applications have been decisioned but no contract has been 
received after a period of time determined by setup. If not acted on, 
these applications will become VOID.

Status/Sub 
status:

Description:
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Using these status and sub status, let us re-examine the early workflow diagram in this 
section.

Note

It is extremely important that the APP CONTRACT EDITS run prior to an application being 
funded. All cycle code definitions should be reviewed to ensure that there are no paths 
through the origination cycle that bypass this EDIT type.

To set up the Cycles

1. On the Oracle Financial Services Lending and Leasing  home screen, click Setup > 
Setup > Administration > User > Products > Cycles > Line

<ANY>-AGED 
CONTRACT

Contracts have been received after a period of time determined by 
setup. If not acted on these applications will become VOID.

<ANY>-VOID Indicate application previously had a sub status of AGED CONTRACT 
or AGED APPLICATION. These applications have not been 
completed and were made VOID after another period of time had 
passed.

Status/Sub 
status:

Description:
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2. In the Cycle Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. In the Cycle Code Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Cycle Specify the cycle code.

Type Displays the cycle type.

Product Select the product from the drop-down list.

Field: Do this:

Current Code Select the current code to transition FROM, from the drop-down 
list.

Current Sub Code Select the current sub code to transition FROM, from the drop-
down list.

Next Code Select the current code to transition TO from the drop-down list.

Next Sub Code Select the next sub code to transition TO, from the drop-down list.

Origination Stage 
Code

Select the origination stage code of the application from the 
adjoining drop-down list.

Edit Type Select the edit type to associate to the cycles, from the drop-down 
list.
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4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Cycle Code Responsibility Definition section, you can define the responsibilities 
that are authorized to change the code. Perform any of the Basic Operations mentioned 
in Navigation chapter.

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.10 Scoring Models

The Scoring screen allows you to setup individual and multiple scoring models. You can 
define different scoring models by company, branch, currency and product. Scoring models 
are used to automate the decisioning process during underwriting and grade applications.

When you complete the Application Entry process, the system determines which scoring 
model to use by finding a best match. The system searches the Company, Branch, Currency 
and Product fields of all enabled scoring models that contain either the exact value on the 
application or ALL. (Exact matches for each field are given a higher weight than matches to 
ALL.) The system then ranks the returned matches in descending order, based on the 
weighted values and the hierarchical position of the field and then by Start Date. The system 
recognizes the first row returned as the best match. This scoring model information is then 
used to determine the next status and sub status of the application.

If you use a standard bureau score as a scoring model, you can set up the system to use the 
adverse action reasons provided by the standard bureau score on the Stipulations sub 
screen.

To set up the Scoring

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Scoring Models > Line. You can set the 
following categories of scoring models:

 Credit Score Models

4.10.1 Credit Score Models

You can either define new Credit Score Model or specify a new name in the New Credit 
Model field and click Create Copy to create a copy of selected score model with details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line > 
Credit Score Models.

Field: Do this:

Responsibility Select the responsibility that will be capable of executing this 
transition, from the drop-down list.

Allowed Select ‘Yes’ to allow change to the status responsibility and ‘No’ 
to disallow.
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 In the Score Models section, perform any of the Basic Operations mentioned in 
Navigation chapter.
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A brief description of the fields is given below:

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Parameters

The Parameters records the parameters used to determine the score calculated by the 
scoring model. You can define multiple parameters and adverse action reason associated 
with each parameter in a scoring model. Each scoring parameter can have maximum values 
set. The score range is based upon the information in the Range Definition section on the 
Parameters sub tab.

Field: Do this:

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model. You can even select the 
date from the adjoining Calendar icon.

End Dt Specify the end date for the scoring model. You can even select the 
date from the adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Results section

Max Score
Specify the maximum score allowed. (This is normally the sum of the 
Max Value fields within the scoring parameters.).

Selection Criteria section

Company
Select the company for the scoring model, from the drop-down list. 
This may be ALL or a specific company.

Branch Select branch within the company for the scoring model, from the 
drop-down list. (This may be ALL or a specific branch. However, if 
you have selected ‘ALL’ in Company field, then you must select ‘ALL’ 
for this field).

Product Select the product for the scoring model, from the drop-down list. 
This may be ALL or a specific product.

Currency Select the currency for the scoring model, from the drop-down list. 
This may be ALL or a specific currency.

Bureau Score 
Reasons

Check this box to use the score reasons supplied by the credit 
bureau. If unchecked, then automatically rejected applications 
scored using this scoring model display the Adverse Action Reasons 
from the Parameters sub screen.

Auto Decision Check this box to assign an application, a status/sub status based on 
the grade associated with the score returned for this scoring model. If 
not selected, the system assigns applications scored using this 
scoring model a status/sub status of NEW-REVIEW REQUIRED.
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The system calculates a final score by adding the score for each parameter in the scoring 
model. A parameter weighted value is used to find the four adverse action reasons, if bureau 
reasons are not used.

Note

– A character parameter range definition should contain the exact value of the 
parameter.

– Each scoring parameter should have range definitions defined that encompass all 
of the values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line > 
Credit Score Models > Parameters.

2. In the Parameters section, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Range Definition section allows you to translate the calculated value for a scoring 
parameter into the value to be used, depending on the returned value of the parameter

5. In the Range Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Parameter Select the parameter from the field, from the drop-down list.

Max Value Specify the maximum value allowed for the selected parameter.

Adverse Action 
Reason

Select the adverse action reason, from the drop-down list. (If, on the 
Scoring Models screen, the Bureau Screen check box is checked for 
the scoring model, you cannot update this field).

Weighted Value Specify the adverse action weighted value. This indicates the priority 
of this parameter when determining which adverse action reasons to 
use on the application. The top ten adverse action reasons based on 
the weighted value of the parameter will be populated.

Enabled Check this box to enable the parameter.

Field: Do this:

Value From Specify the lowest calculated value to apply the specific translation. The 
ceiling of the range definition is based on the range definition with the 
next highest Value From or the Max Value of the scoring parameter 
(whichever is less).
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6. Perform any of the Basic Actions mentioned in Navigation chapter.

Grades

The Grades sub screen allows you to define how the system translates the scoring model 
scores into your organization’s grade. The system uses these grades in the auto-decisioning 
process. Each grade has a specific status/sub status that informs the system what to do with 
the application of a particular grade as it continues through the origination cycle.

Note

Each scoring model should have grade definitions defined that encompass all of the val-
ues that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line > 
Credit Score Models > Grades.

2. In the Grade Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Value From Select the following options to determine how values for a scoring 
parameters are translated:

% Max Value – If selected, then the calculated values within the range 
definition receives a value based on a percentage of the Max Value of the 
scoring parameter.

% Param – If selected, then the calculated values within the range 
definition receives a value based on a percentage of the calculated value 
of the scoring parameter.

Value – If selected, then the calculated values with in the range definition 
receives a specific value.

Percent / 
Value

Specify the percent or value to be used in the translation of the calculated 
value of the scoring parameter.

Enabled Check this box to consider this range definition while translating values 
for this scoring parameter.

Field: Do this:

Score Specify the score the application receives.

Credit Grade Select the grade to assign to an application, from the drop-
down list.

Application 
Status

Select the status to assign to applications with a score 
starting with the value of this grade definition, from the drop-
down list.

Field: Do this:
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.11 Fees

The Fee screen allows you to define fees that may be automatically assessed by the system. 
The Fee Definition section records fees not defined within the Contract screen’s Fees sub 
screen.

The following fee types are currently supported for automatic assessment:

 Late charge

 NSF

 Extension

 Advance

 Over Credit Limit

 Membership

 Prepayment penalty

 Phone Pay

 Payoff Quote

 Periodic Maintenance

 Rental Fee 

 ACH Fee

 Delay Fee

 Other Fee and Tax

Fees can be calculated as either a flat amount or a percentage of payment due based on fee 
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt 
fields. Different fee rules can be setup at the company/branch level. 

When Fees are assessed, the system determines the best match using all enabled fee 
definitions that meet the following criteria:

Sub Status Select the sub status to assign to applications with a score 
starting with the value of this grade definition, from the drop-
down list.

Credit scoring allows you to select the following status/sub 
status pairs:

APPROVED - AUTO APPROVED

REJECTED - AUTO REJECTED

NEW - REVIEW REQUIRED

NEW - RECOMMEND APPROVAL

NEW - RECOMMEND REJECTION.

Enabled Check this box to indicate that this grade definition will be 
considered when grading an application using this scoring 
model.

Field: Do this:
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 Exactly match the fee type being assessed.

 Have an effective date that is greater than or equal to the start date.

 Have a Txn Amt From that is greater than or equal to the outstanding amount related to 
the fee assessment.

 Match either the value or ALL for all other criteria (Exact matches for each field are 
given a higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the 
hierarchical position of the following criteria:

1. Company

2. Branch

3. Product

4. Application state

5. Transaction amount

6. Start date

7. End date

8. Currency

On the ranked rows, the first row is returned as the best match.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases, 
the contract fee, if present, is used first. Only if the contract fee is not present in the state 
fee used.

To set up the Fee

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Fees > Line.

2. In the Fee Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.      
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A brief description of the fields is given below:

Field: Do this:

Fee Rule Specify the fee rule used to identify the particular fee definition.

Fee Type Select the fee type from the drop-down list. The system computes 
these drop-down values from the TXN_TYPE_CD Lookup, with FEE 
as the sub type.

Start Dt Specify the start date. You can even select the date from the 
adjoining Calendar icon.

End Dt Specify the end date. You can even select the date from the 
adjoining Calendar icon.

Enabled Check this box to enable the fee.

Calc Method Select one of the following method of calculating the fee, from the 
drop-down list.

If ‘Flat Amount' is selected, then minimum fee will be charged.

If ‘Percentage’ is selected, then the amount charged will be based 
on percentage defined subject to minimum and maximum amount 
(i.e. 'Txn Amt From').

Min Amt Specify the minimum amount for the fee.

Max Amt Specify the maximum amount for the fee. If you selected FLAT 
AMOUNT in the Calc Method field, then this field is not used and is 
normally populated as $0.00.

Percent Specify the percentage value of the outstanding transaction amount 
to be assessed as a fee. This amount will be adjusted to fall within 
the Min Amount and the Max Amount.

Selection Criteria section

Company Select the portfolio company from the drop-down list. This may be 
ALL or a specific company.

Branch Select the portfolio branch from the drop-down list. This may be ALL 
or a specific branch. (This must be ALL, if you have selected ‘ALL’ in 
the Company field).

Channel Select the channel from the drop-down list, This can be ALL or a 
specific channel.

Product Select the product from the drop-down list. This may be ALL or a 
specific product. The available values come from a validated field 
based on the selected Billing Cycle setup and the Product setup.

State Select the state for this fee, from the drop-down list. This may be 
ALL or a specific state.

Currency Select the currency for this fee, from the drop-down list. This may be 
ALL or a specific currency.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.12 Origination Fees

The system supports the auto computation of origination itemized fees. System 
administrators can define and maintain the itemization formula on the Origination Fees 
screen.

An itemization formula can be set up as a computation of other itemizations (such as adding 
or subtracting one itemization from another) and can consist of multiple itemizations. An 
itemization formula will have a minimum and maximum value. You can set up a formula value 
range to be used as the final value. 

Itemizations are linked to a product with the Products screen’s Product Itemizations subtab.

One itemization can be based on one formula, while the same formula can be attached to 
multiple itemizations. If a formula is attached to a contract itemization and that formula 
requires an itemization not present in Formula Definitions screen, then the system displays 
an error message.

The system will search for any “circular dependency” at the time the contract is enabled. An 
example of a circular dependency is when Itemization1 has Formula1 attached requiring 
Itemization2 for computation and Itemization2 has Formula2 attached requiring Itemization1 
for computation.

To set up the Origination Fees

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Origination Fees > Line.

Txn Amt 
From

Specify the transaction or balance amount. The fee is calculated 
using the specifications of this record only if the transaction amount 
is greater than the value specified in this field (and less than this 
field in another record for the same fee).

IMPORTANT:

 When you select the fee to use, the system searches for a best 
match using the following attributes:

1 Company

2 Branch

3 Product

4 State

5 Amount (Txn Amt From)

6 Effective/start date (Start Dt)

Hence, Oracle Financial Services Software recommends creating a 
version of each fee, where ALL is the value in the these fields.

It is also recommended that you define a default printer for an 
Organization, Division and Department.

Credit Limit 
From

Specify the minimum value of credit limit for the pricing.

Field: Do this:
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2. In the Formula Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter. 

3. A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Formula Details section of Setup > Setup > Administration > User > Products > 
Origination Fees > Line > Detail, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Formula   Specify the formula code to define computation.

Description   Specify the description for the formula.

Min Amt Specify the minimum value that should be considered to compute the 
final value of formula.

Max Amt Specify the maximum value that should be considered to compute the 
final value of formula.

Enabled Check this box to allow the origination fees.

Field: Do this:

Itemization Select the itemization based on which the itemization formula will derive 
its computed value, from the drop-down list.

Percentage   Specify the percentage value that should be considered while 
computing value for itemization formula.
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6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Range Details section of Setup > Setup >  Administration > User > Products > 
Origination Fees > Line, perform any of the Basic Operations mentioned in Navigation 
chapter.

A brief description of the fields is given below:

8. Perform any of the Basic Actions mentioned in Navigation chapter.

4.13 Insurance

Most financial institutes offer financing for insurance to the borrowers; examples include credit 
life, credit disability, and GAP. The insurance product offer permits the customer to cancel the 
insurance in mid term or automatically end when the product matures or is paid-off. The 
system supports financing of insurance products during origination and automatically end the 
insurance when the product is paid-off. The system also can compute the rebate premium 
based on “Rule of 78” or “Actuarial” method.   As the customer might cancel the insurance in 
mid term of the loan, the system computes the premium rebate on a prorate basis. This also 
applies to additional insurance purchase during the life of the loan. Normally, mid term 
insurance cancellations have associated fees and grace period. In such cases, the customer 
may cancel the insurance during the grace period without accruing any fees. However, when 
a customer cancels after the grace period, the result is a predefined fees which the system 
deducts from the computed rebate.

The system supports mid term insurance cancellation with and without grace period and 
cancellation fees. With this enhancement of insurance processing, you can define the 
premium rebate computation with a prorate basis.

You can define financed insurance related itemizations in the Origination Fees screen, as you 
have in previous releases with the Insurance screen. You can also set the refund method to 
“Pro Rate Basis” in the Refund Method field in the Contract Itemization section on the 
Itemization sub screen during setup with the on the Contracts screen.

Sort   Specify the sort sequence for the itemization to be considered while 
computing the value of the itemization formula.

Sign Select the +ve or -ve sign that needs to be considered between two 
itemizations for computing the value of the itemization formula.

Enabled Check this box to allow the itemization details to be used by the system.

Field: Do this:

Amt From   Specify the value up to which the percentage of final value of the 
itemization formula to be considered for the final value of itemization 
formula.

Percent   Specify the percentage value that should be considered while computing 
the value for the final value of the itemization formula.

Enabled Check this box to allow the range details to be used by the system.

Field: Do this:
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To set up the Insurances

You can either define new Insurance details or specify a new code in the New Insurance field 
and click Create Copy to create a copy of selected insurance with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > 
Setup > Products > Insurance > Line.

2. In the Insurance Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code   Specify the code associated with the insurance product.

Description   Specify a brief description of the insurance product.

Start Dt   Specify the date from which you can start offering the product to 
customers. You can even select the date from the adjoining Calendar 
icon.

End Dt   Specify the date from which to stop offering the product to customers. 
You can even select the date from the adjoining Calendar icon.

Enabled   Check this box to allow the offering of this insurance product.

Result section

Insurance 
Type   

Select the insurance types available for financing, from the drop-down 
list.

Insurance 
Company

Specify the name of the company through which the insurance product is 
offered.

Calculation 
Method

Select the insurance calculation method from the drop down list.

Max Age Enter the maximum age allowed by the insurance.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click ‘Create Copy’ button in the Insurance Definition section to create copy of selected 
record with details.

5. In the Insurance Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Cancellation 
Allowed

Check this box to allow the insurance rebate or refund for cancellation or 
paid-off.

Grace Days   Specify the number of grace days allowed for cancellation without 
charging a cancellation fee.

Tier Select the tier from the drop-down list.

Base Select the base from the drop-down list.

Category Select he category from the drop-down list.

Days Enter the number of category days.

Selection Criteria Section

Company   Select the portfolio company that can offer the insurance product, from 
the drop-down list. Select ALL if offered by all companies.

Branch   Select the branch of the specified portfolio company that can offer the 
insurance product, from the drop-down list. Select ALL if offered by all 
the branches of the specified portfolio company.

Product   Select the product for which you can offer the insurance product, from 
the drop-down list. Select ALL if offered for all the products.

State   Select the state for which you can offer the insurance product, from the 
drop-down list. Select ALL if this is offered for all the states.

Currency   Select the currency for which you can offer the insurance product, from 
the drop-down list. Select ALL if this is offered for all the states.

Field: Do this:

Insurance 
Sub Type   

Select the insurance sub type you want to define for the entry in the 
Insurance section, from the drop-down list. For example SINGLE.

Term From Specify the minimum term for the insurance sub type.

Rate   Specify the rate for premium calculation per $1,000.00 for the insurance 
sub type.

Max 
Coverage 
Amt   

Specify the maximum coverage amount covered by the insurance sub 
type.

Enabled Check this box to enable the insurance.

Field: Do this:
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4.14 Checklists

A checklist is an optional set of steps to follow when completing a task in the system, such as 
the underwriting and funding processes. 

Checklists can be used as guidelines to help ensure that the system users follow your 
business’s standard operating procedures and enter all required data. Some checklists are 
optional, but others such as those related to application decisions or contract verification, may 
be required depending on the edit sets defined in your system. The Checklists screen allows 
you to specify the contents of the checklist.

You can define additional checklists for your organization. You can set up multiple checklists 
for a single type of checklist. These checklists can be differentiated by:

 Company 

 Branch

 Product

 Account state

To set up the Checklists

You can either define new Checklist Type Definition details or specify a new code in the New 
Checklist field and click Create Copy to create a copy of selected checklist type definition 
with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Checklists > Line.

2. In the Checklist Type Definition section, perform any of the Basic Operations mentioned 
in Navigation chapter.
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3. A brief description of the fields is given below:

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Checklist actions are steps (a set of one or more tasks) related to the checklist you are 
creating. They are loaded on the Checklist Action Definition section.

5. In the Checklist Action Definition - Regular section, perform any of the Basic Operations 
mentioned in Navigation chapter

A brief description of the fields is given below:

Field: Do this:

Checklist Code Specify the checklist code that identifies checklist being defined.

Description Specify the description for the checklist.

Checklist Type Select the checklist type from the drop-down list, to define where the 
specific checklist will be available in the system.

Company Select the portfolio company associated with the checklist from the 
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch associated with the checklist from the 
drop-down list. This may be ALL or a specific branch. This must be 
ALL if in the Company field you selected ALL).

Channel Select the channel from the drop-down list, This can be ALL or a 
specific channel.

Product Select the product associated with the checklist from the drop-down 
list. This may be ALL or a specific product. The available values 
come from a validated list based on the selected Billing Cycle setup 
and the Product setup.

State Select the state associated with the checklist type from the drop-down 
list. This may be ALL or a specific state.

IMPORTANT: By selecting which edits type to use, the system 
searches for a best match using the following attributes:

1 Company

2 Branch

3 Product

4 State

Hence, Oracle Financial Services Software recommends creating one 
version of each checklist type where ALL is the value in these fields.

Currency Select the currency associated with the checklist from the drop-down 
list. This may be ALL or a specific currency.

Enabled Check this box to enable the checklist.

Field: Do this:

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.
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6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Checklist Action Definition - Document section, perform any of the Basic 
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

8. Perform any of the Basic Actions mentioned in Navigation chapter.

4.15 Stipulations

The system supports the automatic generation of default stipulations for loans during 
origination on the Underwriting window’s Stipulation sub screen (Decision link). The default 
stipulations can be maintained by company, branch, product, state, application status and 
application sub-status on the Stipulations screen. 

To set up the Stipulations

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Stipulations > Line.

Sort Specify the sort order to define the placement of the action type on the 
Checklist sub screen.

Enabled Check this box to include this action in the checklist.

Field: Do this:

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.

Document 
Type

Select the document type from the drop-down list.

Document 
Sub Type

Select the document sub type from the drop-down list.

Document 
Mandatory

Check this box to indicate that the document is mandatory.

Sort Specify the sort order to define the placement of the action type on the 
Checklist sub screen.

Enabled Check this box to include this action in the checklist.

Field: Do this:
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2. In the Stipulation Setup section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Stipulation Details section, perform any of the Basic Operations mentioned in 
Navigation chapter.

Field: Do this:

Company Select the portfolio company associated with the default stipulations, 
from the drop-down list.

Branch Select the portfolio branch associated with the default stipulations, from 
the drop-down list.

Product Select the product associated with the default stipulations, from the 
drop-down list.

State Select the state associated with the default stipulations, from the drop-
down list.

Currency Select the currency associated with the default stipulations, from the 
drop-down list.

Application 
Status

Select the application status associated with the default stipulations, 
from the drop-down list.

Application 
Sub-Status

Select the application sub status associated with the default stipulations, 
from the drop-down list.

Enabled Check this box to allow the default stipulations to be used.
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A brief description of the fields is given below:

5. Perform any of the Basic Actions mentioned in Navigation chapter.

4.16 Letters

The Letters screen allows you to define letters that the system automatically generates when 
the application or the account for a products meets certain conditions, or “trigger events.” 
Each letter has its own trigger event. For example, you can configure the system to 
automatically send a welcome letter when an application becomes an account or send a 
collection letters when an account becomes delinquent. 

The system supports the following types of letters:

Field: Do this:

Stipulations Select the stipulation from the drop-down list.

Sort Specify the sort sequence for the stipulation.

Enabled Check this box to allow the stipulations details to be used by 
the system.

Type of letter: Definition:

ACCOUNT 
STATEMENT

Generated when account is to receive a billing statement (this time is 
defined in contract setup). Letter is sent to customer.

ADVERSE 
Action letter

Generated in nightly batch jobs for applications that were declined. 
This letter is sent to the consumer to indicate the reasons why the 
application was declined. 

CONDITIONAL 
ADVERSE 

Generated in nightly batch jobs for applications that were

ACTION 
LETTER 

declined. This letter is sent to the consumer to indicate the reasons 
why the application was declined. This letter also indicates steps that 
the consumer may take to gain approval of the application.

COLLECTION 
LETTER 1 

Generated when an account becomes delinquent. This is the first 
dunning letter sent to the customer.

COLLECTION 
LETTER 2

Generated when an account remains in delinquency for an extended 
period. This is the second dunning letter sent to the customer.

COLLECTION 
LETTER 3 

Generated when an account remains in delinquency for an extended 
period, even after having received previous notices. This is the final 
dunning letter sent to the customer.

CONTRACT 
FUNDING fax/
email

Generated when an application is APPROVED: FUNDED or 
CONDITIONED: FUNDED. This letter is sent to the producer.

DECISION FAX/
EMAIL 

Generated when an application is APPROVED, CONDITIONED, or 
REJECTED. This letter is sent to the consumer or producer, 
depending on whether the product is a direct or in-direct loan.

PAID IN FULL 
LETTER 

Generated in nightly batch jobs when the account pays off. This letter 
is sent to the customer.
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When the system generates letters, it searches the Letters screen for letter definitions that 
meet the following criteria:

 Definition is enabled.

 Definition is an exact match of the letter code being generated.

 Definition is a match of either the application/account value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the 
hierarchical position of these fields:

1. Company

2. Branch

3. Product

4. State

5. Currency

On the ranked rows, the first row is returned as the best match.

To set up the Letters

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Letters > Line.

PAYOFF 
QUOTE 
LETTER

Generated when a payoff quote is created for an account. This letter 
is sent to the customer.

WELCOME 
LETTER 

Generated when an application is APPROVED: FUNDED. This letter 
is sent to the consumer.

STATEMENT PAST MATURITY   Generated when an accounts are 
matured but unpaid.

This letter is sent to the account holders as a reminder to make their 
payments.

Type of letter: Definition:
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2. In the Letter Definition section, perform any of the Basic Operations mentioned in 
Navigation chapter.      

A brief description of the fields is given below:

Field: Do this:

Letter Code Specify the code for the letter.

File Name Specify the file name of the Oracle report used to generate the letter. 
The file should be named <File Name>.rep on your server.

Letter Type Select the type of letter you want to generate from the drop-down list.

Channel Select the application source (channel) for the letter from the drop-down 
list. This may be ALL or a specific channel.

Enabled Check this box to enable this letter definition.

Result section

Batch Printer Select the batch printer being used to generate the letter from the drop-
down list.

Batch User Select the user who will submit this letter from the drop-down list. This 
will normally be set to BATCH.

Selection Criteria section

Company Select the portfolio company for which this letter will be used from the 
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch for which this letter will be used from the 
drop-down list. This may be ALL or a specific branch. This must be ALL 
if in the Company field you selected ALL).
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.17 Promotions

The Introductory tab of Promotions screen allows you to set up the promotions that a financial 
institution can offer its customers. Promotion details defined here can be selected during 
Application Entry and Application processing.

You can define multiple promotions for a product, then select the appropriate promotion at the 
time the application is processed. Promotions also serve as a selection criteria on the Pricing 
screen.

CAUTION: The system supports promotions selected only when a product is funded.

Same as Cash promotions

In the case of the same as cash promotion:

 If the outstanding amount at the end of the promotional period is within the tolerance 
amount, then the customer receives the full benefit of the promotion and the system will 
not charge any interest on the borrowers’ account. 

 If the outstanding amount is higher than the authorized tolerance amount, then the 
customer loses the benefit of the promotion and the system computes and charges the 
borrower interest from the date the product was funded.

Interest & Payments 

Interest still continues to accrue for a account that is funded using the SAME AS CASH 
promotion. However, the interest accrued during the promotion period is not charged or 
collected on the account until the end of the promotion period.

Any repayment made by the customer during the promotion period is applied towards the Line 
receivables amount. The system then calculates the interest accrual using the reduced Line 
receivables amount, if applicable.

If the product remains unpaid after the end of the promotion period and the Line receivables 
balance is above any stated tolerance amount, then the system starts collecting interest 
earned and accrued during the promotion period. 

Reduced Rate Introductory Promotions

Oracle Financial Services Lending and Leasing’s promotion method PROMOTIONAL RATE 
allows you to create and specify promotions where customers can be charged lower interest 
rates during a specific promotional period of time. You may define the length of the promotion 
in either terms or days. Also, you will be able to set the specific interest rate you want to attach 
to the promotion. During the promotional period, interest on an account is accrued at the 
promotional rate. When the promotional period expires, the system changes the interest rate 

Product Select the product for which this letter will be used from the drop-down 
list. This may be ALL or a specific product.

State Select the state for which this letter will be used from the drop-down list. 
This may be ALL or a specific state.

Currency Select the currency for which this letter will be used from the drop-down 
list. This may be ALL or a specific currency.

Field: Do this:
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of the product to the contractual interest rate to accrue interest. The promotion expires on the 
promotion end date defined by the length of the promotion. However, the system allows you 
to set a grace period for extending the automatic cancellation of the promotion due to 
delinquency, similar to the grace period associated with a payment date.

To set up the Line Introductory

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Promotions > Line Introductory.

2. In the Promotion Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

A brief description of the fields is given below:

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup 
> Administration > User > Products > Promotions > Line Incentive.

Field Do this

Code Specify the code identifying the promotion.

Description Specify a description of the promotion being offered.

Type Select the promotion type from the drop-down list. Oracle Financial 
Services Lending and Leasing supports the following promotion types 
for lines of credit:

NO PAYMENT DUE ANY INTEREST DUE (No payments are required 
and no interest is accrued on the outstanding accrual balances for “x” 
terms).

Term Select the promotion term from the drop-down list.

Index Select the promotion index from the drop-down list.

Margin Specify the promotion margin rate.

Cancel Delq 
Days

Specify the promotion cancellation delinquency days.

Cancel Over-
limit%

Specify the promotion cancellation over limit percentage.

Enabled Check this box to enable the promotion.
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5. In the Promotion Definitions section, perform any of the Basic Operations mentioned in 
Navigation chapter.

6. A brief description of the fields is given below.

Field: Do this:

Code Specify the code identifying the promotion.

Description Specify a description of the promotion being offered.

Start Date Select the start date from the drop-down list.

End Date Select the end date from the drop-down list.

Enabled Check this box to enable the promotion.

Result section

Type Select the promotion type from the drop-down list.

Term Specify the promotion term .

Index Select the promotion index from the drop-down list.

Margin Specify the promotion margin rate.

Cancel Delq 
Days

Specify the promotion cancellation delinquency days.

Cancel Over-
limit%

Specify the promotion cancellation over limit percentage.

Selection Criteria section

Company Select the portfolio company from the drop-down list.
4-61



7. Perform any of the Basic Actions mentioned in Navigation chapter.

    

Branch Select the portfolio branch from the drop-down list.

Product Select the product from the drop-down list.

State Select the state from the drop-down list.

Field: Do this:
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Appendix A: Summary of the Application Credit
Scoring Parameters

A.1 Glossary

A.2 Credit Scoring Parameters by Category

A.2.1 Applicant Details / Debt Ratios

A.2.1.1 Applicant Credit Bureau Auto Debt Ratio

This is the sum of all automobile type line of credit balances and the sum of all automobile 
type credit limits. For installment line of credit, the credit limit is normally equal to the original 
line of credit amount. This applies to open tradelines only. 

A.2.1.2 Applicant Credit Bureau Bank Debt Ratio

This is the sum of all bank type line of credit balances and the sum of all bank type credit limits. 
For installment line of credit, the credit limit is normally equal to the original line of credit 
amount. This applies to open tradelines only.

A.2.1.3 Applicant Credit Bureau Card Debt Ratio

This is the sum of all travel card type line of credit balances and the sum of all travel card type 
credit limits. This applies to open tradelines only.

Term Description

DEROG / DEROGATORY Account has had chargeoffs, collections, bankruptcy, or 
repossession.

MINOR DELINQUENCY Less than or equal to 60 days delinquent.

MAJOR DELINQUENCY Greater than 60 days delinquent.

DEBT RATIO Debt / Available credit.

DEBT TO INCOME RATIO Debt / Income.

“APPLICANT STATED” Parameter is pulling information stated or in any other way 
provided by the applicant on the application on the Applica-
tion Entry form in the system.

“APPLICANT CREDIT 
BUREAU”

Parameter is pulling information from the credit bureau, as 
opposed to another source, such as the Application Entry 
form.

LOAN FINANCE Refers to companies that provide the loan but are not sell-
ing the actual object financed, if any. 

Example: An independent auto finance company.

SALES FINANCE Refers to companies that provide the object being financed 
in addition to the financing. 

Example: Marshall Fields card.
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A.2.1.4 Applicant Credit Bureau Debt Ratio

This parameter provides a value for all debt divided by all available credit as shown on the 
bureau.

A.2.1.5 Applicant Credit Bureau FICO Score

This is the FICO score provided for the applicant in the bureau pull. There are usually several 
different types of FICO scores available at the bureau. The different score models are set up 
to give certain attributes different, weighting based on if the person is buying a car, or a house, 
and so on. The type of FICO score pulled is based on credit bureau setup.

A.2.1.6 Applicant Credit Bureau Inst Debt Ratio

This is the sum of all installment line of credit balances and the sum of all installment line of 
credit credit limits. For installment line of credit, the credit limit is normally equal to the original 
line of credit amount. This applies to open tradelines only.

A.2.1.7 Applicant Credit Bureau credit Fin Debt Ratio

This is the sum of all line of credit finance type lease balances and the sum of all line of credit 
finance type credit amount limits. For installment credit amount lease, the credit limit is 
normally equal to the original line of credit amount. This applies to open tradelines only.

A.2.1.8 Applicant Credit Bureau Mortgage Debt Ratio

This is the sum of all mortgage type line of credit balances and the sum of all mortgage type 
credit limits. For installment line of credit, the credit limit is normally equal to the original credit 
amount. This applies to open tradelines only.

A.2.1.9 Applicant Credit Bureau Open Public Records

This parameter indicates if there are any open public records in the credit bureau associated 
with the applicant. This is a numeric counter covering the full period of time available in the 
bureau. 

A.2.1.10 Applicant Credit Bureau Public Records

This parameter indicates, if there are any public records, open or closed, in the credit bureau 
associated with the applicant. This is a numeric counter covering the full period of time 
available in the bureau.

A.2.1.11 Applicant Credit Bureau Retail Debt Ratio

This is the sum of all retail type line of credit balances divided by the sum of all retail type credit 
limits. For installment line of credit, the credit limit is normally equal to the original line of credit 
amount. This applies to open tradelines only. This is expressed as a percent: 50% shows as 
50.

A.2.1.12 Applicant Credit Bureau Rev Debt Ratio

This is the sum of all revolving type line of credit balances and the sum of all revolving type 
credit limits. This applies to open tradelines only. This is expressed as a percent: 50% shows 
as 50.

A.2.1.13 Applicant Credit Bureau Sales Fin Debt Ratio

This is the sum of all sales finance type line of credit balances and the sum of all sales finance 
type credit limits. For installment line of credit, the credit limit is normally equal to the original 
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line of credit amount. This applies to open tradelines only. This is expressed as a percent: 
50% shows as 50.

A.2.1.14 Applicant Debt Ratio Stated After Requested credit Amount

This is the debt divided by available credit based on the values stated by the applicant after 
factoring in the requested credit amount- this information is not taken from the bureau. This is 
expressed as a percent: 50% shows as 50.

A.2.1.15 Applicant Debt Ratio Stated Before Requested credit Amount

This is the debt divided by available credit based on the values stated by the applicant before 
factoring in the requested credit amount- this information is not taken from the bureau. This is 
expressed as a percent: 50% shows as 50.

A.2.1.16 Applicant Debt To Income Ratio Stated After Requested credit Amount

This is the debt divided by income based on the values stated by the applicant after factoring 
in the requested credit amount- this information is not taken from the bureau. This is 
expressed as a percent: 50% shows as 50.

A.2.1.17 Applicant Debt To Income Ratio Stated Before Requested credit Amount

This is the debt divided by income based on the values stated by the applicant before factoring 
in the requested credit amount- this information is not taken from the bureau. This is 
expressed as a percent: 50% shows as 50.

A.2.1.18 Applicant Payment To Income Ratio Stated

This is the total amount of all monthly payments divided by monthly income. These values are 
stated by the applicant and not taken from the bureau. This is expressed as a percent: 50% 
shows as 50.

A.2.1.19 Applicant Prior Customer

This parameter indicates whether the applicant is a prior customer. It is populated when the 
application is passed to Underwriting for a decision. If the SSN given by the applicant already 
exists then the applicant is marked as a prior customer and the parameter value is Y (Yes).

A.2.1.20 Applicant Revolving Debt Ratio Stated

This is the sum of all revolving type line of credit amount balances / sum of all revolving type 
credit limits. This applies to open tradelines only. This is expressed as a percent: 50% shows 
as 50.

A.2.1.21 Applicant Stated Employment Period (In Months)

This parameter looks at the number of months of stated employment for the most recently 
entered current employment. 

For example, the applicant states that she has been working at her current place of 
employment for 3 years and 5 months. This parameter would be populated with (3years * 12 
months/year) + 5 months which calculates to 41 stated months. If the applicant enters another 
current employment and enters 1 year and 2 months then this parameter will be populated 
with 14 months, even though the other employment is still current.
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A.2.1.22 Applicant Stated Monthly Income

This is the monthly income stated by the applicant on the application. It combines the income 
for all employment marked as “current” in the system. If the income is stated as anything other 
than monthly, the income will be converted to monthly for this parameter. 

For example, the applicant states that he is paid $50,000 with a frequency of ANNUALLY. 
This parameter is populated with $50,000/12, which calculates to $4166.67 stated monthly 
income.

A.2.1.23 Applicant Stated Monthly Liability

This is the stated monthly liability as provided by the applicant on the Application Entry 
screen. 

A.2.1.24 Applicant Stated Residence Period (In Months)

This parameter looks at the stated residence period for the most recent current address.

A.2.2 Line of Credit Details

A.2.2.1 Approximate Cash Price

This is the Approximate Cash price taken from the “Approx Price” field on the Application 
Entry form’s Line of Credit screen in the system.

A.2.2.2 Requested Advance Amount

This is the Requested Advance Amount value taken from the Application Entry form’s Line of 
Credit screen in the system.

A.2.3 Auto Trades / Inquiries

A.2.3.1 Applicant Credit Bureau 6month Auto Trades

This is the number of auto trades that have been opened in the last 6 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

A.2.3.2 Applicant Credit Bureau 12month Auto Trades

This is the number of auto trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.3.3 Applicant Credit Bureau 24month Auto Trades

This is the number of auto trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.3.4 Applicant Credit Bureau Auto Inquries

This is the number of automobile-related credit inquiries the have been made to the bureau.

A.2.3.5 Applicant Credit Bureau Auto Trades

This is the number of auto trades, both open and closed. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.
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A.2.3.6 Applicant Credit Bureau Current Auto Trades

Total number of auto trades that are paid on time right now. These trades may or may not 
have been delinquent in the past.

A.2.3.7 Applicant Credit Bureau Open Auto Trades

This is the number of open auto trades on the account. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.3.8 Applicant Credit Bureau Satisfactory Auto

Total number of auto trades paid as agreed (no delinquencies) for the entire life of the trade. 
This could be a few months or several years- the parameter makes no distinction.

A.2.3.9 Applicant Credit Bureau Worst Auto Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.4 Bank Trades / Inquiries

A.2.4.1 Applicant Credit Bureau 12month Bank Trades

This is the number of bank trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.4.2 Applicant Credit Bureau 24month Bank Trades

This is the number of bank trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.4.3 Applicant Credit Bureau 6month Bank Trades

This is the number of bank trades that have been opened in the last 6 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.
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A.2.4.4 Applicant Credit Bureau Bank Inquiries

This is the number of bank inquiries against the bureau in the applicant's recorded bureau 
history.

A.2.4.5 Applicant Credit Bureau Bank Trades

This is the number of open bank trades on the account. Note that bank trades can be 
considered a sub type to installment, mortgage, and / or revolving line of credit.

A.2.4.6 Applicant Credit Bureau Bank Trades

Total number of bank trades that are paid on time right now. These trades may or may not 
have been delinquent in the past.

A.2.4.7 Applicant Credit Bureau Bank Trades

This is the number of bank trades that are open right now. Note that these trades may now 
be open or closed, paid as agreed, delinquent, or derogatory, and so on.

A.2.4.8 Applicant Credit Bureau Bank Trades

This parameter shows the “current” revolving bank balance. If the revolving credit is owned 
by a bank, then it will show up here.

A.2.4.9 Applicant Credit Bureau Bank Trades

This parameter shows the highest cumulative balance among all revolving bank credit over 
the bureau history. 

NOTE

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account 
4 years ago, this parameter would return $15,000. The parameter is of questionable utility 
in many situations.

A.2.4.10 Applicant Credit Bureau Bank Trades

Total number of bank trades paid as agreed (no delinquencies) for the entire life of the trade. 
This could be a few months or several years- the parameter makes no distinction.

A.2.4.11 Applicant Credit Bureau Bank Trades

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late
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7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.5 Card Trades / Inquiries

A.2.5.1 Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.5.2 Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.5.3 Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 6 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

A.2.5.4 Applicant Credit Bureau Bank Trades

This is the number of card inquiries that have been made against the bureau for the applicant 
in the bureau's recorded history. 

A.2.5.5 Applicant Credit Bureau Card Trades

This is the number of card trades, both open and closed, in the bureau history. Note that these 
trades may be paid as agreed, delinquent, derogatory, and so on. The parameter makes no 
distinction.

A.2.5.6 Applicant Credit Bureau Current Card Trades

Total number of card trades that are paid on time right now. These trades may or may not 
have been delinquent in the past.

A.2.5.7 Applicant Credit Bureau Open Card Trades

This is the number of open card trades on the account. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.5.8 Applicant Credit Bureau Satisfactory Card

Total number of card trades paid as agreed (no delinquencies) for the entire life of the trade. 
This could be a few months or several years- the parameter makes no distinction.

A.2.5.9 Applicant Credit Bureau Worst Card Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current
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2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.6 Installment Trades / Inquiries

A.2.6.1 Applicant Credit Bureau 12month Inst Trades

This is the number of installment trades that have been opened in the last 12 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.6.2 Applicant Credit Bureau 24month Inst Trades

This is the number of installment trades that have been opened in the last 24 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.6.3 Applicant Credit Bureau 6month Inst Trades

This is the number of installment trades that have been opened in the last 6 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.6.4 Applicant Credit Bureau Current Inst Trades

Total number of installment trades that are paid on time right now. These trades may or may 
not have been delinquent in the past.

A.2.6.5 Applicant Credit Bureau Inst Trades

This is the number of installment trades, both open and closed. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.6.6 Applicant Credit Bureau Open Inst Trades

This is the number of open installment trades on the account. Note that these trades may be 
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.6.7 Applicant Credit Bureau Satisfactory Inst Trades

Total number of installment trades paid as agreed (no delinquencies) for the entire life of the 
trade. This could be a few months or several years- the parameter makes no distinction.
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A.2.6.8 Applicant Credit Bureau Worst Inst Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.7 Line of Credit Finance Trades / Inquiries

A.2.7.1 Applicant Credit Bureau 12month credit Amount Fin Trades

This is the number of credit finance trades that have been opened in the last 12 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.7.2 Applicant Credit Bureau 24month credit Amount Fin Trades

This is the number of credit finance trades that have been opened in the last 24 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.7.3 Applicant Credit Bureau 6month credit Amount Fin Trades

This is the number of credit finance trades that have been opened in the last 6 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.7.4 Applicant Credit Bureau Current credit Amount Fin Trades

Total number of credit finance trades that are paid on time right now. These trades may or 
may not have been delinquent in the past.

A.2.7.5 Applicant Credit Bureau credit Amount Fin Trades

This is the number of credit finance trades, both open and closed. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.7.6 Applicant Credit Bureau credit Amount Finance Inquiries

This is the number of credit finance inquires listed on the credit report. The bureaus have their 
own limits as to how long they keep an inquiry on the credit report, but this parameter will show 
whatever total is shown for that bureau.
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A.2.7.7 Applicant Credit Bureau Open credit Amount Finance Trades

This is the number of open credit finance trades on the account. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.7.8 Applicant Credit Bureau Satisfactory credit Amount Fin

Total number of credit finance trades paid as agreed (no delinquencies) for the entire life of 
the trade. This could be a few months or several years- the parameter makes no distinction.

A.2.7.9 Applicant Credit Bureau Worst credit Amount Fin Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.8 Mortgage Trades / Inquiries

A.2.8.1 Applicant Credit Bureau 12month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.8.2 Applicant Credit Bureau 24month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.8.3 Applicant Credit Bureau 6month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 6 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.8.4 Applicant Credit Bureau Current Mortgage Trades

Total number of mortgage trades that are paid on time right now. These trades may or may 
not have been delinquent in the past.
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A.2.8.5 Applicant Credit Bureau Mortgage Trades

This is the total number of mortgage trades, both open and closed. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.8.6 Applicant Credit Bureau Open Mortgage Trades

This is the number of open mortgage trades on the account. Note that these trades may be 
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.8.7 Applicant Credit Bureau Satisfactory Mortgage

Total number of mortgage trades paid as agreed (no delinquencies) for the entire life of the 
trade. This could be a few months or several years- the parameter makes no distinction.

A.2.8.8 Applicant Credit Bureau Worst Mortgage Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.9 Retail Trades / Inquiries

A.2.9.1 Applicant Credit Bureau 12month Retail Trades

This is the number of retail trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.9.2 Applicant Credit Bureau 24month Retail Trades

This is the number of retail trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.9.3 Applicant Credit Bureau 6month Retail Trades

This is the number of retail trades that have been opened in the last 6 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.
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A.2.9.4 Applicant Credit Bureau Current Retail Trades

Total number of retail trades that are paid on time right now. These trades may or may not 
have been delinquent in the past.

A.2.9.5 Applicant Credit Bureau Open Retail Trades

This is the number of open retail trades on the account. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.9.6 Applicant Credit Bureau Retail Inquiries

This is the number of retail inquires listed on the credit report. The bureaus have their own 
limits as to how long they keep an inquiry on the credit report, but this parameter will show 
whatever total is shown for that bureau.

A.2.9.7 Applicant Credit Bureau Retail Trades

This is the number of retail trades, both open and closed. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.9.8 Applicant Credit Bureau Satisfactory Retail

Total number of retail trades paid as agreed (no delinquencies) for the entire life of the trade. 
This could be a few months or several years- the parameter makes no distinction.

A.2.9.9 Applicant Credit Bureau Worst Retail Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.10 Revolving Trades

A.2.10.1 Applicant Credit Bureau 12month Rev Trades

This is the number of revolving trades that have been opened in the last 12 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.
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A.2.10.2 Applicant Credit Bureau 24month Rev Trades

This is the number of revolving trades that have been opened in the last 24 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.10.3 Applicant Credit Bureau 6month Rev Trades

This is the number of revolving trades that have been opened in the last 6 months. Note that 
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so 
on.

A.2.10.4 Applicant Credit Bureau Current Rev Trades

Total number of revolving trades that are paid on time right now. These trades may or may 
not have been delinquent in the past.

A.2.10.5 Applicant Credit Bureau Open Rev Trades

This is the number of open revolving trades on the account. Note that these trades may be 
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.10.6 Applicant Credit Bureau Rev Balance

This is the total revolving credit balance shown on the applicant's credit bureau. This applies 
to all open revolving trades.

A.2.10.7 Applicant Credit Bureau Rev High Balance

This parameter shows the highest cumulative balance among all revolving credit over the 
bureau history. 

NOTE

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account 
4 years ago, this parameter would return $15,000. The parameter is of questionable utility 
in many situations.

A.2.10.8 Applicant Credit Bureau Rev Retail Balance

This is the current revolving retail trade balance shown on the applicant's credit bureau. This 
applies to all open retail trades. It shows current, not historical, information.

A.2.10.9 Applicant Credit Bureau Rev Retail High Balance

This parameter shows the highest cumulative balance among all revolving retail credit over 
the bureau history. 

Note

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account 
4 years ago, this parameter would return $15,000. The parameter is of questionable utility 
in many situations.
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A.2.10.10 Applicant Credit Bureau Rev Trades

This is the number of revolving trades, both open and closed. Note that these trades may be 
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.10.11 Applicant Credit Bureau Satisfactory Rev Trades

Total number of revolving trades paid as agreed (no delinquencies) for the entire life of the 
trade. This could be a few months or several years- the parameter makes no distinction.

A.2.10.12 Applicant Credit Bureau Worst Rev Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.11 Sales Finance Trades / Inquiries

A.2.11.1 Applicant Credit Bureau 12month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 12 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.11.2 Applicant Credit Bureau 24month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 24 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.11.3 Applicant Credit Bureau 6month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 6 months. Note 
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and 
so on.

A.2.11.4 Applicant Credit Bureau Current Sales Fin Trades

Total number of sales finance trades that are paid on time right now. These trades may or 
may not have been delinquent in the past.
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A.2.11.5 Applicant Credit Bureau Open Sales Finance Trades

This is the number of open sales finance trades on the account. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.11.6 Applicant Credit Bureau Sales Fin Trades

This is the number of sales finance trades, both open and closed. Note that these trades may 
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.11.7 Applicant Credit Bureau Sales Finance Inquiries

This is a count of the number of sales finance inquiries that have been made against the 
Applicant's bureau information in the bureau history.

A.2.11.8 Applicant Credit Bureau Satisfactory Sales Fin

Total number of sales finance trades paid as agreed (no delinquencies) for the entire life of 
the trade. This could be a few months or several years- the parameter makes no distinction.

A.2.11.9 Applicant Credit Bureau Worst Sales Fin Trade

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.12 Other Trades

A.2.12.1 Applicant Credit Bureau 12month Trades

This is the number of all trades that have been opened in the last 12 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

A.2.12.2 Applicant Credit Bureau 24month Trades

This is the number of all trades that have been opened in the last 24 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.
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A.2.12.3 Applicant Credit Bureau 6month Trades

This is the number of all trades that have been opened in the last 6 months. Note that these 
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

A.2.12.4 Applicant Credit Bureau Avg Open Trade Age

This is the average trade age in months as calculated using all open trades in the bureau. This 
is based on taking all of the open tradelines, then dividing by the age.

A.2.12.5 Applicant Credit Bureau Avg Trade Age

This is the average trade age in months as calculated using all trades, open and closed, in 
the bureau.

A.2.12.6 Applicant Credit Bureau Chargeoff Trades

This parameter is a count of the total number of charged off trades for that applicant in the 
bureau. 

A.2.12.7 Applicant Credit Bureau Collections

This is the total number of trades in collections for that applicant in the credit bureau. This 
refers to accounts assigned to collections agencies.

A.2.12.8 Applicant Credit Bureau Current Trades

This is the total number of trades that are paid on time right now. These trades may or may 
not have been delinquent in the past.

A.2.12.9 Applicant Credit Bureau Inquiries

This is the number of inquires listed on the credit report. The bureaus have their own limits as 
to how long they keep an inquiry on the credit report, but this parameter will show whatever 
total is shown for that bureau.

A.2.12.10 Applicant Credit Bureau Inquiries 12m

This is the total number of inquiries that have been made against the credit bureau for that 
applicant in the last 12 months

A.2.12.11 Applicant Credit Bureau Inquiries 24m

This is the total number of inquiries that have been made against the credit bureau for that 
applicant in the last 24 months

A.2.12.12 Applicant Credit Bureau Inquiries 6m

This is the total number of inquiries that have been made against the credit bureau for that 
applicant in the last 6 months

A.2.12.13 Applicant Credit Bureau Judgments

This is a count of the number of judgments against the applicant in the credit bureau.

A.2.12.14 Applicant Credit Bureau Liens

This is the total number of liens shown for the applicant in the credit bureau for that applicant.
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A.2.12.15 Applicant Credit Bureau Newest Inquiry

This is the number of months since the most recent inquiry in the credit bureau for that 
applicant. This of course excludes the pull from the immediate past used to do the scoring in 
this particular situation in the system.

A.2.12.16 Applicant Credit Bureau Newest Trade

This is the number of months between now and the newest trade in the bureau for that 
applicant.

A.2.12.17 Applicant Credit Bureau Oldest Inquiry

This is the number of months between now and the oldest inquiry in the bureau for that 
applicant. 

A.2.12.18 Applicant Credit Bureau Oldest Trade

This is the number of months between now and the oldest trade in the bureau for that 
applicant. Oldest is determined by looking at the oldest date on any tradeline, and then 
showing that.

A.2.12.19 Applicant Credit Bureau Open Collection Trades

This is the number of open trades in collections shown in the bureau for that applicant. This 
refers to any accounts assigned to in-house collections departments (as compared to 5.12.7).

A.2.12.20 Applicant Credit Bureau Open Collections

This is the number of open collections in the bureau for that applicant. 

A.2.12.21 Applicant Credit Bureau Open Judgments

This is the total number of open (unsatisfied) judgments against the applicant as indicated in 
the bureau for that applicant.

A.2.12.22 Applicant Credit Bureau Open Liens

This is the total number of open liens against the applicant as indicated in the bureau for that 
applicant.

A.2.12.23 Applicant Credit Bureau Open Trades

This is the number of all open auto trades on the account. Note that these trades may be paid 
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.12.24 Applicant Credit Bureau Past Due 30

This is the number of trades that have been 30 or more days past due at some point in the 
recorded history of the bureau. Note that these trades may be delinquent, derogatory, and so 
on. The parameter makes no distinction. 

A.2.12.25 Applicant Credit Bureau Past Due 30 12m

This is the number of trades that have been more than 30 days past due in the last 12 months. 
The past dues could be for the same or different trades. If one trade has been late 3 times, 
this parameter would show 1 if there are no other trades.
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A.2.12.26 Applicant Credit Bureau Past Due 30 24m

This is the number of times the applicant has been more than 30 days past due in the last 24 
months. The past dues could be for the same or different trades. If one trade has been late 3 
times, this parameter would show 1 if there are no other trades.

A.2.12.27 Applicant Credit Bureau Past Due 60

This is the number of times the applicant has been more than 60 days past due in the 
recorded history of the bureau. The past dues could be for the same or different trades. If one 
trade has been late 3 times, this parameter would show 1 if there are no other trades.

A.2.12.28 Applicant Credit Bureau Past Due 60 12m

This is the number of times the applicant has been more than 60 days past due in the last 12 
months. The past dues could be for the same or different trades. If one trade has been late 3 
times, this parameter would show 1 if there are no other trades.

A.2.12.29 Applicant Credit Bureau Past Due 60 24m

This is the number of times the applicant has been more than 60 days past due in the last 24 
months. The past dues could be for the same or different trades. If one trade has been late 3 
times, this parameter would show 1 if there are no other trades.

A.2.12.30 Applicant Credit Bureau Past Due 90

This is the number of trades that are 90 or more days past due in the recorded history of the 
bureau. Note that these trades may be delinquent, derogatory, and so on. The parameter 
makes no distinction that one trade has been late 3 times; this parameter would show 1 if 
there are no other trades. If one trade has been late 3 times, this parameter would show 1 if 
there are no other trades.

A.2.12.31 Applicant Credit Bureau Past Due 90 12m

This is the number of times the applicant has been more than 90 days past due in the last 12 
months. The past dues could be for the same or different trades. If one trade has been late 3 
times, this parameter would show 1 if there are no other trades.

A.2.12.32 Applicant Credit Bureau Past Due 90 24m

This is the number of times the applicant has been more than 90 days past due in the last 24 
months. The past dues could be for the same or different trades. If one trade has been late 3 
times, this parameter would show 1 if there are no other trades.

A.2.12.33 Applicant Credit Bureau Past Due Now

This is the number of trades on which the applicant is currently past due, according to the 
bureau.

A.2.12.34 Applicant Credit Bureau Repossessions

This is the number of repossessions shown on the bureau for the applicant in the history of 
the bureau.

A.2.12.35 Applicant Credit Bureau Satisfactory Trades

This is the total number of trades of all types, paid as agreed (no delinquencies) for the entire 
life of the trade. This could be a few months or several years- the parameter makes no 
distinction.
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A.2.12.36 Applicant Credit Bureau Too New Trades

This shows the number of trades that have been reported where a lender is reporting a brand 
new account, but has not even billed the applicant yet. 

A.2.12.37 Applicant Credit Bureau Trade Collections

This is the number of trades in collections assigned to collections agencies shown on the 
bureau for the applicant in the history of the bureau. 

A.2.12.38 Applicant Credit Bureau Trades

This is the number of trades in the history of the credit bureau for that applicant. Note that 
different bureaus store information for varying amounts of time.

A.2.12.39 Applicant Credit Bureau Worst Trades

The rating code used for this parameter is the same rating code system displayed for the 
tradelines. The different bureaus use different systems so Oracle Financial Services Lending 
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off 

A.2.13 Bankruptcy information

A.2.13.1 Applicant Credit Bureau 11 Bankruptcies

This parameter provides a count of the number of Chapter 11 Bankruptcies the applicant has 
filed in the stored history of the bureau.

A.2.13.2 Applicant Credit Bureau 13 Bankruptcies

This parameter provides a count of the number of Chapter 13 Bankruptcies the applicant has 
filed in the stored history of the bureau.

A.2.13.3 Applicant Credit Bureau 7 Bankruptcies

This parameter provides a count of the number of Chapter 7 Bankruptcies the applicant has 
filed in the stored history of the bureau.
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A.2.13.4 Applicant Credit Bureau Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant has 
filed in the stored history of the bureau.

A.2.13.5 Applicant Credit Bureau Bkrp Score

The bureaus offer two basic types of scores, a FICO type, and a bankruptcy type. The term 
FICO score is sometimes used as a generic term for a credit score, but it is supposed to mean 
that the score is based on an algorithm purchased or licensed from Fair Isaac Corp. In the 
system, if a score is listed as a FICO score, it is based on a Fair Isaac model. A bankruptcy 
score is a score that is used to predict the likelihood of a consumer to file bankruptcy. It is 
provided much like a FICO score.

A.2.13.6 Applicant Credit Bureau Open 11 Bankruptcies

This parameter provides a count of the number of open Chapter 11 Bankruptcies associated 
with the applicant in the bureau.

A.2.13.7 Applicant Credit Bureau Open 13 Bankruptcies

This parameter provides a count of the number of open Chapter 13 Bankruptcies associated 
with the applicant in the bureau.

A.2.13.8 Applicant Credit Bureau Open 7 Bankruptcies

This parameter provides a count of the number of open Chapter 7 Bankruptcies associated 
with the applicant in the bureau.

A.2.13.9 Applicant Credit Bureau Open Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant X 
has open currently.

A.2.13.10 Applicant Credit Bureau Recent 11 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent 
bankruptcy filing. One would use this parameter to determine if the subject has filed for 
Chapter 11 bankruptcy in the last X months.

A.2.13.11 Applicant Credit Bureau Recent 13 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent 
bankruptcy filing. One would use this parameter to determine if the subject has filed for 
Chapter 13 bankruptcy in the last X months.

A.2.13.12 Applicant Credit Bureau Recent 7 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent 
bankruptcy filing. One would use this parameter to determine if the subject has filed for 
Chapter 7 bankruptcy in the last X months.

A.2.13.13 Applicant Credit Bureau Recent Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent 
bankruptcy filing. One would use this parameter to determine if the subject has filed for any 
kind of bankruptcy in the last X months.
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A.2.13.14 Applicant Has A Prior Bankruptcy

This parameter tracks whether the applicant has indicated a prior bankruptcy based on the 
checkbox in the the system’s Origination module. The prior bankruptcy is set to Y if the 
checkbox is checked otherwise it has a value of N. 

A.2.14 Delinquency Information

A.2.14.1 Applicant Credit Bureau Longest Since Major

This parameter reflects the longest period (in months) a tradeline has been open since the 
last derog.

A.2.14.2 Applicant Credit Bureau Longest Since Minor

This parameter reflects the longest period (in months) a tradeline has been open since the 
last minor delinquency.

A.2.14.3 Applicant Credit Bureau Open Longest Since Major

This parameter considers the greatest amount of time (in months) between now and the 
corresponding major delinquency for all of the open parameters with major delinquencies, and 
reflects the greatest value returned. 

A.2.14.4 Applicant Credit Bureau Open Longest Since Minor

This parameter considers the greatest amount of time (in months) between now and the 
corresponding minor delinquency for all of the open parameters with minor delinquencies, and 
reflects the greatest value returned.

A.2.14.5 Applicant Credit Bureau Open Shortest Since Major

This parameter considers the least amount of time (in months) between now and the 
corresponding major delinquency for all of the open parameters with major delinquencies, and 
reflects the least value returned.

A.2.14.6 Applicant Credit Bureau Open Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the 
corresponding minor delinquency for all of the open parameters with minor delinquencies, and 
reflects the least value returned.

A.2.14.7 Applicant Credit Bureau Shortest Since Major

This parameter considers the least amount of time (in months) between now and the 
corresponding major delinquency for all of the parameters (open and closed) with major 
delinquencies, and reflects the least value returned.

A.2.14.8 Applicant Credit Bureau Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the 
corresponding minor delinquency for all of the parameters (open and closed) with minor 
delinquencies, and reflects the least value returned.
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A.2.15 Derogatory Trade Information

A.2.15.1 Applicant Credit Bureau Derog 12m Trades

Provides the number of trades that were derogatory in the last 12 months. This includes open 
and closed trades. These trades may or may not be derogatory now.

A.2.15.2 Applicant Credit Bureau Derog 24m Trades

Provides the number of trades that were derogatory in the last 24 months. This includes open 
and closed trades. These trades may or may not be derogatory now.

A.2.15.3 Applicant Credit Bureau Derog Now Trades

Provides the number of trades that are derogatory right now. Does this include closed trades? 

A.2.15.4 Applicant Credit Bureau Derog Trades

This parameter addresses the number of derogatory trades associated with the applicant. 
This includes open and closed trades.

A.2.15.5 Applicant Credit Bureau Longest Since Derog

This parameter covers the longest period (in months) since last derog.

A.2.15.6 Applicant Credit Bureau Open Longest Since Derog

This parameter covers the longest period (in months) a tradeline has been open since the last 
derog.

A.2.15.7 Applicant Credit Bureau Open Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the 
corresponding derog for all of the open parameters with derogs, and reflects the least value 
returned.

A.2.15.8 Applicant Credit Bureau Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the 
corresponding derog for all of the parameters (open and closed) with derogs, and reflects the 
least value returned.
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Appendix B: Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs, and so on) are 
rounded to the second decimal place. However, there are occasions where the rounding of 
the computed amounts has to be carried out using different methods. Oracle Financial 
Services Lending and Leasing supports the rounding, raising, or cutting off of calculated 
amounts. 

Rounding will increase the resulting amount to the next number up to the second decimal, 
based on the value of third decimal.

Raising will always increase the resulting amount to the next number up to the second 
decimal. 

Cutting off will always cut the number after the second decimal. 

You can choose the rounding method you want to use by setting the parameter value for the 
system parameter CMN_AMOUNT_ROUND_METHOD in setup screen (Setup > 
Administration > System > System Parameters > System tab). 

You can choose the rounding factor you want to use by setting the parameter value for the 
system parameter CMN_AMOUNT_ROUND_FACTOR in setup screen (Setup > 
Administration > System > System Parameters > System tab).

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Example 2: Amount: 234.134

Example 3: Amount: 234.1319999

Method Result

Round 234.14

Raise 234.14

Cutoff 234.13

Method Result

Round 234.13

Raise 234.14

Cutoff 234.13

Method Result

Round 234.13

Raise 234.14

Cutoff 234.13
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Note

The system rounds only calculated amounts (calculated fees, calculated payment, and so 
on) and not user-entered amounts.

Rate Attributes

The system supports the rounding of the index rate to keep the rate calculation as simple as 
possible for the customers. The general practice is to round the rate to nearest eighth (1/8th) 
(to keep the index rate in the multiple of .125) or fourth (1/4th) (to keep the index rate in the 
multiple of 25). The system rounds only the index rate and not the margin or final rate. You 
can define the index rounding method on the Product tab’s Product Definition screen for 
variable rate line of credits. 

Note

Index rounding does not apply to fixed rate .

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE

2. INDEX RATE ROUNDED TO NEAREST .25

3. INDEX RATE ROUNDED TO NEAREST .125

NO ROUNDING TO INDEX RATE: Select this method for no rounding. 

INDEX RATE ROUNDED TO NEAREST .25: Select this method to round up to 1/4th (to keep 
the index rate in the multiple of .25).

Examples

INDEX RATE ROUNDED TO NEAREST 0.125: Select this method to round up to 1/8th (to keep 
the index rate in the multiple of 0.125).

Type Value

Current rate: 5.125

Round of rate: 5.25

Type Value

Current rate: 5.124

Round of rate: 5.00
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Examples:

Type Value

Current rate: 5.325

Rate rounded to: 5.375

Type Value

Current rate: 5.312

Rate rounded to: 5.250
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Appendix C:System Parameters

C.1 Introduction

System defined parameters help in configuring system specific data, User-access, location of 
system files; reports related URLs and other administration controlled data. These are 
essential to be configured during installation and some of them by nature of application will 
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of 
the system that these would apply and impact:

 System Parameters

 Organization Parameters

 Company Parameters

 Other Parameters

Note

All the above parameters can be controlled (enabled/disabled) only by System Adminis-
trators, and users with Admin/Super User privileges who would be involved in setting-up 
OFSLL system.

C.2 System Parameters

System parameters apply to the entire system. They relate to the overall processing of the 
system like application server file locations, data purging configurations and so on. Table 
below details the list of system parameters with their description and pre-defined values.

Sl.No Parameter Description

1 ACA_DLQ_AMT_EX-
CLUDED

This parameter is used to exclude delinquency 
amount for account ACH

2 ACA_PAYMENT_AU-
TO_LOAD 

This parameter is used to control posting directly 
from the ACH file that has been created for cus-
tomer payments. Input parameter value is Boolean 
(Yes/No). If the parameter is set to ‘Y’, the system 
automatically creates payment batches for the 
payments in the ACH file and posts them on the 
day of payment.

3 ACA_PRENOTE_DAYS This parameter is used to define the number of 
days the prenote should be initiated for customer 
ACH (Automated Clearing House) accounts. Input 
parameter value is numeric.

4 ACA_PRE_PROCESS_-
DAYS 

This parameter is used to specify the number of 
days before draft day for Account ACH process. 
Input parameter value is numeric.

5 ACH_PAYEE_PRENOTE_-
DAYS 

This parameter is used to define the number of 
days for prenote to occur for Producer or Vendor 
ACH accounts. Input parameter value is numeric
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6 ADMIN_SERVER_URL This parameter is used to define the admin server 
URL

7 ADR_DIRECTORY This parameter is used to define the Oracle Direc-
tory Object Name for ADR file location

8 ADR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Direc-
tory Object Name for ADR file location

9 AGE_APPROVED_CON-
DITIONED_DAYS

This parameter is used to specify the number of 
days by which an application in ‘Approved’ or 
‘Conditioned’ status is treated as Aged Applica-
tion. Input parameter value is numeric with no 
upper limit.

10 AGE_CONTRACT_DAYS This parameter is used to specify the number of 
days by which a contract is treated as Aged Con-
tract. Input parameter value is numeric with no 
upper limit.

11 ASC_COL_SER_ENA-
BLED_IND

This parameter is used as the Collection Servicing 
Enabled Indicator

12 CAC_DIRECTORY This parameter is used to define the Oracle Direc-
tory Object Name for CAC file location

13 CAC_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Direc-
tory Object Name for CAC file location

14 CHECK_PRINT_PREVIEW Using this parameter we can allow preview of 
application in pdf form before printing. Input 
parameter value is Boolean (Yes/No).

15 CMN_AMOUNT_ROUND_
FACTOR 

This parameter is used to define the rounding fac-
tor for applicable fields (in this case calculated 
amounts). Input parameter value is ‘ROUND 
AMOUNT TO 2 DECIMALS’. Currently system 
supports rounding factor 2 only.

16 CMN_AMOUNT_ROUND_
METHOD 

This parameter is used to define the amount round 
method during system set-up and would be appli-
cable for all calculated amounts (calculated fees, 
payment etc.) across the application. Input values 
are ROUND, RAISE and CUTOFF: 
ROUND: Rounded to nearest number higher or 
lower
RAISE: Rounded to the nearest higher number
CUTOFF: Truncate the digits without rounding or 
raising

17 CMN_APP_ACC_TI-
TLE_FN_LN 

This parameter is used to set the Application or 
Account title in one of the formats – First/Last 
Name or Last/First Name. Input parameter value is 
Boolean (Yes/No). If Yes is chosen, title would be 
in the format – First/Last Name, else the other 
option.

Sl.No Parameter Description
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18 CMN_APP_-
SERVER_HOME 

This parameter is used to set the Application 
Server Home Directory. Input parameter value is 
user defined. 

19 CMN_CURRENT_MOD-
EL_YEAR 

This parameter is used to default the Current 
Model Year.

20 CMN_DEBUG_LEVEL This is the Common Debug Level

21 CMN_DEBUG_METHOD This is the Common Debug Method

22 CMN_-
FILE_PROCESS_TO_LOB

This parameter is used to change incoming/outgo-
ing file process to CLOB process

23 CMN_GL_POST_DT This parameter is used to specify the General 
Ledger Posting date. If scheduler is enabled, it 
automatically updates this to current system date. 
Else Admin User would need to set this date man-
ually to ensure correct posting dates in GL. 

24 CMN_HTTP_PROX-
Y_PORT 

This parameter is enabled to specify the port to be 
used for outgoing HTTP connections. Input 
parameter value is user defined.

25 CMN_HTTP_PROXY_-
SERVER 

This parameter is enabled to specify the proxy 
server to be used for outgoing HTTP connections. 
Input parameter value is user defined. There 
exists an interdependency of this parameter with 
CMN_HTTP_PROXY_PORT mentioned above.

26 CMN_INT_360_ACCRU-
AL_DAYS_MTHD 

This parameter is used to specify the interest 
accrual method for 360 days, to be used by the 
System for all calculations with interest. Currently 
two methods are supported. Input parameter value 
is ‘US’ or ‘EU’ representing American and Euro-
pean method of interest accrual for 360 days. 

27 CMN_TEST_TOOL_LOG-
GING

This parameter is used to set testing tool logging 
parameter

28 CMN_SCHEMA_ID This is used to specify the schema identifier for all 
users. 

29 CMN_SCHEMA_NAME This is used to specify the Oracle User Name for a 
specific schema. Input parameter value is user 
defined.

30 CMN_SCHEMA_PASS-
WORD 

This captures the password for Oracle, for the 
specific schema. Input parameter value is user 
defined. This parameter need not be enabled 
when in Oracle Network.

31 CMN_SERVER_HOME This parameter captures the Server Home Direc-
tory. Input parameter value is user defined.
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32 CMN_-
SERVER_TEMP_DIR 

This parameter is used to specify the temporary 
directory on the server along with the path. Input 
parameter value is user defined.

33 CMN_SER_ENVIRON-
MENT_FILE 

This parameter captures the environment file (and 
its path) for running the Operating System com-
mands from Job Service. Input parameter value is 
user defined.

34 CMN_SYSTEM_UNDER_-
MAINTENANCE 

This parameter specifies whether the system is 
under maintenance or not. Input parameter value 
is Boolean (Yes/No). 

35 CMN_WALLET_PASS-
WORD 

This parameter is used to specify the common 
wallet password. Input parameter value is user 
defined.

36 CMN_WALLET_PATH This parameter is used to specify the common 
wallet path for oracle database. Input parameter 
value is user defined.

37 CPP_NO_OF_PROMISES This parameter is used to define the maximum 
number of promises/chances allowed for a cus-
tomer who is delinquent and promises to pay. 
Input parameter value is numeric with no upper 
limit.

38 CPP_PROMISE_HELD_-
DAYS 

This parameter is used to define the maximum 
number of days after the promises made by the 
customer to pay are broken to initiate further 
actions. Input parameter value is numeric with no 
upper limit.

39 CRD_CHS_BIN This parameter holds the value of the credit card 
BIN (Bank Identification Number for Credit Cards), 
for CHASE interface. Input parameter value is 
user defined. 
(P.S: OFSLL supports CHASE interface for credit 
card payments processing)

40 CRD_CHS_CUR_CODE This parameter is used to specify the currency 
code of the transacting currency for CHASE inter-
face. Input parameter value is user defined.

41 CRD_CHS_DIR_PATH This parameter is used to specify the directory 
path for CHASE payment interface for Credit 
Cards. Input parameter value is user defined.

42 CRD_CHS_IND_TYPE This is used to specify the industry type for 
CHASE payment interface for Credit Cards. Input 
parameter value is user defined.

43 CRD_CHS_MER-
CHANT_ID 

This captures the merchant ID number for CHASE 
payment interface for Credit Cards. Input parame-
ter value is user defined.
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44 CRD_CHS_RE-
MOTE_HOST_NAME 

This captures the remote host name for seeking 
approvals for CHASE payment interface. Input 
parameter value is user defined.

5 CRD_CHS_SEC_RE-
MOTE_HOST_NAME 

Similar to the previous parameter this captures the 
secondary remote host name of CHASE interface 
for seeking approvals for credit card payments. 
Input parameter value is user defined.

46 CRD_CHS_TIMEOUT This parameter is used to define the timeout limit 
when polling the interface for processing credit 
card payments. Input parameter value is numeric.

47 CRD_CHS_USR_ID This parameter captures the user id for CHASE 
interface which is required whenever the System 
needs to access/seek authorizations/process pay-
ments for credit cards etc. Input parameter value 
is user defined.

48 CRD_PTB_RE-
MOTE_HOST_NAME 

This is the Protobase Remote Host Name 

49 CRD_PTB_RE-
MOTE_HOST_PORT 

This is the Protobase Remote Host Port

50 CRD_PTB_TIMEOUT This is the Protobase Timeout Value

51 CRD_SOURCE_TYPE_CD This is the Source Type Code

52 DDT_CREATE_DUE_-
DATE_HISTORY 

This parameter must be enabled to create a due 
date history for any account. Due date history sub 
tab under Transaction history displays the delin-
quency history of an account in a tabular format 
detailing Due date, Due Amount, Last Payment 
date, Payment Amount, Balance Amount, Days 
past due and Payment received flag. The input 
parameter value for this parameter is Boolean 
(Yes/No).

53 DECI-
SION_BUY_RATE_TOL-
ERANCE

This parameter is used to define the variance in 
buy rate

54 EDF_DIALER_ACCT_-
TYPE

This parameter is used to set up the account num-
ber reference for the dialer file to pick-up records 
for Auto dialer interface. Input parameter value is 
account number.

55 FIN_TIMEOUT This parameter is used to define the polling inter-
val for Fax-in service, i.e. minutes after which the 
Fax-in service would poll to establish a connection 
periodically. Input parameter value is numeric.

56 FLL_BPEL_PROCESS This parameter is set to use BPEL process in 
OFSLL. Input parameter value is Boolean (Yes/
No).
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57 ICA_INPUT_FILE_FOR-
MAT

This parameter is used to define the input call 
activity file format

58 IFD_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IFD file location

59 IFD_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle direc-
tory object name for IFD file location

60 INCOM-
ING_LOB_PURGE_DAYS

This parameter is used to define the incoming pro-
cess file table purge days

61 INPUT_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for INPUT file location

62 ITU_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for ITU file location

63 ITU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle direc-
tory object name for ITU file location

64 IVR_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IVR file location

65 IVR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle direc-
tory object name for IVR file location

66 JSC_START_OF_BUSI-
NESS_TIME

This parameter is used to set the start of business 
time. Input parameter value is time in 24 hour for-
mat.

67 JSC_TIMEOUT This parameter is used to set the polling interval 
for job scheduler. Input parameter value is 
numeric. To check whether it represents minutes/
seconds.

68 JSV_ARCHIVE_-
SERVER_CONFIG

This parameter is used to set the configuration file 
for reports archive server. Input parameter value is 
user defined.

69 JSV_ARCHIVE_-
SERVER_URL

This parameter is used to specify the archive 
server url. Input parameter value is user defined.

70 JSV_BI_PASSWORD This parameter is used to define the BI Publisher 
Password

71 JSV_BI_USER This parameter is used to define the BI Publisher 
User ID

72 JSV_TEMPORARY_DI-
RECTORY

This parameter is used to define Oracle directory 
object name for Job Service Temp file location

73 JSV_BI_PASSWORD-
JSV_REPORTS_RUNT-
IME

This parameter is to specify the reports runtime 
program. Input parameter value is user defined.
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74 JSV_REPORTS_RUNT-
IME_CMDFILE

This parameter is used to specify the reports runt-
ime command file. Input parameter value is user 
defined.

75 JSV_REPORTS_-
SERVER_CONFIG

This parameter is used to specify the configuration 
file for reports server. Input parameter value is 
user defined.

76 JSV_REPORTS_-
SERVER_URL

This is used to specify the URL for the reports 
server. Input parameter value is user defined.

77 JSV_REPORT_AR-
CHIVE_DIRECTORY

This is used to specify the path & directory of 
Reports archive, input parameter value being 
numeric.

78 JSV_SMTP_SERVER This parameter specifies the SMTP server used by 
job service for sending email messages. Input 
parameter value is user defined.

79 JSV_TIMEOUT This is to specify the polling interval for the job ser-
vice during time out. Input parameter value is 
numeric. To check whether it represents minutes/
seconds.

80 JSV_USE_BI_PUBLISHER This parameter defines whether BI publisher 
should be used to process reports are not. Input 
parameter value is Boolean (Yes/No).

81 JSV_USE_REPORTS_-
SERVER

This parameter is used to specify whether reports 
server from job service should be used or not. 
Input parameter value is Boolean (Yes/No).

82 LBX_TXN_GROUP-
ING_CNT

This parameter is used to specify the no. of 
records per batch for payment transactions and 
lock box batch records. Input parameter value is 
numeric.

83 LCO_COL_LET-
TER1_GEN_DAYS

This parameter specifies the number of days post 
which first collection letter should be generated for 
accounts with dues unpaid. Input parameter value 
is numeric.

84 LCO_COL_LET-
TER2_GEN_DAYS

This parameter specifies the number of days post 
which second collection letter should be generated 
for accounts with dues unpaid. Input parameter 
value is numeric.

85 LCO_COL_LET-
TER3_GEN_DAYS

This parameter specifies the number of days post 
which third collection letter should be generated 
for accounts with dues unpaid. Input parameter 
value is numeric.

86 LIEN_RELEASE_DAYS This parameter is used to define the Lien Release 
Days

87 LOCKBOX_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for Lockbox file location
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88 LOCKBOX_PRO-
CESSED_DIRECTORY

This parameter is used to define the Oracle direc-
tory object name for processed Lockbox file loca-
tion

89 LOR_ADVERSE_AC-
TION_GEN_DAYS

This parameter is used to specify the number of 
days after the third collection letter post which the 
adverse action letter is to be generated. Input 
parameter value is numeric.

90 LOG_LOB_PURGE_DAYS This parameter is used to log files header table 
purge days

91 MAX_AGED_TXN_AU-
THORIZE_DAYS

This parameter is used to specify the maximum 
number of days within which a transaction should 
be authorized. Input parameter value is numeric 
and represents the number of days.

92 MAX_VOID_TXN_AU-
THORIZE_DAYS

This parameter is used to set the maximum days 
to authorize transaction

93 OCP_CUSTOMER_P-
MT_SITE_ID

This parameter is used to set the customer pay-
ment extract file site id

94 OCP_IN-
CLUDE_ACH_ACC

This parameter is used to set the customer pay-
ment extract including ach accounts

95 OUTGO-
ING_LOB_PURGE_DAYS

This parameter is used to define the outgoing pro-
cess file table purge days

96 OUTPUT_DIRECTORY This parameter is used to define Oracle directory 
object name for OUTPUT file location

97 PAC_ARCHIVE_DAYS This parameter is used to define number of days 
for periodic archiving of account. Input parameter 
value is numeric.

98 PAC_OARCHIVE_DAYS This parameter is used to define the number of 
days for archiving accounts from ‘O’ tables i.e. old 
tables. Input parameter value is numeric

99 PAP_ARCHIVE_DAYS This parameter is used to define the number of 
days for archiving applications on a periodic basis. 
Input parameter value is numeric.

100 PAP_OARCHIVE_DAYS This parameter is used to define the number of 
days for archiving applications from ‘O’ tables. 
Input parameter value is numeric.

101 PCU_CHECK_REFUND_-
DAYS

This parameter is used to specify the maximum 
number of days within which an overpayment from 
the customer can be refunded. Input parameter 
value is numeric. 

102 PDC_PRE_PROCESS_-
DAYS

This parameter value will define the number of 
days prior to the due day, regular account PDC 
process should be initiated. Input parameter value 
is numeric.
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103 PENDING_PDC_DAYS This parameter value will define the number of 
days before the initiation day for pending PDC 
accounts.

104 PGL_ARCHIVE_DAYS This parameter defines the number of days, post 
which the transactions in GL would be archived. 
Input parameter value is numeric

105 PGL_OARCHIVE_DAYS This parameter is used to define the number of 
days, post which the transactions in GL will be 
moved to the ‘O’ tables. Input parameter value is 
numeric.

106 PJR_PURGE_DAYS This parameter is used to specify the days post 
which the job requests are to be purged. Input 
parameter value is numeric.

107 POD_PURGE_DAYS This parameter is used to define the number of 
days after which the Output data file headers are 
to be purged. Input parameter value is numeric.

108 PPA_ARCHIVE_DAYS This parameter is used to specify number of days 
after which pools and its transactions archiving is 
to be done to ‘O’ tables. Input parameter value is 
numeric.

109 PPA_OARCHIVE_DAYS This parameter is used to specify number of days 
after which pools and its transactions archiving is 
to be done to ‘OO’ tables. Input parameter value is 
numeric

110 PPR_ARCHIVE_DAYS This is used to specify the days for archival of pro-
ducers details on a regular basis. Input parameter 
value is numeric.

111 PPR_OARCHIVE_DAYS This is used to specify the days after which the 
producers details from ‘O’ tables need to be 
archived. Input parameter value is numeric.

112 PPX_ARCHIVE_DAYS This is used to specify the days after which pro-
ducer transactions are to be archived. Input 
parameter value is numeric.

113 PPX_OARCHIVE_DAYS This is used to specify the days after which the 
producer transactions are to be moved from ‘O’ 
tables. Input parameter value is numeric.

114 PJR_COPY_PURGED_-
DATA

This parameter is used to copy data into purge 
tables

115 PST_ARCHIVE_DAYS This parameter specifies the number of days for 
which the statements are to be archived. Input 
parameter value is numeric.

116 PST_OARCHIVE_DAYS This parameter specifies the number of days for 
which the statements are to be archived in the ‘O’ 
tables. Input parameter value is numeric.
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117 PTT_PURGE_DAYS This is used to specify the number of days after 
which the PTT table is to be purged. Input parame-
ter value is numeric.

118 PTX_ARCHIVE_DAYS This parameter is used to specify the number of 
days the transactions are to be archived. Input 
parameter value is numeric.

119 PTX_OARCHIVE_DAYS This parameter is used to specify the number of 
days after which the archived transactions from ‘O’ 
tables are to be moved. Input parameter value is 
numeric.

120 PTX_TX-
N_LAST_PURGE_DT

This parameter stores the date when transactions 
were purged last in the OFSLL system. Input 
parameter value is date. 

121 PUL_PURGE_DAYS This parameter is used to specify the number of 
days post which the User login details are to be 
purged. Input parameter value is numeric.

122 PVA_ARCHIVE_DAYS This parameter stores the number of days for 
archival of regular vendor assignments. Input 
parameter value is numeric.

123 PUP_ARCHIVE_DAYS This parameter stores the number of days for 
archival of transaction upload. Input parameter 
value is numeric

124 PUP_OARCHIVE_DAYS This parameter is used to specify the number of 
days after which the archived transactions from ‘O’ 
tables are to be moved. Input parameter value is 
numeric

125 PUP_TUP_LAST_PURGE
_DT

This parameter stores the date when transactions 
upload were purged last in the OFSLL system. 
Input parameter value is date.

126 PVA_OARCHIVE_DAYS This parameter value specifies the number of days 
for archival of vendor assignments from ‘O’ tables 
to ‘OO’ tables. Input parameter value is numeric.

127 PVI_ARCHIVE_DAYS This parameter is used to specify the number of 
days for which the regular vendor invoices are to 
be archived. Input parameter value is numeric.

128 PVI_OARCHIVE_DAYS This parameter is used to specify the number of 
days post which the regular vendor invoices are to 
be moved from ‘O’ tables to ‘OO’ tables. Input 
parameter value is numeric.

129 RAC_LOAD_FREQUENCY This parameter is used to specify Accounts RDH 
Load Frequency

130 RAP_LOAD_FREQUENCY This parameter is used to specify Applications 
RDH Load Frequency
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131 RAT_LOAD_FREQUENCY This parameter is used to specify Asset Tracking 
RDH Load Frequency

132 RBK_LOAD_FREQUENCY This parameter is used to specify Bankruptcy 
Details RDH Load Frequency

133 RCA_LOAD_FREQUENCY This parameter is used to specify Call Activities 
RDH Load Frequency

134 RCH_LOAD_FRE-
QUENCY

This parameter is used to specify Deficiency 
Details RDH Load Frequency

135 RCO_LOAD_FRE-
QUENCY

This parameter is used to specify Contracts RDH 
Load Frequency

136 RFO_LOAD_FREQUENCY This parameter is used to specify Repo-Foreclo-
sure RDH Load Frequency

137 RPR_LOAD_FREQUENCY This parameter is used to specify Producers Rdh 
Load Frequency

138 RST_LOAD_FREQUENCY This parameter is used to specify Setup Data RDH 
Load Frequency

139 RTX_LOAD_FREQUENCY This parameter is used to specify Txns RDH Load 
Frequency

140 SALESAGENT_-
MAIL_SEND_IND

This parameter is used to specify whether decision 
fax needs to be sent to sales agent (yes/no)

141 SCORING_PARAME-
TER_ALERT

This parameter is used to set the scoring parame-
ter alert

142 SQL_DIRECTORY This parameter is used to set the Oracle directory 
object name for SQL file location

143 TES_ANA_PRE_PROCES
S_CYCLES

This parameter is used to specify the pre-process 
cycles required for Escrow analysis. Input parame-
ter value is numeric.

144 TES_DSB_ANALY-
SIS_PERCENT

This parameter is used to specify the percentage 
for escrow disbursements. Input parameter value 
is numeric.

145 TES_DS-
B_PRE_PROCESS_DAYS

This is used to specify the number of days for pre-
process for escrow disbursements. Input parame-
ter value is numeric.

146 TPE_AMORTIZE_AC-
CRUED_INT_ONLY

This parameter is used to specify that system has 
to amortize accrued interest at month end

147 TPE_APPLY_LTC_-
FROM_CURR_DUE_DT

This parameter is used for pyramid law fee 
method to apply late charge from current due date

148 TPE_ESC_ANALY-
SIS_DELQ_AMT

Parameter considers billed but uncollected 
amount for escrow analysis
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149 TPE_EXCESS_PAY-
MENT_TO_MEMO

Excess payment on the account will be moved to 
memo payment.

150 TPE_EXCLUDE_ESC_LTC This parameter defines whether escrow should be 
included or excluded while calculating late charge. 
Input parameter value is Boolean (Yes/No).

151 TPE_EXT_CY-
CLES_BACKDATED

This parameter is used to define the maximum 
extension cycles allowed for back dating. Input 
parameter value is numeric with no upper limit

152 TPE_FUTURE_PAYOFF_-
DAYS

The value specified in this parameter validates the 
‘Valid Up to Date’ with ‘Payoff quote’ during mone-
tary transactions posting.

153 TPE_GL_RE-
FUND_HOLD_DAYS

This parameter is used to define the number of 
days the non-refunded amount can be held in GL. 
Input parameter value is numeric.

154 TPE_MAX_CY-
CLES_BACKDATED

This parameter is used to define the maximum 
cycles that are allowed for back dating in OFSLL. 
Input parameter value is numeric.

155 TPE_MIN_1098_INT_AMT
_PAID

This parameter is used to specify the lower limit or 
minimum interest amount paid for 1098 i.e. Mort-
gage Interest Statement. In the US, FIs need to 
report mortgage interest of $600 or more received 
from individuals, during the course of their busi-
ness. Input parameter value is 600, the minimum 
value above which reporting by FI is required in 
form 1098 for each mortgage account.

156 TPE_OLDEST_-
DUE_DT_NEW_MTHD

This parameter is enabled to specify whether new 
method for calculation of oldest due date based on 
given data should be used or not. Input parameter 
value is Boolean (Yes/No).

157 TPE_PAID_TO_CLOSE_-
DAYS

This parameter is used to specify the number of 
days allowed post which a paid account would be 
closed. Input parameter value is numeric.

158 TPE_PAYMENT_TO_-
MULTI_ACCOUNTS

This parameter is enabled to allow one payment 
for dues in multiple accounts. Input parameter 
value is Boolean (Yes/No).

159 TPE_PAYOFF_VAL-
ID_THRU_DAYS

This parameter is used to specify the number days 
the pay-off quote is valid by default. i.e. if the 
parameter is set as 7, the payoff quote is valid for 
7 days and customer can pay the quoted amount 
as final closure amount within those days. Input 
parameter value is numeric.

160 TPE_PMT_POST_EOD This parameter is used to allow payments when 
the batch process for End of Day is running. Input 
parameter value is Boolean (Yes/No). If this is set 
to ‘Y’, payments can be allowed during EOD.
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161 TPE_SCHGOFF_DLQ_-
DAYS

This parameter is used to define the number of 
delinquent days to treat an account for SCHGOFF 
(charge – off). Input parameter value is numeric. 
(To verify)

162 TPE_SCHGOFF_RE-
VIEW_DAYS

This parameter is used to define the number of 
days allowed for review of SCHGOFF accounts. 
Input parameter value is numeric.

163 TPE_SCRA_DEFAULT_IN-
TEREST_RATE

This parameter is used to define the default inter-
est rate that is to be applied for customers who are 
in military duty. OFSLL will apply the lower of the 
prevailing interest rate or SCRA default interest 
rate specified through this parameter. Input 
parameter value is numeric (in this case 6, which 
is interest rate to be applied for SCRA accounts.

164 TPE_SHOW_BACK-
DATE_WARNING

This parameter is used to define whether a warn-
ing message is to be shown if monetary transac-
tion is backdated

165 TPE_ST-
M_INC_ALL_TXNS

This parameter is enabled to define whether all 
transactions should be included in the statements 
or otherwise. Input parameter value is Boolean 
(Yes/No).

166 TPE_STOP_COMP_DELQ
_DAYS

This parameter is used to stop computation when 
delq days > 60

167 TPE_TXN_POST_DE-
FAULT_GLDATE

This parameter is used to default GL date in date 
type parameters during txn posting (y/n)

168 TPE_VOID_TO_CLOSE_-
DAYS

This parameter is used to define the number of 
days allowed for closing Void accounts. Input 
parameter value is numeric.

169 UIX_DEFAULT_IMAGE_-
PATH

This parameter is used to define the default image 
directory maintained for the purpose of online 
attachment of document images to an application 
using documents maintenance section under 
Account documentation. Input parameter value is 
user defined.

170 UIX_DIRECT_LOAN_-
COMBO_ULN_UFN

This parameter when set to yes allows underwrit-
ing and funding to be carried on by a single 
responsibility for direct loans only. Input parameter 
value is Boolean (Yes/No). 

171 UIX_INCOMING_FILE_-
PATH

This parameter is used to specify incoming file 
path of app server

172 UIX_LOCAL_COUN-
TRY_CD

Through this parameter we can set the local coun-
try where an FI has multiple branches across dif-
ferent geographies. Input parameter value is user 
defined.
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173 UIX_LOCK_UN-
LOCK_AND_COPY

This parameter is used to enable the user inter-
face lock / unlock and copy features. Input param-
eter value is Boolean (Yes/No).

174 UIX_MAX_ACC_-
SEARCH_ROWS

This parameter is used to specify the maximum 
number of account rows to be returned for search 
functionality. Input parameter value is numeric.

175 UIX_MAX_APP_-
SEARCH_ROWS

This parameter is used to specify the maximum 
number of application rows to be returned for 
search functionality. Input parameter value is 
numeric.

176 UIX_OUTGOING_FILE_-
PATH

This parameter is used to specify outgoing file 
path of app server

177 UIX_REPORTS_-
SERVER_CONFIG

This parameter can be used to specify the user 
interface reports server configuration file. This is 
not required for OFSLL.

178 UIX_REPORTS_-
SERVER_URL

This parameter sets the URL for Reports server. 
Input parameter value is user defined.

179 UIX_SHOW_LN_VARIA-
BLE_RATE_TABS

This parameter can be used to show loan variable 
rate tabs. Input parameter value is Boolean (Yes/
No). This is not required for OFSLL.

180 UIX_UTILITIES_SERV-
LET_URL

This parameter can be used to specify the User 
Interface utilities servlets URL. This is not required 
for OFSLL.

181 UPR_PRO_NBR_SYS-
_GENERATED

This parameter can be used to specify whether 
producer number should be system generated or 
seek input from user. Input parameter value is 
Boolean (Yes/No). Generally this is set to yes for 
system generation.

182 VEV_NADA_TOKEN_URL This parameter is used to set the token URL for 
vehicle evaluation interface NADA. Input parame-
ter value is user defined.

183 VEV_NADA_UPDATE_-
DAY

This parameter is used to specify the day of the 
month to update the vehicle evaluations every 
month. Input parameter value is numeric.

184 VEV_NADA_URL This parameter is used to set the URL for vehicle 
evaluation interface NADA. Input parameter value 
is user defined.

185 VEV_NADA_USER_ID This parameter is used to specify the User id for 
login to the NADA interface. Input parameter value 
is user defined.

186 VEV_NADA_USER_PASS-
WORD

This parameter is used to specify the password for 
login to the NADA interface. Input parameter value 
is user defined.
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187 VEV_VALUATION_RE-
GION

This parameter is used to define the default region 
for vehicle evaluation. Input parameter value is the 
region name, and is user defined.

188 VEV_VALUATION_-
SOURCE_CD

This parameter is used to specify the default vehi-
cle evaluation source code. Input parameter value 
is user defined. A number of parameters are pos-
sible in OFSLL as below:
1.Appraisal Company
2.Broker
3.BUC GUIDE
4.DATA QUICK
5.NAMS/SAMS SURVEY – USED
6.REALTOR
7.NADA INTERFACE USED CARS
8.BLACKBOOK INTERFACE USED CARS
9.KELLY INTERFACE
10.NADA – NEW
11.NADA – USED
12.KELLY NEW BLUE BOOK
13.KELLY USED BLUE BOOK
14.INVOICE
15.BLACK BOOK
16.NADA INTERFACE COMMERCIAL TRUCKS
17.COMPANY INVOICE
18.GOLD BOOK
19.GALVS
20.OTHER
21.ALG

189 WFP_DIRECTORY This parameter is used to specify the Oracle direc-
tory object name for WFP file location

190 WFP_MAX_CY-
CLES_BACKDT

This parameter is used to specify the back dated 
cycles date for WFP.

191 WFP_PROCESSED_DI-
RECTORY

This parameter is used to define oracle directory 
object name for wfp file location.

192 WFP_REVERSE_TX-
N_IND

This parameter is enabled to define the WFP 
reversal indicator. Input parameter value is 
Boolean (Yes/No).

193 XAE_DEALUPD_MAX_AL-
LOWED_DAYS

This parameter is used to define the max allowed 
days for Deal Update

194 XAE_DEALUPD_AL-
LOWED_IND

This parameter is used to indicate whether deal 
update is allowed or not

196 OUTBOUND_CALL_Q This parameter is used to generate reports (includ-
ing emailing statements/letters) using Application 
Server instead of Database server.

197 ACA_PRE_PROCESS_-
DAYS_FIRST

This parameter is used to configure the number of 
days before the debit day for ACH process in first 
time/ one-time case
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198 IPR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle direc-
tory object name for processed IPR file location

199 IPR_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IPR file location

200 UIX_PWD_MGMT_EX-
TERNAL_URL

This parameter is used to set external password 
management url, if applicable

201 UIX_PWD_MGMT_EX-
TERNAL

This parameter is used to define the parameter if 
password management is external. (SET Y IF 
PASSWORD MANAGEMENT IS EXTERNAL (Y/
N)).

202 ICU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle direc-
tory object name for processed ICU file location

203 ICU_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for ICU file location

204 UIX_BILL_CYCLE_AL-
LOWED_IND

This parameter is used to indicate whether Billing 
cycle is allowed at the application level

205 CMN_EOD_SLEEP_MINS This parameter is used to set in minutes the EOD 
sleep time

206 CMN_CORE_BANK_TX-
N_CD

This parameter is used to set code for OFSLL and 
Core Banking integration

207 UIX_DIRECT_DISB_MAN-
UAL_SELECT

This parameter will allow manual selection of dis-
bursement mode for direct loans

208 ICC_DLQ_AMT_EX-
CLUDED

This parameter enabling will exclude delinquency 
amount for CASA account

209 CMN_CORE_BANK_IND This parameter is used to set whether OFSLL can 
integrate with Core Banking.

210 BKRP_FILE_REC_LIMIT This parameter is used to set the limit of total num-
ber of records allowed to be added in the ‘Input 
Data File’ shared from external interface.

Note: if the number of records exceeds the set 
limit, multiple ‘Input Data Files’ are to be created.

211 UVN_VEN_NBR_SYS-
_GENERATED

This parameter is used to validate if ‘Vendor Num-
ber’ has to be auto generated (if set to Y) or to be 
specified manually in the Vendor details screen.
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212 METRO_WITHOUT_COL-
L_IND

This parameter indicates whether Metro II report-
ing is handled without OFSLL Collections module 
being used. If the parameter value is set as ‘Y’ i.e. 
collection module is not used, system updates the 
collateral status directly as part of ‘REPO’ call 
activity.

However when Collections module is being used, 
the Collateral status is tracked with the reposses-
sion details updated in 'Repo/Foreclosure' screen 
of Collections module.

213 METROII_-
FIRST_DELQ_DT_ADD_-
DAY

This parameter is used to calculate the first delin-
quency date that needs to be reported in the Metro 
II reporting file.

By default the parameter is 'disabled' indicating 
that the initial delinquency date calculated by the 
system is used for Metro II reporting. The same 
needs to be enabled to add the parametrized num-
ber of days to the system calculated first delin-
quency date for the Metro II reporting purpose.

214 DAYS_TO_PULL_CR-
B_REPORT

This parameter is used to configure the number of 
days permitted to pull a Bureau report from the 
same company and for the same customer.

215 XWS_ACS_RESP_-
MULTI_RECORD_IND

This parameter is used to indicate if multiple 
records exist in the response file received for 
account search.

Accordingly, when there are multiple records 
found and this parameter is enabled and set to 
‘No’ (default), system displays an error message 
“Too Many Records Found. Please Refine Search 
by Adding One More Parameter”

However, when this parameter is set to ‘Yes’, sys-
tem only indicates that there are multiple records/
rows in response file.

216 GRI_DLQ_DAYS_AU-
TO_STATUS_CHG

This parameter is used to define the delinquency 
days which inturn is used to automatically update 
the status of a work order to ‘PENDING ON HOLD’ 
status.

217 TPE_PMT_POSTING_-
CLS_ACCOUNT

This parameter is used to define the payment 
posting criteria for Closed - Paid Off/ Charged-off 
accounts.

Accordingly, OFSLL accepts payment posting on 
closed accounts only when the parameter is set to 
‘Y’ and all the payments received through Pay-
ment Entry screen or ‘Payment Upload’ file are 
posted to a ‘Suspense’ account.

Sl.No Parameter Description
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218 TPE_BACKDT_P-
MT_POSTING

This parameter is used to define the payment 
posting criteria for backdated payments for the fol-
lowing type of account conditions:

- Paid off

- Charged-off

- Account under activation

 - Account under conversion

 - Non-performing Account

 - PC2 SI (Pre-computed to Simple Interest) 
Reschedule

Accordingly, OFSLL accepts backdated payment 
posting only when the parameter is set to ‘Y’ and 
all the payments received through Payment Entry 
screen or ‘Payment Upload’ file are posted to a 
‘Suspense’ account.

219 EXP_PA_-
SOFT_PULL_IND

This parameter when enabled allows ‘Soft Pull’ 
Credit Bureau request, specifically for Experian 
Premier Attribute Consumer Report without 
impacting the consumer FICO score.

220 PMT_BATCH_POSTING This parameter (PAYMENT BATCH POSTING 
PREFERENCE) is used to define the status of 
payment transactions which are uploaded in bulk 
through a batch process.

221 POOL_ACTIVE_AC-
COUNTS_ONLY

This parameter controls the type of accounts that 
can be added to a Securitization Pool and allows 
adding only ‘Active’ status accounts since the 
same is enabled (value set to ‘Y’) by default. To 
add accounts with other status such as Active, 
Paid Off, Charged Off, Void, Terminate. and so on, 
set the value of system parameter to ‘N’.

222 AUTO_GEN_ACC_NBR_-
CONV

This parameter is used for conversion accounts to 
decide option of account number generation. If the 
value of parameter is set to ‘Y’ the account num-
ber is automatically generated in OFSLL during 
conversion and if the value is ‘N’, then external ref-
erence number (generated in third party system) 
itself is appended as the account number.
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223 OUTBOUND_DL-
R_TRACK_Q

This parameter defines the settings for batch job 
‘SET_XPR’ to either use MDB (Message Driven 
Bean) flow (if value set to ‘Y’) or existing work flow 
(if value set to ‘N’) to dump producer details main-
tained in the system into Dealer Track.

MDB flow generates outbound JMS message 
though the configured MDB interface and can 
avoid current database outbound calls and ses-
sion timeout.

In the existing workflow, the database makes syn-
chronous outbound calls to producer data dump 
web service, to dump the data and acknowledge 
the database with the status (success or failure).

224 OUTBOUND_ROUTE-
ONE_Q

This parameter defines the settings for batch job 
‘SET_XPR’ to either use MDB (Message Driven 
Bean) flow (if value set to ‘Y’) or existing work flow 
(if value set to ‘N’) to dump producer details main-
tained in the system into ROUTEONE.

MDB flow generates outbound JMS message 
though the configured MDB interface and can 
avoid current database outbound calls and ses-
sion timeout.

In the existing workflow, the database makes syn-
chronous outbound calls to producer data dump 
web service, to dump the data and acknowledge 
the database with the status (success or failure).

225 GRI_WEBSER-
VICE_LOG_IND

This parameter is used to decide on logging GRI 
(Generic Recovery Interface) communications. If 
enabled, system logs all the GRI related web ser-
vice communications between OFSLL and exter-
nal interfaced system.

The recorded logs can be viewed in Dashboard > 
System Monitor > Database Server Log Files tab 
by selecting ‘Interfaces’ view option.

226 PVE_ARCHIVE_DAYS This parameter stores the number of days for 
archival of regular vendors. Input parameter value 
is numeric.

227 PVE_OARCHIVE_DAYS This parameter is used to specify the number of 
days post which the regular vendors are to be 
moved from ‘O’ tables to ‘OO’ tables. Input param-
eter value is numeric.

228 LBX_DR_CR_VALI-
DATE_AMT_IND

This parameter (VALIDATE LOCKBOX DR/CR 
BATCH TOTALS) is used to facilitate NACHA file 
validation. Based on the status of the parameter, 
system is either allowed to validate the file or pro-
cess without validation.
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C.3 Organization Parameters

Organization parameters control the functions related to User login, password expirations, 
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be 
created with different values for uniquely defined organizations, divisions, and responsibility 
combinations.

There are three more dimensions other than parameter name, description and enabling 
(similar to system parameters) as indicated below:

1. Organization

2. Division

3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an 
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on 
a hierarchical sort by the Organization, Division, and Responsibility fields, with values of 'ALL' 
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical 
levels (organization, division, and responsibility), not all will be applicable to each parameter.

229 PAP_PURGE_DAYS This parameter allows to define the number of 
days after which the application data from archival 
folders are to be deleted permanently. Purging 
happens based on elapsed number of days i.e. if 
value is set to 60 days, only those records which 
are older by 60 days in archival folder are deleted.

230 PAC_PURGE_DAYS This parameter allows to define the number of 
days after which the accounts data from archival 
folders are to be deleted permanently. Purging 
happens based on elapsed number of days i.e. if 
value is set to 60 days, only those records which 
are older by 60 days in archival folder are deleted.

Sl.No Parameter Description

1 MAX_PASSWORD_HISTO-
RY_CHECK

This is used to set limit for number of times a 
password has been repeated during password 
change. This can be set for specific branches of 
the Organization, Divisions and Users based on 
responsibilities. Numeric value to be input to spec-
ify the limit.

Sl.No Parameter Description
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2 UCS_GROUP_FOL-
LOWUP_DAYS

This parameter is used to set up the number of 
days range for Group follow-up field in customer 
service screen which displays the set of accounts 
that share same account condition as the selected 
account and bear the same customer ID. The pre-
requisite for this is Group Follow-up indicator 
should be enabled in queue setup. Input value is 
numeric.

3 UCS_REVIEW_-
QUEUE_ALLOWED

This is used to specify whether review can be 
done by the specific responsibility (user group) 
without entering details in call activities/activities. 
Parameter value to be input is Boolean (Yes/No).

4 UIX_AP-
P_VIEW_ALL_APPS

The system uses this parameter to determine 
which users have the ability to view all applica-
tions. The system selects the best match based 
on a hierarchical sort by Organization, Division 
and Responsibility fields, with values of ‘ALL’ 
being a lower order match than an exact match. 
Input parameter value is Boolean (Yes/No).

5 UIX_HIDE_RESTRICT-
ED_DATA

This is used to hide sensitive data relating to the 
Contract / Applicant to a specific group/responsi-
bility etc. Suppose there is a need to hide data 
relating to SSN, Bank account details etc. to a 
specific user responsibility who will not need such 
data, this parameter can be enabled with input 
value Boolean (Yes/No). If this parameter is set to 
‘Y’, the details appear in a masked format (for e.g. 
SSN – XXX-XX-456)

6 UIX_SMTP_SERVER This parameter is used to set up the email server 
for user interface. The input value would be 
‘SETME’ and check the ‘Enable’ flag.

7 UIX_VIEW_SE-
CURED_ACCOUNTS

This is used to specify whether an account can be 
viewed by a specific responsibility (users). Param-
eter value is Boolean (Yes/No) and when flagged 
as Yes, such accounts would be viewable only by 
users defined in the Organization, Division hierar-
chy with the specified responsibilities. For exam-
ple, all employee accounts may not be viewable 
by all users and should be made available only to 
the HR department with specific responsibility lev-
els.
Note: While creating application, selecting appro-
priate applicant’s classification would be essential 
for this parameter to be effective.
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8 UIX_VIEW_SE-
CURED_APPLICATION

This is used to specify whether an application can 
be viewed by a specific responsibility (users). 
Parameter value is Boolean (Yes/No) and when 
flagged as Yes, such applications would be viewa-
ble only by users defined in the Organization, Divi-
sion hierarchy with the specified responsibilities. 
For example, all employee accounts may not be 
viewable by all users and should be made availa-
ble only to the HR department with specific 
responsibility levels.
Note: While creating application, selecting appro-
priate applicant’s classification would be essential 
for this parameter to be effective.

9 ULG_DAY_END This is used to specify the upper limit time in day 
for a user to be able to work in the System. 
Parameter value is numeric and range is 1-24, 
else system will throw error.

10 ULG_DAY_START This is used to specify the lower limit time in day 
for a user to be able to work in the System. 
Parameter value is numeric and range is 0-24, 
else system will throw error

11 ULG_FAILED_LOGIN_TRI-
ALS_MAX

This parameter is used to specify the maximum 
number of login trials allowed before disabling the 
User ID due to security reasons. Input parameter 
value is numeric with upper limit of 
999999999999.

12 ULG_INACTIVITY_DAYS_-
MAX

This parameter is used to specify the maximum 
number of days the User ID can be without utiliza-
tion before disabling the User ID due to security 
reasons. Within the specified number of days the 
User Id must be utilized for sign in at least once. 
Input parameter value is numeric with upper limit 
of 999999999999.

13 ULG_PWD_CASE_SENSI-
TIVE_REQ

This is used to allow all passwords to be case sen-
sitive or otherwise. Input parameter value is 
Boolean (Yes/No). When this parameter is set as 
‘NO’, password would be stored in Upper case. If 
this parameter is set to N. then the ULG_P-
WD_LOWER_CHAR_REQ parameter should also 
be set to N.

14 ULG_PWD_CHANGE_-
DAYS_ACTUAL

This is used to set the maximum number of days 
after which system will force a password change, 
in cases where the User has not changed the 
password. Input parameter value is numeric with 
upper limit of 999999999999.
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15 ULG_PWD_CHANGE_-
DAYS_PROMPT

This is used to set the maximum number of days 
after which system will prompt the User for pass-
word change, in cases where password has not 
been changed within the set period. Input parame-
ter value is numeric.

16 ULG_PWD_LENGTH_MIN This is used to set the minimum length of pass-
word string that is required. If this criterion is not 
met, system would throw an alert specifying mini-
mum character length required to be input.

17 ULG_PWD_LOW-
ER_CHAR_REQ

This is used to allow at least one lower case char-
acter in password strings. Input value is Boolean 
(Yes/No). Setting this as ‘NO’ would mean pass-
words would be allowed in uppercase only.

18 ULG_PWD_NBR_REQ This parameter allows setting password with at 
least one numeric character. Input value is 
Boolean (Yes/No) and setting this as ‘YES’ would 
require passwords to have at least one numeric 
character.

19 ULG_PWD_SPE-
CIAL_CHAR_REQ

This parameter is used to allow special characters 
like ‘$’, ‘#’, ‘@’, in passwords. Input value is 
Boolean (Yes/No) and setting this as ‘YES’ would 
require passwords to have at least one special 
character.

20 ULG_PWD_UP-
PER_CHAR_REQ

This is used to allow at least one upper case char-
acter in password strings. Input value is Boolean 
(Yes/No). Setting this as ‘NO’ would mean pass-
words would be allowed in lowercase only.

21 ULG_WEEK_END This parameter enables to set the last day of the 
week when a user can have access to the system. 
Input parameter value is numeric ranging from 1 to 
7. This is useful in business requirements where 
the Organization does not need a specific set of 
responsibilities (users) to not access the system 
on a weekend / week-off day etc.

22 ULG_WEEK_START This parameter is used to set the start day of the 
week when a user is allowed to access the sys-
tem. Input parameter value is numeric.
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C.4 Company Parameters

Company parameters control the processes associated with functions that vary for different 
companies and branches. These parameters address credit scoring, credit bureau interfaces, 
fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and 
branch combinations (i.e. these can be defined to the level of branches in each company or 
a group of companies in terms of applicability).

23 CRB_ERROR_VALIDA-
TION_IND

This parameter is used to validate the Credit 
Bureau report generation request depending on 
the number of days permitted to pull a Bureau 
report from the same company and for the same 
customer and report as either warning/error.

When the number of days is less than or equal to 
the permitted days (as defined in parameter 
DAYS_TO_PULL_CRB_REPORT), system dis-
plays an ‘Error’ message stating ‘Bureau Report 
exists for the same Customer from the same 
Bureau for Account# XYZ’ along with list of 
account number(s) and/or application number(s). 
If not, a ‘Warning’ message is display and request 
is accepted for processing.

Note: Both ‘CRB_ERROR_VALIDATION_IND’ 
and ‘DAYS_TO_PULL_CRB_REPORT’ are to be 
enabled for Credit Bureau report processing.

Sl.No Parameter Description

1 AUD_ADV_REASON_-
MODEL

This parameter is used to set-up default adverse 
action reasons for scoring models during set-up in 
the Parameters sub page. Whenever the flag 
‘Bureau Score Reasons’ is unchecked during 
credit bureau scoring model set-up, then automat-
ically rejected applications scored using this scor-
ing model picks up the Adverse Action Reasons 
from the Parameters sub page.

2 AUD_SCORING_METHOD This parameter is used to set when/where the 
application scoring method has to be applied 
within the company. So when the parameter value 
is chosen as ‘primary applicant only’, the system 
will perform the application scoring for the primary 
applicant only and according to other applicable 
parameters specified. Other parameter input val-
ues are Minimum Score, Maximum Score, Mini-
mum Tier (Grade), Maximum Tier (Grade).
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3 AUD_SCORING_-
METHOD_IN_BUREAU

This parameter is used to define what value to be 
picked up for application scoring from the scores 
returned from the various bureaus. The input 
parameter values are Maximum Score and Mini-
mum Score. If Maximum score is set-up in com-
pany parameters, then for all applications where a 
bureau report is pulled, the system will pick-up the 
Maximum score from the different bureaus.

4 CBU_DATA_SET_SIZE Parameter to define the metro 2 file data selection 
criteria, option values are monthly, Daily, weekly, 
semi monthly.

5 CBU_FILE_FORMAT Metro 2 file format definition, user need to select 
from the parameter value drop down.

6 CMN_ASE_VALIDATE_-
MAKE_MODEL

This parameter is set up to specify to the system 
whether it needs to validate the asset make and 
model at the time of data entry. In parameter value 
is Boolean (Yes/No).

7 CMN_CMB_DE-
FAULT_PRINTER

This is used to define the default printer for print-
ing. The input parameter value is the printer 
name. There is no LOV for this field. If no default 
printer is defined and the parameter enabled, the 
system would display ‘Undefined’.

8 CMN_WEEKLY_NONBUSI-
NESS_DAYS

This parameter is used to set-up the weekly holi-
days at the company level. The input parameter 
value is character string; if no details specified 
and parameter is enabled, system would display 
‘UNDEFINED’.

9 COR_STORAGE_DIREC-
TORY

This parameter is used to specify the path/location 
for Oracle directory object template for corre-
spondence documents. Input parameter value is 
‘SETME’; if none is specified and parameter ena-
bled, ‘UNDEFINED’.

10 DBR_-
JOINT_INC_DEBT_WITH_
2NDRY

This parameter defines whether system should 
consider income and debt details of the Spouse 
and Secondary Applicant along with that Primary 
Applicant. Input parameter value is Boolean (Yes/
No).

11 DBR_-
JOINT_INC_DEBT_WITH_
SPOUSE

This parameter is used to define whether system 
should consider the income and debt details of 
Spouse alone along with that of Primary applicant 
details. Input parameter value is Boolean (Yes/
No).

Sl.No Parameter Description
C-25



12 DDP_CRB_EXPIRATION_-
DAYS

This parameter is used to define the credit bureau 
report expiration days. So if this is set as 30, sys-
tem will use all available credit bureau reports 
pulled which are not older than 30 days from cur-
rent day, during de-dupe. Input value is numeric 
with no upper limit.

13 DDP_DE-
DUP_DEBT_WITH_2NDRY

This parameter defines whether the system 
should de-dupe credit bureau liabilities for Spouse 
and Secondary Applicants, in addition to de-dup-
ing Primary applicant’s liabilities. Input parameter 
value is Boolean (Yes/No).

14 DDP_DE-
DUP_DEBT_WITH_SPOU
SE

This parameter defines whether the system 
should de-dupe credit bureau liabilities for 
Spouse, in addition to de-duping Primary appli-
cant’s liabilities. Input parameter value is Boolean 
(Yes/No).

15 DOT_STORAGE_DIREC-
TORY

This parameter is used to define the location/path 
of the Oracle Directory Object name for Account 
Document Loading. Input parameter value is 
‘SETME’.

16 ECB_EDIT_-
FAIL_ANY_APL

This parameter is used to set the credit bureau 
edit to fail in case the bureau report for any of the 
applicant fails. Input parameter value is Boolean 
(Yes/No). So if this parameter is set to ‘YES’, the 
edit will fail even if one of the applicant’s bureau 
score fails to qualify.

17 ECB_USE_APL_CUR-
RENT_SCORE_CRH

This parameter is used to define whether the sys-
tem should run the credit bureau edits only on the 
current scored applicant bureau. Input parameter 
value is Boolean (Yes/No).

18 FIN_IMAGE_STATUS_CD This parameter is used to set-up default image 
status for fax-in service. The input parameter val-
ues are ‘RUSH’, ‘NEW’, ‘SKIP’, ‘BAD’, ‘PRO-
CESSED’ and ‘PURGED’.

19 FIN_POP_PASSWORD This parameter is used to define the pop pass-
word to access the fax-in service. Input parameter 
value is user (System Administrator) defined.

20 FIN_POP_SERVER This parameter is used to define the pop server to 
receive the faxes in fax-in service. Input parame-
ter value is location and path of the server.

21 FIN_POP_USERNAME This parameter is used to define the pop user-
name to access the fax-in service. Input parame-
ter value is user (System Administrator) defined.
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22 FIN_STORAGE_DIREC-
TORY

This parameter is used to set-up the Oracle direc-
tory object name for storing the images received 
through the fax-in service. Input parameter value 
is user (System Administrator) defined.

23 FIN_TEMP_DIRECTORY This parameter is used to define the temporary 
directory to be used for the fax-in service. Input 
parameter value is user (System Administrator) 
defined.

24 LOR_AUTOMATIC_CON_-
FUND_FAX

This is used to define the decision fax generation 
when an application is funded. The input parame-
ter value is Boolean (Yes/No), and when this is set 
as ‘YES’, system automatically generates the fax 
approval in the pre-defined template whenever an 
application is approved.

25 LOG_STORAGE_DIREC-
TORY

This parameter is used to define the Oracle stor-
age directory. Input parameter value is user (Sys-
tem Administrator) defined.

26 LOR_AUTOMATIC_AP-
PROVAL_FAX

This is used to define the decision fax generation 
when an application is approved. The input 
parameter value is Boolean (Yes/No), and when 
this is set as ‘YES’, system automatically gener-
ates the fax approval in the pre-defined template 
whenever an application is approved.

27 LOR_AUTOMATIC_RE-
JECTION_FAX

This is used to define the decision fax generation 
when an application is rejected. The input param-
eter value is Boolean (Yes/No), and when this is 
set as ‘YES’, system automatically generates the 
rejection fax in the pre-defined template whenever 
an application is declined.

28 MAX_LEAD_DAY_AGE This parameter is used to define the maximum no. 
of days, post which the sales lead would be con-
sidered cold. Input parameter value is numeric 
with no upper limit.

29 MULTI_OFFER Through this parameter the multiple offers (sub-
tab) in pricing can be enabled or disabled for a 
Company/Branch. Input parameter value is 
Boolean (Yes/No). If the flag is set as ‘Y’, the 
underwriter can view multiple offers and select 
one of them to be applied for the specific applica-
tion.

30 MULTI_OFFER_MAX-
_NUMBER

This parameter is used to specify the maximum 
number of multiple offers that can be permitted for 
an application. Input parameter value is numeric 
with no upper limit. If MULTI_OFFER company 
parameter is set as ‘N’, this parameter can be 
ignored as there is no use specifying a value.
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31 MULTI_OFFER_MAX-
_TERM

This company parameter sets the maximum term 
(as in no. of instalments, whichever billing cycle is 
selected) for which multiple offers are calculated 
and displayed during pricing. Input parameter 
value is numeric.

32 MULTI_OF-
FER_MIN_TERM

This company parameter sets the minimum term 
(as in no. of instalments, whichever billing cycle is 
selected) for which multiple offers are calculated 
and displayed during pricing. Input parameter 
value is numeric.

33 MULTI_OFFER_PMT_TOL-
ERANCE

For Multi offer variance in payment is defined in 
this parameter.

34 MULTI_OFFER_TERM_-
VAR

For multi offer Term variance will be defined in the 
parameter.

35 PRESENT_VALUE_COM-
PUTE_RATE

This parameter will perform Present Value Com-
putation Rate (Inflation/Discounting Rate).

36 RATE_CHG_L-
TR_PRE_PROCESS_-
DAYS

This parameter is used to set up the number of 
days prior to rate change effective date to gener-
ate rate change letters in order to provide 
advance intimation to customers. Input parameter 
value is numeric with no upper limit.

37 STM_GEN_AFTER_MATU-
RITY_IND

This parameter is used to enable the statement 
generation for an account after the maturity date 
but Account remains unpaid. Input parameter 
value is Boolean (Yes/No). If this is set to ‘Y’, 
statements will get generated for accounts that 
remain unpaid even after maturity.

38 UIX_RUN_AAI_ACT This parameter is used by the system to deter-
mine whether to create and activate an account 
online. Input parameter value is Boolean (Yes/
No).

39 UIX_UCS_CAC_MAX_-
FOLLOWUP_DAYS

This parameter is used to set up the maximum 
number of days for follow up when the account is 
in delinquent state. Input parameter value is 
numeric with no upper limit.

40 UIX_UCS_CAC_MAX-
_PROMISE_DAYS

This parameter is used to set up the maximum 
number of days allowed for customers who prom-
ise to pay when following up for delinquent 
accounts. Input parameter value is numeric.

41 AUD_QUEUE_INI-
TIAL_CRB_FAILED

This parameter enabling will Queue the applica-
tion if any bureau failed.

42 UIX_UCS_CUA_MAX_-
FOLLOWUP_DAYS

This parameter will allow the user to maintain the 
Collections maximum follow-up days that are 
allowed in the system.
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C.5 Other Parameters

The following additional set of parameters are also available to control system specific data 
and other administration process.

43 XSL_TAX_INTERFACE This parameter is used to specify the sales tax 
interface in OFSLL. Input parameter value is user 
defined. In this case it is held as ‘Manual’.

Sl.No Parameter Description

1 CRB_MAX_BU-
REAU_PULL

This parameter is used to determine the number 
of credit reports automatically per applicant. Input 
parameter value is numeric.

2 CRB_ALL_APL_BU-
REAU_PULL

This parameter is used to set up whether credit 
bureau reports should be pulled for the primary 
applicant only or to all other applicants also (for 
joint applications), regardless of their relationship 
with the primary applicant. Input parameter value 
is Boolean (Y/N).

3 CBU_FILE_FREQUENCY This parameter is used to set the Metro II File Fre-
quency and determine whether output file is to be 
generated daily or monthly. If this is monthly, then 
output file is written with daily data but generated 
monthly.

4 JOINT_DE-
DUP_SPOUSE_LIABILI-
TIES

This parameter is used to determine duplicate lia-
bilities in the Spouse’s liabilities in de-duping logic. 
Input parameter value is Boolean (Yes/No).

5 JOINT_DEDUP_ALLAP-
L_LIABILITIES

This parameter is used to determine duplicate lia-
bilities of all applicants’ liabilities in de-duping 
logic, irrespective of whether they are related to 
each other. Input parameter value is Boolean 
(Yes/No).

6 ASC_COL_SER_ENA-
BLED_IND

This parameter is used for enabling the Collection 
Servicing Indicator. Input parameter value is 
Boolean (Y/N).

7 CMN_TEST_TOOL_LOG-
GING

This parameter is used to set the testing tool log-
ging to enable or disable testing tool log in. Input 
parameter value is Boolean (Yes/No).

8 FIN_DOWNTIME_BEGIN This parameter is to define the start of period for 
down time of Fax-in service. Input parameter 
value is time in 24 hour format.

9 FIN_DOWNTIME_END This parameter is used to define the end of period 
for down time of Fax-in service. Input parameter 
value is time in 24 hour format.
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10 FIN_ERROR_LIMIT This parameter is used to define the error limit for 
Fax-in service. Input parameter value is numeric.

11 ICA_INPUT_FILE_FOR-
MAT

This parameter is used to specify the Input format 
for call activity file. Two Parameter values are pos-
sible – US format and OFSLL format.

12 JSV_BI_USER This parameter is used to define the BI publisher 
User ID. Input parameter value is user defined 
(Admin user).

13 JSV_BI_PASSWORD This parameter is used to define the BI publisher 
User password. Input parameter value is user 
defined (Admin user).

14 PJR_COPY_PURGED_-
DATA

This parameter is used to specify whether data 
should be copied into the purge tables or not. 
Input parameter value is Boolean (Yes/No).

15 PUP_ARCHIVE_DAYS This parameter is used to specify the number of 
days after which the transactions upload details 
are to be archived. Input parameter value is 
numeric.

16 PUP_OARCHIVE_DAYS This parameter is used to specify the number of 
days after which the transactions upload details 
are to be moved from ‘O’ tables. Input parameter 
value is numeric.

17 PUP_TUP_LAST_PURGE_
DT

This parameter is used to capture the last date 
when transactions upload details were purged. 
Input parameter value is date.

18 TPE_APPLY_LTC_-
FROM_CURR_DUE_DT

This parameter is used to specify whether late 
charge should be applied from current due date 
for Pyramid Law fee method. Input parameter 
value is Boolean (Yes/No).

19 TPE_EXCESS_PAY-
MENT_TO_MEMO

This parameter will make excess payment to the 
memo payment by marking this Parameter as 
YES.

20 TPE_STOP_COMP_DELQ
_DAYS

This parameter is enabled to stop computation if 
the account is delinquent for more than 60 days.
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